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Preface
Welcome to the Workforce Management Supervisor User’s Guide. This 
document introduces you to the concepts, terminology, and procedures relevant 
to a Workforce Management Supervisor. All the information in this book can 
also be found in the Supervisor on-line help system.

This preface contains these sections:
 Intended Audience, page 8
 Document Conventions, page 8
 Making Comments on This Document, page 8

Genesys Workforce Management is a contact center resource-planning 
application, which consists of a client, the Workforce Management GUI, and 
Schedule Server, Data Aggregator, and Web Services server software. The 
servers make data available to Workforce Management by writing it to the 
Workforce Management database, serve real-time agent states, and provide 
browser-based functionality. 

Genesys Workforce Management unifies employee scheduling and preference 
allocation, planning, real-time and intraday management, performance 
assessment, and historical reporting into a consolidated contact center 
resource-planning application. The Workforce Management component in this 
product uses interaction data that the servers collect to:

• Forecast contact-center workload and workforce requirements.

• Create agent schedules.

• Monitor adherence to schedules, including the display of real-time agent 
states.
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Intended Audience
This document is intended for use by Supervisors at a contact center and those 
who train them. All information in this book can also be found in the 
Supervisors on-line help system, accessed through the Supervisor GUI.

Document Conventions
This document uses certain stylistic and typographical conventions—
introduced here—that serve as shorthands for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:

76wfm_ref_03-2009_v7.6.101.00 

Type Styles

Italic

In this document, italic is used for emphasis, for documents’ titles, for 
definitions of (or first references to) unfamiliar terms, and for mathematical 
variables.

Examples: • Please consult the Genesys Migration Guide for more information.

• A customary and usual practice is one that is widely accepted and used 
within a particular industry or profession.

Screen Captures Used in This Document

Screen captures from the product GUI (graphical user interface), as used in this 
document, may sometimes contain a minor spelling, capitalization, or 
grammatical error. The text accompanying and explaining the screen captures 
corrects such errors except when such a correction would prevent you from 
successfully using the product. 

Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 

mailto:techpubs.webadmin@genesyslab.com


Supervisor User’s Guide 9

Preface Making Comments on This Document

You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.

When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.
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Chapter

1 Getting Started
This chapter covers the following topics:
 Overview, page 11
 Logging In, page 12
 The Supervisor’s Window, page 13
 Date Selectors, page 15
 Finding Agents in Tables, page 17
 Logging Off, page 17

Overview
With Workforce Management Web for Supervisors (WFM Web), site 
supervisors can use a web browser to:

• View, add, edit, and delete agent preferences and exceptions.

• Set time-off limits.

• Forecast staffing requirements, based on service objectives and historical 
data.

• Schedule agents and teams for multiple activities, and make real-time 
schedule changes.

• Create a bidding scenario with profile agents, which real Agents can use to 
bid on their favorite schedules.

• View, and approve or decline, agents’ proposed schedule trades.

• Monitor real-time site performance.

• Review agents’ real-time adherence to their scheduled status.

• Generate reports that show schedule and performance information.

• Configure e-mail notifications.
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Site Freedom

• WFM Web is optimized for a screen resolution of at least 1024 x 768. At 
lower resolutions, some elements (such as table headers) might not display 
correctly.

• If you are using Mozilla or Firefox, Genesys recommends that you not run 
WFM Web in more than one browser window on the same workstation, 
because doing so can cause the application to behave unexpectedly. 

• If you are using Internet Explorer, Genesys recommends (for the same 
reason) that you not open a second browser window on the same WFM 
Web session by selecting File > New or pressing Ctrl+N. However, starting 
a separate WFM Web session by launching a separate Internet Explorer 
browser thread does not appear to cause this problem.

Security Features

WFM Web includes security features that prevent unauthorized access to 
information:

• You can view and make changes only to those modules (such as Calendar 
or Schedule) and objects (such as sites) for which you have security access. 
You cannot access other modules or objects. 

• Configuration and security options enable you to restrict access to agents’ 
personal information, such as wages.

• Agents use a separate application (WFM Web for Agents), which enables 
them to view and change their own information. They have limited access 
to other agents’ schedule information, but only if schedule trading is 
enabled at your site.

Setting the Clock

WFM Web for Supervisors picks up the regional settings from the local 
computer. You may wish to change this if, for example, WFM Web appears in 
a 12-hour format and you want to view a 24-hour format.

Note: WFM Web for Agents picks up the regional setting from the server 
where the WFM Web application is running—not from the agent’s PC.

Logging In
To start using WFM Web:

1. Open a web browser.
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2. Type the WFM Web URL (address) into your browser's address bar and 
press Enter.

Note: Your system administrator will provide the URL.

The Login window displays. 

3. Enter your user name and password.

4. Click OK.

If WFM Web validates your user name and password, and detects the required 
Java plug-in, the WFM Web application opens in a separate browser window. 
(The original browser window remains open, displaying a Genesys logo. You 
may close this window, if desired.) 

If WFM Web cannot log you in, it displays an error message indicating the 
problem. Either click login to try again (for example, if you think that you mis-
typed your user name or password), or click Show error details. 

Note: Multiple Supervisors using the Firefox web browser cannot be logged 
in to the same host at the same time.

The Supervisor’s Window

Elements of the Supervisors Window

Menu Bar The pull-down menus located at the very top of the WFM Web window allow 
you to jump directly to particular features. For example, use the Modules menu 
to navigate among modules, or use the Help menu to display the Help index or 
the program version.

Actions Menu From the menu bar, pull down the Actions menu to select from a list of view-
specific commands. (This menu's contents change as you move among 
modules and views.) 

Standard Toolbar The toolbar, located below the menu bar, always includes the following four 
standard buttons: 

Refresh updates the Objects tree's contents, and then invokes Get data to 
update the working pane's contents. (Click this button to pick up other users' 
changes to the Workforce Management (WFM) database or to WFM 
configuration.) 

Stop halts a pending data retrieval or display operation. 

Modules displays or hides the Modules tree. 

Objects displays or hides the Objects tree.
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Actions Toolbar Many views (Configuration, Forecast, Schedule, Trading, Performance, 
Adherence, Reports) add a second toolbar, containing buttons for the actions 
that you can take in that view. These buttons correspond to the commands on 
the Actions menu. Hover your mouse pointer over a toolbar button to see a 
tooltip that displays the button's name.

Views Toolbar Some views add a third toolbar, containing a drop-down list that you can use to 
jump to the current module's other views.

Modules Tree The Modules tree, at the upper left in the Modules pane, enables you to move 
among modules and views. To display the views available within a module, 
either click that module's icon, or click its expand/collapse control once. To 
select a particular view, click it in the tree.

Objects Tree The Objects tree, at the lower left in the Objects pane, displays the database 
objects that you can retrieve in the selected module and view. A similar tree 
appears within some dialog boxes and wizards. The database objects that 
display here depend on what is selected in the Modules tree.

The tree is hierarchical from top to bottom: Enterprise (displayed for some 
modules), Business Units (if any), Sites, Teams, and Agents. At the site level, 
you may see a node in the tree labeled <None>. This node lists any agents that 
are assigned to the site, but not assigned to a team. If all agents in that site are 
assigned to a team, the <None> node is empty. The only exception to this 
hierarchy is when Scenarios is selected or when you use the Configuration or 
Reports modules.

Clicking an object in the tree (or clicking its expand/collapse control) displays 
the object's contents to the right of it. When you have displayed the desired 
object, click it (or click it once, and then click Get data) to open the selected 
view for that object.

Where the Objects tree displays check boxes, you can usually select/deselect 
multiple objects by selecting/clearing their respective check boxes. Certain 
views do not display check boxes; in this case, you can select multiple objects 
by clicking the group of objects while holding down the Shift or Ctrl key. 
Some views and windows allow you to select only a single object.

Expand/Collapse
Controls

Wherever you see the  icon in a tree or other control, you can click it to see 
an expanded view of the adjacent item's contents or details.
The  icon indicates an expanded item. Click once on it to collapse the item's 
contents and see more parallel items.

Working Pane The right pane of the window displays data and controls that correspond to 
your selected module and view. Some views display graphs with an 
explanatory legend below them.

Action Buttons View-level action buttons within the working pane provide controls that are 
specific to particular views (for example, apply or cancel).

The Get data button, when present at the lower left below the Objects tree, 
refreshes the display with current data from the database. 
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Note: Not all modules use the Get data button. If there is no Get data button, 
the view is automatically updated with the new data every time you 
change your date or object selection.

Status Bar The status bar, at the very bottom of the window, displays messages about 
WFM Web's current state. (In some views, it displays the most recently 
generated warning or error message.)

Customizing Table Views

Many WFM Web views include on-screen tables. You can typically customize 
the display of these tables in one or both of the following ways:

Resize Columns—In the table's header row, place your mouse pointer over the 
separator between two column headers. When you see a two-headed arrow, 
click and drag the column separator to adjust the column widths.

Sort by Column—In some tables, you can sort the data according to one of 
the displayed columns. Specify the column by clicking its header. 

You can change the sort order by clicking the header again. An upward-
pointing arrowhead in the header indicates ascending order. A downward-
pointing arrowhead indicates descending order.

In the figure below, the Agent column is specified as the sort key, in ascending 
order.

Figure 1: Sorting by Agent

Date Selectors
Many WFM Web modules and views have common date-selection controls to 
modify the date(s) displayed in them. The following sections cover:

• Selecting a start date.

• Jumping to other dates by opening the monthly calendar.

• How WFM Web automatically selects the first workday in weekly views.

Selecting the Start Date

Where available, the date-selection controls appear at the right edge of the 
toolbar:
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Figure 2: Date-selection Controls

These controls function as follows:

<—Click this button to move the start date back one interval (day, week, or 
schedule planning period—depending on the context).

Date:—Type a date into this date box to directly edit the start date. (The 
sequence of month, day, and year digits depends on your operating system's 
regional settings.) You can also use the up or down arrow to modify the 
displayed date.

...Date—Click this button to open the monthly calendar.

End —For views that display more than one day's information, the end date 
appears (but cannot be edited) here.

>—Click this button to move the start date forward one interval (day, week, or 
schedule planning period—depending on the context).

Selecting the Month

The calendar shows one calendar month. You can use the calendar's controls 
to:

Select a new start date—Click a date. (The calendar closes, adjusting the 
current module or view to your selected start date.)

Jump forward or backward one year—Click the small up or down arrow to 
the right of the year text box.

Jump to a specific year—In the year text box, select and retype the digits that 
you want to replace. (Green digits remain editable; press Enter to lock the new 
year, which turns the digits black.)

Jump forward or backward one month—Click the small up or down arrow 
to the right of the month name.

Jump to a specific month:—Click the month name, and then click a different 
month in the drop-down list that appears.

Colors in the calendar have the following meanings:

Dark gray square—Currently-selected start date.

Weekly Views: Automatic Start Day Selection

In weekly views, if you enter a date other than the first weekday, the view 
automatically adjusts to start with the first weekday.
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Note: If the WeekStartDay setting has been specified in the WFM 
Configuration Utility, the first weekday is the one specified in 
WeekStartDay. Otherwise, the first weekday is the one specified in 
your operating system's regional settings.

Finding Agents in Tables
In a number of WFM Web windows, you can search for particular agents by 
using the Find Agent dialog box. To open it, select the table you want to search 
and then either:

• Select Find from the Edit menu.

• Press Ctrl + F.

You can search for agents in these windows:

• The Calendar Module main window. 

• The table in the Schedule Scenario Weekly View and Master Schedule 
Weekly View. Select a cell in the Agent Name column to activate the Find 
command.

• The table in these views:
 Schedule Scenario Agent Extended
 Schedule Scenario Intra-Day
 Master Schedule Agent Extended
 Master Schedule Intra-Day

To search for one or more agents:

1. In the Find Agents dialog box, type either the full name for which you are 
searching or its first few letters.

2. Select the Last Name or First Name radio button.

3. Click Find.

The table that you are searching now shows the first agent listed whose 
name matches the search string that you entered. A message box informs 
you if there are no agent names that match your search criteria. 

4. Click Find again to find the next agent whose names matches the string 
you entered. You can search as many times as you want. 

5. When you have finished searching, click Close to close the Find Agent 
dialog box.

Logging Off
You should always log off when you have finished using WFM Web.
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Warning! If you do not log off, other users of your workstation might be able 
to view your account information.

To log off from any WFM Web view:

1. Pull down the File menu.

2. Select Logoff/Login. 

WFM Web logs you off and the login screen appears. Another user can log in 
or you can now close the browser.
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2 Configuration Module
This chapter covers these topics:
 Configuring Notifications Overview, page 19
 Notification of Schedule Trade Status Changes, page 20
 Notification of Time-Off Request Status Changes, page 22
 Notification of Schedule Modifications, page 24

From the Configuration module, you can access:

• Notifications 

• Colors

Configuring Notifications Overview
Under Configuration, use the Notifications module to create and edit e-mails 
by site for the types of notifications listed below:

• Schedule trade status changes

• Time off request status changes

• Schedule modifications 

Default Setting

By default, WFM does not generate notifications. In order to generate 
notifications, you must select at least one site to send notifications of given 
type in the Targets tab and save. Once you have done so, notifications of the 
selected type(s) are sent. 

Security Permissions

You must have certain security permissions assigned in the Configuration 
Utility. See each individual topic above for the type of permission required. 
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WFM Daemon

A Genesys server component, WFM Daemon, sends out notifications to agents 
and supervisors. For more information on this server component, see the 
current Workforce Management Administrator's Guide. 

Notification of Schedule Trade Status 
Changes

Note: In order to configure notifications of schedule trade status changes, you 
must have the Configuration, Notifications permission assigned in the 
WFM Configuration Utility. 

To bring up the module for notification of schedule trade status changes:

1. In the Modules tree, expand the Configuration module.

2. Click Notifications. The Objects tree highlights Schedule Trades Status 
Changes. The Working pane shows the Messages tab where you configure 
the message Subject, Body, and variables (Tokens).

Figure 3: Notifications module, Schedule Trades Status Changes object, Messages tab
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Message Tab

The message tab has three areas:

• Tokens. This area contains buttons for inserting tokens into the message 
body. Available tokens related to agent schedule trades are: Proposing 
Agent, Responding Agent, Requested Dates, Status, Submission Date, 
Expiration Date.

• Subject. This area contains Genesys-supplied subject text, which you can 
modify by changing text and inserting variables (tokens). The supplied text 
is:
Message from Genesys Workforce Management: Schedule trading status 
changed.

• Message Body. This area also contains Genesys-supplied body text, which 
you can modify by deleting/typing over text and inserting tokens. The 
supplied text is: 
The schedule trade proposal for <Proposing Agent> and <Responding 
Agent> for the date(s) <Dates> has been updated with the status of 
<Status>. Trade proposal submission date is <Submission Date>. It 
will expire on <Expiration Date>.

Modifying the Message

To modify the message subject or body text:

1. Delete/type over text.

2. Place the cursor where you wish to insert a token.

3. Click the appropriate token button. The token gets inserted.

4. Click the Save button on the toolbar. If you switch to another notification 
type without saving, a message asks if you wish to save or cancel.

Targets Tab

Use the targets tab to select business units and/or sites within business units. 
You can expand business units to display their sites. You can select multiple 
sites. 

Rules for Sending

After a successful save, WFM Daemon uses the specified Subject and Body 
and the rules listed below when sending notifications to agents and 
supervisors. In the rules below, the proposing agent is one creating the trade 
request; the responding agent is the one receiving the proposal. 

• Both the proposing and responding agents associated with the selected 
sites get notified when a trade status is User-declined, User-approved, 
Auto-declined, Auto-approved, or Cancelled.
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• Supervisor(s) associated with the selected sites get notified when a trade 
status is Pending.

• The responding agent gets notified when the status of a trade proposal is In 
Review or Open. 

• The proposing agent gets notified when the response status of a trade 
proposal is Accepted, In Review, or Cancelled. 

Double-Handshake Trade Proposals

A double-handshake trade proposal works as follows: When Agent A creates a 
trade proposal for Agent B (or for the community), there is a checkbox that 
asks whether or not the agent wants to manually approve the response: Check 
if you want to manually approve response to this trade proposal.

If this box is not checked, the order of events is: 

1. Agent A creates proposal.

2. Agent B accepts proposal.

3. Trade is either automatically approved or goes into In Review state for a 
supervisor to review and approve, depending on the details of the trade.

If the box is checked, a double-handshake proposal is created. The order of 
events is then:

1. Agent A creates proposal.

2. Agent B accepts proposal.

3. Agent A needs to approve the response from Agent B.

4. Trade is either automatically approved or goes into In Review state for a 
supervisor to review and approve, depending on the details of the trade.

The extra approval step (3) allows Agent A to re-confirm that he wants the 
trade to go through. 

Notification of Time-Off Request Status 
Changes

To configure notifications of time-off request status changes, you must have 
the Configuration, Notifications permission assigned in the WFM 
Configuration Utility.

To bring up the module for notification of time-off request status changes:

1. In the Modules tree, expand the Configuration module.

2. Click Notifications. The Objects tree highlights Schedule Trades Status 
Changes. The Working pane shows the Messages tab where you configure 
the message Subject, Body, and variables (Tokens)).
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Message Tab

The message tab has three areas:

• Tokens. This area contains buttons for inserting tokens into the message 
body. Available tokens related to agent schedule trades are: Proposing 
Agent, Responding Agent, Requested Dates, Requested Status, Submission 
Date, Expiration Date.

• Subject. This area contains Genesys-supplied subject text, which you can 
modify by changing text and inserting variables (tokens). The supplied text 
is:
Message from Genesys Workforce Management: Schedule trading status 
changed.

• Message Body. This area also contains Genesys-supplied body text, which 
you can modify by deleting/typing over text and inserting tokens. The 
supplied text is: 
The schedule trade proposal for <Proposing Agent> and <Responding 
Agent> for the date(s) <Dates> has been updated with the status of 
<Status>. Trade proposal submission date is <Submission Date>. It 
will expire on <Expiration Date>.

Modifying the Message

To modify the message subject or body text:

1. Delete/type over text.

2. Place the cursor where you wish to insert a token.

3. Click the appropriate token button. The token gets inserted.

4. Click the Save button on the toolbar. If you switch to another notification 
type without saving, a message asks if you wish to save or cancel.

Targets Tab

Use the targets tab to select business units and/or sites within business units.

You can expand business units to display their sites. You can select multiple 
sites.

Rules for Sending

After a successful save, WFM Daemon uses the specified Subject and Body 
and the rules listed below when sending notifications to agents and 
supervisors. In the rules below, the proposing agent is one creating the trade 
request; the responding agent is the one receiving the proposal. 
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• Both the proposing and responding agents associated with the selected 
sites get notified when a trade status is User-declined, User-approved, 
Auto-declined, Auto-approved, or Cancelled.

• Supervisor(s) associated with the selected sites get notified when a trade 
status is Pending.

• The responding agent gets notified when the status of a trade proposal is In 
Review or Open. 

• The proposing agent gets notified when the response status of a trade 
proposal is Accepted, In Review, or Cancelled. 

Double-Handshake Trade Proposals

A double-handshake trade proposal works as follows: When Agent A creates a 
trade proposal for Agent B (or for the community), there is a checkbox that 
asks whether or not the agent wants to manually approve the response: Check 
if you want to manually approve response to this trade proposal.

If this box is not checked, the order of events is: 

1. Agent A creates proposal.

2. Agent B accepts proposal.

3. Trade is either automatically approved or goes into In Review state for a 
supervisor to review and approve, depending on the details of the trade.

If the box is checked, a double-handshake proposal is created. The order of 
events is then:

1. Agent A creates proposal.

2. Agent B accepts proposal.

3. Agent A needs to approve the response from Agent B.

4. Trade is either automatically approved or goes into In Review state for a 
supervisor to review and approve, depending on the details of the trade.

The extra approval step (3) allows Agent A to re-confirm that he wants the 
trade to go through. 

Notification of Schedule Modifications
To configure notifications of schedule modifications, you must have the 
Configuration, Notifications permission assigned in the WFM Configuration 
Utility. 

To bring up the module for notification of schedule modifications (sent to 
agents only):

1. In the Modules tree, expand the Configuration module.

2. Click Notifications. 
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3. In the Objects tree, select Schedule Modifications. The Working pane 
shows the Messages tab where you configure the message Subject, Body, 
and variables (tokens).

Message Tab

The message tab has three areas:

Tokens. This area contains buttons for inserting tokens into the message body. 
Available tokens related to agent time off requests are: Agent, Requested 
Dates.

Subject. This area contains Genesys-supplied subject text, which you can 
modify by changing text or inserting tokens. The supplied text is:
Message from Genesys Workforce Management: Schedule modification 
occurred.

Message Body. This area also contains Genesys-supplied body text, which you 
can modify by deleting/typing over text and inserting tokens. The supplied text 
is: 
The schedule for <Agent> has been modified for the date(s) <Dates>. 

Modifying the Message

To modify the message subject or body text:

1. Delete/type over text.

2. Place the cursor where you wish to insert a variable (token).

3. Click the appropriate token button. The variable gets inserted.

4. Click the Save button on the toolbar. If you switch to another notification 
type without saving, a message asks if you wish to save or cancel.

Targets Tab

Use the targets tab to select sites. You can expand business units to display 
their sites. You can select multiple sites. 

Rules for Sending

When a supervisor changes one or more schedule days, WFM sends a schedule 
modification notification to the configured site's affected agent.
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Chapter

3 Calendar Module
This chapter covers the following topics:
 Calendar Items Overview, page 27
 Filter Dialog Box, page 34
 Options Dialog Box, page 35
 Change Preference Status, page 35
 Add Calendar Items Wizard, page 37
 Add or Edit Start/End Time, page 39
 Update Schedule Options, page 44
 Edit Calendar Items, page 44
 Review Calendar Messages Dialog Box, page 45
 Time Off Limits, page 46
 The Set Values Dialog Box, page 49

The Calendar module contains two sub-modules:

• Select Calendar Items to:
 Add Availability, Days Off, Exceptions, Shifts, Time Off, and 

Working Hours.
 Edit agent Exceptions, Preferences, and Time Off.
 Review rotating patterns.

• Select Time Off Limits to set time-off limits. 

Calendar Items Overview
The Calendar module includes Calendar Items and Time Off Limits.

The toolbar buttons are across the top of the window and the action buttons are 
across the bottom of the window. The Agents and Activities tabs are at the top 
of the Objects Tree.
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Use the Calendar Items module to add, and edit agents' exceptions, 
preferences, and time off, as well as grant rotating patterns. 

• Exceptions are periods of time when agents are engaged in non-work 
activities.

• Preferences are agent and supervisor requests for particular shifts, days off, 
availability, and time off.

• Rotating patterns are rotating work weeks of shifts, working days, working 
hours, and/or work activities. A rotating pattern can be assigned to an agent 
or a team. 

Figure 4: Calendar Items module 

Calender Module Controls

The Calendar Items module displays the following controls and columns:

Toolbar Buttons—Click the Filter button to filter the display. Click the 
Options button to select whether to include these columns in the table: Team, 
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Reason, Comments, Paid Hours, Hire Date, Submitted. Click the Add calendar 
items button to add Calendar items

Figure 5: Toolbar Buttons

Action Buttons—Click Prefer, Grant, or Decline to change the status of 
selected preferences. Click Delete to remove selected Calendar items. Click 
Edit to edit one selected Calendar item.

Figure 6: Action Buttons

About the Calendar Items Module

The Calendar Items module displays agents’ shifts, days off, time off, 
exceptions, availabilities, and rotating pattern assignments. You can filter this 
display. You can add and edit most types of Calendar items from this display, 
and you can edit exceptions, working hours, shifts, and availabilities.

Note: Rotating pattern information is read-only. Rotating patterns appear 
with an RP: prefix. To change rotating pattern settings, you must use 
the Rotating Patterns window in the WFM Configuration Utility's 
Policies module. See the current Workforce Management 
Configuration Utility Help for more information.

Calendar Module Security

The WFM Configuration Utility defines security access permissions. Users 
may have full security access to this module, or they may only be able to work 
with preferred Calendar items.

If you have limited access, the Grant, Prefer, and Decline buttons are disabled. 
You can only add, edit, or delete calendar items in Preferred status. 

Displaying the Calendar Module

To view Calendar items:

1. If the Calendar Items module is not displayed, expand Calendar on the 
Modules pane and click Calendar Items.

2. In the three-month Calendar display, select the dates to view as explained 
below.
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Figure 7: Three-month Calendar Display

Calendar Module Columns

Date—Displays the date of the Calendar item.

Agent —Displays the name of the agent who has the Calendar item. Calendar 
items can be applied to sites or teams, but they are displayed and edited agent-
by-agent.

Type—Displays the type of the Calendar item (for example, part-day 
exception).

Item—Displays the name of the Calendar item (for example, Team Meeting or 
Shift_1).

Start time—Displays the time the Calendar item begins. Some full-day 
rotating pattern items (Day Off, Any Shift, and Flexible Shift) do not have start 
or end times. For this reason, the Start time and End time columns are empty 
for these items.

End time—Displays the time the Calendar item ends. A plus sign (+) indicates 
the day after the start time. Some full-day rotating pattern items (Day Off, Any 
Shift, and Flexible Shift) do not have start or end times. For this reason, the 
Start time and End time columns are empty for these items.

Status requested—Displays the status of a Calendar item for a period that has 
not yet been included in a schedule, as set by the user: Granted, Declined, or 
Preferred.

See “Change Preference Status” on page 35 for an explanation of the statuses. 
See Requested Status vs. Actual Status for an explanation of the status that 
appears in the status requested and Status actual columns.

Status actual—Displays the status of the Calendar item as resolved by 
Workforce Management: Granted, Declined, Preferred, Scheduled, or Not 
Scheduled. 
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See “Change Preference Status” on page 35 for an explanation of the statuses. 
See “Requested Status vs. Actual Status” on page 36 for an explanation of the 
status that appears in the status requested and Status actual columns.

Reason—Explains why WFM has set an item's actual status to Declined. You 
can display/hide this column by using the Options dialog box.

Comments—Displays any comments associated with the Calendar item, 
including ones that may have been entered by agents when requesting the item 
using WFM Web for Agents. You can display/hide this column by using the 
Options dialog box. This column is not sortable.

Paid Hours—Displays the number of paid hours for the calendar item. You 
can display/hide this column by using the Options dialog box.

How to Use the Calendar

• Select any single date by clicking it. 

• Select multiple dates by holding down Ctrl while clicking them.

• Select a range of dates by holding down Shift while clicking them or by 
clicking the first day and then dragging the mouse to the last day before 
releasing the mouse button.

• Select the same day of the week throughout a month by clicking that day's 
header. For example, to display all Mondays, click Mon.

• Display a different year or month by clicking the year or month drop-down 
arrow.

• Go back a month by clicking <, or advance to the next month by clicking 
>.

To retrieve specific data:

1. Select a date or range of dates.

2. Select a site, one or more teams, or one or more agents from the Objects 
tree. (You can select multiple teams or agents within a single site, but not 
from more than one site.)

3. Click Get data.

The table displays Calendar items for the selected site, teams, or agents. You 
can sort the display by clicking the header for any column. 

You can search the table for particular agents by using the Find Agent dialog 
box. To open it, select the table to search and then select Find from the Edit 
menu or press [Ctrl] + F.

If the full text is too long to appear in a calendar cell, hover your mouse pointer 
over that cell. The full text appears in a tooltip.



32 Workforce Management 7.6

Chapter 3: Calendar Module Calendar Items Overview

Note:  By default, if another user adds a new exception type while you have 
the Calendar open, the new exception type is not selected in the Filter 
dialog box. To see agents who have an exception of the new type 
assigned, open the Filter dialog box and select the check box for the 
new exception type.

Calendar Object Hierarchy

When you enter more than one kind of Calendar item for an agent at the same 
time, a hierarchy determines which takes precedence. The higher priority item 
appears as Granted, and incompatible lower-priority items appear as Declined. 

The order of priority for exceptions and preferences is:

1. Granted full-day exceptions.

2. Granted days off.

3. Granted full-day time off.

4. Granted availability.

5. Granted shifts.

6. Granted paid (working) hours.

7. Granted part-day exceptions, granted part-day time off.

8. Rotating patterns.

9. Preferred items (including exceptions, paid hours, and time off with 
preferred status).

Consistency Checks
After you add an exception or preference in the Calendar, the Calendar 
performs consistency checks to determine whether it is valid. 

To be valid, an exception or preference must:

• Fall within the agent's Contract availability hours.

• Fall within activity hours of operation for activities that the agent can 
perform.

• Be consistent with the Contract paid hours requirements. Unpaid 
exceptions are added to the paid hours if they do not violate the Contract 
availability hours.

In addition, if you are entering multiple part-day exceptions, part-day time off, 
or a mix of part-day exceptions and time off, these:

• Cannot overlap.

• Must be compatible with a qualifying shift's settings, including meal 
parameters. (This limitation does not apply to full-day time off or days 
off.)
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Preference and Exception Considerations
• You can enter multiple compliant Calendar items for the same day. For 

example, you can enter a shift and a day off for the same day. Or you can 
enter an availability and a shift for the same day if the shift fits into the 
availability parameter. WFM Web assigns the item that best fits the agent’s 
schedule.

• You can enter only one full-day exception of a single type per day. 
However, you can enter multiple part-day exceptions of the same type. 
(WFM Web sets the status of incompatible Calendar items to Declined.)

• You can add or edit preferences and exceptions even after a schedule has 
been created for the affected days. However, if you make changes after 
building the schedule, you must rebuild the schedule to pick up the 
changes.

Explanation of Calendar Colors

The Calendar uses two basic cell colors, white and grey, and two colors for 
selected items, light blue and dark blue. 

Figure 8: Three-month Calendar Display

• Grey indicates a non-selected cell for which data has not been requested. 
There may be data for that day or there may not.

• White indicates a non-selected cell for which there is data. That is, at some 
earlier point in this session you selected this date and clicked Get data. 

• Light blue indicates a selected cell for which there is data.

• Dark blue indicates a selected cell for which data has not been requested. 
There may be data for that day or there may not.

The calendar uses three text colors, black, white, and red. 



34 Workforce Management 7.6

Chapter 3: Calendar Module Filter Dialog Box

• Black indicates that you have not yet requested data for a day or that you 
requested data and there is no data for that day. 

• White replaces black on the dark-blue background for legibility.

• Red indicates that there is data for that day. That is, at some earlier point in 
this session you selected this date and clicked Get data.

Filter Dialog Box
Use the Filter dialog box to change which items appear in the Calendar Items 
module:

1. Open the Calendar module.

2. Select an object (site, team, or agent) from the Objects tree.

3. Select a date or dates from the Calendar.

4. Click Get data.

5. Click the Filter button on the Calendar Items module toolbar. The Filter 
dialog box appears. It has three tabs: Calendar Items, Status Requested, 
and Status Actual. 

Calendar Items lists all exception types, preference types, time-off types, 
and rotating patterns.

Status Requested lists all statuses that can appear in the Status Requested 
column of the Calendar table.

Status Actual lists all statuses that can appear in the Status Actual column 
of the Calendar table.

6. Clear the check boxes for any Calendar items or statuses that you want to 
hide from the Calendar display. Or select the check boxes for any 
currently-hidden items that you want to display.

7. Click Apply to save your changes, or Cancel to restore the existing 
selections.

The Calendar view is updated to match your selection.

Note: By default, if another user adds a new exception type while you have 
Calendar open, the new exception type is cleared in the Calendar Filter 
dialog box. To see agents who have an exception of the new type 
assigned, open the Filter dialog box and select the check box for the 
new exception type.
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Options Dialog Box
Use the Options dialog box to show or hide two columns in the Calendar items 
table: Reason and Comments.

Site—The site of the Agent who appears in that row. 

Team—Team of the Agent who appears in that row.

Reason—An explanation for why the actual status is different from the 
requested status. 

Comments—Any comments made when this calendar item was entered or 
most recently edited.

Paid Hours—The number of paid hours for the calendar item.

Hire Date—The date that the Agent began work for the company.

Submitted—The date and time that the Calendar item was submitted (by 
either an Agent or a Supervisor, depending on the type of Calendar item).

To use the Calendar Options dialog box:

1. Select the Calendar Items module on the Modules pane, select an object (a 
site, team, or agent) from the Objects tree, and select a date or dates from 
the Calendar, and click Get data.

2. Click the Options button on the Actions toolbar or select Options from the 
Actions menu. The Options dialog box opens. Under Columns, check 
boxes appear opposite Reason, Comments, and Paid Hours.

3. To display a column, select the check box next to its name. To hide it, clear 
the check box. 

4. Click Apply to save your settings or Cancel to discard them.

The main Calendar window re-appears, showing the new settings.

Change Preference Status
Use the Calendar Items module to change the status of an agent's preference, 
exception, time off, or working hours (shift and availability) request prior to 
publishing the schedule. 

• Before you publish the schedule, the possible actual status settings are 
Preferred, Granted, and Declined.

• After you publish the schedule, the possible actual status settings are 
Scheduled or Not Scheduled.

Preference Statuses

Before scheduling, a preference can be Granted, Declined, or Preferred. After a 
scheduled is built for the dates that include this preference, the status can be 
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Scheduled (appears in the schedule) or Not Scheduled (does not appear in the 
schedule).

• A Granted preference will appear in the schedule unless it is first removed 
or unless another preference is added that out-ranks the first one. If this 
happens, the status of the lower-ranking preference changes to Declined.

• A Declined preference will not appear in the schedule unless it was 
declined in favor of a higher-ranking preference and the higher-ranking 
preference is later removed before the schedule is built. If this happens the 
preference goes back to its original status, which can be Granted or 
Preferred.

• A Preferred preference may appear in the schedule if it complies with the 
scheduling constraints and optimization settings that are configured for 
your site.

Two columns in the Calendar Items module show the preference status: Status 
Requested and Status Actual. See below for an explanation of the two 
categories.

To change the status of a not-yet-scheduled item:

1. In the Calendar's item column, click the name of the item you want to 
change.

2. Click an action button for the item's new status: Prefer, Grant, or Decline.

3. Click OK.

The new status appears in the Status columns. 

Note:  The status can be different in each column, and the Actual Status can 
differ from the status that you just assigned. This is because of the way 
in which the Requested and Actual Status columns function, as 
explained below.

Requested Status vs. Actual Status

Requested Status and Actual Status refer to the two ways in which each 
exception and preference is saved.

• Requested Status is the preference's status as entered by the user. If more 
than one preference is entered on a particular day, each item is saved to the 
database with the status that it has when entered. 

• Actual Status is the status as resolved by WFM. WFM evaluates all 
current exceptions and preferences based on their positions in the calendar 
object hierarchy. If an agent has multiple preferences for a day, the Actual 
Status indicates how WFM has resolved them. 

For example, if an agent prefers a full-day time off, that preference is saved in 
the database as Preferred. If the agent is then assigned (granted) a meeting 
exception for that day, the exception overrides the preference. WFM evaluates 



Supervisor User’s Guide 37

Chapter 3: Calendar Module Add Calendar Items Wizard

the current set of exceptions and preferences, and notes the time-off preference 
as Declined. However, the database maintains the preference status as 
Preferred because, until a schedule is generated, the exception can be removed. 
In this case the preference would again take effect and the preference Actual 
Status would change to Preferred.

Note:  Rotating pattern assignments are Granted by default, so they do not 
need a separate status saved to the database.

Add Calendar Items Wizard

Overview

Using this wizard, you can add: availability, time off, days off, shifts, and 
working hours. (This wizard is available to supervisors with the appropriate 
security access.) 

To use the wizard:

1. Open the Calendar Items module.

2. Select an object (a site, team, or agent) from the Objects tree.

3. Select a date or dates from the Calendar.

4. Click Get data.

5. Click the Add Calendar Items button on the toolbar.

For instructions on filling in each wizard screen, see:

• Choose Agents.

• Choose Calendar Items.

Depending upon the choices that you make on the first two screens, you 
proceed to one of these screens:

• Add or Edit Start/End Time

• Add or Edit Exceptions

• Add or Edit Shifts

• Add or Edit Time Off

• Comments

The last three screens can also appear when you edit Calendar items.

Choose Agents

The Add Calendar Items Wizard's first screen is Choose Agents. 
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Figure 9: Choose Agents Dialog Box

By default, the enterprise, business units, sites, teams, and agents that were 
selected in the Calendar when you clicked the Add Calendar Items button are 
selected. 

1. Change the selections, if necessary.

2. Click Next to continue. 

Note: If you select objects from more than one site, then the next page 
(Choose Calendar Item) will display a limited list of calendar item 
types: availability, day off, and working hours.

The second wizard screen, Choose Calendar Item, opens. 

Choose Calendar Item

The second Add Calendar Item Wizard screen is Choose Calendar Item.

To choose an item:

1. Select a Calendar item type.
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If you selected objects from more than one site on the previous page 
(Choose Agents), then the list of calendar item types is limited to: 
Availability, Day Off, and Working Hours.

2. Set the Requested state to Preferred, Granted, or Declined.

 If you selected Working Hours or Exception, the Required state is preset 
to Granted. If you grant a Day Off, Scheduler will grant the day off 
regardless of the impact on service levels.

3. Click Next.

Depending on your selection here, one of several screens appears. See 
Calendar Items Wizard Screen Sequences for the next screen for each 
calendar item type. 

4. Fill in the information requested on the next screen and then click Finish to 
save your request. To close the wizard without saving, click Cancel.

If WFM Web cannot assign some selections, it opens a window that lists the 
agents, days, and reasons involved.

Add Calendar Item

The third Add Calendar Item Wizard screen is Add Calendar Item.

To add an item:

1. Select the specific type of the item that you are adding, from the table.

If you selected Time Off on the previous wizard page, you can select the 
Show all check box to display all time-off types. Or, you can clear the 
check box to display only the time-off types that are applicable to the 
selected agent.

2. Make other selections from the dialog, as needed.

Your available choices will vary depending on the type of calendar item 
you are adding.

3. Click Finish.

Notification about Granted, Not Scheduled item(s) is sent to the supervisor 
only if an agent added the item(s).

Add or Edit Start/End Time
To set the Start and End Time for Availability or Working Hours:

1. Enter the Start Time.

You can either type the start time directly into the field, or use the up or 
down arrow to select the time.
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Note:  For Working Hours, your selections must fall within agent 
availability. For Working Hours with a status of Granted, your 
selections override a shift with Preferred status and set absolute 
working hours.

2. Enter the End Time, using the same options.

The Availability or Working Hours duration cannot exceed 36 hours.

3. Select Next Day if the End Time is on the day after the Start Time.

Note:  If you select Next Day, the End Time must be before 12:00 noon.

4. Enter any comments you want to make regarding this Calendar item.

5. Click Finish.

The Calendar reappears, displaying the new or edited availability or working 
hours.

Add or Edit Comments

If you selected Day Off in the Choose Calendar Items screen, the Comments 
screen appears when you click Next.

• Type your comments, if you have any, into the Comments text box, and 
then click Finish.

The Calendar reappears, displaying the new or edited day off.

Add or Edit Exceptions

If you select Exception on the Choose Calendar Item screen, the Choose 
Exception screen appears when you click Next.

1. Select an exception type from the Exceptions list. This list shows all of the 
exceptions that are available for the selected agent(s). 

Yes, under Paid, indicates that the exception counts as paid time. 

No, under Full Day, indicates a part-day exception. 

Yes, under Convertible, indicates an exception that can be converted to a 
Day Off.

2. Set the Start Time and End Time, if necessary.

For part-day and full-day exceptions, you can either type times directly 
into these text boxes, or use the up and down arrows to select the times. 
Click the down and up arrows to control hours. To change minutes, 
highlight and type over existing minutes. For example, you could enter a 
one-minute exception from 10:01 to 10:02. 
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3. If you selected a full-day paid exception, you can select the Specify Paid 
Hours check box to enter a duration other than the default number of hours 
in a work day. 

If you select the Specify Paid Hours check box, the Paid Hours text box 
becomes editable. 

Note:  If you enter a start/end time but do not enter a value for Paid 
Hours, then Paid Hours will equal End Time minus Start Time 
(known as Total Hours or Duration).

4. If you want to enter a comment, type it into the Comments text box.

5. Click Finish.

The Calendar reappears, displaying the new or edited exception. 

If WFM Web cannot assign some selections, it opens a window that lists the 
agents, days, and reasons involved.

Multiple Part-Day Exceptions

You can add multiple part-day exceptions for a single day. Certain consistency 
checks apply:

• The exceptions must be compatible with all shift settings, including meal 
settings. If they are not, all of the exceptions are declined.

• Part-day exceptions cannot overlap each other or any part-day time-off.

Add or Edit Shifts

If you select Shift on the Choose Calendar Item screen, the Choose Shifts 
screen appears when you click Next.

1. Select a shift name from the Shifts list.

This list shows all shifts that are available for the selected agents and days.

2. Change the Start Time, if necessary.

The drop-down list shows all possible start times for the selected shift, 
based on the shift's configuration.

3. Enter or change the End Time, if necessary.

You can either type a time directly into the text box, or use the up or down 
arrow to select the time. The field accepts only times that match the 
selected shift's configured end times.

4. Select Next Day if the End Time is on the day after the Start Time.

5. If you want to enter a comment, type it into the Comments text box.

6. Click Finish.

The Calendar reappears, displaying the new or edited shift.



42 Workforce Management 7.6

Chapter 3: Calendar Module Add or Edit Start/End Time

Add or Edit Time Off

If you select Time Off on the Add Calendar Item screen, from within either the 
Intra-day or Agent-Extended view, the Choose Time Off screen appears when 
you click Next.

1. Select a time-off type from the Choose Time Off list.

This list shows all of the time-off types that are configured for the selected 
site. If you select a time-off type that is not associated with a selected 
agent, then WFM assigns the time off but does not enforce the time-off 
balance rules ...except for limits. If the time-off type counts toward time-
off limits, then WFM takes this time-off item into account when 
calculating limits.

2. If the time-off preference is for a full day off, select the Full Day check 
box. This action changes some parameters:

The Start Time and End Time fields are disabled.

The Specify Paid Hours check box is enabled. Use it to specify the exact 
number of hours in a full day for this particular time off. Then enter or select in 
the Paid Hours box.

You may not need to adjust this value manually. If you selected a single agent, 
then the default is the number of paid hours/minutes configured for the agent's 
time-off rule, for the type of time off being inserted. If you selected multiple 
agents, the default value is 0.
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Figure 10: Choose Time Off Dialog Box

3. Select the Show all checkbox to display all Time Off types. Clear the 
checkbox to display only Time Off types that are applicable to the selected 
agent.

4. Select the Wait-list check box to specify that if a time off request is 
denied because the time-off limits have already been reached, the request 
will stay in a Preferred status, in case an opening becomes available. The 
request could eventually be granted by a Supervisor, although this is not 
guaranteed.

5. For part-day time-off preferences, set the start and end times. If the end 
time falls on the following day, select the Next Day check box.

Note:  Part-day time off must comply with all settings for at least one 
qualifying shift, including meal parameters.

6. If you want to enter a comment, type it into the Comments text box.

7. Click Finish.

The Calendar reappears, displaying the new or edited time-off item.
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Note:  If you are entering multiple part-day time-off items, these cannot 
overlap each other or any part-day exception.

Update Schedule Options
Use this functionality to update the selected schedule with time-off calendar 
items which have the status Granted, Not Scheduled or Recalled, Scheduled.

1. Create a Granted Time Off item in the calendar. (Use the Add Calendar 
Item Wizard.) Its status will be Granted, Not Scheduled.
OR
Select a Time Off item that has Recalled, Scheduled status.

2. Click the Update Schedule icon in the toolbar, or the Update Schedule 
button at the bottom right of the WFM window, or select Update Schedule 
from the Actions menu.

3. Correct any errors.

4. If there are no errors, then the Update Schedule Options dialog box 
appears, offering three check boxes which are all selected by default:

• Insert only if there are no errors or warnings

• Show warnings

• Auto commit inserted items

5. Clear any check boxes that you do not wish WFM to obey, and click OK. 
The selected Time Off item is published to the Master Schedule.

WFM displays a warning under these circumstances:

• When you insert a full-day Time Off either from the Calendar or directly 
into the Master Schedule on a day in the Master Schedule that is already a 
Day Off. 

• When you insert a full-day or part-day Time Off either from the Calendar 
or directly into the Master Schedule on a day in the Master Schedule that 
already has an Exception.

Edit Calendar Items
To edit a Calendar item:

1. Select an item in the Calendar view's table.

You can edit only one Calendar item at a time.

2. Double-click the selection or click Edit.

The appropriate Edit screen appears. See the table below for a list of the 
Calendar-item types and the edit screen that opens for each.
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3. Change the Calendar item's settings as necessary.

The available settings depend on the type of item that you are editing. For 
detailed instructions for each screen, use the table below to find the 
appropriate Help topic.

4. Click OK to save your selections, or Cancel to exit without saving them.

The Calendar reappears, displaying any changes that you have saved.

If WFM Web cannot assign some selections, it opens a window that lists the 
agents, days, and reasons involved.

Calendar Items Wizard Screen Sequences

• Calendar Item: Next Screen

• Availability: Choose Start/End Time

• Day Off: Comments

• Exception: Choose Exception

• Shift: Choose Shift

• Time Off: Choose Time Off

• Working Hours: Choose Start/End Time

Review Calendar Messages Dialog Box
In the Calendar, if you grant a time-off item that exceeds the time-off limits, 
Workforce Management (WFM) returns a warning. WFM presents all 
warnings as a table in the Review Calendar Messages dialog box. The columns 
of the table include the check box column, Team, Agent, Date, and Message.

If you have Prefer/Grant/Decline and Edit Time Off Limits permissions within 
the Calendar module, you can override the warnings. 

1. Select the check box in the leftmost column of each warning that you want 
to override, or click the Select All Warnings button.

2. Click the Proceed for Selected button to ignore the warnings and continue.

Note: Although you can override warnings, you cannot override error 
messages; their check boxes are disabled.
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Time Off Limits

Overview

Under the Calendar module, use Time Off Limits to control the number of 
agents allowed to take time off so that you do not adversely affect the ability to 
meet service objectives. You can configure time-off limits for the agents who 
perform a specific activity, all of the agents on a team, or all of the agents in a 
site. 

• You can set limits for the maximum number or maximum percentage of 
agents who can be on time off at any one time.

• You can set different time-off limits for each timestep during the day, 
enabling more agents to take time off during non-peak work periods. 

• You can see the actual numbers percentage of agents who are scheduled for 
time off and compare your limits with the actual values.

• You can set minimum time-off limits for each timestep. See Setting 
Minimum Time-Off Limits for details.

Notes: The time-off limits apply to all time-off types that have the Counts 
toward time-off limits parameter selected in the Configuration Utility, 
Time Off Types window, Properties tab. You cannot set separate time-
off limits for each time-off type. 

If the Counts toward time-off limits check box is cleared for a time-off 
type, no time-off limits apply to that time-off type. 

After the Master Schedule is published, the Calendar service still 
allows Agents to enter Time Off items. However, these items are 
automatically resolved as Not Scheduled, with the Reason Item is 
Not Scheduled because different schedule has 
already been built for this day. Also, these items are 
not checked against the time-off limits because they are not scheduled. 
This is normal behavior since planning (the Calendar) usually is done 
before scheduling.

Setting Time-Off Limits

1. Select a site, team, multi-site activity or activity in the Objects tree. You 
cannot select a business unit or an individual agent.

2. Select the period to be displayed in the table, Year, Month, or Week. By 
default, the selected period is Year. The granularity associated with the 
selected period appears in the read-only Granularity text box.
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Figure 11: Calendar Time Off Limits module

3. To change the dates that are displayed in the table, click < or > on either 
side of the date range at the top of the window, or click the drop-down 
arrow to open a calendar from which you can select a date.

If you select a day other than the first day of the selected period, the 
display defaults to the first day. For example, if you select Month and then 
select August 12, the display shows August 1-31.

4. To remove the column from the table, clear the check box beside the name 
of that column. 

The table displays the current data for the object and dates that you 
selected. See The Time-Off Limits Table for an explanation of the data 
presented in each column.

The set of columns repeats seven times in each row. Each repeat contains 
the values for one day of the week. 

5. For each period (represented by a row), enter a value directly into the Max. 
Agents or Max. % cell, or both. You can copy and paste values from one 
cell to another using the standard Windows Copy and Paste functions. If 
you enter values into both columns, WFM applies the lower limit.
 No Time Off Limits—Leave the cell blank.
 No Time Off Allowed—Enter 0.
 Some Time Off Allowed—Enter the number or percentage of agents 

who are allowed to be on time off.

Note: Cells with gray backgrounds are not editable. They either fall 
outside the selected period or contain values that WFM generates 
automatically.
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If you have chosen Week as the period, the minimum row appears. It 
displays the lowest limit entered into any cell. See Setting Minimum Time-
Off Limits for how to use this feature. 

6. If you want to set different values for a specific date range, click the Set 
Values button, which is located on the Action toolbar, or select Set Value 
from the Actions menu. See The Set Values Dialog Box for instructions on 
using this feature.

7. To keep your changes, click the Save button, which is located on the 
Action toolbar, or select Save from the Actions menu. 

Note: If you reduce the time-off limit for a specific period or if you assign 
agents to another team after a time-off period is scheduled, the limits 
for a particular period may be exceeded. In this case, agents retain any 
previously planned or scheduled time off, even if the limits are 
exceeded.

The Time-Off Limits Table

The Time-Off Limits table displays rows for each week (if the period is Year or 
Month) or for each 15-minute timestep (if the period is Week).

If you selected the Week period, the table also displays a Minimum row, which 
displays the lowest value set in any timestep during the day. 

The columns in this table are:

• Week/Timestep—If the selected period is Year or Month, this column 
contains the dates of each week in the period. If the period is Week, the 
column lists each 15-minute timestep in a day.

• Max. Agents—Enter an integer value for the greatest number of agents in 
the selected business unit, site, team, or activity who are allowed to have 
time off during the selected period. This must be a whole number, so 
fractions are rounded down.

• Max. %—Enter a percentage value for the greatest number of agents in 
the selected business unit, site, team, or activity who are allowed to have 
time off during the selected period.

• Max. % Agents—WFM automatically calculates, to the nearest whole 
number, the maximum number of agents who can have time off based on 
the percentage value that you entered. This must be a whole number, so 
fractional values are rounded down. This column is read-only. 

• Actual Agents—The actual number of agents in the selected site, team, or 
activity who are scheduled for time off during the selected period. If a 
schedule is unavailable for that day, agents with granted or preferred Time 
Off also count as Actual agents with Time Off. This column is read-only.
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• Actual %—The actual percentage of agents in the selected site, team, or 
activity who are scheduled for time off during the selected period. This 
column is read-only.

Setting Minimum Time-Off Limits

To set minimum limits:

1. Select the Week period.

2. Enter time-off limits in the cells for each timestep. 

By default, the minimum row shows the lowest limit entered into any cell 
of a column. 

3. To set the minimum for multiple timesteps at once, enter a value directly 
into one of the cells in the Minimum row. This new minimum value is 
automatically applied to all cells that contain a lower time-off limit. Cells 
with higher time-off limits are unaffected. 

The minimum value set in the Week view is displayed as the Daily value in the 
Year and Month views.

Note:  Although you cannot view the Minimum row if you select the Month 
or Year view, entering a time-off limit that is lower than the current 
minimum into either of these views automatically changes the 
minimum value shown in the Week view.

The Set Values Dialog Box
Use the Set Values dialog box to adjust the maximum number or percentage of 
agents who can have time off at any one time during a specified period. 

• Use this feature to adjust the maximum for periods, such as holiday 
seasons, when you might want to have a different maximum value than 
during the rest of the year. 

To use the Set Values dialog box:

1. Open the Calendar module and select Time Off Limits. 

2. Select a site, team, or activity in the Objects tree.

3. Select Set Values from the Actions menu.
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Figure 12: Set Values Dialog Box

4. Enter a start date and end date for the period. 

5. Enter a value for one or both of the following fields:

Max Agent—The maximum number of agents who can have time off 
during the specified period. You must enter a positive whole number.

Max %—The maximum percentage of agents. 
 No Time Off Limits—Leave the text box blank.
 No Time Off Allowed—Enter 0.
 Some Time Off Allowed—Enter the number or percentage of agents 

who are allowed to be on time off.

6. Click OK. Or click Cancel to discard your changes

The Set Values dialog box closes, and the new values appear on the Time-Off 
Limits table.
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4 Forecasting
This chapter covers the following topics:
 Overview, page 51
 New Forecast Wizard, page 54
 Forecast Scenarios, page 57
 Volumes Build Wizard, page 62
 Staffing Build Wizard, page 77
 Graph View Options, page 91
 Overlays, page 95
 New Overlay Wizard, page 99
 Forecast Templates, page 102
 Master Forecast Views, page 107
 Historical Data, page 114

Overview
Use the Forecast module to create and edit forecast scenarios, and to publish 
the best scenario to the Master Forecast. 

You can use the forecast views to:

• Create forecast scenarios.

• View your scenarios and the Master Forecast.

• Evaluate volume and staffing estimates for your scenarios and the Master 
Forecast.

• Publish forecast scenarios to, and extract them from, the Master Forecast.

• Add or remove activities from a forecast scenario.

• Create, modify, and apply forecast templates.
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About Forecasting

A forecast is a prediction of activity workloads for one or more sites, and 
consists of:

• Predicted customer-interaction volumes, which include information for 
phone calls, chat, e-mail, outbound calling, back-office work, and so on.

• Predicted average handling time (AHT).

• Staffing (workforce) requirements based on service objectives.

Workforce Management uses these predictions to build optimal schedules for 
real agents, or for a generic staff of profiles based on those agents. For links to 
major forecast help topics, see Creating and Working with Forecasts, below.

Creating and Working with Forecasts

1. The first step in creating a new forecast is to create a forecast scenario for 
one or more activities using the New Forecast Wizard. The Wizard General 
Parameters screen gives the option of creating a scenario with no forecast 
numbers (to be supplied later) or basing the scenario on a existing forecast.

2. If you created a scenario with no forecast numbers, open the Scenario 
Volumes View and use the Volume Build Wizard to build interaction 
volume and AHT forecasts for each activity. You can use various methods 
to build volume, including entering values, using historical data or 
templates.

3. Next, open the Scenario Staffing View and build a staffing forecast for 
each activity.

4. After you create and evaluate your scenarios, publish the best scenario to 
the Workforce Management database. This scenario then becomes the 
Master Forecast. WFM Web builds schedules based on the data in the 
Master Forecast.

Using the Forecast Scenarios View

The Scenarios View enables you to open and work with existing scenarios. It 
also enables you to create, edit, or delete forecast scenarios, and to publish 
them to the Master Forecast.

• In the Modules tree, click Forecast > Scenarios to activate the Scenarios 
view.

Using Other Scenario Views

When you open a forecast scenario, the following views appear on the 
Modules tree for that scenario: Scenario Volumes View, Scenario Staffing 
View, and Scenario Graph View. 
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• Click a view to open it. 

These view options appear on the Views toolbar's Scenarios drop-down list.

Opening additional scenarios adds their view options to these lists. This 
enables you to switch among views for several open scenarios.

• To remove a scenario's views from the displayed lists, close that scenario.

Using the Master Forecast Views

If you have access rights to the Master Forecast, then the Modules tree's 
Forecast branch always displays three Master Forecast views (regardless of 
your scenario selections): Master Forecast Volumes View, Master Forecast 
Staffing View, and Master Forecast Graphs View. 

• Click these views to open them.

Using Historical Data in Forecasts

In most cases, forecasts are based on historical data. You import historical data 
using the WFM Configuration Utility.

• If historical data for interaction volumes and average handling time (AHT) 
has been imported, you can create both interaction-volume forecasts and 
AHT forecasts simultaneously. 

• If historical data exists for interaction volume but not for AHT, first create 
the interaction-volume forecast using any of the forecasting methods. Then 
create the AHT forecast using a template. 

• If historical data exists for AHT but not for interaction volume, first create 
the interaction-volume forecast using templates. Then create the AHT 
forecast using any of the forecasting methods.

Actions Toolbar

You can use the following buttons on the toolbar (the same commands also 
appear on the Actions menu):

Add activity—Opens the Add Activity window, where you can add activities 
to this forecast scenario.

Remove activity—Opens the Remove Activity window, where you can 
remove activities from this forecast scenario.

Save—Saves your changes to this forecast scenario.

Save as Template—Save this forecast scenario as a template.

Build—Opens the Volumes Build Wizard, which builds volume data for the 
selected activity.

Comments—Opens the Comments window, where you can enter comments 
for each day of the forecast.
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Open / Close—Opens the highlighted scenario, closes the current scenario.

Use multi-site activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, business unit, or enterprise in the 
Objects tree.

Required Staffing—Opens the Required Staffing dialog. Use it to modify 
required staffing data in the grid.

Split—Opens the Volume Split Wizard, which splits interaction volumes from 
a multi-site activity to site-specific activities.

Adjust Volumes—Use the Adjust Volumes dialog to adjust the volume, the 
average handling time (AHT), or both, for a selected Scenario Volumes View.

New Forecast Wizard 

Overview

Use the New Forecast Wizard to create a new forecast scenario. Defining a 
forecast scenario involves naming the forecast, defining a forecast date range, 
adding comments (optional), and selecting the activities the forecast will cover. 
You also have the option of basing the scenario on an existing forecast or 
building the numbers later.

To use the New Forecast Wizard:

1. Open the Forecast module.

2. Select Scenarios.

3. On the Forecast Scenarios view toolbar, click the New button. 

The first of the New Forecast Wizard's screens, General Parameters, opens.

4. Fill in the General Parameters screen and then click Next. The Select 
Activity screen opens.

5. Select one or more activities and then click Finish.

After you create a scenario, you can build interaction volume, AHT, and 
staffing forecasts, add comments, and publish the scenario. For details, see 
Forecast Scenarios Overview. 

Terminology Review

In order to better understand WFM forecasting and scheduling views and 
dialog boxes, it is helpful to review certain Configuration Utility terminology.
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Activities

Activities are work that is tracked and managed using Genesys Workforce 
Management. On a general level, example activities are answering inbound 
calls, responding to e-mail, completing after-call work, performing scheduled 
callbacks, and participating in chat sessions. When you create forecasts and 
schedules, these activities are typically associated with a specific product, such 
as inbound calls for product A, inbound calls for product B, and so on. In the 
Configuration Utility, activities are associated with skills. You define separate 
activities for each site or business unit. 

Sites

Sites can be equivalent to switches, which are originally defined in 
Configuration Manager and then imported into WFM via Configuration 
Utility. You can also create sites in Configuration Utility that are unrelated to a 
switch. This is appropriate when switches do not correlate with your 
company's organization. For example, a single location could be divided into 
multiple entities to reflect divisions along business unit lines.

Sites can use activity sets, which provide a means to combine activities into 
groups for multi-skilled scheduling. During that time:

• Agents can only work on the activities defined for the activity set.

• Scheduler cannot schedule meals at times that would interrupt the activity 
set. 

Business units cannot use activity sets.

Business Units

A business unit consists of a set of sites that may be grouped together because 
the agents at the sites perform the same activity, or for ease of management. 

Multi-Site Activities

Multi-site activities combine activities at some or all of the sites in a business 
unit, as well as independent sites, for tracking purposes.

General Parameters

Use the General Parameters screen to define your new forecast's name, dates, 
and other basic information.

1. In the Name text box, enter a name for the forecast scenario.
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2. If you want to base this scenario on one that already exists, select the 
existing scenario (or the Master Forecast) from the Based on drop-down 
list. Otherwise keep None to create a scenario with no forecast numbers. 
You can then use the Volumes Build Wizard to populate the forecast.

Basing your new scenario on an existing scenario is a convenient way to 
build forecasts with frequently used settings. The wizard takes the dates 
activities from the source scenario, and applies them to the new scenario. 
You can then change these parameters.

3. In the Start date and End date text boxes, enter the scenario's start and end 
dates.

You can type directly into each text box, use the up or down arrow to modify 
the displayed date, or click the button at right to display a calendar.

Note: The scenario's date range cannot be more than two years.

4. If you want to fill the new scenario with data from the source (Based on) 
scenario, select the Copy Data check box. If you did not select a value 
from the Based on drop-down list, this check box is disabled.

5. If you want this scenario to be available to other WFM users, select 
Shared.

6. If you want to enter comments about this scenario, use the Comments text 
box.

7. Click Next to proceed to the next screen.

Select Activity

Use the Select Activity screen to finish defining your new forecast.

1. Expand the applicable sites or business units.

2. Select the single-site or multi-site activities that you want to be included in 
this forecast. These are activities previously defined in the Configuration 
Utility.

You can expand business units to display their sites and multi-site activities, 
and you can expand sites to display their activities. You can select any number 
of activities. 

By default, all activities are selected when this screen opens. Clear the check 
boxes for any activities that you do not want to include in this forecast 
scenario.

If you selected a value from the General Parameters screen's Based on drop-
down list, the activities that were in the source scenario are selected in the 
Activities list. You can select any additional activities, or clear selected ones, 
to customize this forecast scenario.
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Note: You can add activities to a forecast after it has been created.

3. Click Finish to generate the new forecast.

Forecast Scenarios 

Overview

After you create a forecast scenario using the New Forecast Wizard:

Use the Forecast Scenarios View to open the forecast scenario. You can then 
select the following views in the Modules tree for that scenario:

Forecast Scenario Volumes View enables you to build, view, and edit a 
scenario's interaction volume and average handle time.

Forecast Scenario Staffing View enables you to build, view, and edit a 
scenario's calculated and required staffing.

Forecast Scenario Graphs View displays your choice of statistics for this 
forecast, using line charts.

Click a branch in the Modules tree to open the corresponding view. Or use the 
Views toolbar's Scenarios drop-down list to move among these views.

If you open other scenarios, their views also appear in the Modules tree and in 
the Scenarios drop-down list. To remove a scenario's views from these 
controls, close that scenario.

Working with Forecast Scenarios

From the Forecast Scenarios view you can:

• View interaction volume and AHT forecasts in the Scenario Volumes view 
or create interaction volume and/or AHT forecasts using the Forecast 
Volumes Build Wizard.

• View staffing forecasts in the Scenario Staffing view or create staffing 
forecasts using the Staffing Build Wizard.

• View the forecast scenario in graph format.

• Add comments to the forecast scenario.

• Publish forecast scenarios to the Master Forecast or extract from the 
Master Forecast into a forecast scenario.

Forecast Scenarios View

Use the Scenarios view to create, open and work with existing forecast 
scenarios. 
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This view also enables you to delete forecast scenarios, publish data from a 
scenario to the Master Forecast, and extract data from the Master Forecast to a 
scenario. 

Displaying the Scenarios View

In the Modules tree, click Forecast > Scenarios to activate the Scenarios view.

Selecting Objects

When the Scenarios view is active, the Objects tree displays existing forecast 
scenarios in a hierarchical list. The All Scenarios node expands to display the 
following options:

My Scenarios displays scenarios that you have created.

Shared Scenarios displays shared scenarios created by other users. Visible 
only if you have the permission Access Shared Scenarios. See the 
Configuration Utility help topic, Forecast Security Options.

Other Scenarios displays (if you have the appropriate access rights) unshared 
scenarios created by other users.

You can select All Scenarios or a lower-level option. Your selection retrieves 
matching scenarios and insets them into the Scenarios table.

Reading the Scenarios Table

The Scenarios table appears at the upper right. Its rows display scenarios that 
match your selection in the Objects tree. The columns (sortable by clicking the 
header) display the following information for each scenario:

Name—The scenario's name.

Start date, End date—The start and end dates for the forecast in this scenario.

Owner—The name of the user who created the scenario.

Shared—A check mark indicates a shared scenario; an open box indicates one 
that is not shared.

Comments—Remarks entered by a user who created or edited the scenario.

Click a row in the Scenarios table to populate the Scenario Properties pane 
with the scenario's details.

Editing a Scenario

To edit a scenario:

• Click its row in the Scenarios table and then click Open on the Actions 
toolbar or select Open from the Actions menu.

• As an alternative, double-click a scenario. 
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The controls described below are available if you own, or have access rights to, 
the scenario.

Toolbar: Managing Scenarios

You can use the following buttons on the toolbar (the same options appear in 
the Actions menu):

New—Opens the New Forecast Wizard.

Open—Opens the selected scenario from the Scenarios table. You can then 
edit its properties using the Data tab.

Close—Closes the open scenario (and prompts you to save unsaved data).

Publish—Opens the Publish Forecast Wizard for transferring forecast 
information between the selected scenario and the Master Forecast.

Delete—Deletes the selected scenario.

Mark as Shared, Mark as Not Shared—Changes the sharing status of the 
selected scenario.

Sort—Opens the Sorting dialog box, which allows sorting by Team Name, 
Contract, Agent Name (first or last), or Agent Rank. You can sort in ascending 
or descending order. Note that Agent Rank sorts in apparent reverse order due 
to limitations imposed by multi-sorting by both agent name and rank.

Scenario Properties—Data Tab

In the Scenario Properties panel at the lower right, click the Data tab to display 
the following controls:

Name—Enables you to edit the scenario's name.

Start date, End date—Displays the scenario's start and end dates.

Owner—Displays the name of the scenario's creator.

Created, Modified—Displays the scenario's original creation date and last 
modification date.

Shared—A check mark indicates a shared scenario; an open box indicates one 
that is not shared.

Comments—Enables you to enter or edit comments about the scenario.

Save—Click this button to save your changes to the scenario's name and/or 
comments.

Cancel—Click this button to cancel changes, restoring the scenario's previous 
name and/or comments.

Scenario Properties—Statuses Tab

Click the Statuses tab (in the Scenario Properties panel at the lower right) to 
display a table with the following information:
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Activity—Lists each activity in the scenario, preceded by its site or Business 
Unit.

Volumes—A check mark indicates that interaction volume was built for this 
activity.

AHT—A check mark indicates that average handle time was built for this 
activity.

Calc. staff—A check mark indicates that calculated staffing was built for this 
activity.

Req. staff—A check mark indicates that required staffing was built for this 
activity.

Scenario Volumes View

Use the Volumes view to build or edit the selected forecast scenario's 
interaction volumes and average handle times. Click the toolbar buttons on the 
image to jump to their descriptions below.

This view provides standard date-selection controls and a grid that shows 
statistics for days or timesteps.

Displaying the Volumes View

To display the Volumes view:

1. In the Forecast Scenarios view, select a scenario. 

2. In the Modules tree, click [Scenario-name] Volumes.

The Volumes view appears.

3. In the Objects tree, select an activity, multi-site activity, site, or Business 
Unit.

Statistics populate the grid. 

If you do not see any forecast data, you may need to adjust the Period, 
Granularity, or Date controls at the top of the window to reflect those used for 
the forecast.

The grid displays open hours for multi-site activities that you select in the 
object tree exactly as it displays them for site activities.

Setting the Grid Properties and Date Range

Use these options in the Grid properties and Date range panels (near the top) to 
customize the grid:
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• The grid displays data for a period of a year, month, planning period, or 
week. To change the period, click Year, Month, Planning Period, or Week 
from the Period drop-down list to change the time range shown on each 
row. (WFM Web prompts you to save any unsaved edits before it refreshes 
the display.)

• If you select Week, you can further adjust each row's time range by 
selecting a Granularity of 15, 30, or 60 minutes.

• Show, or hide, columns by selecting (or clearing respectively) the Volume, 
Volume %, and AHT check boxes.

• Use the standard date-selection controls to jump to a different week within 
the forecast scenario's date range.

Using the Grid

The grid provides columns that display the following statistics:

Week/Time Step—Identifies the range of dates or timesteps on this row. (The 
column's label and contents depend on the date range and granularity that you 
selected above.)

[Days or Dates]—If you select the Month date range, each group of columns 
shows statistics for one full day. 

If you select the Week date range, each group of columns indicates one day, the 
top row shows daily totals, and each lower row shows statistics for one 
timestep on that date. 

(Timestep durations depend on the granularity that you selected above.)

IV—Shows the interaction volume forecasted for each day or timestep. You 
can edit these cells' contents, replacing the displayed values with whole 
numbers.

IV%—Shows this row's percentage of the day's total interaction volume.

AHT—Shows the average handling time.

Weekly Totals—If you select the Month date range, these columns show 
weekly totals, or averages, for the IV, IV%, and AHT statistics.

Note: You can copy and paste data between the grid and a spreadsheet. 
Before doing so, clear the Volume % checkbox so the IV% column is 
hidden. 

Editing the Weekly Totals

If you selected the period Year or Month, you can click inside the Weekly 
Totals cell and edit the value there. Daily values in the same row will 
automatically adjust their values so that the new Weekly Total is redistributed 
according to the original distribution of volume for each day of the week. This 
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is useful if you have a week in which you believe the volume will be increased, 
but you expect the volume to arrive at about the same rate as in your original 
forecast, day-over-day.

Toolbar: Modifying and Managing Scenario Data 

You can use the following buttons on the toolbar (the same commands also 
appear on the Actions menu):

Add activity—Opens the Add Activity window, where you can add activities 
to this forecast scenario.

Remove activity—Opens the Remove Activity window, where you can 
remove activities from this forecast scenario.

Save—Saves your changes to this forecast scenario.

Build—Opens the Volumes Build Wizard, which builds volume data for the 
selected activity.

Comments—Opens the Comments window, where you can enter comments 
for each day of the forecast.

Close—Closes this scenario, prompting you to save any unsaved changes.

Use multi-site activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, Business Unit, or Enterprise in the 
Objects tree.

Split—Opens the Volume Split Wizard, which splits staffing from a multi-site 
activity Staffing forecast scenario.

Adjust—Opens a dialog box that enables you to adjust the volume, average 
handling time (AHT), or both for the Scenario Forecast Volumes view.

Volumes Build Wizard

Overview

Use the Volumes Build Wizard to build volume data for one or more selected 
activities, using parameters that you specify. 

• Do this if you selected None in the New Forecast Wizard General 
Parameters window or if you wish to overwrite an existing Volumes 
scenario. If the correct Volumes data already exists in the Scenario 
Volumes view, you do not need to use this wizard.
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Note: Depending on the build method you specify, you may need to import 
historical data (using the WFM Configuration Utility) or create 
interaction volume, average handling time, or overlap templates before 
using this wizard.

To build volume data:

1. Select a Volumes scenario.

2. On the Scenario Volumes View toolbar, click the Build button.

The Volumes Build Wizard's first screen, Select Activities, opens.

3. Complete the Select Activities screen and then click Next. 

4. Complete the Select Data Build Method screen and then click Next. 

5. The screens/buttons that appear next depend on the selected build method 
and whether you want to use an overlap template. 
 If the selected build method is Use Value, you supply interaction 

volume and/or average handling time values and click Finish. 
 If the build method is Expert Average Engine, Universal Modeling 

Engine, or Copy Historical Data, you will need to complete the Select 
Historical Data screen. 

 If the build method is Template Based, or if you select Use Overlap 
Templates on the Select Historical Data screen, you complete one or 
more screens for selecting templates.

 If the build method is Expert Average Engine or Universal Modeling 
Engine, you will need to complete the Select Events screen.

6. After clicking Finish in the last screen, WFM builds the volumes forecast 
and the Scenario Volumes View reappears, showing your results. 

Select Activities

The Forecast Volume Build Wizard's first screen is Select Activities. The 
activities you previously selected for the scenario in the New Forecast Wizard 
Select Activity screen appear for selection. 

Use the Select Activity screen as follows:

1. Expand business units (if any) to display their sites and multi-site 
activities, and expand sites to display their activities. An example business 
unit with multi-site activities is shown below.
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Figure 13: Business Unit with multi-site activities (at bottom)

2. Select all of the activities that you want to be included in this volumes 
forecast. 

You can select multiple activities to build volume forecasts in “batch” 
mode when configuration information for each activity is identical. If you 
want to use different historical data or build methods for certain activities, 
build the volumes for those activities separately.

If you selected an existing forecast instead of <None> from the General 
Parameters screen's Based on drop-down list, the activities that were in the 
source scenario are selected in the Activities list. You can select any 
additional activities, or clear selected ones, to customize this forecast 
scenario.

Note: You can add activities to a forecast after it has been created.

3. Click Next to continue. 

The next wizard screen, Select Data Build Method, opens. 
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Select Data Build Method

Use the Select Data Build Method screen to define how you want to build your 
volumes data:

1. Select the statistic(s) you want from the Forecast drop-down list:
 Interaction Volume and AHT
 Interaction Volume
 AHT

• Under Target Dates, select the date range for the forecast data. The date 
range cannot be outside the scenario date range.

• Select the forecast build Method: Template Based, Expert Average Engine, 
Universal Modeling Engine, Copy Historical Data, or Use Value (see 
definitions below).

• Click Next to open the wizard's next screen.

The following sections explain the Method options that are available:

Template Based

Default selection. For detailed information about templates, and instructions on 
how to create them, see Forecast Templates List View. With template-based 
forecasting, you can build a forecast using preconfigured interaction volume 
and/or average handling time (AHT) templates. 

You also can have the template-based forecasting engine apply percentage 
growth rate to historical data.

Template-based forecasting is best used by contact centers with very stable 
interaction patterns or for activities that can be manually forecasted, such as 
back-office work, media interactions, or outbound campaigns. 

If you select Template Based, after you click Next, the screen that opens 
depends on the Forecast type selected at the top of the Select Data Build 
Method screen. 

• Interaction Volume and AHT—The Load Interaction Volume Forecast 
Templates screen opens.

• Interaction Volume—The Load Interaction Volume Forecast Templates 
screen opens.

• AHT—The Load Average Handling Time Forecast Template screen opens. 

Expert Average Engine

This method uses the statistical analysis of historical data to produce day-of-
week, weekly, and (if sufficient historical data exists) yearly trend patterns. 
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The Expert Average Engine requires at least one full week of historical data. 
For high-quality day-of-week and weekly results, Genesys recommends that 
you use a minimum of six weeks' worth of data.

The Expert Average Engine applies events in a linear fashion, and this linear 
perspective smooths out the impact of events across the forecast. Therefore, 
this engine is best suited to contact centers with fairly stable interaction 
patterns. 

If you select Expert Average Engine, after you click Next, the Select Historical 
Data screen opens. If a selected activity does not have historical data, an error 
message appears and the Select Historical Data screen does not open.

Universal Modeling Engine

This method uses a complex algorithm to identify trends and patterns in 
historical data, which it then uses to create a forecast. 

The Universal Modeling Engine requires one year's worth, or more, of 
historical data. 

The Universal Modeling Engine is configured so that, in its analysis of 
historical data, it disregards days that contain special events, if those events 
don’t occur during the forecast period. This configuration eliminates 
misleading “noise” from the forecasts. However, if a special event does occur 
during the forecast period, the Universal Modeling Engine uses the historical 
data to calculate the impact of the event, and applies it to the baseline forecast. 
The Universal Modeling Engine is best suited to sites with a large quantity of 
high-quality historical data.

If you select Universal Modeling Engine, after you click Next, the Select 
Historical Data screen opens. If a selected activity does not have historical 
data, an error message appears and the Select Historical Data screen does not 
open.

Copy Historical Data

Appropriate selection if you have some historical data, but not enough to use 
the Expert Average or Universal Modeling engines. You can combine the 
historical data with overlap templates, which fill in gaps in the historical data. 

If you select Copy Historical Data, after you click Next, the Select Historical 
Data screen opens. If a selected activity does not have historical data, an error 
message appears and the Select Historical Data screen does not open.

Use Value

Appropriate selection if your site activity load is very regular. Applies a 
specific interaction volume or AHT to each time interval in the scenario. 
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If the Forecast type is Interaction Volume and AHT, selecting Use Value 
enables both the IV and AHT fields. 

If the Forecast type is interaction Volume, only the IV field is enabled. 

If the Forecast type is AHT, only the AHT field is enabled. 

1. Enter the appropriate value(s) to be used for each cell in the forecast. For 
IV, enter number of interactions per timestep (example: number of 
interactions per 15-minute interval). For AHT, enter the number of seconds 
that represents average handling time.

2. Click Finish.

WFM builds the volumes forecast and the Scenario Volumes View reappears, 
showing your results.

Select Historical Data

Use the select Historical Data screen to define the historical data time range 
with the option of using overlap templates. If you selected the Copy Historical 
Data method, this screen includes a Growth Rate field.

The Wizard brings up this screen if the Build Method is Expert Average 
Engine, Universal Modeling Engine, or Copy Historical Data.

1. Select the Start date and End date of the historical data that you want to 
use. 
 Select the same day of the week as the forecast scenario's first day. For 

example, if the target start date is a Tuesday, the historical data Start 
Date must also be a Tuesday.

2. Select the End date of the historical data. 

Note: If you selected Copy Historical Data on the Select Data Build 
Method screen, this field is disabled. If the End date field is 
enabled:

 You can select a date range as short as one day, or as long as the 
forecast scenario for which you are building data.

 The same historical start and end dates are used for all activities 
selected in the Select Activities screen.

3. If you selected the Copy Historical Data method on the previous screen, 
enter a number into the Growth Rate field. This optional field allows you 
to increase or decrease the historical data by a specified percent. The value 
cannot be less than -100%. 

4. The next series of screens depends on the Build Method and whether you 
clicked the Use Overlap Template check box.
 If the Build Method is Copy Historical Data and you are not using an 

overlap template, click Finish. 
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 If the Build Method is Copy Historical Data and you are using an 
overlap template, click Next to bring up a screen for selecting 
templates.

 If the Build Method is Expert Average Engine or Universal Modeling 
Engine, the next screen depends on whether you want to use an overlap 
template.
 If you did not check the Use Overlap Templates box, click Next. 

The Select Events screen opens.
 If you checked the Use Overlap Templates box, click Next to bring 

up a screen for loading templates.

Select Templates

Use the screens described below to incorporate templates into your Forecast 
Volumes scenario. The Forecast Volumes Build Wizard gives the option of 
using the following template types:

• Interaction volume templates

• Average handling time templates

• Interaction volume overlap templates

• Average handling time overlap templates

The following sections explain the various forecast template screens:

Interaction Volume Templates

The Load Interaction Volume Forecast Templates screen opens if you selected 
the following in the Select Data Build Method screen:

• Forecast = Interaction Volume and AHT or Interaction Volume.

• Methods = Template Based.

1. Select a template from the Templates list on the left.

2. Select Start and End dates for the template.

3. Check days of the week boxes to indicate when the template should be 
applied.

4. Click the >>> button. If you change your mind, click the <<< button.

5. If the Forecast type was Interaction Volume and AHT, click Next. The 
Load Average Handling Time Forecast Template screen opens and you 
must complete that screen. 

If the Forecast type was Interaction volume, the Finish button becomes 
enabled.

6. Click Next. WFM builds the volumes forecast and the Scenario Volumes 
View reappears, showing your results. 
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An error message appears if WFM Web cannot complete the calculation 
(for example, if historical data contains too few timesteps to cover the 
scenario's activity hours). This applies to all the template types discussed 
in this topic. 

Average Handling Time (AHT) Templates

The Load Average Handling Time Forecast Templates screen opens if you 
selected the following in the Select Data Build Method screen:

• Forecast = AHT or Interaction Volume and AHT. (If Interaction Volume 
and AHT is selected, the window appears after clicking Next in Load 
Interaction Volume Forecast Templates screen shown above.)

• Methods = Template Based.

Except for the title and content of the templates list, the screen appears 
identical to the Load Interaction Volume Forecast Templates screen shown 
above.

1. Select a template from the Templates list on the left. 

2. Select Start and End dates for the template.

3. Check days of the week boxes to indicate when the template should be 
applied.

4. Click the >>> button. If you change your mind, click the <<< button.

5. Click Finish. WFM builds the volumes forecast and the Scenario Volumes 
View reappears, showing your results. 

Interaction Volume Overlap Templates

Assume there is some bad data in the historical data. One way to compensate 
for this is to build an overlap template.

The Load Interaction Volume Forecast Overlap Templates screen opens if you 
selected Use Overlap Template in the Historical Data screen and previously 
selected the following in the Select Data Build Method screen:

• Forecast = Interaction Volume and AHT or Interaction Volume.

• Methods = Copy Historical Data, Expert Average Engine, or Universal 
Modeling Engine.

Except for the title, content of the templates list, and day of the week check 
boxes, the screen appears identical to the Load Interaction Volume Forecast 
Templates screen shown above.

1. Select an overlap template from the Templates list on the left.

2. Select Start and End dates for the overlap template.

3. Click the >>> button. If you change your mind, click the <<< button.
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4. If the Forecast type was Interaction Volume and AHT, click Next. The 
Load Average Handling Time Forecast Overlap Template screen opens 
(described below) and you must complete that screen. 

If the Forecast type was Interaction volume, the Finish button becomes 
enabled.

5. Click Finish. WFM builds the volumes forecast and the Scenario Volumes 
View reappears, showing your results. 

Average Handling Time Forecast Overlap Templates 

The Load Average Handling Time Forecast Overlap Templates screen opens if 
you selected Use Overlap Template in the Historical Data screen and 
previously selected the following in the Select Data Build Method screen:

• Forecast = AHT or Interaction Volume and AHT. (If Interaction Volume 
and AHT is selected, the screen appears after clicking Next in the Load 
Interaction Volume Overlap Forecast Templates screen.)

• Methods = Copy Historical Data, Expert Average Engine, or Universal 
Modeling Engine.

Except for the title, content of the templates list, and day of the week check 
boxes, the screen appears identical to the Load Interaction Volume Forecast 
Templates screen shown above.

1. Select an overlap template from the Templates list on the left. 

2. Select Start and End dates for the overlap template.

3. Check days of the week boxes to indicate when the overlap template 
should be applied.

4. Click Finish. WFM builds the volumes forecast and the Scenario Volumes 
View reappears, showing your results. 

Select Events

Use the Select Events screen to factor events into a Forecast Volumes scenario.
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Figure 14: Volumes Build Wizard, Select Events

Note: You must create factors and events in the WFM Configuration Utility, 
and assign them to activities there, before you can add events to a 
forecast scenario in WFM Web. 

• A factor is anything that can be expected to affect the daily interaction 
volume of the enterprise and, therefore, staff and schedule requirements.

• An event is a specific instance when a factor is in effect.

To add events:

• Select the Enabled check box for the events that you want to include. As an 
alternative, use the All Applicable check box. 

If you are using the Universal Modeling Engine, this is all you need to 
configure. Click Finish. 

If you are using the Expert Average Engine:

1. Enter a Spread Over value for each event. This determines the period that 
the event affects.

2. Click Days or Hours. This determines whether the Spread Over value is 
interpreted as days or hours.
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The default values are based on the event's configuration. If the event is 
configured to disregard historical data, you cannot adjust these values here. 
You must change the configuration using the WFM Configuration Utility. 
Adjust the Initial Impact and/or Ending Impact value, if appropriate.

3. Check the All Applicable check box if the forecast build algorithm should 
use all events or factors applicable to the selected activities that fall into 
the scenario/historical data date range.  When checked, disables the fields 
and controls that appear above. 

4. Click Finish.

WFM Web calculates the volumes and displays them in the Volumes view. An 
error message appears if WFM Web cannot complete the calculation (for 
example, if the historical data contains too few timesteps to cover the 
scenario's activity hours).

Volumes Split Wizard

Use the Volumes Split Wizard to split a forecast scenario for a multi-site 
activity:

1. Select a Scenario Volumes view that uses multi-site activities.

2. Click the Split button on the Forecast Scenario Volumes View toolbar.

The first of the Volumes Split Wizard's two screens, Select Multi-site 
Activities, opens.

3. Select the check boxes next to the multi-site activities that you want to 
split.

You can select several multi-site activities within the same Business Unit.

4. Select Use AHT Forecast if you want WFM Web to consider average 
handling time forecasts when performing the split.

Note: If you select Use AHT Forecast but some of the selected activities do 
not have an AHT forecast, the result for each of these activities will be 
0 for the timestep(s) where AHT=0.

Warning! If you do not select Use AHT Forecast, the multi-site activity AHT 
is assigned to the local activities. This overwrites the local activity 
AHT. If there is no multi-site activity AHT, local activity AHT is 
simply deleted.

5. Click Next.

The wizard's second screen, Select Activities within Multi-site Activities, 
opens.

6. Select the local (target) activities into which you want to split the multi-site 
activities.
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You can select several target activities. 

If you selected Use AHT Forecast on the first screen, then you cannot 
select target activities that do not have at least one timestep with at least 
one AHT value greater than zero.

If you select Use All Activities, when WFM splits data for interaction 
volumes, AHT, and agent availabilities for the selected activities in the 
scenario, it takes into account the values for all activities in the specified 
site, whether selected or not. Activities that are not selected are not split; 
WFM Web simply considers them when determining the proportions that 
are split to each selected activity. Note that this option does not affect the 
split result if there are no shared multi-skill agents who work on both 
selected and unselected activities.

7. To have WFM consider existing Calendar items when splitting the 
interaction volume among activities, select the Consider Granted Calendar 
Items check box. 

8. Click Finish.

WFM Web displays a Progress dialog box while it splits the activities. Click 
this box's Cancel button if you want to cancel the split.

After splitting the activities, WFM Web returns to the Volumes View.

Adjust Volume Dialog Box

Use the Adjust Volume dialog box to adjust the volume, average handling time 
(AHT), or both for a selected Scenario Volumes View. 

1. Click the Adjust button on the Forecast Volumes scenario toolbar. The 
Adjust Volume dialog box opens.

2. Click the Target down arrow and select one of the following:
 Interaction Volume
 AHT (average handling time)
 Interaction Volume and AHT

3. Decide how (and by how much) to adjust values in the Forecast Volumes 
grid:
 Select the Adjust By (%) radio button and enter into the field a number 

to be the percentage by which to adjust existing values that fall within 
the date range that is specified by Start Time and End Time below. 
Valid values range from -99% to 999%.

OR
 Select the Set Total radio button and enter into the field a number to be 

the total by which to adjust existing values that fall within the date 
range that is specified by Start Time and End Time below.

4. Specify the date range to adjust values in the Forecast Volumes grid:
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 In the field Start Time, enter or select a start date and timestep. Range: 
any date equal to or later than the date in the upper right of the Forecast 
Volumes grid; 00-23 hours; 00, 15, 30, or 45 minutes.

AND
 In the field End Time, enter or select an end date and timestep. Range: 

any date later than the Start Time date; 00-23 hours; 00, 15, 30, or 45 
minutes.

5. Click OK.  WFM adjusts the forecast and the view reappears, showing 
your results.

Scenario Staffing View

Use the Staffing view to edit the selected forecast scenario's calculated and 
required staffing. Click an Action button on the image below to jump to its 
description. Click the toolbar buttons on the image to jump to their 
descriptions below.

This view provides standard date-selection controls and a grid that shows 
staffing levels for days or timesteps.

Displaying the Staffing View

To display the Staffing view:

1. In the Forecast Scenarios view, select a scenario. 

2. In the Modules tree, click [Scenario-name] Staffing.

The Staffing view appears.

3. In the Objects tree, select an activity.

Statistics populate the grid. 

If you do not see any forecast data, you may need to adjust the Period, 
Granularity, or Date controls at the top of the window to reflect those used for 
the forecast.

Setting the Grid Properties and Date Range

Use these options in the Grid properties and Date range panels (near the top) to 
customize the grid:

• The grid displays data for a period of a year, month, or week. To change 
the period, click Year, Month or Week from the Period drop-down list to 
change the time range shown on each row. (WFM Web prompts you to 
save any unsaved edits before it refreshes the display.)

• If you select Week, you can further adjust each row's time range by 
selecting a Granularity of 15, 30, or 60 minutes.
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• Show columns, or hide them, by selecting or clearing (respectively) the 
Calc or Req check boxes.

• Use the standard date-selection controls to jump to a different week within 
the forecast scenario's date range.

Using the Grid

The grid provides columns that display the following statistics:

Week/Time Step—Identifies the range of dates or timesteps on this row. (The 
column's label and contents depend on the date range and granularity that you 
selected above.)

[Days or Dates]—If you select the Month date range, each group of columns 
shows statistics for one full day. 

If you select the Week date range, each group of columns indicates one day. 
The top row shows daily totals measured in Full-Time Equivalents (defined 
below). Each lower row shows statistics for one timestep on that date. 

(Timestep durations depend on the granularity that you selected above.)

Full Time Equivalent (FTE) is a standard measurement used within contact 
centers that allows the analyst to do an "apples-to-apples" comparison of the 
number of agents required to handle the expected interaction volume, across 
activities that may have different open hours, different working overheads, and 
so on.

In WFM, the number of FTEs is provided for informational purposes only. It 
does not affect the intra-day staffing requirements that WFM produces, which 
is the basis for building schedules.

Calc—Shows the calculated number of agents for each day (measured in Full 
Time Equivalents) or for each timestep (measured in Single Skill Equivalents). 
You can edit these cells' contents. See Req column for more information on 
Calculated and Required Staffing.

Req—Shows the required number of agents for each day (measured in Full 
Time Equivalents) or for each timestep (measured in Single Skill Equivalents). 
You can edit these cells' contents.

WFM populates Calculated Staffing when you build staffing through the 
Staffing Build Wizard. Required Staffing is a user-defined data series. It can be 
populated based on data from the Calculated Staffing data series, or you can 
copy and paste data from an external spreadsheet into these columns. When 
building schedules, the Use Required option lets you base a schedule on 
Calculated or Required Staffing. This allows you to take the staffing forecast 
that WFM provides and adjust it in a user-defined way.

[Weekly Totals]—If you select the Week date range, the columns at right show 
weekly totals for the displayed statistics.

Note: You can copy and paste data between the grid and a spreadsheet. 
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Modifying and Managing Scenario Data

You can use the following buttons on the Actions toolbar (these commands 
also appear on the Actions menu):

Add activity—Opens the Add Activity window, where you can add activities 
to this forecast scenario.

Remove activity—Opens the Remove Activity window, where you can 
remove activities from this forecast scenario.

Save—Saves your changes to this forecast scenario.

Save as template—Opens the Save as Template Wizard, where you can save 
data from this scenario as a forecast template.

Build—Opens the Staffing Build Wizard, which builds staffing data for the 
selected activity.

Comments—Opens the Comments window, where you can enter comments 
for each day of the forecast.

Close—Closes this scenario, prompting you to save any unsaved changes.

Use multi-site activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, Business Unit, or Enterprise in the 
Objects tree.

Required staffing—Opens the Required Staffing dialog box, where you can 
set the forecast's required number of agents.

Split—Opens the Volume Split Wizard, which splits interaction volumes from 
a multi-site activity to site-specific activities.

Required Staffing Dialog Box

Use the Required Staffing dialog box to define required staffing values in a 
forecast scenario's Staffing view.

Note: Before selecting the template option in this dialog box, create 
templates as needed.

To set required staffing when a Staffing view is selected:

1. Bring up the Required Staffing dialog box by clicking the Required 
Staffing toolbar button.

2. In the resulting dialog box, select one of the following radio buttons:
 Select Load Calculated Staffing to set the required staffing to the 

same values as the calculated staffing.
 Select Use template to load a template for the required staffing value.

3. You have the option of entering a percentage in the Adjust by field. Valid 
values are from -99 to 999.
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4. If you selected Use template, do the following:
 Click Load Template.
 In the Staffing Templates window that appears, select a template and 

click OK. This restores the Required Staffing dialog box.

5. Click OK to close the Required Staffing dialog box and load your selection 
into the Staffing view.

About Required Staffing

Required staffing data is user-defined staffing requirements for a forecast 
scenario. 

• If you have compiled calculated staffing values, you have the option of 
setting required staffing to the same values as the calculated staffing.

• Forecasts can contain both calculated and required data. You can build 
schedules with either set of data.

• Required staffing can be composed of a combination of template values, 
manually entered amounts, and calculated staffing values. 

Staffing Build Wizard

Overview

Use the Staffing Build Wizard to build staffing data for a selected single-site 
activity or multi-site activity, based on parameters that you provide. 

Note: Before using this wizard to build a staffing forecast, take these required 
actions:

• Build interaction volumes and AHT for activities.

• If necessary, create templates.

• Build a volume forecast for Multi-Site activity for both IV and AHT. 

• Be aware that even if there is IV and AHT data for all child activities, this 
wizard does not build a staffing forecast for the parent multi-site activity. 

To build staffing data:

1. On the Scenario Staffing View toolbar, click the Build button.

The Staffing Build Wizard's first screen, Provide Budgeting and Overhead 
Data, opens. 

2. Fill in the Provide Budgeting and Overhead Data window and then click 
Next.

The screen that appears next depends on what kind of activity you are 
staffing. 
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 For an Immediate activity (work activities that are handled by agents 
immediately, such as voice calls), the Specify Service Level Objectives 
screen opens if you selected the Use Service Level Objectives check 
box. If you did not select Use Service Level Objectives, the Staffing 
Requirements screen opens. 

 For a Deferred activity (backlog activities, such as e-mail, that use 
special forecasting calculations), the Multimedia Service Level 
Objectives screen opens. 

 For a Fixed-Staff activity (non-CTI activities that do not use Workforce 
Management service objectives), the Staffing Requirements screen 
opens.

3. Fill in the screens that open and then click Finish.

The wizard closes. If you selected Compare results with previous on the first 
wizard screen, the Scenario Build Results window opens. If not, the Scenario 
Staffing View opens. 

Provide Budgeting and Overhead Data

Use the provide budgeting and Overhead Data screen to specify target dates, 
hours and wage data, overhead factors, and whether to use service-level 
objectives. An example completed screen is shown below.

Figure 15: Staffing Build Wizard, Provide Budgeting and Overhead Data
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1. If you want to compare the results obtained from the Staffing Build Wizard 
with the previous staffing scenario results, select the Compare results 
with previous check box. 

If you do so, after you have completed the wizard, the Staffing Build 
Results window opens, showing a comparison of the new and previous 
results.

2. Select a Target Date Range.

3. If this staffing forecast covers single-site activities, fill in the Paid Hours a 
Day and Hourly Wage ($) data to the right.  These fields are not present 
when building a staffing forecast using multi-site activities.

4. If this staffing forecast covers single-site activities, fill in the Working 
Overhead % and Non-Working Overhead % data at the lower left, if 
applicable. These fields are not present when building a staffing forecast 
using multi-site activities.

You can select Use Template Data and click Load Template to load an 
existing template.

5. Click Next to open the wizard's next screen.

The following sections provide details about the fields on this screen.

Hours and Wage Data

Paid Hours a Day—This value should be calculated from the average number 
of hours that all agents in the site worked per day. 

For example, consider a contact center with a 5-day week that uses 10 full-time 
agents who work 40 hours per week and 10 part-time agents who work 30 
hours per week. The paid hours per day is calculated as follows: 10 x 40 = 400 
hours; 10 x 30 = 300 hours; 300 + 400 = 700 hours; 700 hours divided by 5 
days equals 140 hours per day; and 140 hours divided by 20 agents equals an 
average workday of 7 hours.

Note: WFM uses the value in the Paid Hours a Day field as part of its Full 
Time Equivalent definition. The FTE values for each day at the top of 
the columns (under Calc. and Req.) in the Scenarios Staffing View are 
partially based on what you configure for Paid Hours a Day. 

Hourly Wage—This value is calculated similarly to Paid Hours a Day. 

For example, if 10 agents are paid $9.00/hour, 7 are paid $8.00/hour, and 4 are 
paid $11.00/hour, the hourly wage is calculated as follows: 10 x $9.00 = 
$90.00; 7 x $8.00 = $56.00; 4 x $11.00 = $44.00; 90 + 56 + 44 = 190; 
$190.00/hour divided by 21 agents = $9.05/hour average hourly wage.
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Overhead Data

For Indirectly Occupied Time and Working Overhead, you can either enter a 
percentage directly or load it using a template. For Non-Working Overhead, 
you must directly enter the percentage.

• Indirectly Occupied Time—Percentage of time that agents are scheduled 
for work but are not being productive. For example, agents might be away 
from their desks or starting their computers. For more information, see 
Special Note below.

• Working Overhead—Percentage of time that agents are not handling calls 
or performing direct contact center work. For example, an agent might be 
taking a break, participating in a training session, or meeting with peers or 
supervisors. For more information, see Special Note below.

• Non-Working Overhead—Percentage of time in the schedules that agents 
are being paid but are not working. For example, an agent may be on 
vacation, out sick, or on holiday. For more information, see Special Notes 
below.

Use Service-Level Objectives

Select this check box to enable the Specify Service Level Objectives screen, 
later in the wizard.

Special Notes on Overhead Data

At a minimum, enter a value for Indirectly Occupied Time (IOT). IOT is a 
parameter that helps define the queuing model that WFM uses when building a 
staffing forecast. Here is why:

There is a certain pool of agents that WFM considers in its queuing model 
when determining how calls would be distributed from the queue to agents. 
IOT affects the availability of agents to handle calls. For example, if IOT is 
defined as 10%, that means that 10% of the time, an agent will not be in the 
agent pool (because he will be off the phone). 

Working Overhead (WO) or Non-Working Overheard (NWO) do not directly 
affect your intra-day staffing forecast results. Because of this, you may not 
want to enter values for each activity. 

• The value you enter for WO will affect the FTE calculation (the value that 
appears at the top of each column in the staffing forecast when viewed at 
weekly granularity and in the grid when viewed at Monthly or Yearly 
granularity). 

• The value you enter for WO will not affect the intra-day staffing forecast 
results.  

• The value for NWO will not affect the FTE calculation.  

If you estimate values for both WO and NWO, however, you will then be able 
to compare the Actual overheads in schedules against the Plan. The Actual 
Overhead Report will show whether the following was in line with the Plan:
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• The actual time that the agents were not on calls, but were working (such 
as time in meetings or trainings).

• The actual time that the agents were not on calls and were not working 
(such as when they are on time off or full-day exceptions). 

WO or NWO do not affect intra-day staffing requirements. This is because 
they get built into the schedule in the form of pre-planned items from the 
WFM Calendar (such as time off and some exceptions), as well as pre-planned 
Shift items (such as meals and breaks). Of course, there will always be some 
overheads that cannot be planned for. Run the Actual Overhead Report to see 
the percentage of WO and NWO in the schedules that was not anticipated in 
advance.

Specify Multimedia Service Level Objectives

Use the Specify Multimedia Service Objectives screen to define service level 
objectives when you are building staffing volumes for a Deferred staffing 
activity, such as responding to e-mails.

1. Fill in the percentage target for % of Deferred Work in. Enter a value in 
one of the following fields.
 Hrs
 Min
 Sec

2. As an alternative, select Use Service Level Template. 

3. If you select Use Service Level Template, click Load Template to load an 
existing template. 

4. Click Finish.

Staffing Requirements

Use the Staffing Requirements screen to define how staffing requirements are 
built. You will use this screen for Immediate activities if you do not define any 
service objective, or for Fixed-Staff activities.

1. Do one of the following:
 Select Number of Agents Each Time Step and enter the appropriate 

number in the text box to the right.
 Select  Average Activity Handling Time and enter the appropriate 

value (in seconds) in the text box to the right.
 Select Use Staffing Template and click Load Template in order to 

load an existing template.

2. Click Finish.

WFM Web calculates the staffing volumes and displays them in the Staffing 
view. An error message appears if WFM Web cannot complete the calculation.
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Staffing Build Results View

If you selected the Compare Results with Previous check box on the first 
screen of the Scenario Staffing Build Wizard, the Scenario Staffing Build 
Results view opens after you click Finish to complete the wizard. 

The graph shows the new calculated staffing compared to the original 
calculated staffing. 

• Where the new calculated staffing results in an increased number of 
agents, the graph shows the area in red. 

• Where the new calculated staffing results in a decreased number of agents, 
the graph shows the area in green. 

Click Save to keep the new calculated staffing in your scenario, or Discard to 
return to the original calculated staffing values.

Staffing Split Wizard

Use the Staffing Split Wizard to split staffing from a multi-site activity Staffing 
forecast scenario.  

Multi-site Activities

A multi-site activity (virtual activity set up in WFM Configuration Utility) has 
one or more associated activities (existing activities set up in WFM 
Configuration Utility).  After building calculated and required staffing for a 
multi-site activity, you can then use this wizard to split the result between 
associated activities. 

Note: The Staffing Split Wizard is available only within a Forecast Scenario. 
You must add a multi-site activity to the forecast scenario in order for 
them to be available for splitting in Staffing Split Wizard. 

To use the Staffing Split Wizard:

1. In a currently-open forecast scenario, select a multi-site activity with 
already-built staffing values.

2. Click the Split button on the Forecast Scenario Staffing View toolbar. 

The first of the Staffing Split Wizard's three screens, Select Multi-site 
Activities, opens. 

3. Select the check boxes next to the multi-site activities that have staffing 
values you want to be split between associated activities.

You can select several multi-site activities within the same Business Unit.

4. Select Use AHT Forecast if you want WFM Web to consider average 
handling time forecasts when performing the split.
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Note: If you select Use AHT Forecast but some of the selected activities 
do not have an AHT forecast, the result for each of these activities 
will be 0 for the timestep(s) where AHT=0.

5. Click Next.

The wizard's second screen, Select Activities within Multi-site Activity, 
opens.

6. Select the local (target) activities into which you want to split the multi-site 
activities.

You can select several target activities. 
 If you selected Use AHT Forecast on the first screen, then you cannot 

select target activities that do not have at least one timestep with at 
least one AHT value greater than zero.

 If you select Use All Activities, when WFM splits staffing data, it 
takes into account the values for all activities in the specified site, 
whether selected or not. Activities that are not selected are not split; 
WFM Web simply considers them when determining the proportions 
that are split to each selected activity.

7. Click Next. 

Split Required Also is checked by default, If checked, when WFM splits 
staffing data, the required staffing of the selected multi-site activities is 
split to activities using the same proportions as when splitting calculated 
staffing. 

The wizard's third screen, Specify budgeting and overhead data, opens.
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Figure 16: Staffing Split Wizard, Specify budgeting and overhead data

The top half of the screen displays a table with a row for each site in the 
forecast. Each site row contains these columns:
 Site
 Activity
 Hours (corresponds to the Paid Hrs/Day field below the table)
 Wage (corresponds to the Hourly Wage field below the table)
 W. Overhead (corresponds to the Working OH field below the table)
 Templates
 N. Overhead (corresponds to the Non-Working OH field below the 

table)

8. To change an individual value, click on a number inside an Hours, Wage, 
W. Overhead, or N. Overhead cell of the table, and type a new value.

To change all values in a column of the table at once, click inside the 
corresponding field below the table and then click Set All. You can change 
one, some, or all fields.

See the Staffing Build Wizard topic for definitions. 

9. Click Finish.
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WFM Web displays a Progress dialog box while it splits the activities. Click 
this box's Cancel button if you want to cancel the split. After splitting the 
activities, WFM Web returns to the Staffing View.

Scenario Graphs View

Use the Graphs view to display the selected forecast scenario's data in a line 
chart. 

The following sections cover:

• Displaying the Graphs view

• Setting the dates, statistics, and granularity

• Reading the graph and legend

• Modifying and managing scenario data

Displaying the Graphs View

To display the Graphs view:

1. In the Forecast Scenarios view, select a scenario. 

2. In the Modules tree, click [Scenario-name] Graphs

The Graphs view appears.

3. In the Objects tree, select an activity.

A default graph appears, which you can now customize.

Setting the Dates, Statistics, Period, and Granularity

Use the Target Date, Show Statistics, Period, and Granularity controls (near the 
top) to customize the graph:

• Select a Start date within the forecast scenario's date range, using the 
standard date-selection controls.

• Use the Show Statistics drop-down list to select which statistics you want 
to graph: Interaction Volume, AHT (average handling time), Interaction 
Volume and AHT, Calculated Staffing, Required Staffing, Calculated and 
Required Staffing, or Calculated and Multi-skilled Calculated Staffing.

• Use the Period drop-down list to choose whether to view data for a Year, 
Month, Week, or Day.

• Use the Granularity drop-down list to select the time interval for the 
graph's horizontal axis: Monthly, Weekly, Daily, 60 min (minutes), 30 min, 
or 15 min. The choices that are available vary, depending on the Period that 
you selected.

• Click Filter to further customize the graph.
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Reading the Graph and Legend

The graph shows the statistics, dates, period, and granularity that you select. 
The vertical axis indicates the units shown. If you display multiple statistics, 
the right and left vertical axes display different units for the two statistics, 
when necessary.

The Legend, at the bottom, identifies the colors that the graph uses to represent 
particular statistics, events, or historical data. The Legend changes depending 
on the statistics that you select. Special events appear as markers on the graph.

Modifying and Managing Scenario Data

You can use the following buttons on the Actions toolbar (the same commands 
also appear on the Actions menu):

Add activity—Opens the Add Activity window, where you can add activities 
to this forecast scenario.

Remove activity—Opens the Remove Activity window, where you can 
remove activities from this forecast scenario.

Save—Saves your changes to this forecast scenario.

Comments—Opens the Comments window, where you can enter comments 
for each day of the forecast.

Close—Closes this scenario, prompting you to save any unsaved changes.

Use multi-site activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, Business Unit, or Enterprise in the 
Objects tree.

Options—Opens the Options dialog box, where you can further customize the 
graph.

Load Forecast Template Window

Use the Load Forecast Template window to select a forecast template. This 
window opens when you:

• Select Use Templates and click the Load Templates button in these Staffing 
Build Wizard screens: Provide Budgeting and Overhead Data, Specify 
Service Level Objectives, and Staffing Requirements. The window title 
includes the template type; for example, Load Indirectly Occupied Time % 
Forecast Templates.

• Select Template Based and click Next in the Volumes Build Wizard. 

The template's type, and its associated activity, match your selections in the 
previous view or window. 

To use this window:
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1. Select a template in the list of available Templates at the upper left. 

The list shows each source template's name and, for overlap templates, its 
date range. 

2. Select a Start date and End date at the lower left, using the date-selection 
controls.

The date range that you can specify depends on the context from which 
you opened this window. For non-overlap templates, you cannot select 
dates outside the selected template's date range, and you cannot apply 
templates with overlapping date ranges.

3. Select the check boxes (at the lower left) beside any weekday to which you 
want to apply this template. 

Note: This does not apply to overlap templates.

4. Click >>> to apply the template.

The template moves into the Applied Templates list at the upper right. That 
list shows your date and weekday selections, where applicable.

5. Repeat the preceding steps for any additional templates that you want to 
apply.

6. Click <<< if you want to remove any of your selections from the Applied 
Templates list.

7. Click OK to load the templates that you have applied.

You are returned to the window from which you opened the Load Forecast 
Template window.

Add Activity Window

Use the Add Activity window to change the activities that are associated with 
the current forecast scenario:

1. Select the check box next to any activity that you want to include.

You can select from multiple sites.

2. Click OK.

The previous view reappears. Its displayed data changes to match your 
selections.

Remove Activity Window

Use the Remove Activity window to change the activities that are associated 
with the current forecast scenario:

1. Clear the check box next to any activity that you want to remove.

You can clear activities from multiple sites.
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2. Click OK.

The previous view reappears. Its displayed data changes to match your 
selections.

Add Comments to a Forecast

Use the Comments window to add comments to a forecast scenario. For 
example, you might want to add a comment after making manual changes to a 
scenario, so that you can keep a record of the changes.

You can add comments only for an activity, not for a site. A forecast scenario 
activity can have numerous comments, including a new comment for each day.

See the following sections cover:

• Adding comments to a forecast scenario.

• Editing existing comments.

• Deleting existing comments.

Adding Comments to a Forecast Scenario

1. Click the Comments button on the Forecast Scenario View toolbar.

2. In the Comments window that appears, click New at the upper right.

The lower panel's label changes to New comment.

3. Adjust the Comment date, using the date-selection controls.

By default, the start date of the forecast appears. You cannot select a date 
outside the forecast scenario's date range. If you try to make more than one 
comment per date, an error message alerts you to either select a different 
date or edit (or delete) that date's existing comment.

4. Type your comments into the large text box at the bottom left.

5. Click Apply to add your comment to the upper list, or Cancel to discard it.

6. Make any other changes that you want to make in this window and then do 
one of the following:
 Click Save to save all of your changes and close the Comments 

window.
 Click Close to discard all of your changes and close the Comments 

window.

The previous forecast scenario view reappears. Your new comments are now 
attached to the scenario.

Editing Existing Comments

1. Click the Comments button on the Forecast Scenario View toolbar.
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The Comments window appears. The upper section of the window lists 
previously entered comments.

2. Click an existing comment to select it.

The comment's text appears in the large text box at the bottom left.

3. Click Edit.

4. Edit the comment text in the large text box.

5. Click Apply to save your edits, or Cancel to discard them.

6. Make any other changes that you want to make in this window, then do one 
of the following:
 Click Save to save all of your changes and close the Comments 

window.
 Click Close to discard all of your changes and close the Comments 

window.

The previous forecast scenario view reappears.

Deleting Existing Comments

1. Click the Comments button on the Forecast Scenario View toolbar.

The Comments window appears. The upper section of the window lists 
previously entered comments.

2. Click an existing comment to select it.

The comment's text appears in the large text box at the bottom left.

3. Click Delete.

Warning! The comment is deleted immediately. There is no confirmation 
prompt.

4. Make any other changes that you want to make in this window; then do 
one of the following:
 Click Save to save all of your changes and close the Comments 

window.
 Click Close to discard all of your changes and close the Comments 

window.

The previous forecast scenario view reappears.

Publish/Extract Forecasts

Use the Publish Forecast Wizard to transfer unpublished forecast scenarios to 
the Workforce Management database's Master Forecast, or to extract Master 
Forecast information to forecast scenarios.

The following sections cover:
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• Publishing to the Workforce Management Database.

• Extracting from the Workforce Management Database.

Why Publish Forecasts?

• Publishing a forecast to the Workforce Management database means that 
the forecast is final. Schedules for a particular date range are based on the 
published (Master) forecast for those dates.

• Until a forecast is published, you cannot calculate certain performance 
data.

Publishing to the Workforce Management Database

To publish a forecast:

1. In the Forecast Scenarios view's Scenarios Table, select the scenario that 
you want to publish. Then click the Publish button on the toolbar.

The Publish Forecast Wizard's Select Action screen appears.

2. Select Publish to Master Forecast, and then click Next.

The Publish to Master Forecast screen appears.

3. In the Source Dates section, select the Start date and End date.

These fields define what date range of information you want to publish 
information from the selected scenario. By default, the selected scenario's 
own start and end dates appear in these text boxes. Use the date-selection 
controls to adjust the dates. You cannot select dates outside the original 
scenario dates. 

Note: The scenario and target start dates occur on the same day of the 
week.

4. In the Target Dates section, select the Start date and End date.

These values define the date range for which you want to update 
information in the Master Forecast. By default, these fields' entries match 
those in the Source Dates section. Use the date-selection controls to adjust 
the dates.

Data from a specific weekday is copied only to the same weekday. That is, 
forecast information for a Monday is copied to one or more Mondays, 
depending on the target date range that you select. The Monday data is not 
copied to every day within the target date range.

5. In the Activities list, select which activities you want to publish to the 
Master Forecast.

The tree shows all activities for which the selected scenario contains data. 
You can expand Business Units to display their sites and expand sites to 
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display their activities. You can select multiple activities from different 
sites.

6. Click Finish.

Extracting a Forecast from the Workforce Management 
Database

To transfer data from the Master Forecast into a forecast scenario: 

1. In the Forecast Scenarios view's Scenarios Table, select the scenario to 
which you want to extract the data. Then click the Publish button on the 
toolbar.

The Publish Forecast Wizard's Select Action screen appears.

2. Select Extract from Master Forecast, and then click Next.

The Extract from Master Forecast window appears.

3. In the Source Dates section, select the Start date and End date.

These values define the date range for which you want to extract 
information from the Master Forecast. By default, these values match those 
in the Target Dates section. Use the date-selection controls to adjust the 
dates. 

4. In the Target Dates section, select the Start date and End date.

These values define the date range for which you want to update the 
information in the selected target scenario. By default, the scenario's own 
start and end dates appear in the text boxes. Use the date-selection controls 
to adjust the dates. For an existing scenario, you cannot select dates outside 
the scenario's original date range.

5. In the Activities list, select which activities you want to extract to the target 
scenario.

The tree shows all activities for which the Master Forecast scenario 
contains data. You can expand Business Units to display their sites and you 
can expand sites to display their activities. You can select multiple 
activities from different sites.

6. Click Finish.

Graph View Options

Overview

Use the Options dialog box to customize the display of the Scenario Graphs 
view, the Master Forecast Graphs view, or the Historical Data Graphs view.

1. Select a statistic from the Show Statistics drop-down list.
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2. Click the Options button on the toolbar.

The contents of the Options dialog box changes depending on the statistic that 
you selected. The table below shows the statistics and the Help topic that 
explains the corresponding Options dialog box. 

Note: The Options dialog box for the three Staffing statistics (Calculated 
Staffing, Required Staffing, and Calculated and Required Staffing) are 
the same, so a single topic, Graphs Filters (Staffing), covers all three.

Interaction Volume

Use the Options dialog box to customize a Forecast Graphs view whose Show 
Statistics drop-down list is set to Interaction Volume:

1. Click the Options button on the Graphs view toolbar.

The Options dialog box opens.

2. Select the check boxes for the options that you want to have displayed in 
the graphs. Clear the check boxes for those that you want to be hidden. You 
can select or clear any number of the check boxes.

See the option descriptions below. 

3. Click Apply.

The Graphs view is redrawn to match your selections. 

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that 
represents the start of each event’s impact.

Show Values—When selected, graphs display numeric values for each 
granularity period.

Show Historical Data—When selected, graphs display historical data. Check 
boxes appear for the following: This Year, 1 Year Ago, 2 Years Ago, 3 Years 
Ago, 4 Years Ago, 5 Years Ago.

You can independently show or hide the display of multiple prior years' data. 
Each year's data appears in a different color. The Legend identifies what each 
color represents.

AHT

Use the Options window to customize a Forecast Graphs view whose Show 
Statistics drop-down list is set to AHT (average handling time):

1. Click the Options button on the Graphs view toolbar.

The Options window appears.
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2. Select the check boxes for the options that you want to have displayed in 
the graphs. Clear the check boxes for those that you want to be hidden. You 
can select or clear any number of the check boxes.

See the option descriptions below. 

3. Click Apply.

The Graphs view is redrawn to match your selections. 

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that 
represents the start of each event’s impact.

Show Values—When selected, graphs display numeric values for each 
granularity period.

Show Weighted AHT—When selected, graphs use weighted AHT data rather 
than a simple average of AHT data.

Show Historical Data—When selected, graphs display historical data. Check 
boxes appear for the following: This Year, 1 Year Ago, 2 Years Ago, 3 Years 
Ago, 4 Years Ago, 5 Years Ago.

You can independently show or hide the display of multiple prior years' data. 
Each year's data appears in a different color. The Legend identifies what each 
color represents.

IV and AHT

Use the Options dialog box to customize a Forecast Graphs view whose Show 
Statistics drop-down list is set to Interaction Volume and AHT (average 
handling time):

1. Click the Options button on the Graphs view toolbar.

The Options dialog appears.

2. Select the check boxes for the options that you want to have displayed in 
the graphs. Clear the check boxes for those that you want to be hidden. You 
can select or clear any number of the check boxes.

See the option descriptions below. 

3. Click Apply.

The Graphs view is redrawn to match your selections. 

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that 
represents the start of each event’s impact.

Show Values—When selected, graphs display numeric values for each 
granularity period.
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Staffing

Use the Options dialog box to customize a Forecast Graphs view whose Show 
Statistics drop-down list is set to one of the following:

• Calculated Staffing

• Required Staffing

• Calculated and Required Staffing

• Calculated and Multi-skill Calculated Staffing

An Explanation and Caution

Multi-skilled calculated staffing takes into account how many agents with 
multiple skills could be available to work on an Activity, and how the 
occupancy of an average agent would be divided among this Activity and the 
other Activities in his or her skill set. 

Multi-Skilled Calculated Staffing is available only if the Multi-Skilled 
Forecasting option is configured. See the current Workforce Management 
Administrator's Guide, Chapter 1: “Overview” for a discussion of Multi-
Skilled Forecasting and a description of how to enable Multi-Skill support. 

If the Multi-Skill option is not configured, then you will still see Mutli-Skill 
Equivalents in the graphical view, but they will be the same as Calculated 
Staffing in Single-Skill Equivalents.

To bring up the dialog box:

1. Click the Options button on the Graphs view toolbar.

The Options dialog box opens.

2. Select the check boxes for the options that you want to have displayed in 
the graphs. Clear the check boxes for those that you want to be hidden. You 
can select or clear any number of the check boxes.

See the option descriptions below. 

3. Click Apply.

The Graphs view is redrawn to match your selections. 

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that 
represents the start of each event’s impact.

Show Values—When selected, graphs display numeric values for each 
granularity period.

Show Secondary Graph—If you select a radio button other than None in this 
panel, graphs include an additional line that shows values for one additional 
statistic. The secondary line is superimposed in a different color (which is 
identified in the Legend). 
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Choose a secondary statistic by selecting only one of the following radio 
buttons:

None—No secondary graph.

Service Level Objective—The requirement for the service level as defined 
when creating the forecast.

Service Level—The forecasted service level.

Avg Speed of Answer Objective—The requirement for Average Speed of 
Answer (ASA) as defined when creating the forecast.

Avg Speed of Answer—The forecasted Average Speed of Answer (ASA).

% of Abandons Objective—The requirement for the percentage of 
interactions abandoned, as defined when creating the forecast.

% of Abandons—The forecasted percentage of interactions abandoned.

Maximum Occupancy Objective—The requirement for the maximum time 
that a logged-in agent should be handling interactions, as defined when 
creating the forecast.

Maximum Occupancy—The forecasted maximum time that a logged-in agent 
will be handling interactions.

Estimated Budget*—The estimated budget based on a full-time working day 
and hourly rate.

Hiring Plan*—The total number of people, including non-working (on 
vacation) agents, who are needed to handle the forecasted interaction volume.

Agent Hours*—The number of agent hours that are needed to handle the 
interaction volume.

*Omitted from the list of options, if you selected Use multi-site activity for 
any target in the object tree.

Overlays
NEW! Beginning with WFM 7.6.1, you can create and configure overlays in 
the Forecast module of WFM Web for Supervisors. Overlays perform the 
function of factors (which were previously defined and configured in 
Configuration Utility). Overlays help you track events that may affect 
interaction volume. For example, use an overlay to include in your forecast the 
anticipated effect of a sales promotion or a marketing campaign.

Getting Started

Prerequisite: You must have the security permission Events which is 
assignable using
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• WFM Configuration Utility (User Security > Modules > Forecasts > 
Events) before you can create or configure overlays or access the action 
Find Events in the Historical Data Volumes View.

• To use overlays, open the Forecast module in the Modules pane and select 
Overlays.

You can then see a hierarchy of business units (BUs), sites and overlays in 
the Object pane below. 

• To manage the list of Overlays, select a BU or a site in the Objects pane. 

• To edit an overlay, select it in the Objects pane and make changes in the 
Data pane.

Managing the List of Overlays 

You can use toolbar icons or Actions menu commands to manage the overlays:

1. Select a BU or Site in the Object pane.

A table in the Data pane lists all current overlays.

2. Click on a overlay to select its entire row.

3. Select a command from the Actions menu, or an icon from the toolbar:

Toolbar controls 

New—Start the New Overlay wizard.

Edit—Edit the selected overlay.

Delete—Delete the selected overlay. 

Data Pane controls 

The grid displays all overlays that belong to the selected BU or Site. The grid 
contains these columns:

Overlay—Name of the selected overlay.

Spread—The time period over which the overlay is spread; in days or hours.

Type—Possible values (Impacting or Redistributing) indicate how the selected 
overlay will affect forecast values. You can change this in the Properties tab by 
selecting a type:

• Calculate Using Specified Initial and Ending Impact (select to specify 
Impacting)

• Always Use Entered Distribution or Always Calculate Disregarding 
Impacts and Distribution (to specify Redistributing)

Usage—For each overlay, this column lists the Properties tab choice for type 
(see above).



Supervisor User’s Guide 97

Chapter 4: Forecasting Overlays

Editing an Overlay

To edit an overlay, 

1. Select Overlay in the module pane.

2. Select a BU or Site in the object area.

3. Select an overlay by one of these methods:

• Select an overlay in the object area in the object area (beneath the selected 
BU

• or site).

• Select an overlay in the data area and click the Edit (   ) button.

• Double-click an overlay in the data area.

4. Select a command from the Actions menu, or an icon from the toolbar:

Edit Overlay Controls

Save—Save all changes made to overlay.

Calculate Distribution—Start the Calculate Distribution wizard, which 
calculates the distribution of the selected overlay. This action is enabled only if 
the option always use entered distribution is selected.

OR

Select a tab:

Properties tab—View and change the main properties of the selected overlay.

Distribution tab—View and change the distribution method of the selected 
overlay. Enabled in the Properties tab by selecting the type Always Use 
Entered Distribution.

Impacted Activities tab—View and change activities which are impacted by 
the selected overlay.

Events tab—View and change events which are related to the selected overlay.

Properties tab elements

Name field—You can edit the selected Overlay's name in this field.

This overlay is label

• Impacting Forecast Values and Totals—Specify that this overlay can 
impact the forecast by changing forecast’s values and totals. This option is 
the default.

• Redistributing Forecast Without Changing Total—Specify that this 
overlay must preserve a forecast’s total for specific period even while 
changing the distribution of values inside that period.
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• Spread Over field—Displays the length of time that the selected Overlay 
will occupy. Edit this field and select one of the two radio buttons Days or 
Hours to choose the units. The value must be greater than 0 (zero) and the 
default is set during creation.

While building forecast use this overlay in the following way: radio button 
group 

• Calculate Using Specified Initial and Ending Impact—Use the specified 
initial and ending impact when building a forecast. This option enables the 
Distribution tab and the fields Initial Impact and Ending Impact beneath 
that tab.

• Always Use Entered Distribution—Use the specified (entered) 
distribution when building a forecast. This option enables the Distribution 
tab.

• Always Calculate Disregarding Impacts and Distribution—Use this 
overlay, but always disregard impacts and distribution when building a 
forecast. This option disables the Distribution tab.

This overlay is applicable to radio button group

• IV—Specify that this overlay applies only to Interaction Volume (IV)

• AHT—Specify that this overlay applies only to Average Handling Time 
(AHT).

Distribution tab elements

What you see depends upon choices that you made on the Properties page.

• This page is completely disabled if Always Calculate Disregarding 
Impacts and Distribution was selected under the Properties tab.

• If Always Use Entered Distribution was selected on the Properties tab:

• Graph—Displays the same information as the grid below it displays, but 
in graphical form.

• Grid—Displays and allows you to edit the overlay's distribution. Columns:
 Daily or Hourly Impact   Each row displays an increment that the 

overlay will be in effect. The actual increment (Day or Hour) is 
configured in Spread.

 Distribution Value   Displays the distribution value for each increment. 
The default value in each cell is zero.

• If Calculate Using The Specified Initial and Ending Impact was 
selected on the Properties page:
 Initial Impact field—Use this field to specify the initial impact of the 

overlay. Range: zero (the default) and positive numbers.
 Ending Impact field—Use this field to specify the ending impact of 

the overlay. Range: zero (the default) and positive numbers.



Supervisor User’s Guide 99

Chapter 4: Forecasting New Overlay Wizard

Impacted Activities tab

(Also a page in the New Overlay wizard.)

This tab lists all activities that correspond to the Factor that is selected in the 
object tree. 

• Select the check box to the left of each activity in the list, to specify which 
activities will be impacted by the selected factor.

• Clear the check box to specify no impact.

Events tab elements

The grid on this tab lists all Events in the selected Overlay, one per row. The 
value in every cell of this grid is editable.  The columns are:

Name—Edit the Event name in this cell. 

Start Date—Edit the start date. 

Start Time—Edit the start time. 

Strength—Edit the strength of the event. Range is 0 or any positive value. 

Disregard Historical Data—Select this check box if the event should 
disregard historical data. Clear the check box  to consider historical data. 

Events Controls

• Click the Add Event button to add a new row to the grid, with default 
values in the cells.

• Click the Delete Event button to delete the selected event from the grid.

• Click Cancel or Save to perform those functions.

New Overlay Wizard
Use the New Overlay Wizard to create a new overlay. 

1. Open the Forecast module and select Overlays in the modules area.

2. Select a Business Unit or Site in the objects area.

3. Click the New icon or select New from the Action menu. 

The New Overlay Wizard opens and displays the following pages, in order: 
 Properties
 Usage
 Impact
 Impacted Activities.

4. Select the appropriate controls on each page, remembering that some 
selections may deselect others.
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The New Overlay Wizard opens and displays these pages, in order: Properties, 
Usage, Impact, Impacted Activities.

Properties Page

1. Select the appropriate settings on this page, remembering that some 
selections may deselect others.

2. Click Next. 

The settings on this page are:

• Name field—You can edit the selected Overlay's name in this field.

• This Overlay shall: radio buttons
 Impact Forecast Values and Totals—Specify that this overlay can 

impact the forecast by changing forecast’s values and totals. This 
option is the default.

 Redistribute Forecast Without Changing Total—Specify that this 
overlay must preserve a forecast’s total for specific period even while 
changing the distribution of values inside that period.

• Spread Over: field

Displays the length of time that the selected Overlay will occupy. 

Edit this field and select one of the two radio buttons Days or Hours to 
choose the units. The value must be greater than 0 (zero) and the default is 
1.

• This Overlay is Applicable To: radio buttons

Select one of the two radio buttons IV or AHT to choose whether the 
overlay applies to Interaction Volume (IV) or Average Handling Time 
(AHT).

Usage Page

The New Overlay Wizard opens and displays these pages, in order: Properties, 
Usage (this page), Impact, Impacted Activities.

1. Select the appropriate settings on this page, remembering that some 
selections may deselect others.

2. Click Next. 

The settings on this page are:

While Building A Forecast use This Overlay In The Following Way: radio 
button group

Calculate Using The Specified Initial and Ending Impact

Use the specified initial and ending impact when building a forecast. This 
options is the default.
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This option is missing from the display, and thus disabled, if you selected This 
Overlay Shall / Redistribute Forecast Without Changing Total (on the 
Properties Page).

Always Use Entered Distribution

Use the specified (entered) distribution when building a forecast.

Always Calculate Disregarding Impacts and Distribution

Use this overlay, but always disregard impacts and distribution when building 
a forecast.

Impact Page

Note: This page appears only if  you selected the radio button Calculate Using 
The Specified Initial and Ending Impact on the Usage page.

The New Overlay Wizard opens and displays these pages, in order: Properties, 
Usage, Impact (this page), Impacted Activities.

1. Select the appropriate settings on this page, remembering that some 
selections may deselect others.

2. Click Next. 

The settings on this page are:

Impact parameters of overlay fields

Initial Impact field

Use this field to specify the initial impact of the overlay. Range: zero (the 
default) and positive numbers. Enabled only if the option Calculate Using 
Specified Initial and Ending Impact is selected.

Ending Impact field

Use this field to specify the ending impact of the overlay. Range: zero (the 
default) and positive numbers. Enabled only if the option Calculate Using 
Specified Initial and Ending Impact is selected.

Impacted Activities Page

The New Overlay Wizard opens and displays these pages, in order: Properties, 
Usage, Impact, Impacted Activities (this page).

1. Select the appropriate settings on this page, remembering that some 
selections may deselect others.

2. Click Finish. 

This page contains the same controls and constraints as the Impacted Activities 
tab a list of Activities, each with its own with selectable check box.
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Forecast Templates

Overview

Forecast templates help you create forecasts for sites or business units that 
have little or no historical data. In addition, there are other uses for templates. 
For example, you can create templates for service objectives, such as Average 

Speed of Answer, and Service Level. In those cases, forecast templates are 
used to apply different values for different periods of the day, instead of using a 
single value for the whole day.

Use WFM Web's forecast templates features to:

Select and manage forecast templates—See Forecast Templates List View.

Edit template values—See Template Properties: Data Tab .

View template values in a graph—See Template Properties: Graph Tab.

Add or remove activities within a template—See Template Properties: 
Activities Tab.

Create a new template—See New Forecast Template Window

Note: You can copy and paste data between a grid and a spreadsheet. For 
example, you can copy and paste from a Scenario Volumes view or 
Scenario Staffing view. 

Create a new template from existing data—See Save as Template Window.

List View

Use the Forecast Templates List view to create, edit, and delete forecast 
templates. 
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Figure 17: Forecast Templates List view

You use these templates to create forecasts for sites or business units that have 
little or no historical data. In addition, there are other uses for templates. For 
example, you can create templates for service objectives, such as Average 
Speed of Answer, and Service Level. In those cases, forecast templates are 
used to apply different values for different periods of the day, instead of using a 
single value for the whole day.

The following sections cover:

• Displaying the Forecast Templates List view

• Using the Templates table

• Creating, editing, or deleting templates

Displaying the Forecast Templates List View

1. In the Modules tree, click Forecast > Templates to activate the Templates 
List View.

2. In the Objects tree, select a business unit, site, or template. Business units 
and sites expand to display their templates.
 If you selected a business unit or site, the table on the right-hand pane 

shows the templates that correspond to your selection.
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 If you selected a template, the template properties appear in the Data 
tab. 

See Template Properties: Data, Template Properties: Activities, and Template 
Properties: Graph for information on the three template properties tabs.

Using the Templates Table

The Templates table shows each template's name, type, associated site, and 
date range.

To filter the table so that it shows more or fewer templates:

• Select or clear check boxes in the Show Template Types panel at the top.

To select a template for editing or deletion:

• Click the template's row in the table.

Creating, Editing, or Deleting Templates

You can use the following buttons on the Actions toolbar (these commands 
also appear in the Actions menu):

New—Opens the New Forecast Template dialog box.

Edit—Opens the Forecast Template Properties view for the selected template.

Delete—Deletes the selected template after first displaying a dialog box asking 
you to confirm your choice.

Template Properties: Data Tab

Use the Template Properties view's Data tab to edit a forecast template's values 
in a table format.

The boxes at the top of the tab contain the template's name, associated site, 
business unit, type, and total or average value. The table lists timesteps and 
corresponding values for the template's activities.

To edit values:

1. Select the value in the right column, and replace it with the value that you 
want.

2. Repeat this for other timesteps that you want to change.

You can use the vertical scroll bar on the right to display more timesteps.

3. Click Save to save your changes to the template.

Template Properties: Graph Tab

Use the Template Properties view's Graph tab to view a forecast template's 
values in a graphical format.
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To adjust the graph's displayed time interval, use the Display Date drop-down 
list. If you select Whole Period, the graph's horizontal axis indicates: 

• Days of the week, for non-overlap templates.

• All dates in the template, for overlap templates.

• If you select an individual weekday (for non-overlap templates) or a 
specific date (for overlap templates), the horizontal axis indicates 
timesteps. 

The graph's vertical axis identifies the values shown in the graph.

Template Properties: Activities Tab

Use the Template Properties view's Activities tab to modify the activities 
associated with a forecast template:

1. Select the check boxes beside the activities that you want to associate with 
the template. Clear the check boxes beside the activities that you want to 
remove from the template.

The check boxes show activities belonging to the Business Unit or site 
with which the template is associated. Use the vertical scroll bar on the 
right to display more activities.

2. Click Save to save your changes to the template's activities.

New Forecast Template Dialog Box

Use the New Forecast Template dialog box to create a new template. 

1. Click the New button on the Forecast Templates List view toolbar.

The New Forecast Template dialog box appears. 

2. Enter a Name for the new template.

3. Use the Associated drop-down list to select the site for which you are 
building this template. 

4. Select the template type from the Type drop-down list. See below for a list 
of template types.

5. If you want to use settings from a previously configured template, select 
that template from the Based On drop-down list. 

6. Enter a number in the Initial Value text box.

The initial value is a minimum value that applies to all timesteps. After 
you have created the template, edit it to adjust the precise values for each 
timestep. See Template Properties: Data for details.

WFM Web interprets the Initial Value setting differently, depending on the 
type of template. For example, if you are creating an Interaction Volume 
template, the initial value might be 8 (calls per timestep).

7. If you are creating an overlap template, enter the Start and End dates.
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8. Select the Activities that you want to be associated with this template.

Selecting Activities enables you to control which templates are used when 
forecasting for specific activities.

9. Click OK.

Your new forecast template is now available in the Forecast Templates List 
view.

Forecast Template Types

Interaction Volume—Number of interactions per timestep.

Note: When you save historical IV or AHT for a multi-site activity as a 
template, only multi-site activity data are saved, never the sum of 
underlying activities.

Average Handle Time—In seconds. See above note.

Service Level Percentage—As a percentage. See Special Note at end of this 
topic. 

Overheads—As a percentage. See Special Note.

Indirectly Occupied Time—As a percentage. See Special Note.

Maximum Occupancy—As a percentage. 

Interaction Volume Overlap—Number of interactions per timestep.

Average Handle Time Overlap—In seconds.

Staffing—Number of agents (full-time equivalents) to be scheduled for each 
timestep. This can be either calculated by WFM (Calculated Staffing) or set by 
the user (Required Staffing), or you can use both Calculated and Required 
values in a forecast. See Special Note.

Average Speed of Answer—In seconds. See Special Note.

Note: You can create these templates at the business unit level and apply 
them when building a multi-site activity staffing forecast.

Save as Template Dialog Box

Use the Save As Template dialog box to create a new forecast template from 
existing data. You can open this dialog box from:

• Historical Data Volumes View

• Master Forecast Staffing View

• Scenario Staffing View

To complete the dialog box:
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1. Enter a Name for the new template.

2. From the Associated drop-down list, select the site to which you want this 
template associated.

3. From the Type drop-down list, select the template type.

Note: The Based on drop-down list and the Initial Value text box are 
disabled. You cannot alter their default entries.

4. Select the Start date and End date.

For regular (non-overlap) templates, the date range must be one week. If 
you enter a different date range, WFM Web automatically adjusts it to one 
week. Overlap templates, which fill in gaps in historical data, have 
specified start and end dates.

5. Select the Activities that you want to be associated with this template.

6. Click OK.

The new forecast template now appears in the Forecast Templates List view.

Master Forecast Views

Master Forecast Overview

You can open the following Master Forecast views from Modules tree's 
Forecast branch

Master Forecast Volumes View—Enables you to view the Master Forecast's 
interaction volumes.

Master Forecast Staffing View—Enables you to view the Master Forecast's 
calculated and required staffing.

Master Forecast Graphs View—Displays your choice of statistics for the 
Master Forecast, using line charts.

Master Forecast Volumes View

Use the Volumes view to display the Master Forecast's interaction volumes. An 
example view is shown below. Click a toolbar button on the image below to 
jump to its description. 

This view provides standard date-selection controls and a grid that shows 
statistics for days or timesteps.

The following sections cover:

• Displaying the Volumes view.

• Setting the grid properties and date range.
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• Using the grid.

• Cleanup and use multi-site activities.

Displaying the Volumes View

To display the Volumes view:

1. In the Modules tree, click Master Forecast Volumes.

2. In the Objects tree, select an activity.

Statistics populate the grid. 

Setting the Grid Properties and Date Range

Use these options in the Grid properties and Date range panels (not shown in 
partial view above, but at top right) to customize the grid:

• The grid displays data for a period of a year, month, planning period, or 
week. To change the period, click Year, Month, Planning Period, or Week 
from the Period drop-down list to change the time range shown on each 
row.

• If you select Week, you can further adjust each row's time range by 
selecting a Granularity of 15, 30, or 60 minutes.

• Show columns, or hide them, by selecting or clearing (respectively) the 
Volume, Volume %, and AHT check boxes.

• Use the standard date-selection controls to jump to a different week within 
the Master Forecast's date range.

Using the Grid

The grid provides columns that display the following statistics:

Week/Time Step—Identifies the range of dates or timesteps on this row. (The 
column's label and contents depend on the date range and granularity that you 
selected above.)

[Days or Dates]—If you select the Month date range, each group of columns 
shows statistics for one full day. 

If you select the Week date range, each group of columns indicates one date, 
the top row shows daily totals, and each lower row shows statistics for one 
timestep on that date.

(Timestep durations depend on the granularity that you selected above.)

IV—Shows the interaction volume forecasted for each day or timestep. 

IV%—Shows this row's percentage of the day's total interaction volume.

AHT—Shows the average handling time.
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Weekly Totals—If you select the Month date range, these columns show 
weekly totals, or averages, for the IV, IV%, and AHT statistics.

Cleanup and Calculation Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu)

Cleanup—Opens the Cleanup Master Forecast window, where you can 
remove information from the Master Schedule for selected dates and activities.

Use Multi-site Activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, business unit, or enterprise in the 
Objects tree.

Master Forecast Staffing View

Use the Staffing view to display the Master Forecast's calculated and required 
staffing. An example view is shown below. Click a toolbar button on the image 
below to jump to its description. 

This view provides standard date-selection controls and a grid that shows 
staffing levels for days or timesteps.

The following sections cover:

• Displaying the Staffing view.

• Setting the grid properties and date range.

• Using the grid.

• Save as Template, Cleanup, and Calculation Options.

Displaying the Staffing View

To display the Staffing view:

1. In the Modules tree, click Master Forecast Staffing.

The Staffing view appears as shown above. 

2. In the Objects tree, select an activity.

Statistics populate the grid. 

Setting the Grid Properties and Date Range

Use these options in the Grid properties and Date range panels (near the top) to 
customize the grid:



110 Workforce Management 7.6

Chapter 4: Forecasting Master Forecast Views

• The grid displays data for a period of a year, month, planning period, or 
week. To change the period: click Year, Month, Planning Period, or Week 
on the Period drop-down list. Your selection changes the time range shown 
on each row. (WFM Web prompts you to save any unsaved edits before 
refreshing the display.)

• If you select Week, you can further adjust each row's time range by 
selecting a Granularity of 15, 30, or 60 minutes.

• Show columns, or hide them, by selecting or clearing (respectively) the 
Calc or Req check boxes.

• Use the standard date-selection controls to jump to a different week within 
the Master Forecast's date range.

Using the Grid

The grid provides columns that display the following statistics:

Week/Time Step—Identifies the range of dates or timesteps on this row. (The 
column's label and contents depend on the date range and granularity that you 
selected above.)

[Days or Dates]—If you select the Month date range, each group of columns 
shows statistics for one full day. 

If you select the Week date range, each group of columns indicates one date, 
the top row shows daily totals, measured in Full Time Equivalents. Each lower 
row shows statistics for one timestep on that date.

(Timestep durations depend on the granularity that you selected above.)

Calc—Shows the calculated number of agents for each day (measured in Full 
Time Equivalents) or for each timestep (measured in single skill equivalents). 

Req—Shows the required number of agents for each day (measured in Full 
Time Equivalents) or for each timestep (measured in single skill equivalents). 

[Weekly Totals]—If you select the Month date range, the columns at right 
show weekly totals for the displayed statistics.

Save As Template, Cleanup, and Calculation Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

Save as template—Opens the Save as Template Wizard, where you can save 
Master Forecast data as a forecast template.

Cleanup—Opens the Cleanup Master Forecast window, where you can 
remove information from the Master Forecast for selected dates and activities.

Use Multi-site Activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
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only if you first select a multi-site activity, business unit, or enterprise in the 
Objects tree.

Master Forecast Graphs View

Use the Graphs view to display Master Forecast data in a line chart. An 
example view is shown below. Click a toolbar button on the image below to 
jump to its description. 

Figure 18: Master Forecast Graphs View

The following sections cover:

• Displaying the Graphs view.

• Setting the dates, statistics, and granularity.

• Reading the graph and legend.

• Cleanup, Calculation, and Options.

Displaying the Graphs View

To display the Graphs view:

1. In the Modules tree, click Master Forecast Graphs.
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2. In the Objects tree, select an activity.

A default graph appears, which you can now customize.

Setting the Dates, Statistics, Period, and Granularity

Use the Target Date, Show Statistics, Period, and Granularity controls (near the 
top) to customize the graph:

• Select a Start date within the Master Forecast's date range, using the 
standard date-selection controls.

• Use the Show Statistics drop-down list to select which statistics you want 
to graph: Interaction Volume, AHT (average handling time), Interaction 
Volume and AHT, Calculated Staffing, Required Staffing, or Staffing 
Calculated and Required, or Calculated and Multi-skilled Calculated 
Staffing.

• Use the Period drop-down list to choose whether to view data for a Year, 
Month, Planning Period, Week, or Day.

• Use the Granularity drop-down list to select the time interval for the 
graph's horizontal axis: Monthly, Weekly, Daily, 60 min (minutes), 30 min, 
or 15 min. The choices that are available vary depending on the period that 
you selected.

Reading the Graph and Legend

The graph shows the statistics, dates, period, and granularity that you selected 
above. The vertical axis indicates the units shown. If you display multiple 
statistics, the right and left vertical axes display different units for the two 
statistics.

The Legend, at the bottom, identifies the colors that the graph uses to represent 
particular statistics, events, or historical data. The Legend changes depending 
on the statistics you selected above. Special events appear as markers on the 
graph.

Cleanup, Calculation, and Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

Cleanup—Opens the Cleanup Master Forecast window, where you can 
remove information from the Master Forecast for selected dates and activities.

Use Multi-site Activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, business unit, or enterprise in the 
Objects tree.
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options—Opens the Options dialog box, where you can further customize the 
graph. 

Options for the Master Forecast Graphs

Use the Options dialog box to customize the display of the Master Forecast 
Graphs view:

1. Select a statistic from the Show Statistics drop-down list.

2. Click the Options button on the toolbar.

One of the following versions of the Options dialog box opens, depending on 
the statistic that you selected.

Cleanup Master Forecast Window

Use the Cleanup Master Forecast window if you need to remove information 
from the Master Forecast for specific dates and activities.

Warning! This feature deletes all data that was saved for the selected date 
range and activities. Genesys recommends that you do not use the 
Cleanup Master Forecast feature unless it is absolutely necessary. 
If you must remove Master Forecast data, Genesys recommends 
that you first extract the data to a forecast scenario (using the 
Publish Forecast Wizard), and/or make a backup of the WFM 
database (using the WFM Database Utility).

To remove Master Forecast information:

Table 1: Master Forecast Graph Options

 Statistic Selected Topic for the Corresponding Options 
Dialog Box

Interaction Volume Graph View Options (IV)

AHT Graph View Options (AHT)

Interaction Volume and AHT (not available in the 
Historical Data Graphs view)

Graph View Options (IV and AHT)

Required Staffing (not available in the Historical 
Data Graphs view)

Graph View Options (Staffing)

Calculated Staffing (not available in the Historical 
Data Graphs view)

Graph View Options (Staffing)

Calculated and Required Staffing (not available in 
the Historical Data Graphs view)

Graphs View Options (Staffing)
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1. In the Start date and End date pane, select the range of dates for which you 
want to remove data, using the standard date selectors.

2. From the Activities list, select the activities whose forecast information 
you want to remove.

You can expand business units to display their sites and you can expand 
sites to display their activities. You can select multiple activities across 
sites.

3. Click OK to remove the Master Forecast information that you have 
specified, or click Cancel to close the window without changing the 
Master Forecast.

Historical Data

Overview

You can open the following Historical Data views from Modules tree's 
Forecast branch:

Historical Data Volumes View—Displays interaction volumes for historical 
data that has either been imported into WFM or collected automatically by 
WFM Data Aggregator.

Historical Data Graphs View—Displays your choice of statistics, using line 
charts, for historical data that has either been imported into WFM or collected 
automatically by WFM Data Aggregator. 

Click a branch in the Modules tree to open the corresponding view. (Or use the 
Views toolbar's Scenarios drop-down list to move among these views.)

Historical Data Overview

You can open the following Historical Data views from Modules tree's 
Forecast branch:

Historical Data Volumes View—Displays interaction volumes for historical 
data that has either been imported into WFM or collected automatically by 
WFM Data Aggregator.

Historical Data Graphs View—Displays your choice of statistics, using line 
charts, for historical data that has either been imported into WFM or collected 
automatically by WFM Data Aggregator. 

Click a branch in the Modules tree to open the corresponding view. (Or use the 
Views toolbar's Scenarios drop-down list to move among these views.)
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Historical Data Volumes View

Use the Volumes view to display interaction volumes within imported or 
collected historical data. This view provides standard date-selection controls 
and a grid that shows statistics for days or timesteps. 

Figure 19: Historical Data Volumes View

The following sections cover:

• Displaying the Volumes view.

• Setting the grid properties and date range.

• Using the grid.

• Save and calculation options.

Displaying the Volumes View

To display the Volumes view:

1. In the Modules tree, click Historical Data Volumes.

The Volumes view appears.

2. In the Objects tree, select an activity.

Statistics populate the grid. 



116 Workforce Management 7.6

Chapter 4: Forecasting Historical Data

Setting the Grid Properties and Date Range

Use these options in the Grid properties and Date range panels (near the top) to 
customize the grid:

• The grid displays data for a period of a year, month, or week. To change 
the period, click Year, Month or Week from the Period drop-down list to 
change the time range shown on each row. 

• If you select Week, you can further adjust each row's time range by 
selecting a Granularity of 15, 30, or 60 minutes.

• Show, or hide, columns by selecting or clearing (respectively) the Volume, 
Volume %, and AHT check boxes.

• Use the standard date-selection controls to jump to a different week within 
the historical data's date range.

Using the Grid

The grid provides columns that display the following statistics:

Week/Time Step—Identifies the range of dates or timesteps on this row. (The 
column's label and contents depend on the date range and granularity that you 
selected above.)

[Days or Dates]—If you select the Month date range, each group of columns 
shows statistics for one full day.

If you select the Week date range, each group of columns indicates one date, 
the top row shows daily totals, and each lower row shows statistics for one 
timestep on that date. 

(Timestep durations depend on the granularity that you selected above.)

IV—Shows the interaction volume forecasted for each day or timestep.

IV%—Shows this row's percentage of the day's total interaction volume.

AHT—Shows the average handling time.

Weekly Totals—If you select the Month date range, these columns show 
weekly totals, or averages, for the IV, IV%, and AHT statistics.

Note: You can copy and paste data between the grid and a spreadsheet. 
Before doing so, clear the Volume % checkbox so the IV% column is 
hidden. 

To Edit the Weekly Totals

If you selected the period Year or Month, you can click inside the Weekly 
Totals cell and edit the value there. Daily values in the same row will 
automatically adjust their values so that the new Weekly Total is redistributed 
according to the original distribution of volume for each day of the week. This 
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is useful if you have a week in which you believe the volume will be increased, 
but you expect the volume to arrive at about the same rate as in your original 
forecast, day-over-day.

Save and Calculation Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

Save as template—Opens the Save as Template Wizard, where you can save 
historical data as a forecast template.

Note: When you save historical IV or AHT for a multi-site activity as a 
template, only multi-site activity data are saved, never the sum of 
underlying activities.

Use Multi-site Activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, business unit, or enterprise in the 
Objects tree.

Historical Data Graphs View

Use the Graphs view to display historical data in a line chart. An example view 
is shown below. Click a toolbar button on the image below to jump to its 
description. 
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Figure 20: Historical Data Graphs View

The following sections cover:

• Displaying the Graphs view.

• Setting the dates, statistics, and granularity.

• Reading the graph and legend.

• Calculation and filtering options.

Displaying the Graphs View

To display the Graphs view:

1. In the Modules tree, click Historical Data Graphs.

The Graphs view appears.

2. In the Objects tree, select an activity.

A default graph appears, which you can now customize.
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Setting the Dates, Statistics, Period, and Granularity

Use the Target Date, Show Statistics, Period, and Granularity controls (near the 
top) to customize the graph:

• Select a Start date within the imported or collected historical data's date 
range, using the standard date-selection controls.

• Use the Show Statistics drop-down list to select which statistic you want to 
graph: Interaction Volume or AHT (average handling time).

• Use the Period drop-down list to choose whether to view data for a Year, 
Month, Week, or Day.

• Use the Granularity drop-down list to select the time interval for the 
graph's horizontal axis: Monthly, Weekly, Daily, 60 min (minutes), 30 min, 
or 15 min. The choices that are available vary, depending on the period that 
you selected.

• Click the Options button on the Actions toolbar to further customize the 
graph.

Reading the Graph and Legend

The graph shows the statistics, dates, period, and granularity that you selected. 
The vertical axis indicates the units shown. When graphing multiple statistics, 
the right and left vertical axes display different units (where necessary) for the 
two statistics.

The Legend, at the bottom, identifies the colors that the graph uses to represent 
particular statistics, events, or historical data. The Legend changes depending 
on the statistics you select. Special events appear as markers on the graph.

Calculation and Filtering Options

You can use the following buttons on the Actions toolbar (these commands 
also appear in the Actions menu)

Use multi-site activities—Controls whether WFM Web's calculation of 
aggregated information includes multi-site activities. You can select this button 
only if you first select a multi-site activity, business unit, or enterprise in the 
Objects tree.

Options—Opens the Options dialog box, where you can select/de-select Show 
Values.

Options for Historical Data Graphs

Use the Options dialog box to customize the display of the Historical Data 
Graphs view:

1. Select a statistic from the Show Statistics drop-down list.
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2. Click Options on the toolbar. The Options dialog box opens.

3. Select or de-select Show Values. 

Based on your selection, WFM refreshes the Historical Data Graphics view.

Supervisors Help Options

You can use the forecast views to:

• Create forecast scenarios.

• View your scenarios and the Master Forecast.

• Evaluate volume and staffing estimates for your scenarios and the Master 
Forecast.

• Publish forecast scenarios to, and extract them from, the Master Forecast.

• Add or remove activities from a forecast scenario.

• Create, modify, and apply forecast templates.

About Forecasting

A forecast is a prediction of activity workloads for one or more sites, and 
consists of:

• Predicted customer-interaction volumes, which include information for 
phone calls, chat, e-mail, outbound calling, back-office work, and so on.

• Predicted average handling time (AHT).

• Staffing (workforce) requirements based on service objectives.

Workforce Management uses these predictions to build optimal schedules for 
real agents, or for a generic staff of profiles based on those agents. For links to 
major forecast help topics, see Creating and Working with Forecasts, below.

Creating and Working with Forecasts

1. The first step in creating a new forecast is to create a forecast scenario for 
one or more activities using the New Forecast Wizard. The Wizard General 
Parameters screen gives the option of creating a scenario with no forecast 
numbers (to be supplied later) or basing the scenario on a existing forecast.

2. If you created a scenario with no forecast numbers, open the Scenario 
Volumes View and use the Volume Build Wizard to build interaction 
volume and AHT forecasts for each activity. You can use various methods 
to build volume, including entering values, using historical data or 
templates.

3. Next, open the Scenario Staffing View and build a staffing forecast for 
each activity.
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4. After you create and evaluate your scenarios, publish the best scenario to 
the Workforce Management database. This scenario then becomes the 
Master Forecast. WFM Web builds schedules based on the data in the 
Master Forecast.

Using the Forecast Scenarios View

The Scenarios View enables you to open and work with existing scenarios. It 
also enables you to create, edit, or delete forecast scenarios, and to publish 
them to the Master Forecast.

• In the Modules tree, click Forecast > Scenarios to activate the Scenarios 
view.

Using Other Scenario Views

When you open a forecast scenario, the following views appear on the 
Modules tree for that scenario: Scenario Volumes View, Scenario Staffing 
View, and Scenario Graph View. 

• Click a view to open it. 

These view options appear on the Views toolbar's Scenarios drop-down list.

Opening additional scenarios adds their view options to these lists. This 
enables you to switch among views for several open scenarios.

• To remove a scenario's views from the displayed lists, close that scenario.

Using the Master Forecast Views

If you have access rights to the Master Forecast, then the Modules tree's 
Forecast branch always displays three Master Forecast views (regardless of 
your scenario selections): Master Forecast Volumes View, Master Forecast 
Staffing View, and Master Forecast Graphs View. 

• Click these views to open them.

Using Historical Data in Forecasts

In most cases, forecasts are based on historical data. You import historical data 
using the WFM Configuration Utility.

• If historical data for interaction volumes and average handling time (AHT) 
has been imported, you can create both interaction-volume forecasts and 
AHT forecasts simultaneously. 

• If historical data exists for interaction volume but not for AHT, first create 
the interaction-volume forecast using any of the forecasting methods. Then 
create the AHT forecast using a template. 
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If historical data exists for AHT but not for interaction volume, first create the 
interaction-volume forecast using templates. Then create the AHT forecast 
using any of the forecasting methods.
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5 Scheduling
This chapter covers the following topics:
 Overview, page 124
 Schedule Scenarios View, page 127
 New Schedule Scenario Wizard, page 131
 Scenario State Group Totals, page 163
 Schedule Filter Dialog Box, page 168
 Statuses Filter Dialog Box, page 168
 Options Dialog Boxes, page 169
 Sorting Dialog Box, page 171
 Swap Agent Schedules Wizard, page 172
 Review Swapping Messages, page 173
 Reviewing Messages, page 173
 Insert Multiple Wizard, page 173
 Delete Multiple Wizard, page 180
 Commit/Rollback Multiple Wizard, page 185
 Modify Individual Agents' Schedules, page 187
 Meeting Scheduler Wizard, page 203
 Master Schedule, page 203
 Schedule Bidding, page 230
 Schedule Build Wizard, page 238
 Intra-Day Schedule Rebuild Wizard, page 243
 Schedule Rebuild Wizard, page 251
 Publishing/Extracting Schedules, page 252
 Schedule Validation, page 255
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Overview
Before creating a schedule, you should:

1. Configure forecast scenarios.

2. Create, build and publish a staffing forecast for each activity you plan to 
schedule. 

Note:  A single forecast scenario can contain forecasts for multiple activities.

You can create a schedule before publishing a forecast, but many schedule 
functions (such as Coverage) will be unavailable.

Schedule Module

The Schedule module displays agent schedule information in a variety of 
tables and graphs. 

Use the Schedule views to:

• Create schedule scenarios, including profile scenarios, which can be used 
for Schedule Bidding.

• Build the Schedule.

• Publish schedule scenarios to, and extract them from, the Master Schedule.

• View weekly and daily schedules for your scenarios and the Master 
Schedule.

• Evaluate schedule coverage for your scenarios and the Master Schedule. 

• Revise schedules as circumstances require.

• Create, view, edit, remove, and commit pending schedule changes.

• Assign agents to profile schedules, if your scenario includes them.

Schedule Security

You may have full access to all parts of the Schedule module or you may have 
limited access, depending on the settings configured for your Security Role in 
the WFM Configuration Utility. 

If you do not have permission to access certain schedule functions, that 
functionality is disabled.

About Scheduling

The Schedule module helps you make the most efficient use of personnel, 
enabling you to adjust schedules in real time, as workload or agent availability 
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changes. The Schedule module builds optimal schedules based on real agents, 
incorporating their exceptions and preferences into the scheduling process. 

Workforce Management builds optimal schedules within a site’s business 
constraints. 

Constraints include:

• Available resources with required skills.

• Service-level requirements.

• Employment contracts and business policies.

• Agent preferences.

Profile Scheduling: Creating Schedules Without 
Agents

Profile scheduling enables you to model schedule outcomes without having 
actual agents.

You can create schedules based on user-defined profiles and then assign agents 
to the resulting schedules; or you can create schedules using a mix of real and 
profile agents. 

Use profile scheduling whenever you want to create a schedule before you 
actually hire agents.

1. Use the WFM Configuration Utility to define profiles, which consist of 
contract working rules and a skill set. 

2. Use the Schedule module to create schedules, using profiles appropriate to 
the work and to your anticipated hires.

3. Assign newly hired agents to the open slots in the profile schedules.

Note: You must assign real agents to profile schedule slots before you can 
publish those schedule slots to the Master Schedule.

Using the Schedule Scenarios View

The Scenarios view enables you to open existing scenarios and work with 
them. It also enables you to create, edit, or delete schedule scenarios, and to 
publish them to the Master Schedule.

To activate the Scenarios view:

• In the Modules tree, click Schedule > Scenarios.
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Using Other Scenario Views

When you open a scenario, the following views appear in the Modules tree for 
that scenario: Coverage view, Weekly view, Intra-Day view, Agent-Extended 
view, Profiles/Bidding view, and Summary view. 

To open a view:

• Click the view. 

The same view options appear on the Views toolbar's Scenarios drop-down list.

Opening additional scenarios adds their view options to these lists. You can 
switch among views for several open scenarios.

To remove a scenario's views from the displayed lists:

• Close that scenario.

Using the Master Schedule Views

If you have access rights to the Master Schedule, then the Modules tree's 
Schedule branch always displays five Master Schedule views (regardless of 
your Scenario selections): Master Schedule Coverage View, Master Schedule 
Weekly View, Master Schedule Intra-Day View, Master Schedule Agent-
Extended view, and Master Schedule Summary View. A sixth view, the Master 
Schedule Changes Approval view, will only be displayed if you have the 
permission to Approve Changes in WFM Configuration Utility.

To open these Master Schedule views:

• Click the view.

Pending Schedule Changes

If you do not have security permission to Approve Changes, any edits you 
make to a schedule scenario or the Master Schedule are entered as pending. 
That is, they are visible only to you and do not appear in the publicly-visible 
version of the schedule scenario or the Master Schedule until a user who has 
the Approve Master Schedule Changes permission reviews and approves them.

• If you publish a schedule scenario to the Master Schedule, pending 
changes are not published.

• If you extract data from the Master Schedule to a scenario, the pending 
changes do not appear in the scenario. 

Approving Pending Changes

There are a number of ways to view and approve or reject pending schedule 
changes. If the pending changes were created by another user, you can use:

• The Master Schedule Changes Approval view.

If the pending changes were made by you, then you can use:
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• The Master Schedule Changes Approval view.

• The Commit/Rollback Multiple Wizard.

• The Commit and Rollback commands from the shortcut menus in the 
Schedule Scenario Intra-Day view and Master Schedule Intra-Day view.

• The auto-commit feature in the Insert Multiple Wizard and the Delete 
Multiple Wizard.

Schedule Scenarios View
Use the Schedule Scenarios View to create a new scenario or open an existing 
schedule scenario. The figure below shows an example.

Figure 21: Schedule Scenarios View

You can select the following views in the Modules tree for an open scenario:

Scenario Coverage View—Compares staffing coverage to forecasted 
(calculated and required) staffing data, and highlights overstaffed or 
understaffed timesteps.

Scenario Weekly View—Displays a weekly summary table of total paid 
hours, working start/end times, or shift names for a site's agents and/or 
profiles. 

Scenario Intra-Day View—Displays schedule details for a 24- or 36-hour 
period, enabling you to modify schedules for individual or multiple agents.

Note: You do not need the Approve Changes security permission (as required 
by the Master Schedule) to commit your changes (which are only 
visible to you). You can roll back or remove your own pending 
changes. 

You can view your pending changes in the Coverage, Weekly, and Intra-Day 
views.
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Scenario Agent-Extended View—Displays schedules for one week or the 
schedule planning period for a single agent.

Scenario Profiles/Bidding View—Enables you to assign real agents to profile 
schedule slots.

Scenario Summary View—Displays service-level and related statistics for the 
scenario.

Scenario State Group Totals—Presents Schedule Group Totals for Schedule 
Groups configured.

To open a view, click a branch in the Modules tree. (Or use the Views toolbar's 
Scenarios drop-down list to move among these views.)

If you open other scenarios, their views also appear in Modules tree and in the 
Scenarios drop-down list. 

To remove a scenario's views from these controls:

• Close that scenario.

Schedule Scenarios View

Use the Scenarios view to open and work with existing schedule scenarios. 
This view enables you to create, edit, or delete schedule scenarios, and to 
publish scenarios to the Master Schedule. 

The following sections cover:

• Displaying the Scenarios view.

• Reading the Scenarios table.

• Editing a scenario.

• Creating and managing scenarios.

• Scenario properties—The Data tab.

• Scenario properties—The Statuses tab.

Displaying the Scenarios View

To activate the Scenarios view:

• In the Modules tree, click Schedule > Scenarios.

Selecting Objects

When the Scenarios view is active, the Objects tree displays existing schedule 
scenarios in a hierarchical list. You can expand the All Scenarios node to 
display the following options:

My Scenarios—Displays scenarios that you have created.

Shared Scenarios—Displays shared scenarios created by other users. Visible 
only if you have the permission Access Shared Scenarios. See the 
Configuration Utility help topic, Schedule Security Options.
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Other Scenarios—Displays (if you have appropriate access rights) unshared 
scenarios created by other users.

You can select All Scenarios or a lower-level option. 

To select an option:

• Click the option. Your selection retrieves the matching scenarios and insets 
them into the Scenarios table.

Reading the Scenarios Table

The Scenarios table appears at the upper right of the WFM Web for 
Supervisors window. Its rows display scenarios that match your selection in 
the Objects tree. The columns (sortable except for Comments) display the 
following information for each scenario:

Name—The scenario's name.

Start date, End date—The start and end dates for the schedule in this 
scenario. Range: from 1 to 6 weeks.

Extended End date—Specifies the time period from the currently-published 
Forecast that will be used to calculate the average staffing needs for this 
schedule. For example: the schedule itself covers only the time period between 
Start date and End date, but the Forecast data used to calculate staffing needs 
for the schedule is based on the time period between Start date and Extended 
End date. 

Note: It's okay if the Forecast data covers a shorter period of time than 
Extended End Date defines.

Owner—The name of the user who created the scenario.

Shared—A check mark indicates a shared scenario; an open box indicates one 
that is not shared.

Comments—Remarks entered by a user who created or edited the scenario.

To populate the Scenario Properties pane with the scenario's details:

• Click a row in the Scenarios table. 

Editing a Scenario

To edit a scenario:

• Double-click the scenario in the Scenarios table. Or click its row in the 
Scenarios table, and then click Open. 

The controls described below are available to you if you own, or have access 
rights to, the scenario.
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Creating and Managing Scenarios

You can use the following buttons on the toolbar (these same commands also 
appear on the Actions menu):

New—Opens the New Schedule Scenario Wizard.

Open—Opens the selected scenario from the Scenarios table. You can then 
edit its properties using the Data tab.

Close—Closes the open scenario (and prompts you to save unsaved data).

Publish—Opens the Publish Schedule Wizard for transferring forecast 
information between the selected scenario and the Master Forecast.

Delete—Deletes the selected scenario.

Mark as Shared, Mark as Not Shared—Changes the sharing status of the 
selected scenario.

Filter—Displays the Statuses Filters dialog box, which you can use to control 
which Statuses are displayed. These Statuses are described below.

Sort—Opens the Sorting dialog box, which allows sorting by Team Name, 
Contract, Agent Name (first or last), or Agent Rank. You can sort in ascending 
or descending order. Note that Agent Rank sorts in apparent reverse order due 
to limitations imposed by multi-sorting by both agent name and rank.

Scenario Properties—Data Tab

To display the following controls:

• Click the Data tab on the Scenario Properties pane at the lower right.

Name—Enables you to edit the scenario's name.

Start date, End date—Displays the scenario's start and end dates.

Extended End date—Specifies an extended end date for a bidding scenario, to 
specify that the schedule you are building will apply by repeating over a longer 
range of time.

Owner—Displays the name of the scenario's creator.

Created, Modified—Displays the scenario's original creation date and last 
modification date.

Shared—A check mark indicates a shared scenario; an open box indicates one 
that is not shared.

Comments—Enables you to enter or edit comments about the scenario.

Save—Click this button to save your changes to the scenario's name and/or 
comments.

Cancel—Click this button to cancel your changes, restoring the scenario's 
previous name and/or comments.
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Scenario Properties—Statuses Tab

To display a table with the following information, click the Statuses tab on the 
Scenario Properties pane at the lower right. This table's columns are:

Site—Displays the sites covered by this scenario.

Status—See the Status Column Values table below for all possible values and 
their definitions.

Bidding Start—Bidding start date for this scenario, defined in Control 
Bidding Process wizard. (Exclusive to bidding scenarios). 

Bidding End—Bidding end date for this scenario, defined in Control Bidding 
Process wizard. (Exclusive to bidding scenarios). 

Ranking Used—Ranking system used for this scenario, defined in Auto-
Assign Schedules dialog. (Exclusive to bidding scenarios). 

Last Published—Date and Time that this scenario was last published to the 
Master Schedule

Status Column Values

This table defines each possible value that may appear in the Status column. 

New—This scenario was just created and has no schedule built for it.

Imported—This scenario was imported from the Master Schedule.

Scheduled—A schedule was built for this scenario.

Scheduled with Profiles—A schedule containing profile agent schedules was 
built for this scenario.

Profiles Assigned—A schedule containing profile agent schedules was built 
for this scenario, and every profile agent schedule has an actual agent assigned.

Published—This scenario was published to the Master Schedule.

Bidding Pending Scenario—This scenario has a bidding window and agents 
defined, but the current date is before the bidding window's start date. 
(Exclusive to bidding scenarios). 

Open for Bidding—This scenario is currently open for bidding (exclusive to 
bidding scenarios). 

Bidding Closed—This scenario is closed for bidding. (Exclusive to bidding 
scenarios). 

New Schedule Scenario Wizard

Overview

Use the New Schedule Scenario Wizard to create a new schedule scenario:
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1. On the Schedule Scenarios view toolbar, click the New button.

The first of the New Schedule Scenario Wizard's screens, General 
Parameters, opens.

2. Fill in the necessary information on each screen, and then click Next.

Clicking Help on any screen opens a Help page that explains that screen's 
options.

Clicking Previous returns you to the previous screen, if you need to revise 
your entries there.

3. Click Finish.

The scenario is created. In the Schedule Scenarios view, you can now select 
My Scenarios to load the scenario into the Scenarios table.

General Parameters

To fill in the first New Schedule Scenario Wizard screen, General Parameters:

1. In the Name text box, enter a name for the schedule scenario.

2. If you want this scenario to be available to other WFM users, select the 
Shared check box. 

3. If you want to base this scenario on one that already exists, select the 
existing scenario from the Based on drop-down list.

Basing your new scenario on an existing scenario is a convenient way to 
build schedules with frequently used settings. The wizard takes the dates, 
activities, and agents (real, virtual, and profile) from the source scenario 
and applies them to the new scenario. You can then change these 
parameters.

4. In the Start Date field, enter the scenario's start date.

You can type directly into the field, use the up or down arrow to modify 
the displayed date, or click the button at the right to display a calendar.

Note: If the WeekStartDay setting has been specified in the WFM 
Configuration Utility, your scenario's starting weekday must match 
this setting. Otherwise, your scenario starts on the first weekday as 
determined by your operating system's regional settings.

5. In the End Date field, enter the scenario's end date. The maximum time 
between Start date and End Date is 42 days (6 weeks).
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Note: You must build the scenario in units of one week. For example, if 
the schedule starts on a Monday, it must end on a Sunday. 
Schedules must be at least one week, and no more than six weeks, 
long. WFM Web always obeys schedule period constraints, if you 
are using a scheduling period for your site, regardless of the 
number of weeks in the scenario.

6. In the Extended End Date field, enter the scenario's extended end date, if 
necessary.

Default value: the scenario’s end date. This value is useful when you create 
a schedule scenario for bidding. (Use the Profiles/Bidding view to 
configure bidding.) Edit this value manually to specify an extended end 
date for the scenario; to specify that the schedule will apply over a longer 
period of time (maximum: 6 months).

For example, Extended End Date could define an entire quarter—3 
months. Start Date and End Date could define a period of 1 week that 
Agents actually use for bidding. When the schedule scenario is published 
to the Master Schedule, the 1-week schedule would be repeated for the 
entire quarter. 

Note: You can also use this value to extend a non-bidding schedule for 
real agents in the same way: create a 1-6 week schedule that 
repeats itself over a longer period of time. When you publish this 
schedule scenario out into the future, you can optionally ask WFM 
to overlay items from the Calendar, such as days off, time off, and 
exceptions.

7. Click Next to proceed to the next screen.

Select Activity

To fill in the second New Schedule Scenario Wizard screen, Select Activity:

1. Select all activities that you want to include in this schedule.

In the Activities list, you can expand business units to display their sites 
and expand sites to display their activities. You can select any number of 
activities.

If you selected an existing scenario from the General Parameters screen's 
Based On drop-down list, the Activities list shows only those activities that 
were pre-selected in the source scenario.

Note: You can add activities later, but you can add them only for the sites 
that you select now, on this screen.

2. Click Next to proceed to the next screen.
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Select Agents

To fill in the third New Schedule Scenario Wizard screen, Select Agents:

1. Select the agents that you want to include in the scenario.

In the Agents list, you can expand Business Units to display their sites and 
expand sites to display their agents. The list shows only those agents who 
have the skills that are required for the activities you selected on the Select 
Activity screen.

2. For each selected agent, select Real or Profile.

Selecting one of these check boxes clears the other check box.

A profile agent inherits the contract and skill set of the selected real agent, 
but the profile agent's schedule slot is not assigned to this (or any other) 
real agent. One reason to use profile agents is when you create a bidding 
scenario. See the topic Configure Scheduling Scenario in the Schedule 
Bidding section.

If agents in General Parameters screen's Based On scenario were Real, 
then Real check box is pre-selected for them; if Profile agents, then the 
Profile check box is pre-selected.

3. If you want to fill the new scenario with the schedules from the source 
(Based on) scenario, select the Copy Schedules check box. 

4. To insert a granted exception, time off or day off item from the calendar, 
select the Insert granted exception, time off and day off calendar items 
check box. You can insert multiple items.

This check box is enabled only if the following conditions are met:
 The scenario you are creating is based on an existing scenario.
 The Copy Schedules check box is selected.

5. To have WFM place profile agents (which are based on real agents) into 
the same team as real agents, select the Place profile agents, based on 
real agents, into their teams check box.

6. Click Next to proceed to the next screen.

About Scheduling with Profiles

Profile agents are “generic” agents that you create by omitting preferences and 
exceptions. You can create schedule scenarios using a mix of real agents and 
profiles. 

You can also create schedule scenarios based on user-defined profiles, and then 
assign agents to the resulting schedules. See Scenario Profiles View for 
instructions.

When you use profiles, you generate a schedule scenario that includes open 
schedules. An open schedule is one that has no agents assigned to it. You can 
then insert agents into the open schedules using any criteria. (WFM 
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automatically filters the list of qualified agents, based on the selected 
schedule.)

Select Profile

To fill in the final New Schedule Scenario Wizard screen, Select Profile:

1. Expand and/or scroll through the Profiles list to select the number of each 
type of Contract profile that you want to include in this scenario.

You can expand business units to display their sites and expand sites to 
display their profiles. The list shows only those profiles that have the skills 
that are required for the activities you selected on the Select Activity 
screen.

2. Modify (if necessary) the number of occurrences each profile that should 
be included in the scenario.

3. Click Finish.

This saves your new scenario and restores the Schedule Scenarios view.

Select Profile vs. Select Agents

Here is the difference between the profiles on this screen, and the profiles on 
the previous screen. 

On the previous Select Agents screen, you have the opportunity to select 
“profile agents.” This will result in the schedule scenario including open 
schedules based on hypothetical agents that are similar in skill set and Contract 
to the agents whose profile you select. 

On the Select Profile screen, you are selecting profiles. A profile is based on a 
Contract, and is defined by a set of one or more skills and skill levels that are 
required for an agent to fit this profile. When creating a schedule, you may 
include any combination of real agents, profile agents, and profiles.

Scenario Coverage View

Use the Scenario Coverage view to compare a schedule's staffing coverage 
with the forecast (calculated and required) staffing data. The figure below 
shows an example Scenario coverage view when the Chart Type is Required. 
Graphs and tables show you coverage for each weekday in the selected week, 
along with totals for the whole week and scenario. Overstaffed and 
understaffed timesteps appear in a distinctive color.

The following sections cover:

• Displaying the Scenario Coverage view.

• Using the Daily graphs and tables.

• Reading the Totals table.
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• Customizing the Scenario Coverage view.

• How understaffing and overstaffing are calculated.

Displaying the Scenario Coverage View

To display the Scenario Coverage view:

1. In the Schedule Scenarios view, open a scenario. 

2. In the Modules tree, click [Scenario-name] Coverage.

3. In the Objects tree, you can select business units (if any are listed), multi-
site activities, sites, activity groups, or activities.

You can select a single business unit, a single site or a single multi-site activity 
within a business unit, a single activity group or a single activity within a site.

Using the Daily Graphs and Tables

The Coverage view displays the following information for days of the week: 

Graphs—Display coverage information for each day, with a data point for 
each timestep. Select from the Chart Type dropdown menu to display 
calculated staffing, required staffing, or both (advanced). A blank graph 
indicates a closed site (or no scheduled activity) for the day.

Tables—Display overstaffing and understaffing totals for each day, with 
respect to calculated and/or required staffing. Contractual constraints and other 
configured parameters can reduce a schedule's optimization.

Legend—Explains the significance of each color used in the graphs.

Reading the Totals Table

The Totals table (at the lower right) displays overstaffing and understaffing 
totals for the selected week and for the whole schedule scenario, with respect 
to calculated and/or required staffing.

Customizing the Scenario Coverage View

Use the following controls (at top of the working pane) to customize the 
schedule coverage data: 

Chart Type

Select the type of graphs that you want to be displayed: 

Advanced—Graphs present both calculated and required information. 
Calculated information appears as an area graph with 
overstaffing/understaffing data, and required staffing appears as a linear graph.
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Calculated—Graphs present calculated information with 
overstaffing/understaffing data.

Required—Graphs present required information with 
overstaffing/understaffing data.

Date

Use the standard date-selection controls to move to other weeks within the 
scenario's date range.

Toolbar Buttons

Use the buttons on the toolbar (these commands also appear in the Actions 
menu) for the following: 

Add/Remove scenario elements—Opens the Add/Remove Scenario Elements 
Wizard, where you can add activities, and add or remove agents, for the current 
schedule scenario.

Build schedule—Opens the Schedule Build Wizard, which builds a complete 
schedule for the selected site.

Rebuild schedule—Opens the Schedule Rebuild Wizard, where you can 
modify and rebuild schedules, while optionally leaving intact any agent 
schedules that you have edited since the last build/rebuild.

Validate schedule—Opens the Review Messages window, which lists 
scheduling warnings for a selected site. Warnings will only be visible if you 
have built a schedule for this scenario and you saved any warnings that were 
generated.

Close—Closes the open scenario (and prompts you to save unsaved data).

How Understaffing and Overstaffing Are Calculated

Any timestep can be subject to either understaffing or overstaffing. WFM 
calculates these conditions by evaluating Coverage against Forecast.

Understaffing = The Forecast is greater than the Coverage — there are too few 
agents on duty.
Overstaffing = The Forecast is less than the Coverage — there are too many 
agents on duty. 

Note: Coverage is an estimate of the agents’ contributions to the presented 
activities, and is displayed in the time format (hh:mm). These 
contributions are based on the agents' scheduled activities for each time 
interval, and on any schedule items that affect these scheduled 
activities for an interval (such as a break that occurs during only part of 
an interval).
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Totals are calculated by summing Understaffing/Overstaffing for all activities 
for a given time range (because each single Understaffing/Overstaffing value is 
for one timestep).

Scenario Weekly View

Use the Scenario Weekly view to display a summary table of total paid hours, 
working start/end times, or shift names. The table shows this information for a 
selected scenario, and for selected agents and/or profiles within a single site. 
The figure below shows the view after selecting a specific team in the Objects 
tree. 

Note: The Scenario Weekly view also enables you to see summary tables of 
total paid hours, working start/end times, or shift names for your 
schedule planning period. See Mode for details.

The following sections cover:

• Displaying the Scenario Weekly view.

• Using the table.

• Customizing the Scenario Weekly view.

• Modifying the schedule.

Displaying the Scenario Weekly View

To display the Scenario Weekly view:

1. In the Schedule Scenarios view, open a scenario.

2. In the Modules tree, click [Scenario-name] Weekly.

3. In the Objects tree, select a site, teams, and/or agents.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can work with only one site at a time, 
but you can select any number of agents and/or teams within that site.

If profile agents were created for this site during schedule building, these 
profiles appear within a Profiles team.

4. Click Get data to populate the Weekly view table for the selected agents. 

Using the Table

The Weekly view table contains rows for each agent or profile that you 
selected in the Objects tree. (If a scroll bar is displayed to the right, you can use 
it to reveal more agents.) 

This table includes the following columns:
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[Expand/Collapse]—If in Planning Period mode, the first column provides 
expand/collapse controls that you use to display or hide each agent's or 
profile's weekly schedule details.

Team—This column lists each agent's or profile's team.

Agent—Two columns show an icon representing this agent's or profile's 
contract, and then the agent's or profile's name.

[Week Start Dates]—In Planning Period mode, when you display agent 
details, the rows below each agent's or profile's name indicate the start date for 
each week in the scenario.

[Weekdays]—These cells show agent schedule information for each weekday, 
for each week in the scenario. The cells' contents correspond to your selection 
from the Show Data for drop-down list.

If the agent is not scheduled for a shift, the cell contains Day Off, the name of a 
a full-day time-off type, Working Hours (for scheduled working hours without 
a shift), or an exception name (for scheduled full-day exceptions).

An icon in the cell for a weekday indicates whether the schedule has been 
changed for that agent. 

• If the agent's schedule for that day was assigned during scheduling or 
rescheduling, no icon appears. 

• If the agent's day was edited after scheduling or rescheduling, a light-gray 
pencil icon appears.

• If the agent's day was assigned by trading or swapping, the swap icon 
appears.

• A Yield icon (upside down red triangle) appears if there are pending 
changes that have not yet been committed to the scenario. 

Note: If there have been multiple changes, the icon represents the most recent 
status.

Weekly Totals—Shows each agent's or profile's total paid hours for the 
displayed week.

Long (Planning) Period Totals—Shows each agent's or profile's total paid 
hours for the schedule planning period. This period's duration and start date are 
set in the WFM Configuration Utility's Policies > Contracts > Contracts 
General tab.

The Weekly Totals and Period Totals boxes below the table show a grand total 
of the paid hours for all selected agents for the weekly or planning period, 
respectively.
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Note: If the WeekStartDay setting has been specified in the WFM 
Configuration Utility, the first weekday is the one specified in 
WeekStartDay. Otherwise, the first weekday is the one specified in 
your operating system's regional settings.

Customizing the Scenario Weekly View

To customize the displayed table, use these controls at the top of the working 
pane:

Show Data for

From this drop-down list, select what you want to be displayed inside each 
day's table cell:

Total Paid Hours—Total paid time for the day.

Working Start/End Time—Start and end times of agents' work.

Shift Names—Names of agents' assigned shifts.

Mode

Select 1 Week or Planning Period from the Mode drop-down list. The table 
displays data for the selected period. The Planning Period option is disabled if 
no schedule planning period was configured in the WFM Configuration Utility. 

The Scenario
Planning Period

Mode 

The Scenario Planning Period mode displays schedules for the entire planning 
period, even if the scenario range is shorter than the number of weeks in your 
planning period or if the scenario's date range falls on the boundary between 
two different planning periods.

In these cases, different shades of white and gray indicate the type of date 
range that you are viewing.

Planning Period Color Legend

• White—Indicates dates that fall within both the scenario period and the 
planning period.

• Light Gray—Indicates dates that fall within the scenario period but are 
outside the planning period.

• Gray—Indicates dates that fall outside the scenario period but are within 
the planning period.

• Dark Gray—Indicates dates that are outside both the scenario and the 
planning period.
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Filter and Sort the Schedule Data

You can use the following buttons on the Actions toolbar (these commands 
also appear in the Actions menu) to further customize the displayed table:

Options—Opens the Options dialog box. Enables you to customize the view 
by including the Agent Rank column.

Filter—Enables you to filter the displayed information by activities and 
contract types. (If you set a new filter, this immediately refreshes the view.)

Sort—Opens the Sorting dialog box, which allows sorting by name, owner, 
sharing, time of creation, time of last modification, scenario start date, or 
scenario end date. You can sort in ascending or descending order.

Searching for an Agent

To find a specific agent in the Scenario Weekly view:

1. To search the table for particular agents, select Find from the Edit menu or 
press Ctrl + F. 

The Find Agents dialog box opens. You can search by first or last name. 

2. Enter part or all of the agent's name, and then click OK. 

The Weekly view display shifts to display the table row for the selected agent.

Toolbar: Modifying the Schedule

You can use the following buttons on the Actions toolbar (or on the Actions 
menu) to modify the displayed schedule scenario:

Add/Remove schedule elements—Opens the Add/Remove Schedule 
Elements Wizard, where you can add activities, and add or remove agents, for 
the current schedule scenario.

Build schedule—Opens the Schedule Build Wizard, which builds a complete 
schedule for the selected site.

Rebuild schedule—Opens the Schedule Rebuild Wizard, where you can 
modify and rebuild schedules, while optionally leaving intact any agent 
schedules that you have edited since the last build/rebuild.

Re-build intra-day schedule—Opens the “Intra-Day Schedule Rebuild 
Wizard” on page 243 to rebuild an Intra-Day schedule for a specific day or 
time period for a site, team, or agent. 

Validate schedule—Opens the Review Messages window, which lists 
scheduling warnings for a selected site. Warnings will only be visible if you 
have built a schedule for this scenario already, and you chose to save any 
warnings that were generated.

Close—Closes the open scenario (and prompts you to save unsaved data).

Options—Opens the Options dialog box. Enables you to select/de-select the 
Agent Rank column.
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Filter—Opens the Filter dialog box. Enables you to filter the displayed 
information according to activities and contract types. (If you set a new filter, 
this immediately refreshes the view.)

Sort—Opens the Sorting dialog box, which allows sorting by Team Name, 
Contract, Agent Name (first or last), or Agent Rank. You can sort in ascending 
or descending order. Note that Agent Rank sorts in apparent reverse order due 
to limitations imposed by multi-sorting by both agent name and rank.

Swap—Opens the Swap Agent Schedules Wizard, which enables you to swap 
two agents' schedules.

Insert Multiple—Opens the Insert Multiple Wizard, which enables you to add 
multiple items to the scenario at one time.

Delete Multiple—Opens the Delete Multiple wizard, which enables you to 
remove multiple items from the scenario at one time.

Commit/Rollback Multiple—Opens the Commit/Rollback Multiple Wizard, 
which enables you to insert pending changes into the schedule scenario or to 
remove them and return the scenario to its former settings.

Meeting Scheduler—Opens the Meeting Scheduler, which enables you to 
schedule meetings to already build scenario for selected agents.

Scenario Intra-Day View 

Use the Intra-Day view to manage schedule details for agents and profiles, for 
a selected scenario on a specific day.

If you selected the Show Performance Information check box on the 
Performance tab of the Options dialog box, this window also shows 
performance data in a graph. If you have cleared the Full View check box, data 
is also shown in a table. 

You can modify schedule items for individual agents or profiles here, and you 
can insert schedule items for multiple agents and/or profiles. 
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Figure 22: Schedule Intra-Day View

Displaying the Intra-Day View

To display the Intra-Day view:

1. In the Schedule Scenarios view, open a scenario.

2. In the Modules tree, click [Scenario-name] Intra-Day.

The Scenario Intra-Day view appears.

3. In the Objects tree, select a site, teams, and/or agents.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can work with only one site at a time, 
but you can select any number of agents and/or teams within that site.

4. Open the Select Target window and select a Performance Data Target.

By default no performance target is selected for the Intra-day schedule 
view, and performance data cannot be displayed without one selected. See 
Performance Data Target.

5. Click Get data to display the Intra-Day performance graph (if you have 
opted to view it) and the schedule grid.

Using the Grid

The Intra-Day view includes a grid with one row per agent, and the following 
fields and controls. You can sort by team, agent, contract, start time, paid 
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hours, overtime, shift start time, and total hours, by clicking on the header for 
that column.

Full View—Select the Full View check box to have the intraday grid display 
the entire day. If you clear this check box, the grid shows a more detailed view. 

Options—Enables you to customize the view by selecting options that cover 
agent availability, 24-hour or 36-hour display, marked time, performance data, 
and whether to display or hide the Overtime, Paid Hours, Total Hours, Start 
Time, and Comment columns. For more information, see the Options Dialog 
Box topic.

Scheduled agents—This indicator shows the number of agents displayed 
(based on your selection in the Objects tree).

Edited schedules—This indicator shows the number of agents whose 
schedules you have edited in this view, but not yet saved.

Date—These controls are standard date selectors.

! (Save Messages/Warnings)—This column contains icons that provide 
information about the agents' schedules. 

• A green pencil icon indicates schedule items that you have changed but not 
yet saved. 

• A red pencil icon indicates an item that generated an error. (Error 
conditions are more serious than warning conditions.) 

• A light-gray pencil icon indicates that the agent's day was edited after 
scheduling or rescheduling.

• A swap icon indicates that the agent's day was assigned by trading or 
swapping.

• A yellow icon indicates an item that generated a warning and you chose 
the Fix Later option.

• A Yield icon (upside down red triangle) appears if there are pending 
changes not yet committed to the scenario. 

• An agent icon and red check box appear for every schedule day that 
contains a granted calendar item (if the option Show agents with granted 
and scheduled rotating pattern or any other calendar preference is selected 
in the Options dialog box).

Double-click a yellow or red icon to review message details and resolve the 
unsaved items.

Team—This column indicates each agent's assigned team.

Agent—This column indicates each agent's name.

Overtime—If displayed (using the Options dialog box), this column shows the 
duration of overtime for each agent on the selected day.

Paid Hours—If displayed (using the Options dialog box), this column shows 
each agent's paid hours for the selected day.
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Total Hours—If displayed (using the Options dialog box), this column shows 
each agent's total hours for the selected day.

Start Time—If displayed (using the Options dialog box), this column shows 
each agent's start time for the selected day's work.

* (Comment)—If this column is displayed (using the Options dialog box), an 
asterisk (*) indicates that a comment was saved for the indicated agent and 
schedule day.

Double-click a column cell to view or edit comments.

[Timesteps]—These columns indicate the agent's schedule items in each 
timestep. To see greater detail, clear the Full View check box and/or resize the 
columns. 

Figure 23: Timestep shortcut menu

To make changes to one agent's schedule at a time, right-click the timestep that 
you want to modify and then select the command from the shortcut menu. See 
Modify Individual Agent's Schedules for instructions and explanations.

[Horizontal scroll bar]—Appears below the table when clearing the Full 
View check box causes some timesteps to be hidden offscreen. Scroll it to the 
right to display later timesteps.

Legend—Indicates the particular type of schedule item that each bar color 
represents.

Details—When you click an agent's row, this field lists the agent's scheduled 
activities on the selected day. It displays only what fits in one line: additional 
information does not appear.
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Customizing the Grid

You can display more timesteps by resizing some columns to the left of the 
table. For details, see the Getting Started Overview.

Search for an Agent

To find a specific agent in the Scenario Intra-Day view:

1. You can search the table for particular agents by using the Find Agent 
dialog box. To open it, select Find from the Edit menu or press [Ctrl] + F. 

The Find Agent dialog box opens. You can search by first or last name. 

2. Enter part or all of the agent's name and then click OK. 

The Intra-Day view display shifts to display the table row for the selected 
agent.

Toolbar: Modifying Multiple Agents' Schedules

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu) to modify multiple agents' schedules at once, to further 
customize the displayed table, or to modify the selected scenario:

Auto-Commit—This button toggles on and off the auto-commit feature. If it is 
on, changes are immediately applied to the scenario. If it is off, the changes 
have pending status and can be committed/approved before they are 
incorporated in the publicly-available version of the schedule scenario.

Add/Remove scenario elements—Opens the Add/Remove Scenario Elements 
Wizard, where you can add or remove activities and agents for the current 
schedule scenario.

Build schedule—Opens the Schedule Build Wizard, where you can build a 
complete schedule for the selected site.

Rebuild schedule—Opens the Schedule Rebuild Wizard, where you can 
rebuild agent schedules, while optionally leaving intact any agent schedules 
that you have modified since the last build/rebuild.

Rebuild intra-day schedule—Opens the “Intra-Day Schedule Rebuild 
Wizard” on page 243 to rebuild an Intra-Day schedule for a specific day or 
time period for a site, team, or agent.

Validate schedule—Opens the Review Messages window, which lists 
schedule warnings that the server returns for a selected site.

Close—Closes the open scenario (and prompts you to save unsaved data).

Options—Opens the Options dialog box. Enables you to customize the view, 
including whether to show agent availability, whether to use a 24-hour or 36-
hour display, whether to display performance data, and whether to display or 
hide the Overtime, Paid Hours, Total Hours, Start Time, and Comment 
columns.

Filter—Enables you to filter the displayed schedule information.
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Sort—Enables you to sort the table.

Swap—Enables you to swap two agents' schedules.

Insert Multiple—Opens the Insert Multiple Wizard, which enables you to 
insert breaks, meals, exceptions, days off, or vacation days for multiple agents 
or teams.

Delete Multiple—Opens the Delete Multiple Wizard, which enables you to 
remove multiple items from the scenario at one time.

Commit/Rollback Multiple—Opens the Commit/Rollback Multiple Wizard, 
which enables you to insert pending changes (changes entered when auto-
commit was off) into the schedule scenario or to remove them and return the 
scenario to its former settings.

Save—Saves any changes that you have made to the current scenario. (If the 
server cannot save all changes, red or yellow icons in the grid's first column 
indicate the agents for whom you must correct errors or acknowledge 
warnings.

Meeting Scheduler—Opens the Meeting Scheduler, which enables you to 
schedule meetings to already build scenario for selected agents.

To make detailed scheduled changes for one agent at a time (such as inserting, 
editing, or deleting the agent's schedule items), see Modifying Individual 
Agents' Schedules.

If you make schedule changes in the Intra-Day view and do not click Save, you 
are prompted to save your changes when you select a different module or view, 
or when you launch certain wizards or child windows.

The Performance Data Display

Selecting the Show Performance Data check box on the Performance tab of the 
Options dialog box adds a chart and a table to the Scenario Intra-Day display.

Note: The table appears only if you clear the Full View check box.

To configure the performance data views:

1. Select a target for the performance data by clicking the ellipsis (...) button 
next to the Target: label. The list that appears contains both the activities 
associated with the site selected on the Objects pane and the multi-site 
activities associated with the current scenario. If no site is selected, the list 
contains only multi-site activities.

2. Select the granularity in which performance data should be presented: 15, 
30, or 60 minutes. 

3. Select the type of data to be displayed in the graph and table.
 Schedule coverage appears as a red line on the graph. To configure the 

graph, select a value from the Chart Type drop-down list: Calculated 
(appears on the graph in blue), Required (appears on the graph in 
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yellow), or Advanced (both Calculated and Required; appears on the 
graph as a blue area for the calculated staffing and as a yellow line 
showing the required staffing). By default, the graph shows Calculated 
staffing.

 The table always displays values for schedule coverage and calculated 
staffing. It may show additional figures, depending on your selections 
on the Performance tab of the Options dialog box. 

If you are not using automatic updates, click the Refresh Performance Data 
button to update the performance data view. You can select Update 
Automatically on the Performance tab of the Options dialog box. 

The label Multi-Skill Enabled appears on the right end of the Performance 
Data Display if you enabled the SplitMS option in Configuration Manager. See 
the “Enabling Multi-Skill Support” section in the current Workforce 
Management Administrator's Guide. 

Performance Data Target

To view performance data in the Master Schedule or Schedule Scenario Intra-
Day view, you must choose a target. The target is the source of the 
performance data. You can select the Enterprise, a business unit, a site, an 
activity group, or an activity (either multi-site or single-site).

To open the Select Target window:

• Click Target... on the Schedule Intra-Day view window.

Note: This option is available only if you have chosen to view performance 
data by selecting the Show Performance Information check box on the 
Performance tab of the View Options dialog box.

Your Site Selection Determines the Local Time Zone

When you select a site in the object pane (for example, San Francisco), you are 
also specifying the local time that is applied to the grid and graphs that you 
view when you request performance data. In this example, schedules and 
whatever you select to view would be displayed in San Francisco's Pacific time 
zone, regardless of the data source's local hours (WFM makes the appropriate 
time conversion). 

Viewing Multi-Site Activity Data

Select the Use Multi-site Activities check box to display forecast data that is 
taken from multi-site activities (MSAs), and schedule data that is the 
sum/average of Activities under your selected target (MSA, business unit, or 
site). All data is transposed to the time zone of the site that you selected in the 
Object pane.
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Clear the Use Multi-site Activities check box to display all MSA data as a 
sum/average. All data is transposed to the selected site's time zone.

Edit Comments Dialog Box

Use the Edit Comments dialog box to enter or view comments about an agent's 
schedule for the selected day in the Scenario Intra-Day or Agent-Extended 
view. To open this dialog box:

• Double-click the Comments cell for the appropriate agent.

Note: The Comments column is visible only if you select it on the Columns 
tab of the Options dialog box.

This dialog box contains the following controls:

Comments—Enter or edit comments in this text box. 

OK—Click this button to accept your changes and close the dialog box. (The 
WFM database does not save your comments until you save the scenario.)

Cancel—Click this button to discards your changes and close the dialog box.

Note: Adding and editing comments changes the schedule. Therefore, when 
you save comments, WFM validates the schedule and relevant 
schedule warning messages appear. A schedule warning message that 
is generated when you first save the schedule scenario may continue to 
be regenerated when you save your comments if the schedule 
continues to contain the problems that were noted in the warning.

Master Schedule Intra-Day View Options Dialog Box

Use the Options dialog box to configure the data that is shown on the:

• Intra-Day view or Agent Extended view for the current scenario. 

• Master Schedule Intra-Day or Master Schedule Agent-Extended view.

To open the Options dialog box:

• Click the Options button on the Actions toolbar or select Options from the 
Actions menu.

The Options dialog box appears. 

• When called from an Intra-Day view, it has three tabs: Options, 
Performance, and Columns. 

• When called from an Agent-Extended view, it two tabs: Options and 
Columns.

Each tab is described below. After you are done configuring the Options dialog 
box, click Apply to save your changes, or Cancel to restore the original 
selections.
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The Options dialog box closes and the view refreshes. The settings that you 
configure for a scenario or the Master Schedule appear whenever you return to 
the view for that scenario or for the Master Schedule, until you log off.

To configure options in this dialog box:

1. If you do not need the Legend to appear, you can clear the Show Schedule 
Legend check box to provide more space for the grid.

2. If you want to see agent availability on the grid, select the Show Agent 
Availability check box. Hours when an agent is unavailable are then shown 
in light gray on the grid.

3. Select the check box Show agents with granted and scheduled rotating 
pattern or any other calendar preference to see which schedule days 
contain such an item. The result: a red check box and Agent icon appears 
in the leftmost column (labeled “!”) for every Agent who meets these 
conditions.

Note: You can use this tool to learn whether an agent was given a 
schedule based on a schedule preference, which might influence 
your decision to modify this agent's schedule. This icon is 
displayed only if the agent was given a rotating pattern or 
preference (such as for time off) as a result of building a schedule. 
If an agent’s schedule is manually edited to give him one of his 
preferences, or a schedule from a rotating pattern, then the icon 
will not be displayed.

4. Select the radio button for the hours you want to show, 24 to show 24 
hours or 36 to show 36 hours.

5. Select the Presentation type: Schedule only, Schedule on top, or Marked 
time on top. Your selection affects the colored bars in the schedule. If 
Schedule only is selected, you cannot see Marked time.

To configure the Performance tab (not available in Agent-Extended view):

1. If you select the Show Performance Information check box, you can 
further customize exactly what performance information WFM Web shows 
on the Intra-Day Schedule view. If you clear this check box, the rest of the 
options on this tab are disabled.

2. If you prefer not to see the legend that explains the colors used to 
distinguish performance data, clear the Show Performance Legend check 
box.

3. The Update Automatically check box determines whether schedule 
changes are shown when they happen. Clear this only if you have network 
bandwidth issues that make automatic updates a problem.

4. If you selected to view performance data, you can select the check boxes to 
show additional information in the performance table. 
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Note: You see the table only if the Full View check box is not selected.

In addition to scheduled coverage and calculated staffing, which always 
appear, you can select any or all of the following options to appear in the table:

• Required Staffing

• Difference between Coverage and Calculated Staffing

• Difference between Coverage and Required Staffing

• Scheduled Service Level Percentage

• Scheduled ASA (Average Speed of Answer)

To configure the Columns tab:

• Select the check boxes for the optional columns that you want to display. 
Clear the check boxes for any columns that you want to hide. For Intra-
Day and Agent-Extended views, you can add the following columns: 
Overtime, Paid Hours, Total Hours, Start Time, Comments. In Intra-Day 
view, all columns are sortable, except for Comments. In Agent-Extended 
view, these columns are not sortable.

Master Schedule Intra-Day View Review Messages 
(Save) Dialog Box

Use this dialog box to respond to any warnings or errors that the server 
returned during your last attempt to save an agent's edited schedule. 

The dialog box includes the following columns and controls:

Team—Displays the team to which this agent belongs.

Agent—Displays the agent whose schedule generated this message.

Message—Displays the message type (either Warning or Error), numeric code, 
and the message text.

Action—Use each message's drop-down list to select an action to resolve the 
warning or error: 

Save—Saves the edited agent schedule. This is the default action for warnings. 
It is unavailable for agent schedules whose edits generated errors (which are 
more severe than warnings).

Fix Later—Does not attempt to save the agent schedule, but keeps it in the 
Intra-Day grid so that you can further modify it. This is the default action for 
agent schedules whose edits generated errors.

Undo—Discards the change that caused the warning or error to be generated.

OK—Closes the dialog box, applies your selected actions, and retrieves fresh 
data from the server.

Cancel—Closes the dialog box without saving or refreshing data.
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Note: These errors and warnings are generated by schedule changes that you 
made manually in the Intra-Day view. They differ from Validation 
warnings and errors, which WFM Web generates during the schedule 
building process.

Add/Remove Scenario Elements Wizard

Use the Add/Remove Scenario Elements Wizard to modify the selected 
scenario by adding activities or agents to it, or by removing agents. 

To use this wizard:

1. Click the Add/Remove Scenario Elements button on a schedule scenario 
view's Actions toolbar or select it from the Actions menu.

The first of the Add//Remove Scenario Elements Wizard's three screens, 
Select Activities, opens.

2. Make whatever changes you want to the schedule scenario's activities.

You can expand business units to display their sites and you can expand 
sites to display their activities. The tree shows only those sites that the 
scenario included when it was created.

By default, activities included in the selected scenario are selected in the 
tree, and you cannot clear their check boxes.

To add activities to the scenario, select their check boxes.

3. Click Next.

4. On the Select Agents screen, make whatever changes you want to the 
schedule scenario's agents.

You can expand business units to display their sites and you can expand 
sites to display their agents. The tree shows only those sites that were 
included in the scenario when it was created.

By default, those agents who were originally included in the scenario are 
selected in the tree.

To add an agent to the scenario:

Select the agent's Real or Profile check box. (You can select only one 
check box for each agent, and selecting one check box automatically clears 
the other.)

To remove an agent from the scenario:

Clear both of the agent's check boxes.

5. Click Next.

6. In the Select Profiles window, make whatever changes you want to make 
to the number of profile agents.
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You can expand business units to display their sites and expand sites to 
display their profiles. For each profile, you can edit the Number column's 
entry (which is initially zero).

7. Click Finish to save your changes to the schedule scenario.

Or you can click Previous to review or change your selections in earlier 
windows, or Cancel to close the wizard without modifying the scenario.

Scenario Agent-Extended View

Use the Scenario Agent-Extended view to display and/or edit a single agent's 
schedule for one week or for the schedule planning period. The figure below 
shows an example. 

Figure 24: Scenario Agent-Extended View

Note: A legend at the bottom of the window indicates the particular type of 
schedule item that each bar color represents.

You can modify schedule items for individual agents or profiles here, and you 
can insert schedule items for multiple agents and/or profiles. The following 
sections and links cover:

• Displaying the Agent-Extended view.

• Using the Agent-Extended view grid

• Customizing the Agent-Extended view grid.

• Using the Agent-Extended view toolbar buttons.

• Modifying an agent's schedule.
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Displaying the Scenario Agent-Extended View

To display the Agent-Extended view:

1. In the Modules pane, expand the Schedules module. 

2. Click Scenarios.

3. In the Schedule Scenarios view, open a scenario.

4. In the Modules tree, click [Scenario-name] Agent-Extended.

If already accessed during the current session, the Agent-Extended view 
appears with the last selected agent. 

If accessed for the first time, an empty Agent-Extended view grid appears. 
The Objects tree displays the business unit/site(s)/team(s) associated with 
the selected scenario. 

5. Expand the Objects tree and select a single agent. You can work with only 
one agent at a time. The Scenario Agent-Extended view appears.

Using the Scenario Agent-Extended View Grid

The Agent-Extended view includes a grid for the selected agent. Each row in 
the grid contains a color coded bar. Each bar represents a scheduled day or day 
off for the selected agent. The table below explains the fields and controls.

Scheduled agents—This indicator shows the number of agent days displayed 
(based on the selected Mode).

Edited schedules—This indicator shows the number of daily schedules you 
have edited in this view, but not yet saved.

Full View—Select the Full View check box to have the grid display the entire 
day similar to the Intra-Day view. If you clear this check box, the grid shows a 
more detailed view as shown in the example above. Full View also affects the 
Options dialog box.

Mode:—The starting Mode is set to the default of one week, but can be 
changed to Schedule Planning Period if schedule planning periods are used at 
your site.

Date:—These controls are the standard date selectors. The grid displays data 
for the period containing the selected date.

! (Save Messages/Warnings)— column contains icons that provide 
information about the agents' schedules. 

• A light-gray pencil icon indicates that the agent's day was edited after 
scheduling or rescheduling.

• A green pencil icon indicates schedule items that you have changed but not 
yet saved. 

• A yellow pencil icon indicates an item that generated a warning and you 
selected the Fix Later option. 
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• A red pencil icon indicates an item that generated an error. (Error 
conditions are more serious than warning conditions.) 

• A swap icon indicates that the agent's day was assigned by trading or 
swapping.

• A yield icon (upside down red triangle) appears if there are pending 
changes. Pending changes must be committed by a user with Approve 
Changes security permission.

• Double-click a yellow or red icon to review message details and resolve 
the unsaved items.

Team—This column on the grid indicates the selected agent's assigned team.

colored icon—The column on the grid may display a colored icon. This icon, 
assigned in Configuration Utility, represents the agent's contract.

Agent—This column on the grid indicates each agent's name.

Date—This column on the grid indicates the calendar day. 

[Timesteps]—These columns indicate the agent's schedule items in each 
timestep. To see greater detail, clear the Full View check box and/or resize the 
columns. 

Figure 25: Timestep shortcut menu

To make changes to the selected agent's schedule, right-click the timestep that 
you want to modify and then select the command from the shortcut menu. The 
figure below shows the menu when you right-click on a dark blue area within a 
color-coded bar (unless you change the color). The menu items vary depending 
on the area clicked.

See Modify Individual Agent's Schedules for instructions and explanations.
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[Horizontal scroll bar]—Appears below the table when clearing the Full 
View check box causes some timesteps to be hidden offscreen. Scroll it to the 
right to display later timesteps.

Legend—Indicates the particular type of schedule item that each bar color 
represents.

Figure 26: Scenario Agent-Extended View Legend

Customizing the Scenario Agent-Extended View Grid

You can resize the Team, Agent, and Date columns. For details, see the Getting 
Started Overview. You can also add and remove columns. 

Overtime—If displayed (using the Options dialog box), this column shows the 
duration of overtime for each agent on the selected day.

Paid Hours—If displayed (using the Options dialog box), this column shows 
each agent's paid hours for the selected day.

Total Hours—If displayed (using the Options dialog box), this column shows 
each agent's total hours for the selected day.

Start Time—displayed (using the Options dialog box), this column shows 
each agent's start time for the selected day's work.

* (Comment)—If this column is displayed (using the Options dialog box), an 
asterisk (*) indicates that a comment was saved for the indicated agent and 
schedule day.

Double-click a column cell to view or edit comments.

Using the Scenario Agent-Extended View Toolbar 
Buttons

The Scenario Agent-Extended view toolbar is similar to the Scenario Intra-Day 
view toolbar. The only exception is that Scenario Agent-Extended view does 
not contain Filter, Sort, or Meeting Scheduler buttons. Click a button on the 
Scenario Agent-Extended view image to jump to its description. 

Toolbar: Modifying an Agent's Schedule

Use buttons on the toolbar (or commands from the Actions menu) for the 
following:

Add/Remove scenario elements—Opens the Add/Remove Scenario Elements 
Wizard, where you can add or remove activities and agents for the current 
schedule scenario.
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Build schedule—Opens the Schedule Build Wizard, where you can build a 
complete schedule for the selected site.

Rebuild schedule—Opens the Schedule Rebuild Wizard, where you can 
rebuild agent schedules, while optionally leaving intact any agent schedules 
that you have modified since the last build/rebuild.

Rebuild intra-day schedule—Opens the “Intra-Day Schedule Rebuild 
Wizard” on page 243 to rebuild an Intra-Day schedule for a specific day or 
time period for a site, team, or agent. 

Validate schedule—Opens the Review Messages window, which lists 
scheduling warnings for a selected site. Warnings will only be visible if you 
have already built a schedule for this scenario and you saved any warnings that 
were generated.

Close—Closes the open scenario (and prompts you to save unsaved data).

Options—Opens the Options dialog box. Enables you to customize the view, 
including whether to show agent availability, whether to use a 24-hour or 36-
hour display, and whether to display or hide the Overtime, Paid Hours, Total 
Hours, Start Time, and Comment columns.

Auto-Commit—The Auto-Commit toolbar button toggles on and off the auto-
commit feature. The feature is also turned on and off by selecting Auto-
Commit on the Actions menu. If it is on, changes are immediately applied to 
the scenario. If it is off, the changes have pending status and can be 
committed/approved before they are incorporated in the publicly-available 
version of the schedule scenario.

Swap—Opens the Swap Agent Schedules Wizard, which enables you to swap 
two agents' schedules.

Insert Multiple—Opens the Insert Multiple Wizard, which enables you to 
insert breaks, meals, exceptions, days off, or vacation days for multiple agents 
or teams.

Delete Multiple—Opens the Delete Multiple Wizard, which enables you to 
remove multiple items from the scenario at one time.

Commit/Rollback Multiple—Opens the Commit/Rollback Multiple Wizard, 
which enables you to insert pending changes (changes entered when auto-
commit was off) into the schedule scenario or to remove them and return the 
scenario to its former settings.

Save—Saves any changes that you have made to the current scenario. (If the 
server cannot save all changes, red or yellow icons in the grid's first column 
indicate the agents for whom you must correct errors or acknowledge 
warnings.

If you make schedule changes in the Agent-Extended view and do not click 
Save, you are prompted to save your changes when you select a different 
module or view, or when you launch certain wizards or child windows.



158 Workforce Management 7.6

Chapter 5: Scheduling New Schedule Scenario Wizard

Scenario Profiles/Bidding View

Use the Scenario Profiles/Bidding view to assign agents to a schedule that you 
have created using profiles. The figure below shows an example (partial view). 
Click the toolbar buttons on the image to jump to their descriptions below. 
Bidding controls and tools are described at the bottom of this topic.

Figure 27: Scenario Profiles/Bidding View

Using Profile-based Scheduling for Bidding Scenarios

The WFM offers Schedule Bidding view offers controls that you can use to:

• Assign agents to a bidding scenario before bidding starts.

• Set the start and end dates for bidding.

• Start the auto-assignment process, to assign agents to schedules, after 
bidding is closed.

These tools are a key portion of WFM's Schedule Bidding functionality.

Using Profile-based Scheduling for Advance Planning

You can use a profile-based schedule to plan for and schedule agents who you 
have not yet hired. 
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1. Configure and build your scenario(s) using profiles with the characteristics 
of your not-yet-hired agents.

2. Once the real agents are on board, assign them to the profile schedules.

The following sections cover:

• Displaying the Scenario Profiles/Bidding view.

• Reading the tables.

• Using the tables.

• The Show Data For drop-down list.

• Filter, build, validate, and save options.

Displaying the Scenario Profiles/Bidding View

To display the Scenario Profiles/Bidding view:

1. In the Schedule Scenarios view, open a scenario.

2. In the Modules tree, click [Scenario-name] Profiles/Bidding.

The Scenario Profiles/Bidding view appears.

3. In the Objects tree, select a site and/or profiles.

You can expand business units to display their sites and expand sites to display 
their profiles. You can work with only one site at a time, but you can select any 
number of profiles within that site. You can select or remove all of a site's 
profiles by selecting or clearing (respectively) the check box beside the site 
node.

Reading the Tables

This view includes two tables, arranged vertically. Each table displays a 
vertical scroll bar (when required), which you can use to reveal additional 
rows. You can also give one table additional room by clicking and dragging the 
divider bar between the two tables. 

The upper table displays a list of profile schedules, identified by a contract 
icon and by an index number (each of which is unique within the scenario). 
This table has the following columns:

—Click this icon to shrink a multiple line listing down to a single line. Click 
again to expand the listing back to multiple lines.

Team—The assigned team of the agent on this row.

—This icon represents the agent's contract, and is assigned in Configuration 
Utility.

Agent—Shows a contract icon and index, with expand/collapse controls to 
display or hide schedule details in the Week column.

Bid—The agent's bid ranking number for this schedule
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[Weekdays]—Shows profile schedule information for the specific day. (The 
cells' contents correspond to your selection in the Show Data for drop-down 
list.)

Weekly Totals—To the right of each week, the total hours in that week (sum 
of all days). If there is more than one total, the sum of all totals appears above 
them.

Planning Period Totals—The total hours of all weeks in the Planning Period.

The lower table displays a list of real agents, with the following columns: 
Team, Agent Name, Rank, Hire Date, and Employee ID.

Each row displays information for one agent. Each agent listed meets all the 
requirements imposed by the check boxes Show Assigned Agents and Show 
Bidding Candidates Only.

Team—The assigned team of the agent on this row.

Agent name—The name of the agent on this row being documented in this 
row.

Rank—The agent's rank, if one exists.

Hiring Date—The agent's hiring date.

Employee ID—The agent's employee ID.

Bid—The agent's bid ranking number for this schedule.

Using the Tables

To assign a real agent to a profile schedule slot:

1. Click a profile schedule in the upper table. This populates the lower table 
with any real agents who are eligible to fill this slot. WFM Web presents 
agents who share the selected profile's contract, and who have the skills 
necessary to handle all of the profile's activities.

2. Click a real agent in the lower table.

3. Click . In the upper table, the real agent's name replaces the selected 
schedule's index.

To remove an assignment:

1. Click the assigned agent in the upper table.

2. Click . A numbered profile replaces the agent's name in the upper 
table. The agent's name reappears in the lower table.

To remove a profile slot from the upper table:

• In the Objects tree, clear that profile's check box.

To save changes:

• Click Save.

To discard all of the assignments that you have made:

• Click Close and then decline the prompt to save before closing.
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Show Data for Use this drop-down list to select what you want to display inside each day's 
table cell:

Total Working Hours—Total working time for the day. (Default display 
option.)

Working Start/End Time—Start and end times of agents' work.

Shift Names—Names of agents' assigned shifts.

Mode

Use this drop-down list to select what you want to display in the table:

All data—Displays all profile schedules for the scenario period defined by 
Start Date and End Date. Includes columns for Weekly Period Totals and 
Planning Period Totals.

Planning Period—Displays all profile schedules for the entire Planning 
Period. Includes columns for Weekly Period Totals and Planning Period Totals 
for each profile schedule.

Filter, Build,
Validate, Bidding

Configuration and
Save Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

Add/Remove schedule elements—Opens the Add/Remove Schedule 
Elements Wizard, where you can add activities, and add or remove agents, for 
the current schedule scenario.

Build schedule—Opens the Schedule Build Wizard, which builds a complete 
schedule for the selected site.

Rebuild schedule—Opens the Schedule Rebuild Wizard, where you can 
modify and rebuild schedules, while optionally leaving intact any agent 
schedules that you have edited since the last build/rebuild.

Rebuild Intra-day schedule—Opens the Schedule Intra-day Rebuild Wizard, 
where you can modify and rebuild intra-day schedules.

Validate schedule—Opens the Review Messages window, which lists 
scheduling warnings for a selected site. Warnings will only be visible if you 
have already built a schedule for this scenario and saved any warnings that 
were generated.

Close—Closes the open scenario (and prompts you to save unsaved data).

Filter—Enables you to filter the displayed contract types and activities.

Bidding Candidates Selection—Opens the Bidding Candidates Selection 
dialog, where you specify which Agents can bid on the current bidding 
scenario.

Control bidding process—Opens the Control Bidding Process wizard, where 
you specify the Start and End dates for the current bidding scenario.

Auto-assign schedules—Opens the Auto-assignment wizard, where you 
initiate the auto-assignment process that assigns bid-upon profile schedules to 
real agents.
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Bidding Scenario Tools in this View

Use these controls to assign agents to a bidding scenario before bidding starts; 
to set the start and end dates for bidding; and to start the auto-assignment 
process to assign agents to schedules, after bidding is closed.

Icons Bidding Candidates Selection—Opens the Bidding Candidates Selection 
dialog, where you specify which Agents can bid on the current bidding 
scenario.

Control Bidding Process—Use this wizard to specify the dates and times 
when bidding begins and ends.

Auto-Assign Schedules—Use this wizard to automate the assignment of 
profile shifts to real agents, after bidding has closed.

All other icons and modules are described in the Scenario Intra-Day View and 
the Scenario Agent-Extended View.

Check boxes • Show assigned agents displays real agents and their assigned shifts in the 
grid above, only if the schedule was originally created using agent profiles. 
Otherwise selecting has no effect.

• Show bidding candidates only controls which agents are listed in the 
bottom pane. Select this check box to display (in the bottom pane) only 
agents who can bid on the profile schedule selected in the top pane. Clear 
this check box to display (in the bottom pane) all agents at the Site who 
qualify for the profile schedule selected in the top pane. 
 When you use this view for schedule bidding, check the checkbox. 
 When you use this view for profile-based scheduling, clear the 

checkbox.

You can select both check boxes at once, as shown in the graphic.

Arrows

Use these arrows to manually assign real agents to profile shifts or to unassign 
them.

 (up arrow) Assigns a real agent to the selected profile shift. To use this 
function:

1. Highlight a profile shift in the upper grid. 

2. Highlight a real agent in the eligible list below. 

3. Click the up arrow to assign the real agent to the profile shift.

The profile shift you selected becomes a real agent shift and the real agent 
disappears from the eligible list below.

 (down arrow) Unassigns a real agent from the selected shift. To use 
this function:

1. Select a real agent shift in the upper grid. 

2. Click the down arrow to unassign the shift.
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The shift you selected becomes a profile shift (now available for assignment) 
and the real agent appears in the eligible list below.

Scenario State Group Totals
Use the Scenario State Group Totals view to display coverage statistics for 
every time step in a selected day. 

Displaying State Group Totals

1. Select a Scenario.

2. Select State Group Totals for that scenario, under the Schedule module.

3. Select the object—Switch(es), Team(s), Agent(s)—whose State Group 
Totals you want to work display.

4. Click Get data.

The columns in the Master Schedule State Group Totals data table, and the 
stacked lines in the graph, correspond to the configured schedule state groups. 
Use the State Groups Filter in the toolbar to specify which columns appear in 
the table and which lines appear in the graph. 

Data Tab

Click the Data tab to view to view the data in a table.

• The group columns are ordered with the highest weight displayed in the 
left-most column of the grid.

Note: An agent who is in multiple schedule state groups during an interval, is 
pro-rated in the grid by the fraction of the interval that he is in each 
state group. For example, an agent on Break for 5 minutes and at Work 
for 10 minutes is listed in the Break cell as .33 and in the Work cell as 
.67.

Graph Tab 

Click the Graph tab to view the data in a stacked area graph.

• The groups are sorted by their weight descending and their name 
ascending. For example, the group with the highest weight is layered first, 
at the bottom of the chart.

• The graph’s legend displays the names of each schedule state group in its 
matching color.
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State Groups Filter Dialog Box

Reach this dialog by clicking the Filters button in the toolbar at the Scenario 
States Groups Totals module.

Use the State Groups Filters dialog box to control which State Groups are 
displayed:

1. Select the check boxes for State Groups that you want to display. By 
default, all State Groups are selected for display.

2. Clear the check boxes for any State Groups that you want to hide.

3. You can select the State Groups at the top of the list to select the entire list 
at once. 

4. Click OK to apply your selections, or Cancel to abandon them.

WFM filters the view according to your selections. If you have filtered a 
scenario view, this filter remains in effect until you close the scenario. 
However, if you select another site and then click the Filter button, the Filter 
dialog box reopens with its default settings.

Scenario Summary View

Use the Scenario Summary view to display statistics about the current schedule 
scenario. The Summary view provides standard date-selection controls and 
two clickable tabs, Data and Graph. The following sections cover:

• Displaying the Scenario Summary view.

• Data tab.

• Graph tab.

• Actions toolbar.

Displaying the Scenario Summary View

To display the Summary view:

1. In the Schedule Scenarios view, open a scenario. 

2. In the Modules tree, click [Scenario-name] Summary.

The Scenario Summary view appears.

3. In the Objects tree, select sites and/or activities.

You can select a single business unit, a single site within a business unit, or a 
single activity within a site. Making the selections populates the Data tab grid.

Setting Granularity

Use this drop-down list to select the Time Step increment to display in the grid. 
Select from one of these three values (in minutes): 15, 30, or 60.
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Data Tab

The Data tab provides a scrollable grid that displays aggregate and per-
timestep statistics. The grid's first row displays a daily total or average for each 
statistic. Each of the remaining rows displays statistics for one timestep.

Grid Columns The grid provides columns that display the following statistics and quantities.

• Click the Options button to display or hide each of these available 
columns.

Time Step—The start time for each 15-minute timestep.

Coverage [Scheduled]—The scheduled staffing coverage for an activity or 
multi-site activity. Schedule coverage is calculated and displayed in fractional 
units. For example, if any agent is scheduled to work on three Activities in a 
15-minute timestep, that agent may count as 1/3 toward the coverage of each 
activity. 

The way the scheduling engine splits an agent’s time among the activities he 
can work on depends on many factors. Examples include the open hours of 
each activity, the volume and handle time of each activity, and some other 
factors such as whether an agent has granted items in the Calendar, such as 
time off or exceptions for any or part of the day. 

Headcount [Scheduled]—The number of agents scheduled (agents scheduled 
to be seated).

Service Level Percentage Scheduled—The service level percentage that can 
be achieved given the staffing coverage, assuming that other planned metrics 
(such as interaction volumes and Average Handling Time) remain unchanged.

Service Level Percentage Forecasted—The service level percentage that can 
be expected to be achieved based on the number of agents forecasted. 

This may differ than the original service level objective that was stated when 
the staffing forecast was built due to agent rounding. For example, WFM may 
forecast a staffing requirement of 12 agents to meet a service level objective of 
80% of interactions answered within 20 seconds, but Service Level Percentage 
Forecast may report a higher number, such as 83.48%. This is because 12 was 
the minimum number of agents required to meet the 80% service level 
objective but, with that number of agents, the contact center can be expected to 
achieve a slightly better service level than 80%. With one less agent (11 
agents), the contact center would not be expected to achieve the 80% service 
level.

Difference Service Level—Service Level Scheduled minus Service Level 
Forecasted

Interaction Volume Scheduled—The number of interactions that can be 
handled based on the schedule coverage—assuming that other planned metrics 
remain unchanged.

Interaction Volume Forecasted—The expected number of interactions, 
according to the Master Forecast.
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Difference Interaction Volume—Interaction Volume Scheduled minus 
Interaction Volume Forecasted

AHT Scheduled—The Average Handling Time per interaction, based on the 
schedule—assuming that other planned metrics remain unchanged.

AHT Forecasted—The expected Average Handling Time, according to the 
Master Forecast.

Difference AHT—AHT Scheduled minus AHT Forecasted

Budget Scheduled—The budget for the scheduled coverage for the selected 
day and activities, based on the full-time-equivalent (FTE) paid hours per day 
and the salary specified in the Forecast scenario that was published to the 
Master Forecast for this date.

Budget Forecasted—The budget for the calculated staffing for the selected 
day and timesteps, based on the full-time-equivalent (FTE) paid hours per day 
and the salary specified in the Forecast scenario that was published to the 
Master Forecast for this date.

Difference Budget—Budget Scheduled minus Budget Forecasted

Staffing Calculated—The required number of agents as calculated by WFM, 
based on the forecasted interaction volumes, AHT, and applicable service 
objectives.

Staffing Required—The required number of agents defined by the user, either 
by explicitly entering forecast targets or by using a template. This column 
appears if selected in the Options dialog box.

Difference Calculated—The difference between Coverage [Scheduled] and 
Staffing Calculated. This column appears if selected in the Options dialog box.

Difference Required—The difference between Coverage [Scheduled] and 
Staffing Required. This column appears if selected in the Options dialog box.

Coverage Published—The schedule coverage based on the “baseline” Master 
Schedule.

Coverage Difference—The difference between the schedule coverage based 
on the “current” Master Schedule and schedule coverage based on the 
“baseline” Master Schedule.

ASA Scheduled—The Average Speed of Answer that you should achieve with 
the number of scheduled agents.

ASA Forecasted—The Average Speed of Answer that you should be able to 
achieve with the number of agents from the staffing forecast.

Difference ASA—ASA Scheduled minus ASA Forecasted

Occupancy Scheduled—The Occupancy that you should achieve on this 
activity, with the number of agents currently scheduled.

Occupancy Forecasted—The Occupancy objective that you should be able to 
achieve when staffing with the number of agents from the staffing forecast.

Difference Occupancy—Occupancy Scheduled minus Occupancy Forecasted



Supervisor User’s Guide 167

Chapter 5: Scheduling Scenario State Group Totals

Graph Tab

The Graph tab provides a linear graph for each statistic that you select, with 
data points for individual timesteps across the selected day.

Show data for From the Show data for drop-down list, select the statistic you want to graph. 
The options correspond to the Data tab's available columns (except that 
Difference Calculated and Difference Required cannot be graphed).

Graph The graph is redrawn to match your drop-down list selection from the Show 
data for drop-down list. Timesteps are shown from left to right. Quantities 
from bottom to top show the number of interactions, the number of agents, or 
the expense amount (for Budget).

Using the Actions Toolbar

Use buttons on the toolbar (or commands from the Actions menu) for the 
following:

Add/remove scenario elements—Opens the Add/Remove Schedule Elements 
Wizard, where you can add activities and agents to, or remove them from, the 
current schedule scenario.

Build schedule—Opens the Schedule Build Wizard, where you can build a 
complete schedule for the selected site.

Rebuild schedule—Opens the Schedule Rebuild Wizard, where you can 
modify and rebuild schedules, while optionally leaving intact any agent 
schedules that you have edited since the last build/rebuild.

Validate schedule—Opens the Review Messages window, which lists 
scheduling warnings for a selected site. Warnings will only be visible if you 
have already built a schedule for this scenario and saved any warnings that 
were generated.

Close—Closes the open scenario (and prompts you to save unsaved data).

Options—Opens the Options dialog box for enabling or hiding individual 
statistics. 

The following statistics are available for selection: Coverage Scheduled, 
Headcount Scheduled, Service Level Scheduled, Service Level Forecasted, 
Interaction Volume Scheduled, Interaction Volume Forecasted, AHT (Average 
Handling Time) Scheduled, AHT Forecasted, Budget Scheduled, Budget 
Forecasted, Staffing Calculated, Staffing Required, Difference Calculated, 
Difference Required, Coverage Published, Coverage Difference. 

Use Multi-Site Activities—This button becomes enabled when you select a 
multi-site activity or business unit in the Objects tree. Clicking this button 
displays data for the selected multi-site activity.
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Schedule Filter Dialog Box
Applies to these modules: Weekly, Intra-day, State Group Totals, 
Profiles/Bidding.

Use the Filter dialog box to control the activities and contracts that are 
displayed within the selected site:

1. In any of these views Weekly, Intra-day, State Group Totals, or 
Profiles/Bidding, click the Filter button on the Actions toolbar.

The Filter dialog box opens.

2. Click the Agent Properties tab.

3. In the Activities Agents Have Skills For list, select the check boxes for 
activities that you want to display. Clear the check boxes for any activities 
that you want to hide.

By default, all activities are selected.

4. In the Contracts list, select the check boxes for contracts that you want to 
display. Clear the check boxes for contracts that you want to hide.

By default, all contracts are selected.

5. Click the Schedule States tab.

6. If you are in the Weekly, Intra-day, or Profiles/Bidding module, this tab 
contains the Activities Agents Work On list. Select the check boxes for 
activities that you want to display. Clear the check boxes for any activities 
that you want to hide. By default, all activities are selected.

OR

If you are in the State Group Totals module, this tab contains the Schedule 
State Groups list. Select the check boxes for groups that you want to 
display. Clear the check boxes for any groups that you want to hide. By 
default, all groups are selected.

7. Click OK.

The view is now filtered according to your selection. If you have filtered a 
scenario view, this filter remains in effect until you close the scenario. 
However, if you select another site and then click the Filter button, the Filter 
dialog box reopens with its default settings.

Statuses Filter Dialog Box
Use the Statuses Filters dialog box to control which Statuses are displayed:

1. Select the check boxes for Statuses that you want to display. By default, all 
Statuses are selected for display.

2. Clear the check boxes for any activities that you want to hide.
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3. You can select the Statuses at the top of the list to select the entire list at 
once.

4. Click OK to apply your selections, or Cancel to abandon them.

WFM filters the view according to your selections. If you have filtered a 
scenario view, this filter remains in effect until you close the scenario. 
However, if you select another site and then click the Filter button, the Filter 
dialog box reopens with its default settings.

Options Dialog Boxes

Summary View Options Dialog Box

Use the Options dialog box to customize the statistics that the Summary view 
displays.

1. Click the Options button on the Summary view's Actions toolbar.

The Options dialog box opens. 

2. Select the check boxes for statistics that you want to display, and clear the 
check boxes for statistics that you want to hide.

Double-click the Statistics node to reveal its contained statistics. 

Display or hide all statistics at once by selecting or clearing (respectively) 
the Statistics node's check box.

3. Click OK.

The Summary view reappears, displaying only the statistics that you selected.

Coverage Statistics

Starting with Workforce Management 7.2, you have the option to include two 
new Coverage statistics in the Summary view:

Coverage Published displays the schedule coverage based on the “baseline” 
Master Schedule.

Coverage Difference displays the difference between the schedule coverage 
based on the “current” Master Schedule and schedule coverage based on the 
“baseline” Master Schedule.

Metrics

You can include these new Difference statistics in the Summary view:

Difference [S/L Scheduled minus S/L Forecasted] displays (Service Level 
Scheduled minus Service Level Forecasted).
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Difference [IV Scheduled minus IV Forecasted] displays (Interaction 
Volume Scheduled minus Interaction Volume Forecasted).

Difference [AHT Scheduled minus AHT Forecasted] displays (Average 
Handle Time Scheduled minus Average Handle Time Forecasted).

Difference [Budget Scheduled minus Budget Forecasted] displays (Budget 
Scheduled minus Budget Forecasted).

You can include these new statistics in the Summary view:

ASA Scheduled displays the Average Speed of Answer that would be 
expected with the number of scheduled agents.

ASA Forecasted displays the Average Speed of Answer that would be 
expected with the number of agents from the staffing forecast.

Difference [ASA Scheduled minus ASA Forecasted] displays (ASA 
Scheduled minus ASA Forecasted).

Occupancy Scheduled displays the Occupancy that you should achieve on 
this activity, with the number of agents currently scheduled.

Occupancy Forecasted displays the Occupancy objective that you should be 
able to achieve when staffing with the number of agents from the staffing 
forecast.

Difference [Occupancy Scheduled minus Occupancy Forecasted] displays 
(Occupancy Scheduled minus Occupancy Forecasted).

For in-depth descriptions of these statistics and the formulae used to derive 
them see “Appendix B: Metrics” in the current Workforce Management 
Administrator's Guide.

Background on Baseline Master Schedule

When you publish a schedule scenario to the Master Schedule, WFM retains a 
snapshot of the Master Schedule at that point in time. This is the “baseline” 
Master Schedule.

Then, after you or other schedulers make changes to the schedule such as 
adding exceptions and granting vacations, you can compare the schedule 
coverage shown in the “current” Master Schedule against the schedule 
coverage stored in the “baseline” Master Schedule.

This “baseline” of the Master Schedule is created/updated at the last time 
something was published to the Master Schedule for a particular date range. 
For example, assume on May 25 you publish the June schedule scenario to the 
Master Schedule, and then on May 28 you re-publish the same June schedule 
scenario to the Master Schedule. In this case, WFM uses the May 28 published 
schedule as the “baseline” against which the “current” schedule is compared.
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Weekly View Options Dialog Box

Use the Options dialog box to configure the data that is shown on the Weekly 
view or Master Weekly view.

To open the Options dialog box:

Click the Options button on the Actions toolbar

OR

Select Options from the Actions menu.

To configure options on the Options tab:

Select the Show agents with granted and scheduled rotating pattern or any 
other calendar preference check box. When the check box is selected, the grid 
shows the schedule days that contain such an item. A red check box and Agent 
icon appears in the leftmost column (labeled “!”) for every Agent who meets 
these conditions.

Note: You can use this tool to learn whether an agent was given a schedule 
based on a schedule preference, which might influence your decision to 
modify this agent's schedule. This icon is displayed only if the agent 
was given a rotating pattern or preference (such as for time off) as a 
result of building a schedule. If an agent’s schedule is manually edited 
to give him or her one of his or her preferences, or a schedule from a 
rotating pattern, then the icon will not be displayed.

To configure options on the Columns tab:

Select the Rank check box to add a column to the Weekly View grid that 
displays an agent's Rank value (which is set in the WFM Configuration 
Utility).

Sorting Dialog Box
Use the Sorting dialog box to sort the Weekly or Intra-Day views.

1. Select the item by which you want to sort. Agent Name is the default sort 
option. If agents do not have the option by which you are sorting, they 
appear last in the list.

• Weekly View—Team Name, Contract, Agent Name (first or last), or Agent 
Rank. You can sort in ascending or descending order. Note that Agent 
Rank sorts in apparent reverse order due to limitations imposed by multi-
sorting by both agent name and rank. 

• Intra-Day View—Team Name, Contract, Agent Name (first or last), 
Overtime, Paid Hours, Total Hours, Shift Start Time, or Start Time of First 
Exception.
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Note: If you select Start Time of First Exception, agents with full-day 
exceptions appear after agents with part-day exceptions. Agents 
with no exceptions appear at the bottom of the list. 

2. Click Apply.

The view is now sorted by the item that you selected. If you have sorted a 
scenario view, it retains this sort order until you close the scenario.

Swap Agent Schedules Wizard
Use the Swap Agent Schedules Wizard to swap the schedules of two agents in 
the same schedule scenario:

1. Click the Swap button on the Actions toolbar of an Intra-Day, Agent-
Extended, or Weekly view. 

For Weekly view, the Select Date and First Agent screen opens. Continue 
with Step 2.

For Agent-Extended or Intra-Day view:

If you previously selected an agent, the Select Second Agent screen opens. 
Continue with Step 5.

If no agent is selected, the Select Date and First Agent screen opens. 
Continue with Step 2.

2. Select the Start Date and End Date.

These dates must lie within the schedule scenario's date range.

3. From the Select Agent list, select the first agent.

In this hierarchical list, you can expand business units to display sites, 
teams, and agents. You can select a single real or profile agent.

4. Click Next.

The Wizard's second screen, Select Second Agent, opens.

5. From the Select Agent to Swap with list, select the agent with whom you 
want to swap schedules. 

You can select a single real or profile agent.

6. Click Finish.

If the swap is successful, the wizard closes and returns you to the view where 
you opened it.
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Review Swapping Messages
After you swap agent schedules, you might receive messages warning you that 
the swap results in constraint violations. For example, the new shift assignment 
might violate an agent's Contract.

If there are problems, the Review Messages dialog box opens. For each issue, 
the Review Messages dialog box shows the name of the affected agent and 
explains the problem.

After reviewing each entry in the list, do one of the following:

• Click Perform Anyway to make the swap in spite of the constraint 
violation(s).

• Click Cancel to cancel the swap and return the schedule to its former state.

Reviewing Messages
Use the Review Messages dialog box to view any warnings or errors that the 
server returned, in a variety of situations. 

The dialog box contains the following columns and controls:

Agent—The agent whose action(s) generated this message.

Team—The team to which the agent belongs.

Message—The message type (either Warning or Error), numeric code, and the 
message text.

OK—Closes the dialog box and retrieves fresh data from the server.

Help—Displays this help topic.

Insert Multiple Wizard

Overview

Use the Insert Multiple Wizard to add an item, such as a break, into multiple 
agents' schedules at once. You can use it in either scenarios or the Master 
Schedule.

To use the Insert Multiple Wizard:

1. In Intra-Day or Agent Extended view, select Insert Multiple from one of 
the following:
 Actions toolbar
 Actions menu
 Shortcut menu 
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Insert Multiple is also available in Weekly view from the Actions toolbar 
or Actions menu.

If you have unsaved changes, WFM Web prompts you to save them before 
proceeding. 

The Insert Multiple Wizard's first screen, Select Agents, opens.

2. Select the agents whose schedules you are editing. 

Note: If using the Insert Multiple feature in one of the Master Schedule 
views and you have the Approve Changes security permission, you 
can select the Auto commit inserted items check box to have your 
changes immediately inserted into the schedule. If you do not have 
the necessary security permission, this check box is cleared and 
disabled. In that case, any inserts that you make are pending, and 
they must be committed or approved before they can take effect in 
the official version of the Master Schedule. 

If using one of the Scenario views, this checkbox is always enabled. 

3. Click Next.

4. Select the dates in which to insert items, and then click Next.

5. On the Select State Type screen, select a state, and then click Finish (for a 
Day Off) or Next (for other schedule items).

6. Fill in the Select Break, Select Meal, Select Exception, or Select Time Off 
screen that appears next, and then click Finish.

The view reappears. 

• If the Auto commit inserted items check box was enabled, and you are 
editing a schedule scenario, your changes are committed to the scenario. 

• If the Auto-Commit inserted items check box was not enabled and you are 
editing a schedule scenario, then your changes appear in the schedule in 
Pending mode. You must commit them or roll them back with the 
Commit/Rollback Multiple wizard. 

Pending changes in a schedule scenario are not transferred to the Master 
Schedule when the scenario is published. If you are editing the Master 
Schedule, and the Auto commit inserted items check box is enabled, then the 
changes are committed to the Master Schedule are visible to all users. 

If the Auto commit inserted items check box is not enabled, then changes go 
into a Pending mode and appear to you, but not to other users, in the Master 
Schedule views. Pending changes in the Master Schedule must either be:

• Reviewed and approved/declined by a user with Approve Changes 
permissions (through the Master Schedule Changes Approval view) or 

• Committed or rolled back by you, if you have Approve Changes 
permissions, through the Commit/Rollback Multiple wizard.
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Select Agents Screen

To fill in the Select Agents screen:

1. Select any combination of agents.

You can select individual agents from multiple teams, or you can select 
whole teams or the whole site. Only objects that you had selected the last 
time you clicked Get data are available. 

2. If you want, select Insert only if there are no errors and/or Show 
warnings.

If you select the Insert only if there are no errors check box, then when you 
try to save the new items, WFM Web will not insert any of them if the 
server returns any schedule validation errors.

If you select the Show warnings check box, WFM Web displays any 
schedule validation warnings that would be generated if the items were 
inserted into agents' schedules. 

Note: If schedule validation errors also occur, WFM Web does not insert 
any of your changes into the schedule.

If you are editing the Master Schedule and have Approve Changes security 
permission, you can select the Auto commit inserted items check box to 
have your changes immediately inserted into the Master Schedule. If you 
do not have the necessary security permission, this check box is cleared 
and disabled. In that case, any inserts that you make are pending, and they 
must be reviewed and approved before they can take effect in the Master 
Schedule.

If you are editing a schedule scenario, you have the option to select the 
Auto commit inserted items check box. If checked, your changes are 
committed to the schedule scenario. If not checked, your changes go into a 
Pending state. They can be committed or rolled back by you using the 
Commit/Rollback Multiple wizard. Pending changes in a schedule scenario 
are not transferred to the Master Schedule when the scenario is published.

3. Click Next to open the Select Dates screen.

Click Cancel if you want to close the wizard without saving your selection.

Select Dates Screen

The select dates screen contains a calendar. 

1. Select the date or dates into which to insert the schedule items.

The calendar works as described in How to Use the Calendar.
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Note: If you are inserting into a schedule scenario, you cannot select 
dates that fall outside of the scenario's date range.

2. Click Next.

The Select state type screen appears.

Select State Type Screen

To fill in the Select State Type screen:

1. Select the state that you want to insert. 

2. Click Finish or Next.

The button that is enabled depends on the state that you have selected:

• The Finish button is enabled if you selected Day Off. Clicking it inserts a 
day off on the selected dates for the selected agents and closes the wizard. 

• If you select any other state, the Next button is enabled. Click it to open the 
appropriate wizard screen for selecting breaks, meals, exceptions, or time 
off.

• If you want to review or change your entries on the Select Dates screen, 
click Previous. Or click Cancel if you want to close the wizard without 
saving your selection.

Select Shift Screen

To fill in the Select Shift screen:

1. Select the shift that you want to insert. 

2. If the selected shift ends on the day after it begins, select Next Day next to 
the End Time text box.

3. Select the Automatically Insert Meals and Breaks check box to enable that 
function.

4. Click Next to open the Select Activity Set screen.

Select Activity Set Screen

To fill in the Select Activity Set screen:

1. Select the check box next to each shift that you want to insert. 

2. Click Finish.

Select Break Screen

To fill in the Select Break screen:
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1. Select a break from the Choose Item to Insert list. Click a single row to 
select its break. (If more breaks are hidden above or below the displayed 
list items, a vertical scroll bar appears to the right to help you reveal them.)

2. Fill in the Start time and End time text boxes for this break. Type in the 
times that you want, or use the up or down arrows to modify the displayed 
times.The list shows all of the breaks that have been configured for the 
selected site in the WFM Configuration Utility. The list's columns show 
each break's full name, short name, how long it lasts, and whether or not 
the break is paid. You cannot select or clear the Paid check box here.

3. Select Next Day next to the Start Time and End Time text boxes if the 
break starts on the day after the agents' shifts begin. Or select Next Day 
next to the End Time text box if the break begins on the same day as the 
agents' shifts begin, but ends on the day after.

4. Click Finish to insert the selected break and close the wizard. This returns 
you to the Intra-Day view.

If you want to review or change your entries in the Select State Type screen, 
click Previous. 

If you want to close the wizard without inserting the break, click Cancel.

Select Meal Screen

To fill in the Select Meal screen:

1. Select a meal from the Choose Item to Insert list. Click a single row to 
select its meal. (If more meals are hidden above or below the displayed list 
items, a vertical scroll bar appears to the right to help you reveal them.)

The list shows all of the meals that have been configured for the selected 
site in the WFM Configuration Utility. The list's columns show each meal's 
full name, short name, how long it lasts, and whether or not the meal is 
paid. You cannot select or clear the Paid check box here.

2. Fill in the Start time and End time text boxes for this meal. Type in the 
times that you want, or use the up or down arrows to modify the displayed 
times.

3. Select Next Day next to the Start Time and End Time text boxes if the 
meal starts on the day after the agents' shifts begin. Or select Next Day 
next to the End Time text box if the meal begins on the same day as the 
agents' shifts begin, but ends on the day after.

4. Click Finish to insert the selected meal and close the wizard. This returns 
you to the Intra-Day view.

If you want to review or change your entries in the Select State Type screen, 
click Previous. 

If you want to close the wizard without inserting the meal, click Cancel.
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Select Exception Screen

To fill in the Select Exception screen:

1. Select an exception from the Select Exception list. Click a single row to 
select its exception. (If more exceptions are hidden above or below the 
displayed list items, a vertical scroll bar appears to the right to help you 
reveal them.)

The list shows all of the exceptions that have been configured for the 
selected site in the WFM Configuration Utility. The list's columns show 
each exception's full name, its short name, whether it is paid, whether it 
counts as time off, whether the exception is convertible to a day off, and 
whether it is a full-day exception. 

Note: The check boxes simply indicate the exception's configured 
properties. You cannot select or clear them here.

2. If the Start time and End time text boxes are enabled, fill them in for this 
exception. Either type in the times that you want, or use the up or down 
arrows to modify the displayed times.

3. Select Next Day next to the Start Time and End Time text boxes if the 
exception starts on the day after the agents' shifts begin. Or select Next 
Day next to the End Time text box if the exception begins on the same day 
as the agents' shifts begin, but ends on the day after.

4. If you selected a full-day, paid exception, you can select the Specify Paid 
Hours check box to enter a duration other than the default number of hours 
in a work day. If you select the Specify Paid Hours check box, the Paid 
Hours text box becomes editable. 

5. Click Finish to insert the selected exception and close the wizard. This 
returns you to the Intra-Day view.

If you want to review or change your entries in the Select State Type screen, 
click Previous. 

If you want to close the wizard without inserting the exception, click Cancel.

Select Time Off Screen

To fill in the Select Time Off screen:

1. Select a time-off type from the Select Time Off list. Click a single row to 
select its time-off type. (If more time-off types are hidden above or below 
the displayed list items, a vertical scroll bar appears to the right to help you 
reveal them.)

The list shows all of the time-off types that have been configured for the 
selected site in the WFM Configuration Utility. The list's columns show 
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each time-off type's name, short name, whether or not the time off is paid, 
and whether the time off counts toward the configured time-off limits.

Select the Show all check box to display all Time Off types. Clear the 
check box to display only the Time Off types that are applicable to the 
selected agent. See the “Time Off Primer” appendix in the Workforce 
Management 7.6 Administrator's Guide.

Note: The Paid and Counts check boxes are informational only. You 
cannot select or clear them.

2. If the time-off item is part-day, fill in the Start time and End time text 
boxes. Type in the times that you want, or use the up or down arrows to 
modify the displayed times.

3. Select Next Day next to the Start Time and End Time text boxes if the 
time-off starts on the day after the agents' shifts begin. Or select Next Day 
next to the End Time text box if the time-off begins on the same day as the 
agents' shifts begin, but ends on the day after.

4. If the time off is for the entire day, select the Full Day check box. This 
disables the start time and end time text boxes.

5. Click Finish to insert the selected time off and close the wizard. This 
returns you to the Intra-Day view.

If you want to review or change your entries in the Select State Type screen, 
click Previous. 

If you want to close the wizard without inserting the time off, click Cancel.

Review Messages Dialog Box

Use the Review Messages dialog box to respond to any warnings returned 
when you tried to save agents' edited schedules. 

1. For each Warning that is listed, check the items you want to insert and then 
click Insert for selected. To select all Warnings, use the Select All 
Warnings check box. 

2. Review all Errors. You cannot select the checkbox next to the Error. 

To cancel out without applying any changes, click Close.

The Review Messages dialog box includes the following columns and 
controls:

Date—Displays the schedule date.

Agent—Displays the agent whose schedule generated this message.

Message—Displays the message type (either Warning or Error), and the 
message text itself. 

Select All Warnings—Marks the check box for all Warnings.
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Repeat Insert—Closes the dialog box, applies your selected actions, and 
retrieves fresh data from the server.

Close—Closes the dialog box without saving or refreshing data.

Note: These errors and warnings are generated by schedule changes that you 
made manually in the Agent-Extended, Intra-Day, or Weekly view. 
They differ from Validation warnings and errors, which WFM Web 
generates during the schedule building process.

Delete Multiple Wizard 

Overview

Use the Delete Multiple function to remove one or more items from one or 
more agents' schedules at once. You can use the Delete Multiple Wizard to 
delete items from either schedule scenarios or the Master Schedule.

To use the Delete Multiple Wizard:

1. From the Agent-Extended, Intra-Day, or Weekly view's Actions toolbar or 
Actions menu, select Delete Multiple.

If you have unsaved changes, WFM Web prompts you to save them before 
proceeding. 

The Delete Multiple Wizard's first screen, Select Agents, opens.

2. Select the agents whose schedules you are editing. 

Note: If you are deleting items from the Master Schedule and you have 
the Approve Changes security permission, you can select the Auto 
commit deleted items check box to have your items immediately 
deleted from the Master Schedule. If you do not have the necessary 
security permission, this check box is cleared and disabled. In that 
case, any deletions that you make are pending, and they must be 
reviewed and approved before they can take effect in the Master 
Schedule.

If you are deleting items from a schedule scenario, you have the option to 
select the Auto commit deleted items check box. If selected, then your 
deletions are committed to your schedule scenario. If not selected, then 
your deletions go into a Pending state. They can be committed or rolled 
back by you using the Commit/Rollback Multiple wizard. Pending changes 
in a schedule scenario are not transferred to the Master Schedule when the 
scenario is published.

3. Click Next.
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4. Select the dates from which to delete items in the Select Dates screen, then 
click Next.

Warning! Any item that overlaps the dates and times selected will be 
deleted, even if it overlaps by as little as a minute.

5. In the Select State Types screen, select one or more states. Then click Next 
(for other schedule items).

6. Fill in the Select Breaks, Select Meals, Select Exceptions, or Select Time 
Off screen that appears next. Then click Finish.

The view reappears. If Auto-commit was on, your changes are committed to 
the schedule. If not, the changes are in a Pending mode.

Select Agents Screen

To fill in the Select Agents screen:

1. Select any combination of agents.

You can select individual agents from multiple teams, or you can select 
whole teams or the whole site. However, you can select only within the site 
for which you displayed the Agent-Extended, Intra-Day, or Weekly view.

2. If you want, select Delete only if there are no errors and/or Show 
warnings.

If you select the Delete only if there are no errors check box, then when 
you try to save the new items, WFM will not delete any of them if the 
server returns any schedule validation errors.

Note: If you select the Show warnings check box, WFM displays any 
schedule validation warnings that would be generated if you were 
to delete the items If schedule validation errors also occur, WFM 
does not delete any items from the schedule.

3. If you are deleting items from the Master Schedule and you have the 
Approve Changes security permission, you can select the Auto commit 
deleted items check box to have your deletions immediately made to the 
Master Schedule. If you do not have the necessary security permission, this 
check box is cleared and disabled. In that case, any deletions that you make 
are Pending. They must be reviewed and approved before they can take 
effect in the Master Schedule.

If you are deleting items from a schedule scenario, you have the option to 
select the Auto commit deleted items check box. If you do, then your 
deletions are committed to your schedule scenario. If not, then your 
deletions go into a Pending state. They can be committed or rolled back by 
you using the Commit/Rollback Multiple wizard. Pending changes in a 
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schedule scenario are not transferred to the Master Schedule when the 
scenario is published. 

4. Click Next to open the Select Dates screen.

Click Cancel if you want to close the wizard without saving your selection.

Select Dates Screen

The Select Dates screen contains a calendar. 

1. Select the date or dates from which you want to delete the schedule items.

The calendar works as described in How to Use the Calendar.

Note: If you are deleting from a schedule scenario, you cannot select 
dates that fall outside of the scenario's date range.

2. Click Next.

The Select State Type screen appears.

Note: Any item that overlaps the dates and times selected will be deleted, 
even if it overlaps by as little as a minute.

Select State Types Screen

To fill in the Select State Types screen:

1. Select the state or states that you want to delete. You can delete breaks, 
meals, exceptions, and/or time off.

2. Click Next. The screen that appears next depends on your selections on 
this screen. If you are deleting one state type, the screen for that state 
appears. Otherwise, the screens appear one after the other in the order 
Select Breaks, Select Meals, Select Exceptions, and Select Time Off.

If you want to review or change your entries in the Select Dates screen, click 
Previous.

Or, if you want to close the wizard without saving your selection, click Cancel.

Select Breaks Screen

To fill in the Select Breaks screen:

1. Select a break or breaks from the Select Breaks list. (If more breaks are 
hidden above or below the displayed list items, a vertical scroll bar appears 
to the right to help you reveal them.)

To select individual items, hold down the Ctrl key while you select. To de-
select, continue holding Ctrl and click the item(s) you wish to de-select.
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For a range of items, select the first item, hold down the Shift key, select 
the last item in the range. To revise the range, continue holding Shift and 
click the last item to be included in the range. 

The list shows all of the breaks that have been configured for the selected 
site in the WFM Configuration Utility. The list's columns show each 
break's full name, short name, how long it lasts, and whether the break is 
paid. You cannot select or clear the Paid check box here.

2. If you selected to delete meals, exceptions, or time off, click Next. 
Otherwise, click Finish to delete the selected breaks and close the wizard. 
This returns you to the Agent-Extended, Intra-Day, or Weekly view.

If you want to review or change your entries in the Select State Types screen, 
click Previous.

Or, if you want to close the wizard without saving your selection, click Cancel.

Select Meals Screen

To fill in the Select Meals screen:

1. Select one or more meals from the Select Meals list. (If more meals are 
hidden above or below the displayed list items, a vertical scroll bar appears 
to the right to help you reveal them.)

To select individual items, hold down the Ctrl key while you select. To de-
select, continue holding Ctrl and click the item(s) you wish to de-select.

For a range of items, select the first item, hold down the Shift key, select 
the last item in the range. To revise the range, continue holding Shift and 
click the last item to be included in the range. 

The list shows all of the meals that have been configured for the selected 
site in the WFM Configuration Utility. The list's columns show each meal's 
full name, short name, how long it lasts, and whether or not the meal is 
paid. You cannot select or clear the Paid check box here.

2. If you selected to delete exceptions or time off, click Next. Otherwise, 
click Finish to delete the selected meals and close the wizard. This returns 
you to the Agent-Extended, Intra-Day, or Weekly view.

If you want to review or change your entries in a previous screen, click 
Previous.

Or, if you want to close the wizard without saving your selection, click Cancel.

Select Exceptions Screen

To fill in the Select Exceptions screen:

1. Select one or more exceptions from the Select Exceptions list. (If more 
exceptions are hidden above or below the displayed list items, a vertical 
scroll bar appears to the right to help you reveal them.)
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To select individual exceptions, hold down the Ctrl key while you select. 
To de-select, continue holding Ctrl and click the exception(s) you wish to 
de-select.

For a range of exceptions, select the first exception, hold down the Shift 
key, select the last exception in the range. To revise the range, continue 
holding Shift and click the last exception to be included in the range. 

The list shows all of the exceptions that have been configured for the 
selected site in the WFM Configuration Utility. The list's columns show 
each exception's full name, its short name, whether it is paid, whether it is 
convertible to a day off, and whether it is a full-day exception. 

Note: The check boxes simply indicate the exception's configured 
properties. You cannot select or clear them here.

2. If you selected to delete time off, click Next. Otherwise, click Finish to 
delete the selected exceptions and close the wizard. This returns you to the 
Agent-Extended, Intra-Day, or Weekly view.

If you want to review or change your entries in a previous screen, click 
Previous.

Or, if you want to close the wizard without saving your selection, click Cancel.

Select Time Offs Screen

To fill in the Select Time Offs screen:

1. Select one or more time-off types from the Select Time Off list. (If more 
time-off types are hidden above or below the displayed list items, a vertical 
scroll bar appears to the right to help you reveal them.)

To select individual time-off types, hold down the Ctrl key while you 
select. To de-select, continue holding Ctrl and click the time-off type(s) 
you wish to de-select.

For a range of time-off types, select the first time-off type, hold down the 
Shift key, select the last time-off type in the range. To revise the range, 
continue holding Shift and click the last time-off type to be included in the 
range. 

The list shows all of the time-off types that have been configured for the 
selected site in the WFM Configuration Utility. The list's columns show 
each time-off type's full name, its short name, whether it is paid, and 
whether it counts toward the configured time-off limits. 

Note: The check boxes simply indicate the time-off type's configured 
properties. You cannot select or clear them here.
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2. Click Finish to delete the selected time-off items, and all other selected 
items, and close the wizard. This returns you to the Agent-Extended, Intra-
Day, or Weekly view.

If you want to review or change your entries in a previous screen, click 
Previous.

Or, if you want to close the wizard without saving your selection, click Cancel.

Commit/Rollback Multiple Wizard

Overview

Use the Commit/Rollback Multiple Wizard to commit or roll back all pending 
schedule changes for selected agents on selected dates. You can use this wizard 
in Agent-Extended, Intra-Day, or Weekly view for a schedule scenario or the 
Master Schedule.

Note: You must have the Approve Changes security permission enabled to 
commit pending changes to the Master Schedule. If you do not, you 
can use this wizard only to roll back pending changes. If you are 
working in a schedule scenario, then you can commit/rollback all 
pending changes.

Terminology

• Commit—Committing a pending change makes it part of the publically-
available scenario or Master Schedule. When a schedule scenario is 
published, only committed changes appear in the Master Schedule.

• Rollback—Rolling back pending changes removes them from possible 
inclusion in the scenario or Master Schedule. 

• Pending—A schedule change will be put in Pending status in three cases: 

1. The user making changes to the Master Schedule does not have security 
permissions to “Approve Changes” in the Schedule module

2. The user making changes to the Master Schedule does have permission to 
“Approve Changes,” but turns off the Auto-Commit icon.

3. The user is working with a schedule scenario and turns off the Auto-
Commit icon.

In all cases, the user must click the Save button in order for the changes to 
be evaluated by the system (and appropriate warnings generated). At that 
point, the changes go into a Pending state if any of the three conditions are 
met. 
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Users can see changes that are Pending because they will have an upside-
down red triangle (yield icon) in the left-most column of the schedule 
view. If, however, the user does have “Approve Changes” permission and 
does have the Auto-Commit icon enabled, then when the user clicks Save, 
barring any warnings, these changes will become Committed to the 
schedule.) 

So, with Pending changes, the user may invoke the Commit/Rollback 
wizard to either Commit Pending changes for selected agents and dates, or 
Roll those Pending changes back, which is basically Undoing those 
Pending changes for the selected agents and dates

If you have the Approve Changes permission, there are two additional ways to 
work with pending schedule changes:

• You can approve or reject pending changes to the Master Schedule using 
the Master Schedule Change Approval module. The Changes Approval 
module enables you to view each pending change before deciding whether 
to approve or reject them. Using the Commit/Rollback Multiple Wizard, 
you commit or roll back all changes for the selected agents and dates 
without seeing each change.

• You can commit or roll back all items in an agent's schedule day that have 
pending status directly in the Master Schedule Intra-Day or Master 
Schedule Agent-Extended views. To do so, right-click the row showing the 
agent's schedule and then select Commit or Rollback. If you are working 
in a schedule scenario, you can do this regardless of whether or not you 
have Approve Changes permissions.

To use the Commit/Rollback Multiple Wizard:

1. From the view's Actions toolbar or Actions menu, select 
Commit/Rollback Multiple.

If you have unsaved changes, WFM Web prompts you to save them before 
proceeding. 

The Commit/Rollback Multiple Wizard's first screen, Select Agents, opens.

2. Select the agents whose pending changes you want to commit or roll back.

3. Select whether to commit or roll back pending changes.

4. Click Next.

5. In the Select Dates screen, select the dates for which to save or delete 
pending items, then click Finish.

The view reappears. 

Select Agents Screen

To fill in the Select Agents screen:

1. Select any combination of agents.
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You can select individual agents from multiple teams, or you can select 
whole teams or the whole site. However, you can select only within the site 
displayed in the Agent-Extended, Intra-Day, or Weekly view.

2. Select Commit or Rollback.

If you do not have the Approve Changes security permission, the Commit 
check box is cleared and disabled. In that case, you can only roll back 
pending changes. 

3. Click Next to open the Select Dates screen.

Click Cancel if you want to close the wizard without saving or deleting 
pending changes.

Select Dates Screen

The Select Dates screen contains a calendar. 

1. Select the date or dates for which you want to commit or rollback all 
schedule items.

The calendar works as described in How to Use the Calendar.

Note: If you are working with a schedule scenario, you cannot select 
dates that fall outside of the scenario's date range.

2. Click Finish. This returns you to the Agent-Extended, Intra-Day, or 
Weekly view. If you committed items, these now appear in the schedule.

If you want to review or change your entries on the Select Agents screen, click 
Previous.

Or, if you want to close the wizard without saving your selection, click Cancel.

Modify Individual Agents' Schedules 

Overview

You can insert and edit schedule items for a particular agent using:

• Master Schedule Agent Extended or Intra-Day view

• Scenario Agent Extended or Intra-Day view

For example, you might want to reassign an agent from an overstaffed activity 
to an understaffed activity; or you might want to swap paid hours for a day off, 
due to a change in overall interaction volume.

You can insert and edit schedule items using shortcut menus. Once items are 
inserted, you can graphically move or resize certain items using your mouse. 
The following sections cover:
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• Using shortcut menus.

• Inserting full-day schedule items.

• Modifying full-day exceptions, days off, and full-day time off.

• Modifying shifts.

• Inserting and editing shift items.

• Moving and resizing shift items.

• Committing or rolling back pending changes.

Using Shortcut Menus

To display a shortcut menu:

• Right-click an agent's grid row at the timestep where you want to insert or 
edit a schedule item. (To zoom in on a particular timestep, clear the Full 
View check box and/or resize the columns.) 

To close a shortcut menu without selecting any of its commands: 

• Press Esc.

Inserting Full-Day Schedule Items

Right-click an agent timestep that contains schedule items to bring up a 
shortcut menu. The menu items available for selection depend on the full-day 
items that already exist (or do not exist) in the agent's schedule day. The table 
below discusses all menu items. 

Insert Day Off—Assigns the agent a day off, which appears as a light-green 
bar.

Insert Full-Day Time Off—Displays a window where you can select a full-
day time-off type. Once inserted, the time off appears as a dark-green bar (you 
can change the color with the Colors Tool).

Insert Full-Day Exception—Displays a window where you can select a full-
day exception type. Once inserted, the exception appears as a red bar.

Insert Shift—Displays a window where you can select a shift type and 
start/end times. Once inserted, the shift appears as a dark-blue bar with thick 
black borders (you can change the color with the Colors Tool).

Undo Changes—Restores this agent's schedule to the state in which it was last 
saved.

Insert Multiple—Enables you to insert schedule items for multiple agents or 
teams.

Copy Schedule—This menu item appears in Agent-Extended view. You can 
select a single agent schedule day, and use this option to select the Start and 
End dates to which you want to copy the selected schedule day.
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Modifying Full-Day Exceptions, Days Off, and Full-Day 
Time Off

Once a full-day exception, day off, or a full-day time off is inserted, you cannot 
delete or move or resize its bar in the grid. However, you can replace it by 
inserting a different full-day item.

When you right-click an inserted full-day exception, day off, or full-day time 
off, the existing item (Exception, Day Off, or Full-Day Time Off) does not 
appear on the full-day shortcut menu.

Modifying Shifts

Once a shift is inserted, you cannot delete its bar in the grid; but you can 
replace the bar by inserting a different full-day item. When you right-click an 
inserted shift, you see the shift items shortcut menu. 

To change the shift's start and/or end times, do one of the following:

• Use the shortcut menu's Edit command.

• Move or Resize the shift bar visually while holding down the Ctrl key.

Inserting and Editing Shift Items

Once an agent's schedule contains a shift (represented by a blue bar with thick 
black borders), you can insert and edit schedule items within that shift, or you 
can edit the shift itself.

• Right-click the shift to display a shortcut menu with the options listed 
below.

• When you move your mouse pointer over an option that ends with an 
arrow (>), a submenu displays further options.

Insert >—From the submenu, select Break, Meal, [part-day] Exception, [part-
day] Time Off, Marked Time, or Activity Set. Use the resulting dialog box to 
insert schedule items.

Edit >—From the submenu, select the activity set, shift, or other schedule item 
that you want to edit. Use the resulting Edit dialog box to adjust the item's start 
and/or end times.

Set Activities For >—From the submenu, select a Work or Activity Set. Use 
the resulting Set Activities dialog box to define the agent's work activities. 
Activity Sets appear in the grid as yellow bars.

Delete >—From the submenu, select the activity set or other schedule item that 
you want to delete from the schedule. 
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Note: Select carefully, because there is no confirmation prompt before the 
item is deleted. If a shift has only one activity set, you cannot delete 
that activity set, so the Delete command does not appear when you 
right-click it.

Commit—When working in the Master Schedule, if the agent's schedule day 
has pending items, and you have the Approve Changes security permission 
enabled, you can select Commit to have all that day's pending changes 
included in the schedule. If you are working in a schedule scenario and the 
agent's schedule day has pending items, you can select Commit to have all that 
day's pending changes included in the schedule.

Rollback—If the agent's day has pending schedule items, you can select 
Rollback to remove all pending changes for the agent for that day.

Undo Changes—Restores this agent's schedule to the state in which it was last 
saved.

Insert Multiple—Enables you to insert schedule items for multiple agents or 
teams.

Note: A warning message appears if your insertions or edits violate time 
constraints for the shift or for any shift item, including the timing and 
distribution of meals, breaks, and exceptions.

Moving and Resizing Shift Items

Once an agent's schedule contains a shift, you can use your mouse to move 
(drag and drop) or resize some of the shift's schedule items (activity sets, 
breaks, meals, and part-day exceptions) or the shift itself.

Moving an item changes both its start and end times, but maintains its duration. 
Resizing an item changes its start or end time, which changes its duration.

Note: An error message appears if your changes would create overlapping 
schedule items, or if they would violate time constraints for the shift or 
any shift item. (Some examples of time constraints are: WFM Web 
never moves meals or part-day exceptions along with shifts; some 
meals or part-day exceptions—depending on their configuration—
cannot occur outside shift hours.)

Moving a Shift Item

To Move a Shift Item

Note: If you want to move the shift itself, hold down the Ctrl key throughout 
the first two steps.
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1. Click in the middle of the schedule item and hold down the mouse button.

The mouse pointer changes to a four-pointed arrow.

2. Drag the item to the right or left. 

3. Release the mouse button (and any keys) when the item has the start and 
end times that you want.

A warning message informs you of any constraint violations.

Resizing a Shift Item

To Resize a Shift Item

Note: If you want to resize the shift itself, hold down the Ctrl key throughout 
the first two steps.

1. Click near a schedule item's start or end point and hold down the mouse 
button.

The mouse pointer changes to a two-pointed arrow. (If you see a four-pointed 
arrow, or if the point does not change at all, release the mouse button, and then 
click at the very edge of the item's colored bar.)

2. Drag the bar's start or end point to the right or left.

3. Release the mouse button when the item has the start or end time that you 
want.

A warning message informs you of any constraint violations.

Committing or Rolling Back Pending Changes

To include all pending changes that are in an agent's schedule for the selected 
day, or to remove them all:

1. Right-click the agent's schedule row in the Intra-Day view.

2. Select Commit or Rollback from the shortcut menu.

Note: If do not have the Approve Changes security permission enabled, you 
cannot select Commit.

Insert Shift Wizard

Use the Insert Shift Wizard to insert a shift into an agent's schedule:

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.

Click any timestep for any agent who does not have a scheduled shift. 

2. From the shortcut menu that appears, select Insert Shift.

The first of the Insert Shift Wizard's two screens, Select Shift, opens. 

3. In the Choose Item to Insert list, click a shift row to select it.
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The list shows the name and hours of each shift that was configured in the 
WFM Configuration Utility. If necessary, a vertical scroll bar appears to 
the right.

4. Adjust the shift's Start time and End times, as necessary.
 Select Next Day if the End time is on the day after the Start time. Your 

settings must match the shift type's configured time constraints.
 Select Automatically Insert Meals and Breaks to have meals and 

breaks automatically inserted along with the shift and optimized, based 
on schedule coverage, according to the constraints configured for this 
Shift in the Configuration Utility. If this option is unchecked, then the 
Shift will be inserted with no meals and breaks, and those can be 
inserted manually.

5. Click Next.

6. On the Select Activity Set screen, you can select:
 one or more work activities
 an activity set
 one or more activities associated with an activity set

If you are inserting a shift for an agent that can work on multiple activities, 
you can select multiple activities.

Note: The shift hours that you selected on the previous screen must be 
consistent with the activity set's configured time constraints. (Click 
Previous if you need to change the shift's start or end times.) 

7. Click Finish to insert the selected work activities or activity sets and close 
the wizard. 

Note: No warnings are displayed if the shift contains incorrectly configured 
shift items that cannot be inserted.

The view reappears. The new shift appears as a dark-blue bar (you can change 
the color with the Colors Tool).

Insert Break Dialog Box

Use the Insert Break dialog box to insert a break into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue 
shift bar (you can change the color with the Colors Tool).

Click at or near the timestep where you want the break to begin.

2. From the shortcut menu that appears, select Insert > Break.

The Insert Break dialog box opens. It shows the breaks that are associated 
with the selected shift. 
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Click Show all if you prefer to display all of the breaks that are configured 
for your site.

3. In the Choose Item to Insert list, click a break row to select it.

The list's first two columns show each break's full and Short name. 

The Hours column shows the break's configured duration in hours and 
minutes. 

A check mark in the Paid column indicates that the break time is paid. 
(You cannot select or clear check boxes to change this attribute here.)

4. Adjust the Start time and End time, as necessary.

Select Next Day if the End time is on the day after the Start time.

5. Click OK to insert the selected break and close the dialog box. 

The view reappears. The new break appears as a light-gray bar.

Insert Meal Dialog Box

Use the Insert Meal dialog box to insert a meal into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue 
shift bar (you can change the color with the Colors Tool).

Click at or near the timestep where you want the meal to begin.

2. From the shortcut menu that appears, select Insert > Meal.

The Insert Meal dialog box opens. It shows meals that are associated with 
the selected shift. 

Click Show all if you prefer to display all of the meals that are configured 
for your site.

3. In the Choose Item to Insert list, click a meal row to select it.

The list's first two columns show each meal's full and Short name. 

The Hours column shows the meal's configured duration in hours and 
minutes. 

A check mark in the Paid column indicates that the meal time is paid. (You 
cannot select or clear check boxes to change this attribute here.)

4. Adjust the Start time and End time, as necessary.

Select Next Day if the End time is on the day after the Start time.

5. Click OK to insert the selected meal and close the dialog box. 

The view reappears. The new meal appears as a light-blue bar.

Note: When you insert a meal using this dialog box, the schedule does not 
take into account the agent’s qualification for the meal.
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Insert Activity Set Dialog Box

Use the Insert Activity Set dialog box to insert an activity set into an agent's 
schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue 
shift bar (you can change the color with the Colors Tool).

Click at or near the timestep where you want the activity set to begin.

2. From shortcut menu that appears, select Insert > Activity Set.

The Insert Activity Set dialog box opens. 

3. Select an activity set, or one or more of its associated activities.

In the Choose Item to Insert tree, you can expand activity sets to display 
their activities. You can select a whole activity set, or one or more 
activities within any one activity set.

4. Adjust the Activity Set or selected Activity Start time and End times, as 
necessary.

Select Next Day if the End time is on the day after the Start time.

Note: Your settings must match the activity set's configured time 
constraints.

5. Click OK to insert selected activity set and close the dialog box.

The view reappears. Activity Sets appear as yellow bars (you can change the 
color with the Colors Tool).

Insert Exception Dialog Boxes

WFM uses different dialog boxes and menu items for part-day and full-day 
exceptions:

• Use the Insert Exception dialog box to insert a part-day exception into an 
agent's schedule.

• Use the Insert Full-Day Exception dialog box to insert a full-day exception 
into an agent's schedule. 

For example, you might need to schedule a full-day meeting or a one-hour 
appointment after the schedule was created.

Insert Exception Dialog Box

To insert a part-day exception:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue 
shift bar (you can change the color with the Colors Tool).

Click at or near the timestep where you want the exception to begin.
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2. From the shortcut menu that appears, select Insert > Exception.

The Insert Exception dialog box opens. The agent's name appears in the 
title bar.

3. In the grid, click an exception row.

The grid shows the part-day exception types that are configured in the 
WFM Configuration Utility. If necessary, a vertical scroll bar appears to 
the right.

The first two columns show each exception's full and short name. 

Check marks in the remaining columns indicate whether the exception is 
paid, whether it is convertible to a day off, and whether it counts as time 
off. You cannot select or clear check boxes to change these attributes here.

4. Adjust the Start time and End time for this exception.

Select Next Day next to the Start Time and End Time text boxes if the 
exception starts on the day after the agent's shifts begin. Or select Next 
Day next to the End Time text box if the exception begins on the same day 
as the agent's shifts begin, but ends on the day after.

5. Click OK to insert the selected exception and close the dialog box. 

The view reappears. The new exception appears as a red bar (you can change 
the color with the Colors Tool).

Note: If the Start and End times would place the exception outside the agent's 
shift hours, a warning message appears. If an agent's activities are all 
scheduled in activity sets, and you assign a long exception, the 
exception may be the only schedule state group available during the 
agent's paid hours.

Insert Full-Day Exception Dialog Box

To insert a full-day exception:

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.

2. From the shortcut menu that appears, select Insert > Full-Day Exception.

The Insert Full-Day Exception dialog box opens. The agent's name 
appears in the title bar.

3. Click an exception row.

The list shows the full-day exception types that were configured in the 
WFM Configuration Utility. If necessary, a vertical scroll bar appears to 
the right.

The first two columns show each exception's full and short name. 

Check marks in the remaining columns indicate whether the exception is 
paid, whether it is convertible to a day off, and whether it counts as time 
off. You cannot select or clear check boxes to change these attributes here.
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4. In the Specify Start/End section, you can optionally adjust the exception's 
Start time and End time as necessary.

Select Next Day next to the Start Time and End Time text boxes if the 
exception starts on the day after the agent's shift begins. Or select Next 
Day next to the End Time text box if the exception begins on the same day 
as the agent's shift begins, but ends on the day after.

5. If you selected a paid exception, you can select the Specify Paid Hours 
check box to enter a duration other than the default number of hours in a 
work day. 

6. If you select the Specify Paid Hours check box, the Paid Hours check box 
becomes enabled. 

Note: If you enter a start/end time but do not enter a value for Paid 
Hours, then Paid Hours will equal End Time minus Start Time 
(known as Total Hours or Duration).

Click OK to insert the selected exception and close the dialog box. 

The view reappears. The new exception shows as a red bar.

Insert Time Off Dialog Boxes

WFM uses different dialog boxes and menu items for part-day and full-day 
time-off schedule items:

• Use the Insert Time Off dialog box to insert part-day time off into an 
agent's schedule.

• Use the Insert Full-Day Time Off dialog box to insert full-day time off into 
an agent's schedule. 

For example, an agent might be called to jury duty or need to be out sick after 
the schedule is created.

Inserting Part-Day Time Off

To insert a part-day time off schedule item:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue 
shift bar (you can change the color with the Colors Tool).

Click on the bar or near the timestep where you want the time off to begin.

2. From the shortcut menu that appears, select Insert > Time Off. 

The Insert Time Off dialog box opens. The agent's name appears in the title 
bar.

3. In the list of time-off types, click the row for the time-off type that you 
want to insert. 
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Select the Show all checkbox to display all Time Off types. Clear the 
checkbox to display only Time Off types that are applicable to the selected 
agent. See Appendix D, "Time Off Primer" in the WFM Administrator's 
Guide.

The list shows part-day time-off types that were configured in the WFM 
Configuration Utility. If necessary, a vertical scroll bar appears to the right.

If you select a time-off type that is not associated with a selected agent, 
WFM assigns the time off but does not enforce the time-off balance rules. 
However, if the time-off type counts toward time-off limits, WFM takes 
this time-off item into account when calculating limits.

The first two columns show each time-off type's full and short name. 

Check marks in the remaining columns indicate whether the time off is 
paid and whether it counts toward time-off limits. You cannot select or 
clear check boxes to change these attributes here.

4. Optional: Adjust the Start Time and End Time for this time off, if the 
default values are not correct.

Select the check box Specify Start/End to enable the Start Time and End 
Time fields, then click inside each field to modify the default values for 
hours, minutes, and AM/PM.

Select Next Day to the right of the Start Time text box if the time-off starts 
on the day after the agent's shifts begin.

Select Next Day to the right of the End Time text box if the time-off ends 
on the day after it begins.

5. Optional: Specify a nonstandard length of your full-day time off. 

Select the Specify Paid Hours check box to enable the Paid Hours field, 
then click inside and enter or select a value to specify the exact number of 
hours in a full day for this particular time off.

Note: The Specify Paid Hours check box is enabled only if you selected a 
paid time-off type in the Choose Time Off list. 

6. Click OK to insert the selected time off and close the dialog box. 

The view reappears. The new time off appears as a dark-green bar (you can 
change the color with the Colors Tool).

Note: If the Start and End time would place the time off outside the agent's 
shift hours, a warning message appears. If an agent's activities are all 
scheduled in activity sets, and you assign a long time off, the time off 
may be the only schedule state group available during the agent's paid 
hours.
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Inserting Full-Day Time Off

To insert full-day time-off into an agent's schedule:

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.

2. From the shortcut menu that appears, select Insert > Full-Day Time Off.

The Insert Full-Day Time Off dialog box opens. The agent's name appears 
in the title bar.

3. In the list of time-off types, click the row for the time-off type that you 
want to insert. 

The list shows the full-day time-off types that were configured in the WFM 
Configuration Utility. If necessary, a vertical scroll bar appears to the right. 
If you select a time-off type that is not associated with a selected agent, 
WFM assigns the time off but does not enforce the time-off balance rules. 
However, if the time-off type counts toward time-off limits, WFM takes 
this time-off item into account when calculating limits.

The first two columns show each time-off type's full and short name. 

Check marks in the remaining columns indicate whether the time off is 
paid and whether it counts toward time-off limits. You cannot select or 
clear check boxes to change these attributes here.

Adjust the Start time and End time as necessary, by using the text boxes in 
the lower left of the dialog.

Select Next Day next to the Start Time and End Time text boxes if the 
time-off starts on the day after the agent's shifts begin. Or select Next Day 
next to the End Time text box if the time-off begins on the same day as the 
agent's shifts begin, but ends on the day after.

4. Optional: Adjust the Start time and End time for this time off, if the default 
values are not correct.

Clear the Full Day check box.

Select the check box Specify Start/End to enable the Start Time and End 
Time fields, then click inside each field to modify the default values for 
hours, minutes, and AM/PM.

Select Next Day to the right of the End Time text box if the time-off ends 
on the day after it begins.

5. Optional: Specify a nonstandard length of your full-day time off. 

Select the Specify Paid Hours check box to enable the Paid Hours field, 
then click inside and enter or select a value to specify the exact number of 
hours in a full day for this particular time off.

Note: The Specify Paid Hours check box is enabled only if you selected a 
paid time-off type in the Choose Time Off list. 

6. Click OK to insert the selected time off and close the dialog box. 
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The view reappears. The new full-day time off appears as a dark-green bar 
(you can change the color with the Colors Tool).

Insert Marked Time Dialog Box

Marked Time allows you to mark part or all of an agent's shift to track how that 
time is being spent by the agent. For example, you may want to mark extra 
time that an agent is working at the end of the day. You can see this marked 
time on the schedule, and you can run several reports to track how different 
types of marked time are used within the schedules.

Use the Insert Marked Time dialog box to insert marked time into an agent's 
schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue 
shift bar (you can change the color with the Colors Tool).

Click at or near the timestep where you want the marked time to begin. 
You can also click on a timestep outside of the shift. If you click on a 
timestep before the shift's current start time, you will be able to both extend 
the shift start time and insert the marked time between the new earlier start 
time, and the current start time, in one step. If you click on a timestep after 
the shift's current end time, you will be able to both extend the shift end 
time and insert the marked time between the current end time and the new 
later end time, in one step.

2. From the shortcut menu that appears, select Insert > Marked Time.

The Insert Marked Time dialog box opens. It shows the marked-time types 
that are configured for the selected site. 

3. In the list of marked-time types, click the row for the type that you want to 
insert. 

The list shows each marked-time type's full and short name. 

4. Adjust the Start time and End time, as necessary. 

Select Next Day next to the Start Time and End Time text boxes if the 
marked time starts on the day after the agent's shifts begin. Or select Next 
Day next to the End Time text box if the marked time begins on the same 
day as the agent's shifts begin, but ends on the day after.

5. Click OK to insert the marked time and close the dialog box. 

The view reappears. The new marked time appears in orange (you can 
change the color with the Colors Tool). If the marked-time period that you 
selected overlaps any time off, WFM Web generates an error message, and 
the marked time is not inserted.

For an explanation of how to display marked time, see Options Dialog View 
Options in the Master Schedule Intra-Day View topic or the Schedule Scenario 
Intra-Day View topic.
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Edit Item Dialog Box

Use the Edit Item dialog box to edit the start time, and the end time or duration, 
of an agent's schedule item.

1. In the Intra-Day or Agent-Extended grid, right-click an agent's shift or shift 
item.

To edit the shift itself, right-click anywhere in the shift. To edit a shift item 
(activity set, time off, marked time, break, or meal), right-click that item. 
See Edit Exception Dialog Box if you are editing an exception.

2. From the shortcut menu that appears, click or hover over Edit to display 
the Edit submenu.

3. From the submenu, select the item that you want to edit.

The submenu always includes the Shift option. If it omits the shift item that 
you intended to edit, press Esc to close the shortcut menu, and then right-
click again directly inside that shift item.

4. Adjust the Start time and End time, if you want to.

Select Next Day next to the Start Time and End Time text boxes if the shift 
item starts on the day after the agent's shifts begin. Or select Next Day 
next to the End Time text box if the shift item begins on the same day as 
the agent's shifts begin, but ends on the day after.

5. If you are editing a shift, you can select Move Items With Shift.

If you select this check box, you cannot directly edit the shift's end time. 
WFM Web calculates the end time based on the start time that you enter. It 
moves the whole shift and all shift items, except for meals and exceptions.

If you leave this check box cleared, you can specify the shift's start and end 
time.

The Move Items With Shift option appears only when you edit a shift.

6. Click OK to save your changes.

The dialog box closes if the edit is successful. The grid reflects your edits 
to this schedule item, and adjacent activity sets may automatically expand 
or contract to maintain a continuous schedule.

A warning message appears if the edit violates time constraints for the shift or 
any shift item. For example, WFM Web attempts to maintain the distribution 
of breaks and activity sets within shifts, and it never moves meals or 
exceptions along with shifts. Also, meals cannot occur outside shift hours.

Edit Exception Dialog Box

Use the Edit Exception dialog box to edit exceptions on the Schedule Intra-day 
or Agent-Extended view.

1. In the Intra-day or Agent-Extended grid, right-click the exception that you 
want to change.
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2. From the shortcut menu that appears, click or hover over Edit to display 
the Edit submenu.

3. From the submenu, select Exception.

You can either edit the parameters of the current exception or replace it 
with a new one from the exception list in the Edit Exception dialog box. 
Only valid exceptions are shown in the list. 

• Beginning with release 7.5, you can set start and end times for full-day 
exceptions. Select the Specify Start/End check box and enter or select the 
correct times in the Start time and End time text boxes.

• If you replace a part-day exception with a full-day exception, all other 
schedule items for that day are removed.

To edit exceptions:

1. If you are replacing the current exception with another one, select it from 
the list.

2. If it is a part-day exception, set start and end times.

3. If you selected a full-day, paid exception, you can select the Specify Paid 
Hours check box to enter a duration other than the default number of hours 
in a work day. If you select the Specify Paid Hours check box, the Paid 
Hours text box becomes editable. 

Note: If you enter a start/end time but do not enter a value for Paid 
Hours, then Paid Hours will equal End Time minus Start Time 
(known as Total Hours or Duration).

4. Select Next Day next to the Start Time and End Time text boxes if the 
exception starts on the day after the agent's shifts begin. Or select Next 
Day next to the End Time text box if the exception begins on the same day 
as the agent's shifts begin, but ends on the day after.

5. Click OK to save your changes or Cancel to discard them. 

The view reappears, showing the edited exception.

Set Activities Dialog Box

Use the Set Activities dialog box to modify an agent's activity set by adding or 
removing activities:

1. In the Intra-Day or Agent-Extended view, right-click an agent's shift or 
activity set. (The agent's schedule must already contain a shift with or 
without an activity set.)

2. From the shortcut menu that appears, select Set Activities For.

3. From the submenu, select the activity set that you want to modify.
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If right-clicking on dark blue activity work inside a shift, the submenu 
allows you to select Work (you can change the color with the Colors 
Tool). 

If right-clicking on a yellow activity set, the submenu also allows you to 
select Activity Set (you can change the color with the Colors Tool). 

Depending on your selection from this submenu, you will either edit the 
work activities or the activities inside the Activity Set.

The Set Activities dialog box opens. Its grid shows all activities that 
belong to the selected work or activity set. (If necessary, a vertical scroll 
bar appears to the right.)

In the first column, a check mark indicates activities that have already been 
assigned.

4. Add or remove activities.

Select a check box to add an activity.

Clear a check box to remove an activity.

You can add multiple activities within any one activity set.

5. Click OK to save your changes. 

If your changes violate no constraints, the dialog box closes and the view 
reappears.

If your changes would delete an activity set's last remaining activity, an error 
message appears. Use the Delete command to delete the activity set itself.

If your changes violate any constraints (for example, keeping too few activities 
to fill the activity set's hours of operation), a warning message informs you of 
the problem.

Copy Schedule Dialog Box

The Copy Schedule Dialog Box appears when you right-click an agent 
schedule and select Copy Schedule from the shortcut menu in:

• Scenario Agent Extended View

• Master Schedule Agent-Extended View 

The top of the Copy Schedule dialog box contains the date to be copied. 

To use this dialog box, specify the copy-to date range:

1. Click the date selector for Start date. Select the start date for the copy-to 
range.

2. Click the date selector for End date. Select the end date for the copy-to 
range.

3. Click OK. If the copy operation does not violate the agent's schedule 
constraints (maximum selection of six weeks and the Start and End dates 
must fall within the target schedule's date range (Master Schedule or 
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schedule scenario), WFM copies the selected schedule day from the Start 
date to the End date. If the operation does violate schedule constraints, the 
Review Messages dialog box opens.

4. Under Action, keep Save or click the down arrow and select Fix Later or 
Undo.

5. When through in this dialog box, click OK.

Meeting Scheduler Wizard
Use the Meeting Scheduler Wizard to schedule a meeting:

1. In the Schedule module, select one of these views: Master Schedule 
Weekly, <schedule> Weekly, Master Schedule Intra-day, <schedule> Intra-
day.

2. At the top right of the Work pane, select the week that you want to 
schedule the meeting.

3. Click the Meeting Scheduler icon .

4. At the Select Agents dialog, choose the Agents who should attend.

5. At the Specify Meeting Parameters dialog, select the meeting type, 
possible dates, possible times, duration, and minimum percentage of 
required attendees.

A message box appears, listing how many agents were scheduled for the 
meeting. Click OK.

6. If some agents were not scheduled, a message box may appear listing 
them. Click OK.

The meeting is scheduled, and exceptions, representing meeting, get inserted 
into the schedule.

Meeting Scheduler vs. Meeting Planner

The Meeting Scheduler is best suited for scheduling ad hoc meetings and other 
meetings that you did not know about when you built the original schedule.

The Meeting Planner (available through the WFM Configuration Utility) is 
useful for scheduling pre-planned meetings especially ones that recur, such as 
weekly team meetings or bi-weekly one-on-one coaching sessions. 

Master Schedule
Use the Master Schedule views to display and modify Master Schedule data. 

If your access rights include access to the Master Schedule, the Schedule 
branch in the Modules tree displays the following Master Schedule views:
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Master Schedule
Coverage View

Compares staffing coverage to forecasted (calculated and required) staffing 
data, and highlights overstaffed or understaffed timesteps.

Master Schedule
Weekly View

Displays a weekly summary table of total paid hours, working start/end times, 
or shift names for a site's agents and/or profiles. 

Master Schedule
Intra-Day View

Displays Master Schedule details for a 24- or 36-hour period, enabling you to 
modify schedules for individual or multiple agents and profiles.

Unless you have the Approve Master Schedule Changes security permission, 
your changes are entered in pending mode. An approver with the Approve 
Master Schedule Changes security permissions must then accept or reject the 
changes.

Unless you have the Approve Changes security permission, your changes are 
entered in pending mode. An approver with the Approve Changes security 
permissions must then accept or reject the changes.

You can view your pending changes in the Weekly, Agent-Extended, and Intra-
Day views.

Master Schedule
Agent-Extended

View

Displays and allows editing of a single agent's schedule for one week or the 
schedule planning period.

Master Schedule
Summary View

Displays service-level and related statistics for the Master Schedule.

Master Schedule
Changes Approval

View

Enables users with the appropriate security permissions to review pending 
schedule changes, and approve or reject them.

Master Schedule
State Group Totals

View

Displays coverage statistics for every timestep in a selected day.

Click a branch in the Modules tree to open the corresponding view. (Or use the 
Views toolbar's Scenarios drop-down list to move among these views.)

Master Schedule Coverage View

Use the Master Schedule Coverage view to compare the Master Schedule's 
staffing coverage with the forecasted (calculated and required) staffing data. 

Graphs and tables show you coverage for each weekday in the selected week, 
along with totals for the whole week. Overstaffed and understaffed timesteps 
appear in a distinctive color.

The following sections cover:

• Displaying the Coverage view.

• Using the Daily graphs and tables.

• Reading the Totals table.

• Customizing the Coverage view.

• How understaffing and overstaffing are calculated.
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Displaying the Coverage View

To display the Coverage view:

1. In the Modules tree, click Master Schedule Coverage.

The Master Schedule Coverage view appears.

In the Objects tree, select sites and/or activities.

You can select a single business unit, a single site within a business unit, or a 
single activity within a site.

Using the Daily Graphs and Tables

The Coverage view displays the following information for days of the week: 

Graphs—Display coverage information for each day, with a data point for 
each timestep. Click the Chart Type down arrow to select calculated staffing, 
required staffing, or both. A blank graph indicates a closed site (or no 
scheduled activity) for the day.

Tables—Display overstaffing and understaffing totals for each day, with 
respect to calculated and/or required staffing. Contractual constraints and other 
configured parameters can reduce a schedule's optimization.

Legend—Explains the significance of each color that is used in the graphs.

Reading the Totals Table

The Totals table (at the lower right) displays overstaffing and understaffing 
totals for the selected week, with respect to calculated and/or required staffing.

Customizing the Coverage View

To customize the schedule coverage data that is presented, use these controls at 
the top of the working pane:

Chart Type—Click the Chart Type down arrow to choose the type of graphs 
that you want to be displayed:

• Advanced—Graphs present both calculated and required information. 
Calculated information appears as an area graph with 
overstaffing/understaffing data, and required staffing appears as a linear 
graph.

• Calculated—Graphs present calculated information with 
overstaffing/understaffing data.

• Required—Graphs present required information with 
overstaffing/understaffing data.

Cleanup—Opens the Cleanup window, where you can delete Master Schedule 
information for selected dates and agents.
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Date—Use the standard date-selection controls to move to other weeks.

How Understaffing and Overstaffing Are Calculated

Any timestep can be subject to either understaffing or overstaffing. WFM 
calculates these conditions by evaluating Coverage against Forecast. The result 
is displayed in Time format (hh:mm). 

Understaffing = The Forecast is greater than the Coverage — there are too few 
agents on duty.

Overstaffing = The Forecast is less than the Coverage — there are too many 
agents on duty.

Note: Coverage is measured by evaluating the agents’ contributions against 
the presented activities. These contributions are based on the agents' 
scheduled activities for each time interval, and on any schedule items 
that affect these scheduled activities for an interval (such as a break 
that occurs during only part of an interval).

Totals are calculated by summing Understaffing/Overstaffing for all activities 
for a given time range (because each single Understaffing/Overstaffing value is 
for one timestep).

Master Schedule Weekly View

Use the Master Schedule Weekly view to display a summary table of total paid 
hours, working start/end times, or shift names, for all selected agents and/or 
profiles within a single site. An example view is shown below. 

You can also see a summary table of total paid hours, working start/end times, 
or shift names for your schedule planning period. See Mode for details. 

When displaying the Master Schedule Weekly view, you can use the Intra-Day 
Schedule Rebuild Wizard.

The following sections cover:

• Displaying the Weekly view.

• Using the table.

• Customizing the Weekly view.

Displaying the Master Schedule Weekly View

To display the Master Schedule Weekly view:

1. In the Modules tree, click Master Schedule Weekly.

The Master Schedule Weekly view appears.

2. In the Objects tree, select a site, teams, and/or agents.
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You can expand business units to display their sites, and you can expand 
sites to display their teams and agents. You can work with only one site at a 
time, but you can select any number of agents and/or teams within that site.

3. Click Get data to populate the Weekly view table for the selected agents.

You can search the table for particular agents using the Find Agent dialog box. 
To open it, select Find from the Edit menu or press [Ctrl] + F.

Using the Table

The Weekly View table contains rows for each agent that you selected in the 
Objects tree. (If a scroll bar is displayed to the right, you can use it to reveal 
more agents.) This table includes the following columns:

[Expand/Collapse]—If in Planning Period mode, the first column provides 
expand/collapse controls that you use to display or hide agent details.

Team—This column lists each agent's team.

Agent—Two columns show an icon representing each agent's contract and the 
agent's name.

[Week Start Dates]—If you display agent details and you are in Planning 
Period mode, the rows below each agent's name indicate the start date for each 
week in the schedule.

[Weekdays]—These cells show agent schedule information for each weekday, 
for each week in the schedule. The cells' contents correspond to your selection 
from the Show Data for drop-down list.

If an agent is not scheduled for a shift on this day, the cell will contain: 
Day Off, Vacation, Working Hours (for scheduled working hours without a 
shift), or an exception name (for scheduled full-day exceptions).

An icon in the cell for a weekday indicates whether the schedule has been 
changed for that agent. 
 If the agent's schedule for that day was assigned during scheduling or 

rescheduling, no icon appears. 
 If the agent's day was edited after scheduling or rescheduling, a light-

gray pencil icon appears.
 If the agent's day was assigned by trading or swapping, the swap icon 

appears.
 A yield icon (upside down red triangle) appears if there are pending 

changes. Pending changes must be committed by a user with Approve 
Changes security permission.

 An icon and red check box appears for every schedule day that 
contains a granted calendar item (if the option Show agents with 
granted and scheduled rotating pattern or any other calendar preference 
is selected in the Options dialog box).
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Note: If there have been multiple changes, the icon represents the most 
recent status.

Weekly Totals—Shows an agent's total working hours for the displayed week.

Long (Planning) Period Totals—Shows an agent's or profile's total paid hours 
for the schedule planning period. This period's duration and start date are set in 
the WFM Configuration Utility's Policies > Contracts> Contracts General tab.

The Weekly Totals and Period Totals boxes below the table show a grand total 
of all weekly or planning period total paid hours (respectively) for all selected 
agents.

Customizing the Master Schedule Weekly View

To customize the displayed table, use these controls at the top of the working 
pane:

Show Data for

From this drop-down list, select what you want to display inside each day's 
table cell:

Total Paid Hours—Total working time for the day.

Working Start/End Time—Start and end times of agents' work.

Shift Names—Names of agents' assigned shifts.

Mode

Select 1 Week or Planning Period from the Mode drop-down list. The table 
displays data for the selected period. If no schedule planning period was 
configured in the WFM Configuration Utility, the Planning Period option is 
disabled. 

Planning Period Mode 

Planning Period mode displays schedules for the entire planning period. White 
and dark gray indicate the type of date range that you are viewing.

Planning Period
Color Legend

White—Indicates dates that fall within the planning period. 

Dark Gray—Indicates dates that are outside the planning period. 

Date

Use the standard date-selection controls to move to other weeks.
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Toolbar Buttons

You can use the following buttons on the Actions toolbar (or commands in the 
Actions menu) to further customize the displayed table:

Cleanup—Opens the Cleanup Master Schedule window. Enables you to delete 
Master Schedule information for selected dates and agents.

Rebuild intra-day schedule—Opens the Intra-day Schedule Rebuild Wizard 
to rebuild an Intra-Day schedule for a specific day or time period for a site, 
team, or agent.

Options—Opens the Options dialog box. Enables you to select/de-select the 
Agent Rank column.

Filter—Opens the Filter dialog box. Enables you to filter the displayed 
information according to activities and contract types. (If you set a new filter, 
this immediately refreshes the view.)

Sort—Opens the Sorting dialog box, which allows sorting by name, owner, 
sharing, time of creation, time of last modification, scenario start date, or 
scenario end date. You can sort in ascending or descending order.

Swap—Enables you to swap two agents' schedules with the Swap Agent 
Schedule Wizard.

Insert Multiple—Opens the Insert Multiple Wizard, which enables you to add 
multiple items to the Master Schedule at one time.

Delete Multiple—Opens the Delete Multiple Wizard, which enables you to 
remove multiple items from the Master Schedule at one time.

Commit/Rollback Multiple—Opens the Commit/Rollback Multiple Wizard, 
which enables you to insert pending changes into the Master Schedule or to 
remove them and return the Master Schedule to its former settings.

Meeting Scheduler—Opens the Meeting Scheduler Wizard.

Note: You can save changes from within the Master Schedule Weekly view 
only if you have appropriate access rights.

Weekly View Options Dialog Box

Use the Options dialog box to display/hide the Agent Rank column in the 
Schedule Scenario and Master Schedule Weekly views. To open this dialog 
box:

• Click the Options button on the toolbar or select Options from the Actions 
menu.

The dialog box that opens for Weekly view has two tabs, Options and 
Columns.

On the Options tab:
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1. Select Show agents with granted and scheduled rotating pattern or any 
other calendar preference to display an icon and red check box <near the 
agent> for every schedule day that contains a granted calendar item.

2. Click Apply to save.

On the Columns tab:

1. Select Agent Rank to display the column; de-select to hide the column.

2. Click Apply to save.

Master Schedule Intra-Day View

Overview

Use the Master Schedule Intra-Day view to manage schedule details for agents 
and profiles, for a specific day in the Master Schedule. 

If you selected the Show Performance Information check box on the 
Performance tab of the Options dialog box, this window also shows 
performance data in a graph. If you have cleared the Full View check box, data 
is also shown in a table. 

You can modify schedule items for individual agents or profiles here, and you 
can insert schedule items for multiple agents and/or profiles. The following 
sections and links cover:

• Displaying the Intra-Day view.

• Using the grid.

• Customizing the grid.

• Modifying multiple agents' schedules.

• Modifying individual agents' schedules.

• Searching for an agent.

• Viewing performance data.

• Using the Intra-Day Schedule Rebuild Wizard.

Displaying the Intra-Day View

To display the Intra-Day view:

1. In the Modules tree, click Master Schedule Intra-Day.

The Master Schedule Intra-Day view appears.

2. In the Objects tree, select a site, teams, and/or agents.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can work with only one site at a time, 
but you can select any number of agents and/or teams within that site.

3. Click Get data to display the Intra-Day view for the selected agents.
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Using the Grid

The Master Schedule Intra-Day view includes a grid with one row per agent 
and the following fields and controls. You can sort by team, agent, contract, 
start time, shift start time, paid hours, overtime, and total hours, by clicking on 
the header for that column.

Note: Double-click on cells containing these items, to edit them: Shift, 
Activity Set, Time Off, Meal, Break, Exception, Marked Time.

Auto-Commit—This button toggles on and off the auto-commit feature. If it is 
on, changes are immediately applied to the Master Schedule. If it is off, the 
changes have pending status and can be committed/approved before they are 
incorporated in the official version of the Master Schedule.

Note: If you do not have the Approve Changes security permission for the 
Master Schedule, the auto-commit button is disabled.

Full View—Select the Full View check box to have the Intra-day grid display 
the entire day. If you clear this check box, the grid shows a more detailed view. 

Options—Enables you to customize the view by selecting options that cover 
agent availability, 24-hour or 36-hour display, marked time, performance data, 
and whether to display or hide the Overtime, Paid Hours, Total Hours, Start 
Time, and Comment columns. For more information, see the Options Dialog 
Box topic.

Scheduled agents—This indicator shows the number of agents displayed 
(based on your selection in the Objects tree).

Edited schedules—This indicator shows the number of agents whose 
schedules you have edited in this view, but not yet saved.

Date—These controls are standard date selectors.

! (Save Messages/Warnings)—This column contains icons that provide 
information about the agents' schedules. 

• A yellow pencil icon indicates an item that generated a warning and you 
selected the Fix Later option. 

• A green pencil icon indicates schedule items that you have changed but not 
yet saved. 

• A red pencil icon indicates an item that generated an error. (Error 
conditions are more serious than warning conditions.) 

• A light-gray pencil icon appears if the agent's day was edited after 
scheduling or rescheduling.

• A Swap icon appears if the agent's day was assigned by trading or 
swapping.
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• A Yield icon (upside down red triangle) appears if there are pending 
changes. Pending changes must be committed by a user with Approve 
Changes security permission.

• An icon and red check box appears for every schedule day that contains a 
granted calendar item (if the option Show agents with granted and 
scheduled rotating pattern or any other calendar preference is selected in 
the Options dialog box).

Double-click a yellow or red icon to review message details and resolve 
the unsaved items.

Team—This column shows each agent's assigned team.

Agent—This column shows each agent's name.

Overtime—If displayed (using the Options dialog box), this column shows the 
duration of overtime for each agent on the selected day.

Paid Hours—If displayed (using the Options dialog box), this column shows 
each agent's paid hours for the selected day.

Total Hours—If displayed (using the Options dialog box), this column shows 
each agent's total hours for the selected day.

Start Time—If displayed (using the Options dialog box), this column shows 
each agent's start time for the selected day's work.

* (Comment)—If this column is displayed (using the Options dialog box), an 
asterisk (*) indicates that a comment was saved for the indicated agent and 
schedule day. 

Double-click a column cell to view or edit comments.

[Timesteps]—These columns indicate the agent's schedule items in each 
timestep. To see greater detail, clear the Full View check box and/or resize the 
columns.

To make changes to one agent's schedule at a time, right-click the timestep that 
you want to modify and then select the command from the shortcut menu. See 
Modify Individual Agent's Schedules for instructions and explanations.

[Horizontal scroll bar]—This scrollbar appears below the grid when clearing 
the Full View check box causes some timesteps to be hidden offscreen. Scroll 
it to the right to display later timesteps.

Legend—Identifies the particular type of schedule item that each bar color in 
the grid indicates.

Details—When you click an agent's row, this field lists the agent's scheduled 
activities on the selected day.

Customizing the Grid

You can display more timesteps by resizing some columns to the left of the 
grid. For details, see the Getting Started Overview.
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Searching for an Agent

To find a specific agent in the Master Schedule Intra-day view:

1. You can search the table for particular agents by using the Find Agent 
dialog box. To open it, select Find from the Edit menu or press [Ctrl] + F.

The Find Agent dialog box opens. You can search by first or last name. 

2. Enter part or all of the agent's name and then click OK. 

The Master Schedule Intra-day view display shifts to display information for 
the selected agent.

Toolbar: Modifying Multiple Agents' Schedules

Use the following buttons on the toolbar (or commands in the Actions menu) 
to modify multiple agents' schedules at once, or to further customize/cleanup 
the displayed grid:

Cleanup—Opens the Cleanup Master Schedule window, which enables you to 
delete Master Schedule information for selected dates and agents.

Rebuild intra-day schedule—Opens the Intra-Day Schedule Rebuild Wizard. 
Use this wizard to rebuild an Intra-Day schedule for a specific day or time 
period within a day for a selected site, team, or agent.

Options—Opens the Options dialog box. Enables you to customize the view, 
including whether to show agent availability, use a 24-hour or 36-hour display, 
display marked time on top, display performance data, and display or hide the 
Overtime, Paid Hours, Total Hours, Start Time, and Comment columns.

Filter—Opens the Filter dialog box. Enables you to filter the displayed Master 
Schedule information. (If you set a new filter, this immediately invokes Get 
data.)

Sort—Opens the Sorting dialog box.

Swap—Opens the Swap Agent Schedule Wizard, which enables you to swap 
two agents' schedules.

Insert Multiple—Opens the Insert Multiple Wizard, which enables you to 
insert breaks, meals, and exceptions for multiple agents or teams.

Delete Multiple—Opens the Delete Multiple Wizard, which enables you to 
remove multiple items from the Master Schedule at one time.

Commit/Rollback Multiple—Opens the Commit/Rollback Multiple Wizard, 
which enables you to insert pending changes (changes entered when auto-
commit was off or disabled) into the Master Schedule or to remove them and 
return the Master Schedule to its former settings. 

Save—If you have the appropriate access rights, clicking this button saves any 
Master Schedule changes that you have made in this view. If the server cannot 
save all changes, red or yellow icons in the grid's first column indicate those 
agents for whom you must correct errors or acknowledge warnings.
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Auto-Commit—Toggles the auto-commit feature on and off (or you can select 
Auto-Commit from the Actions menu). If on, changes are immediately applied 
to the Master Schedule. If off, changes have pending status and can be 
committed/approved before they are incorporated in the official version of the 
Master Schedule.

If you do not have the security permission Approve Changes for the Master 
Schedule, the auto-commit check box is cleared and disabled.

Meeting Scheduler—Opens the Meeting Scheduler, which enables you to 
schedule meetings to already build scenario for selected agents.

To make detailed schedule changes for one agent at a time (such as inserting, 
editing, or deleting the agent's schedule items), see Modifying Individual 
Agents' Schedules.

If you make schedule changes in the Intra-Day view and do not click Save, you 
are prompted to save your changes when you select a different module or view, 
or when you launch certain wizards or child windows.

Performance Data Display

Selecting the Show Performance Data check box on the Performance tab of the 
View Options dialog box adds a graph and a table to the Master Schedule 
Intra-day display.

Note: The table appears only if you clear the Full View check box.

To configure the performance data views:

1. Select a target for the performance data by clicking the ellipsis (...) button 
next to the Target: label. This list that appears contains both the activities 
that are associated with the site selected on the Objects pane and the multi-
site activities that are associated with the current schedule. If no site is 
selected, the list contains only multi-site activities.

2. Select the granularity in which performance data should be presented: 15, 
30, or 60 minutes. 

3. Select the type of data to be displayed in the graph and table.

• Schedule coverage appears as a red line on the graph. To configure the 
graph, select a value from the Chart Type drop-down list: Calculated 
(appears on the graph in blue), Required (appears on the graph in yellow), 
or Advanced (both Calculated and Required; appears on the graph as a blue 
area for the calculated staffing and as a yellow line showing the required 
staffing). By default, the graph shows Calculated staffing.

• The table always displays values for schedule coverage and calculated 
staffing. It may show additional figures, depending on your selections on 
the Performance tab of the Options dialog box. 
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If you are not using automatic updates, click the Refresh Performance Data 
button to update the performance data view. You can select Update 
Automatically on the Performance tab of the Options dialog box. 

The label Multi-Skill Enabled appears on the right end of the Performance 
Data Display if you enabled the SplitMS option in Configuration Manager. For 
more information, see the "Enabling Multi-Skill Support" section in the current 
Workforce Management Administrator's Guide. 

Performance Data Target

To view performance data in the Master Schedule or Schedule Scenario Intra-
Day view, you must choose a target. The target is the source of the 
performance data. You can select the Enterprise, a business unit, a site, or an 
activity (either multi-site or single-site).

To open the Select Target window:

• Click Target... on the Schedule Intra-Day view window.

Note: This option is available only if you have chosen to view performance 
data by selecting the Show Performance Information check box on the 
Performance tab of the View Options dialog box.

Options Dialog Box

Use the Options dialog box to configure the data that is shown on the:

• Intra-Day view or Agent Extended view for the current scenario. 

• Master Schedule Intra-Day or Master Schedule Agent-Extended view.

To open the Options dialog box:

• Click the Options button on the Actions toolbar or select Options from the 
Actions menu.

The Options dialog box appears. 

• When called from an Intra-Day view, it has three tabs: Options, 
Performance, and Columns. 

• When called from an Agent-Extended view, it two tabs: Options and 
Columns.

Each tab is described below. After you are done configuring the Options dialog 
box, click Apply to save your changes, or Cancel to restore the original 
selections.

The Options dialog box closes and the view refreshes. The settings that you 
configure for a scenario or the Master Schedule appear whenever you return to 
the view for that scenario or for the Master Schedule, until you log off.

To configure options in this dialog box:
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1. If you do not need the Legend to appear, you can clear the Show Schedule 
Legend check box to provide more space for the grid.

2. If you want to see agent availability on the grid, select the Show Agent 
Availability check box. Hours when an agent is unavailable are then shown 
in light gray on the grid.

3. Select the check box Show agents with granted and scheduled rotating 
pattern or any other calendar preference to see which schedule days 
contain such an item. The result: a red check box and Agent icon appears 
in the leftmost column (labeled "!") for every Agent who meets these 
conditions.

Note: You can use this tool to learn whether an agent was given a 
schedule based on a schedule preference, which might influence 
your decision to modify this agent's schedule. This icon is 
displayed only if the agent was given a rotating pattern or 
preference (such as for time off) as a result of building a schedule. 
If an agent’s schedule is manually edited to give him one of his 
preferences, or a schedule from a rotating pattern, then the icon 
will not be shown.

Select the radio button for the hours you want to show, 24 to show 24 
hours or 36 to show 36 hours.

Select the Presentation type: Schedule only, Schedule on top, or Marked 
time on top. Your selection affects the colored bars in the schedule. If 
Schedule only is selected, you cannot see Marked time.

To configure the Performance tab (not available in Agent-Extended view):

1. If you select the Show Performance Information check box, you can 
further customize exactly what performance information WFM Web shows 
on the Intra-Day Schedule view. If you clear this check box, the rest of the 
options on this tab are disabled.

2. If you prefer not to see the legend that explains the colors used to 
distinguish performance data, clear the Show Performance Legend check 
box.

3. The Update Automatically check box determines whether schedule 
changes are shown when they happen. Clear this only if you have network 
bandwidth issues that make automatic updates a problem.

4. If you selected to view performance data, you can select the check boxes to 
show additional information in the performance table. 

Note: You see the table only if the Full View check box is not selected.

In addition to scheduled coverage and calculated staffing, which always 
appear, you can select any or all of the following options to appear in the table:
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• Required Staffing

• Difference between Coverage and Calculated Staffing

• Difference between Coverage and Required Staffing

• Scheduled Service Level Percentage

• Scheduled ASA (Average Speed of Answer)

To configure the Columns tab:

• Select the check boxes for the optional columns that you want to display. 
Clear the check boxes for any columns that you want to hide. For Intra-
Day and Agent-Extended views, you can add the following columns: 
Overtime, Paid Hours, Total Hours, Start Time, Comments. In Intra-Day 
view, all columns are sortable, except for Comments. In Agent-Extended 
view, these columns are not sortable.

Review Messages (Save) Dialog Box

Use this dialog box to respond to any warnings or errors that the server 
returned during your last attempt to save an agent's edited schedule. 

The dialog box includes the following columns and controls:

Team—Displays the team to which this agent belongs.

Agent—Displays the agent whose schedule generated this message.

Message—Displays the message type (either Warning or Error), numeric code, 
and the message text.

Action—Use each message's drop-down list to select an action in order to 
resolve the warning or error: 

Save—Saves the edited agent schedule. This is the default action for 
warnings. It is unavailable for agent schedules whose edits generated errors 
(which are more severe than warnings).

Fix Later—Does not attempt to save the agent schedule, but keeps it in the 
Intra-Day grid so that you can further modify it. This is the default action 
for agent schedules whose edits generated errors.

Undo—Discards the change that caused the warning or error to be 
generated.

OK—Closes the dialog box, applies your selected actions, and retrieves fresh 
data from the server.

Cancel—Closes the dialog box without saving or refreshing data.

Note: These errors and warnings are generated by schedule changes that you 
made manually in the Intra-Day view. They differ from Validation 
warnings and errors, which WFM Web generates during the schedule 
building process.
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Master Schedule Agent-Extended View

Use the Master Schedule Agent-Extended view to display/edit a single agent's 
schedule for one week or the schedule planning period. The figure below 
shoClick the toolbar buttons on the image to jump to their descriptions below. 

Note: A legend at the bottom of the window indicates the particular type of 
schedule item that each bar color represents.

You can modify schedule items for individual agents or profiles here, and you 
can insert schedule items for multiple agents and/or profiles. The following 
sections and links cover:

• Displaying the Agent-Extended view.

• Using the Agent-Extended view grid.

• Customizing the Agent-Extended view grid.

• Using the Agent-Extended view toolbar buttons.

• Modifying an agent's schedule.

Displaying the Master Schedule Agent-Extended View

To display this view:

1. In the Modules pane, expand the Schedules module. 

2. In the Modules tree, click Master Schedule Agent-Extended. 

If already accessed during the current session, the Agent-Extended view 
appears with the last selected agent. 

If accessed for the first time, an empty Agent-Extended view grid appears. 
The Objects tree displays the business unit/site(s)/team(s) associated with 
the Master Schedule. 

3. Expand the Objects tree and select a single agent. You can work with only 
one agent at a time.

Using the Master Schedule Agent-Extended View Grid

The Agent-Extended view includes a grid for the selected agent. Each row in 
the grid contains a color coded bar. Each bar represents a scheduled day or day 
off for the selected agent. The table below explains the fields and controls.

Note: Double-click on cells containing these items, to edit them: Shift, 
Activity Set, Time Off, Meal. Break, Exception, Marked Time.

Scheduled agents—This indicator shows the number of agent days displayed 
(based on the selected Mode).
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Edited schedules—This indicator shows the number of daily schedules you 
have edited in this view, but not yet saved.

Full View—Select the Full View check box to have the grid display the entire 
day similar to the Intra-Day view as shown in the example above. If you clear 
this check box, the grid shows a more detailed view as shown for the Scenario 
Agent-Extended view. Full View also affects the Options dialog box.

Mode:—The starting Mode is set to the default of one week, but can be 
changed to Schedule Planning Period (if Schedule Planning Periods are in use 
at your site).

Date:—These controls are the standard date selectors. The grid displays data 
for the period containing the selected date.

! (Save Messages/Warnings)—This column contains icons that provide 
information about the agents' schedules. 

• A light-gray pencil icon (see graphic above) indicates that the agent's day 
was edited after scheduling or rescheduling.

• A yellow pencil icon indicates an item that generated a warning and you 
selected the Fix Later option. 

• A green pencil icon indicates schedule items that you have changed but not 
yet saved. 

• A red pencil icon indicates an item that generated an error. (Error 
conditions are more serious than warning conditions.) 

• A swap icon indicates that the agent's day was assigned by trading or 
swapping.

• A yield icon (upside down red triangle) appears if there are pending 
changes that have not yet been committed by a user with Approve Changes 
security permission.

• Double-click a yellow or red icon to review message details and resolve 
the unsaved items.

Team—This column on the grid indicates the selected agent's assigned team.

colored icon—The column on the grid may display a colored icon. This icon, 
assigned in Configuration Utility, represents the agent's contract.

Agent—This column on the grid indicates each agent's name.

Date—This column on the grid indicates the calendar day.

[Timesteps]—These columns indicate the agent's schedule items in each 
timestep. To see greater detail, clear the Full View check box and/or resize the 
columns. 

To make changes to the selected agent's schedule, right-click the timestep that 
you want to modify and then select the command from the shortcut menu. The 
figure below shows the menu when you right-click on a dark blue area within a 
color-coded bar (unless you change the color). The menu items vary depending 
on the area clicked.
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Figure 28: Modifying an Individual Agent's Schedule

See Modify Individual Agent's Schedules for instructions and explanations.

[Horizontal scroll bar]—Appears below the table when clearing the Full 
View check box causes some timesteps to be hidden offscreen. Scroll it to the 
right to display later timesteps.

Legend—Indicates the particular type of schedule item that each bar color 
represents.

Customizing the Master Schedule Agent-Extended 
View Grid

You can resize the Team, Agent, and Date columns. For details, see the 
Getting Started Overview. You can also add and remove columns. 

Overtime—If displayed (using the Options dialog box), this column shows the 
duration of overtime for each agent on the selected day.

Paid Hours—If displayed (using the Options dialog box), this column shows 
each agent's paid hours for the selected day.

Total Hours—If displayed (using the Options dialog box), this column shows 
each agent's total hours for the selected day.

Start Time—If displayed (using the Options dialog box), this column shows 
each agent's start time for the selected day's work.

* (Comment)—If this column is displayed (using the Options dialog box), an 
asterisk (*) indicates that a comment was saved for the indicated agent and 
schedule day.

Double-click a column cell to view or edit comments.
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Using the Master Schedule Agent-Extended View 
Toolbar Buttons

The Master Schedule Agent-Extended view toolbar is similar to the Master 
Schedule Intra-Day view toolbar. The only exception is that Agent-Extended 
view does not contain a Sort button. Click an Action button on the Master 
Schedule Agent-Extended view image to jump to its description. 

Modifying an Agent's Schedule

You can use the following buttons on the Actions toolbar (these commands 
also appear in the Actions menu):

Cleanup—If you have Schedule Clean Up Master permission, opens the 
Cleanup Master Schedule window that enables you to delete Master Schedule 
information for selected dates.

Rebuild intra-day schedule—Opens the Intra-Day Schedule Rebuild Wizard 
that enables you to rebuild an Intra-Day schedule for a specific day or time 
period within a day for a selected site, team, or agent.

Options—Opens the Options dialog box that enables you to customize the 
view. This includes whether to show agent availability, whether to use a 24-
hour or 36-hour display, and whether to display or hide the Overtime, Paid 
Hours, Total Hours, Start Time, and Comment columns.

Filter—Opens the Filter dialog box. Enables you to filter the displayed Master 
Schedule information. (If you set a new filter, this immediately invokes Get 
data.)

Auto-Commit—The Auto-Commit toolbar button toggles on and off the auto-
commit feature. The feature is also turned on and off by selecting Auto-
Commit on the Actions menu. If it is on, changes are immediately applied to 
the Master Schedule. If it is off, the changes have pending status and can be 
committed/approved before they are incorporated in the official version of the 
Master Schedule.

If you do not have the Approve Changes security permission for the Master 
Schedule, the auto-commit check box is cleared and disabled.

Swap—Opens the Swap Agent Schedule Wizard that enables you to swap two 
agents' schedules.

Insert Multiple—Opens the Insert Multiple Wizard that enables you to insert 
breaks, meals, exceptions, days off, or vacation days for multiple agents or 
teams.

Delete Multiple—Opens the Delete Multiple Wizard, which enables you to 
remove multiple items from the Master Schedule at one time.

Commit/Rollback Multiple—Opens the Commit/Rollback Multiple Wizard, 
which enables you to insert pending changes (changes entered when auto-



222 Workforce Management 7.6

Chapter 5: Scheduling Master Schedule

commit was off or disabled) into the Master Schedule or to remove them and 
return the Master Schedule to its former settings.

Save—Saves any changes that you have made to the schedule. (If the server 
cannot save all changes, red or yellow icons in the grid's first column indicate 
the agents for whom you must correct errors or acknowledge warnings.

If you make schedule changes in the Agent-Extended view and do not click 
Save, you are prompted to save your changes when you select a different 
module or view, or when you launch certain wizards or child windows.

Master Schedule Summary View

Use the Master Schedule Summary view to display statistics about the Master 
Schedule. 

The summary view provides standard date-selection controls, a Granularity 
control, and two clickable tabs, Data and Graph.

The following sections cover:

• Displaying the Summary view.

• The Data tab.

• The Graph tab.

• Customizing the Summary view.

Displaying the Master Schedule Summary View

To display the Master Schedule Summary view:

1. In the Modules tree, click Master Schedule Summary.

The Summary view appears.

2. In the Objects tree, select an object.

You can select a single business unit, a single site or a multi-site activity or an 
activity group within a business unit, or a single activity within a site. Making 
the selections populates the Data tab grid.

Data Tab

The Data tab provides a scrollable grid displaying aggregate and per-timestep 
statistics. The grid's first row displays a daily total or average for each statistic. 
Each of the remaining rows displays statistics for one timestep.

Grid Column Statistics and Quantities

The grid provides columns displaying the following statistics and quantities. 

• Coverage Scheduled, Headcount Scheduled

• Service Level Scheduled, Service Level Forecasted

• Interaction Volume Scheduled, Interaction Volume Forecasted



Supervisor User’s Guide 223

Chapter 5: Scheduling Master Schedule

• AHT (Average Handling Time) Scheduled, AHT Forecasted

• Budget Scheduled, Budget Forecasted

• Staffing Calculated, Staffing Required

• Difference Calculated, Difference Required

• Coverage Published, Coverage Difference

• ASA Schedule, ASA Forecasted, Difference [ASA Scheduled - ASA 
Forecasted]

• Occupancy Scheduled, Occupancy Forecasted, Difference [Occupancy 
Scheduled - Occupancy Forecasted]

• Difference [S/L Scheduled - S/L Forecasted]

• Difference [IV Scheduled - IV Forecasted]

• Difference [AHT Scheduled - AHT Forecasted]

• Difference [Budget Scheduled - Budget Forecasted]

See explanations of Optional fields in the Filters Dialog Box topic.

.

Table 2: Grid Columns Defined

Column Definition

Time Step The start time for each timestep, configured by the Granularity 
setting.

Coverage [Scheduled] The scheduled staffing coverage for an activity or multi-site 
activity. Schedule coverage is calculated and displayed in 
fractional units. For example, if any agent is scheduled to work 
on three Activities in a 15-minute timestep, that agent may 
count as 1/3 toward the coverage of each activity. 

The way the scheduling engine splits an agent’s time among the 
activities the agent can work on depends on many factors. 
Examples include the open hours of each activity, the volume 
and handle time of each activity, and some other factors such as 
whether an agent has granted items in the Calendar, such as 
time off or exceptions for any or part of the day. 

Headcount [Scheduled] The number of agents scheduled (agents scheduled to be 
seated).

Service Level Percentage 
Scheduled

The service level percentage that can be achieved given the 
staffing coverage—assuming that other planned metrics (such 
as interaction volumes and Average Handling Time) remain 
unchanged.
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Service Level Percentage 
Forecasted

The service level percentage that can be expected to be achieved 
based on the number of agents forecasted. 

This may differ than the original service level objective that was 
stated when the staffing forecast was built due to agent 
rounding. For example, WFM may forecast a staffing 
requirement of 12 agents to meet a service level objective of 
80% of interactions answered within 20 seconds, but Service 
Level Percentage Forecast may report a higher number, such as 
83.48%. This is because 12 was the minimum number of agents 
required to meet the 80% service level objective but, with that 
number of agents, the contact center can be expected to achieve 
a slightly better service level than 80%. With one less agent (11 
agents), the contact center would not be expected to achieve the 
80% service level.

Interaction Volume Scheduled The number of interactions that can be handled based on the 
schedule coverage—assuming that other planned metrics remain 
unchanged.

Interaction Volume Forecasted The expected number of interactions, according to the Master 
Forecast.

AHT Scheduled The Average Handling Time per interaction, based on the 
schedule—assuming that other planned metrics remain 
unchanged.

AHT Forecasted The expected Average Handling Time, according to the Master 
Forecast.

Budget Scheduled The budget for the scheduled coverage for the selected day and 
timesteps, based on the full-time-equivalent (FTE) paid hours 
per day and the salary specified in the Forecast scenario that 
was published to the Master Forecast for this date. (This statistic 
appears only if you have the access rights to view agents' wage 
fields.) 

Budget Forecasted The budget for the calculated staffing for the selected day and 
timesteps, based on the full-time-equivalent (FTE) paid hours 
per day and the salary specified in the Forecast scenario that 
was published to the Master Forecast for this date. (This statistic 
appears only if you have access rights to view agents' wage 
fields.) 

Staffing Calculated The required number of agents as calculated by WFM, based on 
the forecasted interaction volumes, AHT, and applicable service 
objectives.

Table 2: Grid Columns Defined (Continued) 

Column Definition
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Graph Tab

The Graph tab provides a linear graph for each statistic that you select, with 
data points for individual timesteps across the selected day.

Staffing Required Optional field. The required number of agents as defined by the 
user, either by explicitly entering forecast targets or by using a 
template.

Difference Calculated The difference between Coverage [Scheduled] and Staffing 
Calculated.

Difference Required Optional field. The difference between Coverage [Scheduled] 
and Staffing Required.

ASA Scheduled Optional field. The Average Speed of Answer that you should 
achieve on this activity, with the number of agents currently 
scheduled for this activity.

ASA Forecasted Optional field. The totals/average row for ASA Forecasted 
reports a weighted average, calculated across the open hours 
and weighted by Forecasted IV

Difference [ASA Scheduled 
minus ASA Forecasted]

Optional field. ASA Scheduled minus ASA Forecasted

Occupancy Scheduled Optional field. The Occupancy that you should achieve on this 
activity, with the number of agents currently scheduled.

Occupancy Forecasted Optional field. The Occupancy objective that you should be 
able to achieve when staffing with the number of agents from 
the staffing forecast

Difference 
[Occupancy Scheduled 
minus Occupancy Forecasted]

Optional field. Occupancy Scheduled minus Occupancy 
Forecasted

Difference [S/L Scheduled 
minus S/L Forecasted]

Optional field. S/L Scheduled minus S/L Forecasted

Difference [IV Scheduled 
minus IV Forecasted]

Optional field. IV Scheduled minus IV Forecasted

Difference [AHT Scheduled 
minus AHT Forecasted]

Optional field. AHT Scheduled minus AHT Forecasted

Difference [Budget Scheduled 
minus Budget Forecasted]

Optional field. Budget Scheduled minus Budget Forecasted

Table 2: Grid Columns Defined (Continued) 

Column Definition
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Show data for

From the Show data for drop-down list, select which statistic that you want to 
graph. The options correspond to the Data tab's available columns (except that 
Difference Calculated and Difference Required cannot be graphed).

Graph

The graph is redrawn to match your selection from the Show data for drop-
down list. Timesteps are shown from left to right. Quantities from bottom to 
top show the number of interactions, the number of agents, or the expense 
amount (for Budget).

Customizing the Summary View

These commands are available on the Actions toolbar (and also on the Actions 
menu):

Options—Opens the Options dialog box. Enables you to display or hide 
individual statistics. 

The following are available for selection: Coverage Scheduled, Headcount 
Scheduled, Service Level Scheduled, Service Level Forecasted, Interaction 
Volume Scheduled, Interaction Volume Forecasted, AHT (Average Handling 
Time) Scheduled, AHT Forecasted, Budget Scheduled, Budget Forecasted, 
Staffing Calculated, Staffing Required, Difference Calculated, Difference 
Required, Coverage Published, and Coverage Difference, ASA Scheduled, 
ASA Forecasted, Difference [ASA Scheduled - ASA Forecasted], Occupancy 
Scheduled, Occupancy Forecasted, Difference [Occupancy Scheduled - 
Occupancy Forecasted], Difference [S/L Scheduled - S/L Forecasted], 
Difference [IV Scheduled - IV Forecasted], Difference [AHT Scheduled - 
AHT Forecasted], Difference [Budget Scheduled - Budget Forecasted]. See 
Optional field section.

Use multi-site activities—This button becomes enabled when you select a 
multi-site activity or business unit in the Objects tree. Clicking this button 
causes both tabs to display combined data for all the activities included in the 
selected multi-site activity or business unit.

Cleanup—Opens the Cleanup window. Enables you to delete Master Schedule 
information for selected dates and agents.

Granularity

Select a timestep to apply to the grid: 15 (default), 30, or 60. All values are in 
minutes.

Date

Use the standard date-selection controls to move to other days.
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Cleanup Master Schedule Window

Use the Cleanup Master Schedule window if you need to remove information 
from the Master Schedule for selected dates and agents. You must have 
Schedule Clean Up Master security permission.

Warning! This feature deletes all previously saved data that was saved for the 
selected date range and agents. Genesys recommends that you do 
not use the Cleanup Master Schedule feature unless it is absolutely 
necessary. If you must remove Master Schedule data, Genesys 
recommends that, before doing so, you first extract the data to a 
forecast scenario (using the Publish Schedule Wizard), and/or 
make a backup of the WFM database (using the WFM Database 
Utility).

To remove Master Schedule information:

1. In the Cleanup dates section, select the range of dates for which you want 
to remove data.

You can type in the Start date and End date, or use the up or down arrows 
to modify the displayed dates. You can also click the ellipsis (...) button to 
display a monthly calendar that you can use to jump to other dates.

2. From the Agents list, select the agents whose schedule information you 
want to remove.

You can expand business units to display their sites and you can expand 
sites to display their teams and agents. You can select any number of 
agents. (By default, no agents are selected.)

3. Click OK to remove the specified Master Schedule information. (Or click 
Cancel to close the window without changing the Master Schedule.)

As the cleanup starts, the progress bar displays additional information in 
brackets:

 Number of selected agents.
 Number of selected teams for a particular site. 

If an asterisk,(*), is displayed instead of a number, this indicates all agents or 
teams under the site were selected.

Master Schedule Changes Approval

Viewing and using the Master Schedule Changes Approval module requires 
that you have Schedule Approve Changes security permission enabled. If you 
do not, you cannot see this module in the Modules tree.

Changes to the Master Schedule that are made by users with the Schedule 
Approve Changes security permission disabled are first entered in Pending 
mode. Use the Master Schedule Changes Approval module to accept or reject 
these pending changes. 
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Alternatively, for pending changes that you made, you can:

• Use the Commit/Rollback Multiple Wizard to commit or rollback all 
pending changes for selected agents on selected dates.

• Use the Schedule Intra-Day views to directly save or delete all items in an 
agent's schedule day that have Pending status. To do so, right-click the row 
showing the agent's schedule and then select Commit or Rollback.

Displaying Pending Changes

1. Select Master Schedule Changes Approval under the Schedule module.

2. Select the objects whose schedule you want to work with. You can only 
choose one site, or objects within one site, at a time.

3. From the Period drop-down list, select the time period to view. You can 
select Daily or Weekly.

4. From the Users drop-down list, select which user's changes you want to 
see. Select All to see all pending schedule changes. All is selected by 
default. 

5. Use the date selectors to change the schedule dates to view. 

By default, if you chose to view the Weekly period and select a day other 
than the first day of the week, the display begins on the first day of the 
week containing the day you selected.

6. Click Get data.

The top pane of the Changes Approval view displays a table containing the 
pending schedule changes made by the users you selected. The columns in the 
table are sortable.

The columns in the Pending Changes table are:

Date—The schedule date that has been changed.

User—The user who made the change, or “Changed by Agent” if an agent 
made the change.

Agent—The agent whose schedule has been changed.

Team—The team to which the affected agent belongs.

Filter By Agent Properties

You reach this dialog box by clicking on the Filter button in the Master 
Schedule Changes Approval dialog box. 

Use this dialog box to filter the display by specific Agent properties.  You can 
choose from two lists of Agent properties under the current site: 

• The left-hand column displays a list of Activities Agents Have Skills For.

• The right-hand column displays a list of Contracts. 

All check boxes are selected by default. 
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1. Clear the check boxes for the items that you want excluded from the filter. 

2. Click OK to apply your choices.

Approving or Rejecting Pending Changes

1. Select one or more schedule changes in the pending changes table.

The current version of each affected agent's schedule, and the agents' 
schedules as they would appear with the changes incorporated, appear in 
the Original Schedule and Modified Schedule panes below the table.

Original Schedule pane—Shows the agent's schedule as it appears in the 
current version of the Master Schedule.

Modified Schedule pane—Shows the agent's schedule with the pending 
changes included.

These panes contain the following columns:

Item—The name or type of the changed item. For shifts, this column 
includes the shift's start and end times. For shifts and activity sets, this 
column displays all of the associated activities.

Start Time—The start time of the changed item. For full-day items, this 
column is empty.

End Time—The end time of the changed item. For full-day items, this 
column reads Full Day.

Colors—Items that do not match in the original and edited schedules 
appear in specific colors. Non-matching items in the schedule pane are 
marked in blue. Non-matching items in the modified schedule pane are 
marked in red. 

2. To see whether the changes violate any schedule constraints, select the 
change in the pending changes table and then click Validate. The Review 
Validation Messages dialog box opens. See Schedule Validation for a list 
of possible error and warning messages and their descriptions.

3. After reviewing the changes, select one or more of them and then click 
Accept to save the changes in the Master Schedule or Reject to discard 
them.

Warning! If you accept or reject any pending change for an agent, all pending 
changes for that agent are accepted or rejected. 

The Master Schedule is updated to include all accepted schedule changes.

Review Validation Messages Dialog Box

Use the Review Validation Messages dialog box to view any warnings or 
errors that the server returned when you validated the selected pending 
changes to the Master Schedule. 
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The dialog box contains the following columns and controls:

Team—The team to which the agent whose schedule is being changed 
belongs.

Agent—The agent whose schedule change generated this message.

Message—The message type (either Warning or Error), numeric code, and the 
message text.

OK—Closes the dialog box and retrieves fresh data from the server.

Cancel—Closes the dialog box without saving or refreshing data.

Note: These errors and warnings would be generated if you approved the 
selected pending schedule changes. They differ from Validation 
warnings and errors, which WFM Web generates during the schedule 
building process.

Schedule Bidding

Overview

Schedule bidding allows a workforce planner to create schedules with no agent 
names, and then distribute those schedules to agents via the Web, so that agents 
can rank their most desired and least desired schedules. 

Schedule bidding enables contact centers to comply with certain labor union 
regulations that require that the most senior agents, or the most highly-ranked 
agents, get the schedules they most desire. Even if your contact center does not 
have these labor regulations, it may still be a process that could provide 
business value to you.

It is a way to empower agents to have more input into the schedules they will 
be given, and therefore could be used to increase morale within the contact 
center and reward high-performing agents.

How Bidding Works

Instead of simply assigning schedules to Agents, the Supervisor designs and 
builds a schedule scenario. Then, Agents view the scenario and may enter bids 
for their most desired, and most unwanted, shifts. Finally, the Supervisor can 
auto-assign or manually assign schedules to Agents based on their bids, using a 
hierarchy system of seniority or rank.

Click on links in the summary steps below, to read details.
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Setting Up Bidding

1. Someone with administration permissions must enable schedule bidding. 
This is described in the “Agent Bidding Section” of Chapter 5: 
Configuring the Options Tabs in the current Workforce Management 
Administrator's Guide.

2. The Supervisor creates and configures a bidding scenario. (See “Configure 
Bidding Scenario” on page 232.)

Steps include creating a forecast and then a schedule for specific activities 
and profile agents, then deciding which agents can bid and when.

This opens the bidding process and makes the schedule options visible to 
Agents.

Note: During the Schedule Bidding period, a scenario’s site has the status 
Open for Bidding. Any action or operation that would alter 
schedules for that site is disabled.

This includes (but is not limited to) these actions: direct schedule editing, 
insertions or deletions, clean up or extraction from the Master Schedule, 
schedule rebuild or optimization.

Bidding on the Schedule

3. Agents examine the bidding scenario options and submit their bids. 

4. The bidding period closes when the Bidding End Date arrives.(See 
“Control Bidding Process Wizard” on page 234.) 

Agents can not access the closed bidding scenario. 

Resolving the Bids

5. The Supervisor reviews schedule bids. (See “Resolving and Publishing a 
Bidding Scenario” on page 236.) 

The Supervisor may wish to manually modify or assign schedules to 
agents.

6. The Supervisor starts the auto-assignment wizard. (See “Auto-Assign 
Schedules Wizard” on page 236.) 

The wizard assigns schedules to agents. 

7. The Supervisor reviews results of auto-assignment. (See “Resolving and 
Publishing a Bidding Scenario” on page 236.) 

The Supervisor may wish to manually modify or reassign schedules. 
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Finalizing the Schedule

8. The Supervisor publishes the bidding scenario to the Master Schedule. 
(See “Publishing/Extracting Schedules” on page 252.)

After all schedules have been assigned to real agents, the Supervisor can run a 
Schedule Bidding Report. 

Configure Bidding Scenario

Begin at the Schedule Scenarios View. (See “Schedule Scenarios View” on 
page 127.)

Create a Forecast Scenario

1. Create a New Forecast Scenario. (See “New Forecast Wizard” on page 54.)

Define the work week(s) that this forecast spans and the activities that it 
requires.

2. Build Volumes (see “Volumes Build Wizard” on page 62), Build Staffing 
(see “Staffing Build Wizard” on page 77), and then Publish the Forecast 
(see “Publish/Extract Forecasts” on page 89).

This transfers the forecast to the master schedule database, so you can 
configure a bidding schedule. Follow all the steps are exactly as you would 
to create a non-bidding schedule.

Create a Schedule Scenario

3. Create a New Schedule Scenario. (See “New Schedule Scenario Wizard” 
on page 131.)

Define the General Parameters including Start Date, End Date and 
Extended End Date. (See “General Parameters” on page 132.)

For example, you can build a 1-week bidding schedule the Start Date 3 
June 2007, and the End Date 9 June 2007, and the Extended End Date is 1 
September 2007. The one-week schedule that you present to agents for 
bidding, is applicable for the entire 3rd quarter of 2007. Agents can see the 
Extended End Date during bidding, and thus know that they are bidding on 
schedules for the entire 3rd quarter.

4. Select Activities (See “Select Activity” on page 133), and Agent Profiles 
(See “Select Agents” on page 134).  You can select real agents too, but 
their schedules will not be biddable.

5. Build the scenario.
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Configure the Scenario for Bidding

6. Build the Bidding Schedule. (See “Schedule Build Wizard” on page 238.)

7. Define which Agents can bid in the Bidding Candidates Selection dialog. 
(See “Bidding Candidates Selection” on page 233.)

8. Define when Agents can bid in the Control Bidding Process Wizard. (See 
“Control Bidding Process Wizard” on page 234.)

Bidding Candidates Selection

Use the Bidding Candidates Selection dialog to specify which Agents are 
eligible to bid on a chosen bidding Scenario.

Preparation

1. Create and configure a Scenario for bidding. (See “Configure Bidding 
Scenario” on page 232.)

2. Open the Scenario and select the Profiles/Bidding view. (See “Schedule 
Scenarios View” on page 127.)

Assigning the Agents

3. To open the wizard, click the Bidding Candidates Selection icon  in the 
toolbar.

4. In the Bidding Candidates Selection dialog, open the site(s) and then the 
Team(s).

5. Select only the team members who will be eligible to bid on your 
configured Scenario. Clear the checkbox to the left of each member who 
will not be eligible to bid.

6. Click OK.
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Figure 29: Bidding Candidates Selection dialog

Control Bidding Process Wizard

Figure 30: Control Bidding Process Wizard

Use this wizard to:
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• Define the Schedule Bidding period (Bidding Start date/time and Bidding 
End date/time) for the current bidding scenario.

• End bidding early or extend bidding by changing the Bidding End value 
for a bidding scenario that is currently open.

Preparation

1. Create and configure a Scenario to be used for bidding. (See “Configure 
Bidding Scenario” on page 232.)

2. Open the Scenario and select the Profiles/Bidding view for that scenario. 
(See “Schedule Scenarios View” on page 127.)

Running the Wizard

3. To start the wizard, click the Control bidding process icon  in the 
toolbar.

4. In the Select Site dialog, select the appropriate site and click Next.

5. In the Set Bidding Options dialog, use these controls to specify the start 
and end of bidding:

Bidding Start—Specify the bidding start date and time. You can type 
directly into each text box, use the up or down arrow to modify the 
displayed date, or click the button at right to display a calendar. 

Default value: bidding start date (if bidding was already initiated) or 
midnight tomorrow (if bidding is not yet initiated).

Bidding End—Specify the bidding end date and time.  You can type 
directly into each text box, use the up or down arrow to modify the 
displayed date, or click the button at right to display a calendar.

Default value: bidding end date (if bidding was already initiated) or 
midnight tomorrow + 1 week (if bidding is not yet initiated).

Note: You can change the End Date after the bidding scenario is already 
open and while agents are bidding. You may need to change the 
date, either to extend or to shorten the bidding period, for business 
reasons. But be careful if you do that.

The End Date is visible to agents as they bid, and they will rely on its accuracy.

If you decide to close bidding early (or to extend it), inform all your agents 
beforehand so they will not be caught by surprise.

Click Finish.
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Resolving and Publishing a Bidding Scenario

The Schedule Bidding period has ended. Eligible Agents have bid on their 
preferred schedules. And if each agent requested a different schedule, then the 
Supervisor could grant everyone's wish. But of course there are conflicts. The 
Supervisor must resolve identical bids and create a schedule with a real agent 
assigned to every schedule, while heeding such factors as Agent seniority and 
rank.

Supervisors should follow these steps to resolve the bidding and publish a 
schedule with real agents:

1. Select the Schedule module, open the bidding scenario that needs 
resolution, and select the Bidding/Profiles View. 

If necessary, you can end bidding early for a still-open schedule. (See 
“Control Bidding Process Wizard” on page 234.)

2. Examine the agents' bids, and make manual adjustments or assignments as 
necessary.

3. Run the Auto-Assign Schedules Wizard, to assign real agents to the 
"profile" schedules automatically. (See “Auto-Assign Schedules Wizard” 
on page 236.)

4. Publish the now-finished bidding schedule to the Master Schedule. (See 
“Publishing/Extracting Schedules” on page 252.)

The Publish to Master Schedule page of the Publishing wizard includes the 
check box Insert granted exception, time off, and day off Calendar items, 
which you can use to overlay these items in the schedule.

Note: Unassigned profile schedules are not published to the Master 
Schedule; only real agents' schedules.

Once the bidding scenario is published to the Master Schedule, agents can 
view it when they log in.

The Supervisor can generate a Schedule Bidding Report if all profile schedules 
were assigned to real agents. (See “Schedule Reports” on page 324.)

Auto-Assign Schedules Wizard

Reach this wizard by clicking the Auto-Assign Schedules icon   in the toolbar.

Follow these steps:

1. Select a site.

2. Select a ranking system by clicking one of these three radio buttons:

Seniority favors agents by their hire dates. 

Rank favors agents by their rank, as defined by a supervisor in the WFM 
Configuration Utility's Agent Configuration window.
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Seniority + Rank favors agents by Seniority first, and if that results in a 
tie, then uses Rank as the criterion.

3. Select a target (which Agents will be assigned schedules).

All Agents - Auto-assigns from the pool of all agents. Here are two uses 
for this option:
 You previously prepared profile schedules, not intended for bidding but 

for 400 new agents that you have now hired, and need to assign. 
 Bidding is resolved but you still need to assign a few profile schedules 

to real agents. 

Bidding Candidates Only (default) - Auto-assigns only those agents that 
were designated as eligible to bid, in the Bidding Candidates Selection 
dialog. 

4. Click OK to begin the auto-assignment process or Cancel to abandon it.

Figure 31: Auto-Assign Schedules Dialog
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Schedule Build Wizard

Overview

Use the Schedule Build Wizard to build a schedule for a selected site, based on 
a selected scenario. 

The build process includes all activities and agents defined for this site in the 
scenario. 

To use the wizard:

1. Use the New Schedule Scenario Wizard to create a schedule scenario or 
select an existing scenario.

2. Click the Build schedule button from the Actions toolbar in a Schedule 
Scenario view (Scenario Intra-Day view, Scenario Agent-Extended view, 
Scenario Coverage view, Scenario Weekly view, Scenario Profiles/Bidding 
view, or Scenario Summary view).

The first of the Schedule Build Wizard's two screens, Site Options, opens. 

3. Select the site and build options that you want and then click Next.

If you select the Use Team Constraints check box, the Team Synchronicity 
screen opens next.

4. Select the specific constraints to apply and click Next.

5. Specify the settings that you want to apply to the build and click Next.

If you created your schedule scenario using profiles (not real agents), then 
the Optimize Number of Profiles and Assign Profiles to Teams screens 
follow, in that order.

6. At the Optimize Profiles screen, specify the settings that you want to apply 
to the build and click Next.

If you set Team Size and select the Use Backfilling of Existing Teams 
check box, go to step 7. If you did not, click Finish.

7. At the Assign Profiles to Teams screen, specify the settings that you want 
to apply to the build and click Next. 

8. Click Finish.

Select Site/Build Options

Use the Schedule Build Wizard's Select Site screen to select a site and schedule 
build options.

1. From the Sites drop-down list, select the site whose schedule you want to 
build.

The list offers you the sites in the selected scenario.
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2. Under Build Options, select or clear Force Single Skills. 

If you select this option and an agent has multiple skills, the agent can be 
scheduled for only one activity on each workday. 

If you clear this option, the agent can be scheduled for multiple activities 
on the same day.

3. Select or clear Use Required.

If you select this option, the schedule is built with the Required Staffing 
forecast, not with the Calculated Staffing forecast. 

4. Select or clear Disable monthly constraints for the first month.

Select this check box when the first month is not complete (because you 
are scheduling from the middle of the month) and there is no historical data 
for the beginning of the month. In this situation, schedule building cannot 
correctly accommodate monthly constraints, such as minimum or 
maximum work hours per month. Selecting this check box relaxes those 
constraints for this month.

5. Select or clear Shuffle Agents.

If you select this option, the agent pool is randomized before scheduling. 
(Randomizing ensures that the schedule's results are independent of the 
sequence in which agents are loaded into the scheduling algorithm.)

6. Select or clear Use Team Constraints.

If you select this option, if you have synchronization of daily schedules 
configured for one or more of your Contracts, the schedule start times are 
synchronized for agents in the same team, within the configured threshold.

7. Select or clear Exclude granted agents from team constraints.

If you select this option, agents who have been granted full-day exceptions 
or working hours are not considered when team synchronization is 
enforced. 

Note: Always select this option when you are using team constraints.

8. Click Next to continue, or Cancel to discard your selections and close the 
wizard.
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Preference Fulfillment Options

Figure 32: Preference Fulfillment Options window

Select Force Maximum Preference Fulfillment to:

• treat all preferences in preferred status as granted

• resolve all granted and would-be granted preferences

• use the result to build the schedule

• disable all other options in the dialog box

Or, clear Force Maximum Preference Fulfillment (the default setting) and use 
the Schedule Build Wizard's second (and final) screen, Preference Fulfillment 
options, to set preference-fulfillment options the Schedule Build Wizard's 
second (and final) screen, preference Fulfillment options, to set preference-
fulfillment options.

Preference Fulfillment Options

The screen's upper area provides the following options:
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1. From the Prioritization drop-down list, select None, Seniority, Rank, or 
Seniority + Rank to determine how WFM Builder favors agent requests 
when building the schedule. If you select None, the Emphasis drop-down 
list is not enabled.

Seniority favors agents by their hire dates (which are indicated in the table 
on the lower part of the Preference Fulfillment screen). 

Rank favors agents by their rank, as defined by a supervisor in the WFM 
Configuration Utility's Agent Configuration window (and also indicated in 
the table on the lower part of the Preference Fulfillment screen).

Seniority + Rank favors agents by Seniority first, and if that results in a tie, 
then uses Rank as the criterion.

2. From the Emphasis drop-down list, select None, Low, Medium, or 
Strong. This setting controls how closely the build process considers skill 
coverage when it assigns priorities to preferences.
 None means that agents' preferences are assigned on the basis of 

seniority and/or rank alone, using the percentages assigned to the 
agents (as shown in the % column). This option tends to favor 
multiskilled optimization over preference fulfillment.

 Strong means that schedule building does not consider multiskilled 
optimization when it allocates preferences.

 Medium indicates that schedule building accommodates preferences if 
a loss in any skill coverage is caused only by an exception.

 Low means that schedule building places more emphasis on preference 
fulfillment, without sacrificing multiskilled optimization.

3. Enter percentage values for Min and Max.

Min and Max set the minimum percentage of preferences that schedule 
building fulfills. For example, if you set Min to 10% and Max to 80%, 
every agent has at least 10% of his or her preferences fulfilled, while the 
highest-ranking or most senior agent has at least 80% of his or her 
preferences fulfilled. Agents with intermediate standing receive a 
percentage between the two extremes (their exact percentage depends on 
their place in the hierarchy).

Note: Schedule building applies these percentage values separately to 
each preference type and satisfies all preferences, when possible. 
For example, if an agent has a 50% fulfillment ratio, and makes 20 
shift preferences and 8 day-off preferences over a 4-week period, 
the agent is guaranteed to receive at least 10 preferred shifts and 4 
preferred days off, unless this preference fulfillment is prohibited 
by other working rules.

In cases where the preference fulfillment ratio cannot be achieved due to 
working-rule violations, WFM Web displays a warning indicating that the 
schedule results may not be desirable. WFM Web attempts to satisfy more 
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than the minimum level of preference fulfillment, as long as the results do 
not cause understaffing.

4. Click Calculate.

The table display is re-sorted by the % column, which now shows each agent's 
calculated chance of preference fulfillment. (You can use the table's vertical 
scroll bar to display more agents.)

Adjust Fulfillment Ratio (-100 – 100)

To adjust the preference fulfillment ratio using the controls below the table:

1. In the Adjust Fulfillment Ratio text box, enter a value or use the up or 
down arrows to modify the displayed value.

2. Click Adjust.

In the % column, WFM Web adds your adjustment to, or subtracts it from, all 
agents' chances of preference fulfillment. However, it does not increase any 
agent's fulfillment ratio above 100% or reduce it below 0%.

How the Preference Fulfillment Ratio Works

The preference fulfillment ratio modifies the impact of the agent prioritization 
settings.

• The preference fulfillment functionality applies only to calendar items that 
an agent can request (Shift, Day Off, and Availability). Also these items 
may be inserted into the calendar by a supervisor. Any other preferred 
calendar items (such as Exceptions, Times Off, Working Hours) are not 
fulfilled; they remain in Preferred status even if 100% fulfillment is 
defined.

• If you set the ratio to a value greater than 0, then each agent's chances of 
having his or her preferences fulfilled is increased by whatever value you 
entered, up to the maximum percentage that you set for the Max option.

• If you set the ratio to a value less than 0, then every agent's preference 
fulfillment ratio is reduced by whatever value you entered, down to the 
minimum percentage that you set for the Min option.

Note: The preference fulfillment ratio cannot surpass the Min and Max 
percentage values set under Preference Fulfillment Options. For 
example, if Max is set to 80%, and the preference fulfillment ratio is 
set to 100 (maximum preference fulfillment), all agents will top out at 
80%. If Max is set to 80% and Min is set to 10%, and the preference 
fulfillment ratio is set to -30 (favoring optimization), then agents who 
would be at 80% are dropped to 50%; agents at 40% are dropped to 
10%; and all agents with prioritizations lower than 40% also drop to 
10%.
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Navigation Buttons

The buttons at the bottom of the screen provide the following options:

• Click Finish to build the schedule with the settings that you have selected.

• Click Back to review or change your settings in the Site and Build Options 
screen.

• Click Cancel to close the wizard without building a schedule.

Intra-Day Schedule Rebuild Wizard 

Overview

Use this wizard to rebuild an Intra-Day schedule for a specific day or time 
period for a site, team, or agent. While in a Schedule Scenario or Master 
Schedule view, you can rebuild from any of the following views: Intra-Day, 
Weekly, or Agent Extended.

The rebuild process can include any activities and agents defined for this 
site/day in the selected scenario.

Reasons For Using This Wizard

The goal of the WFM scheduling algorithm is to minimize the over and under-
staffing of agents, against the forecasted staffing requirements. This is the 
outcome when a schedule is generated. However, several circumstances may 
cause the schedule to be sub-optimal by the time a particular schedule day 
arrives. For example:

1. You may have re-forecasted volumes and staffing for the day.

2. Agents may have called in sick or were given time off.

3. Existing agent schedules may have been manually adjusted.

4. Additional agents may have been added into the schedule.

5. Meetings or other types of exceptions may have been added to the 
schedule.

Because of this, you may wish to re-optimize the schedule day. It does not 
make sense to re-optimize days or hours that have already passed. You 
probably do not want to re-optimize the current hour, since any changes to 
meals, breaks, and/or work activities would be difficult to communicate to the 
affected agents. The Intra-day Rebuild wizard allows you to re-optimize 
specific types of schedule items for selected agents, based on a particular 
configured start time, which would normally be later than the current time 
when you invoke the re-optimization.

To use the wizard:
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1. Select a Schedule Scenario or Master Schedule view (Intra-Day, Weekly, 
or Agent Extended).

2. Click the Rebuild intra-day schedule button from the Actions toolbar.

3. The first of the Wizard's screens, Select Options, opens. Select a date/time 
and rescheduling options, then click Next.

4. In the next screen select a site and build options, then click Next.

5. In the next screen, select agents. 

6. If you selected certain options on the Select Options screen, the Select 
Activities screen opens. Otherwise, click Finish, or Cancel to discard 
your selections and close the wizard.

Select Options 

Use the Intra-Day Schedule Rebuild Wizard's Select Options screen to select a 
start date and time and rescheduling options. 

Note: For information on task sequences (fourth and fifth rescheduling 
options), see the Workforce Management 7.5 Configuration Utility 
Help. Also see the Workforce Management 7.5 Administrator's Guide.

1. From the Date drop-down, select the date to be rebuilt in the schedule. This 
date cannot be outside the scenario's date range. The default value shown is 
the date selected in the view from which the Wizard was called.

2. Opposite Start from, select the time in the scheduled day to start 
rebuilding. The default value shown is the computer's current time rounded 
to the nearest time step start plus one hour. Before selecting the time from 
which you want to rebuild, consider that you will need to notify the 
affected agents of these changes.

3. Select/clear other rescheduling options including: 

Reschedule breaks, meals, activities/activity sets/task sequences, shift start 
and/or end times may change. 

If the above option is selected, the following check boxes become enabled:
 Shift start time is fixed. You might not want to change shift start 

and/or end times because you might not want to subject agents to that 
level of disruption. You may not be able to notify agents in a timely 
manner if you plan to change their start times, so by selecting the Shift 
start time is fixed checkbox, you would not have to be concerned about 
that. 

 Shift end time is fixed. See above entry for Shift start time is fixed.
 Paid duration is fixed. Applies to breaks and meals (shift items), 

which are defined as paid or non-paid. If paid duration is fixed, when 
WFM rebuilds, it cannot give an agent a shift with a different paid 
duration than the agent currently has assigned. Otherwise, if the agent 
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has a flexible Contract, it could be possible for the agent to get 
assigned a shorter or longer shift than currently assigned. The agent 
could potentially be assigned different meals and breaks as well.

4. Keeping the Auto-commit changes default instructs the schedule builder 
to commit all schedule changes. Otherwise, they will be put into the 
schedule in a pending mode. 

5. Click Next to continue, or Cancel to discard your selections and close the 
wizard.

Site and Build Options

Use the Intra-Day Schedule Rebuild Wizard's Select Options screen to select a 
site and schedule rebuild options.

1. From the Sites drop-down list, select the site whose schedule you want to 
build.

The list offers you the sites in the selected scenario.

2. Under Build Options, select or clear Force Single Skill. 

If you select this option and an agent has multiple skills, the agent can be 
scheduled for only one activity on each workday. 

If you clear this option, the agent can be scheduled for multiple activities 
on the same day.

3. Select or clear Use Required.

If you select this option, the schedule is rebuilt with the Required Staffing 
forecast, not with the Calculated Staffing forecast. 

4. Select or clear Disable monthly constraints for the first month.

Select this check box when the first month is not complete (because you 
are scheduling from the middle of the month) and there is no historical data 
for the beginning of the month. In this situation, schedule building cannot 
correctly accommodate monthly constraints, such as minimum or 
maximum work hours per month. Selecting this check box relaxes those 
constraints for this month.

5. Select or clear Shuffle Agents.

If you select this option, the agent pool is randomized before rescheduling. 
(Randomizing ensures that the schedule's results are independent of the 
sequence in which agents are loaded into the scheduling algorithm.)

6. Select or clear Use Team Constraints.

If you select this option and you have synchronization of daily schedules 
configured for one or more of your contracts, the schedule start times are 
synchronized for agents in the same team, within the configured threshold. 

If you select this option and you have synchronization of daily schedules 
configured for one or more of your contracts, the next page in the wizard 
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will be Team Synchronicity, where you can specify the specific constraints 
that will be used to synchronize a team's schedule.

7. Select or clear Exclude granted agents from team constraints.

If you select this option, agents who have been granted full-day exceptions 
or working hours are not considered when team synchronization is 
enforced. 

Note: Always select this option when you are using team constraints.

8. Click Next to continue, or Cancel to discard your selections and close the 
wizard.

Team Synchronicity

Use the Schedule Build Wizard's Select Site screen to select a site and schedule 
build options.

This wizard page appears when you selecte Use Team Constraints in the Select 
Site dialog box.

1. Select the Synchronize Days Off check box to specify that days off should 
be synchronized for all teams. 

2. Use the radio buttons under Synchronize By: to specify the 
synchronization combinations to apply when building the schedule:
 No additional synchronization
 Shift Start Time—If checked, use the duration control Maximum 

Start Time Difference to specify the maximum difference between 
shift start times inside the team. Use the format HH:MM; where 02:59 is 
two hours and fifty-nine minutes.

 Paid Duration
 Paid Duration and Shift Start Time
 Paid Duration, Shift Start Time and Meals
 Paid Duration, Shift Start Time, Meals and Breaks
 Paid Duration and Meals
 Paid Duration, Meals and Breaks

3. Select the Apply constraints only to the same contracts inside team 
check box to specify that while synchronizing teams, WFM must take 
configured contract information into account while creating the schedule. 
By default, this check box is cleared.

4. Click Finish to enable your choices.

Synchronization applies to all teams.
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Preference Fulfillment Options

This Schedule Build Wizard screen appears if the schedule scenario you are 
building contains actual agents (not profiles) in the selected site. Use these 
controls described below to optimize the number of profiles.

Select Force Maximum Preference Fulfillment to:

• Treat all preferences with preferred status as granted.

• Resolve all granted and would-be granted preferences.

• Use the result to build the schedule.

• Disable all other options on the page (as illustrated above).

Or, clear Force Maximum Preference Fulfillment (cleared is the default 
setting), and use the Schedule Build Wizard's second (and final) screen, 
Preference Fulfillment options, to set preference-fulfillment options, as 
described in the sections Preference Fulfillment Options and Adjust 
Fulfillment Ratio.

Preference Fulfillment Options

The screen's upper area provides the following options:

1. From the Prioritization drop-down list, select None, Seniority, Rank, or 
Seniority + Rank to determine how WFM Builder favors agent requests 
when building the schedule.
 If you select None, the Emphasis drop-down list is not enabled.
 Seniority favors agents by their hire dates (which are indicated in the 

table on the lower part of the Preference Fulfillment screen). 
 Rank favors agents by their rank, as defined by a supervisor in the 

WFM Configuration Utility's Agent Configuration window (and also 
indicated in the table on the lower part of the Preference Fulfillment 
screen).

 Seniority + Rank favors agents by Seniority first, and if that results in a 
tie, then uses Rank as the criterion.

2. From the Emphasis drop-down list, select None, Low, Medium, or Strong. 
This setting controls how closely the build process considers skill coverage 
when it assigns priorities to preferences.
 None means that agents' preferences are assigned on the basis of 

seniority and/or rank alone, using the percentages assigned to the 
agents (as shown in the % column). This option tends to favor 
multiskilled optimization over preference fulfillment.

 Low means that schedule building places more emphasis on preference 
fulfillment, without sacrificing multiskilled optimization.

 Medium indicates that schedule building accommodates preferences if 
a loss in any skill coverage is caused only by an exception.
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 Strong means that schedule building does not consider multiskilled 
optimization when it allocates preferences.

3. Enter percentage values for Min and Max.

Min and Max set the minimum percentage of preferences that schedule 
building fulfills.

For example, if you set Min to 10% and Max to 80%, every agent has at 
least 10% of his or her preferences fulfilled, while the highest-ranking or 
most senior agent has at least 80% of his or her preferences fulfilled. 
Agents with intermediate standing receive a percentage between the two 
extremes (their exact percentage depends on their place in the hierarchy).

Note: Schedule building applies these percentage values separately to 
each preference type and satisfies all preferences, when possible. 
For example, if an agent has a 50% fulfillment ratio, and makes 20 
shift preferences and 8 day-off preferences over a 4-week period, 
the agent is guaranteed to receive at least 10 preferred shifts and 4 
preferred days off, unless this preference fulfillment is prohibited 
by other working rules.

In cases where the preference fulfillment ratio cannot be achieved due to 
working-rule violations, WFM Web displays a warning indicating that the 
schedule results may not be desirable. WFM Web attempts to satisfy more 
than the minimum level of preference fulfillment, as long as the results do 
not cause understaffing.

4. Click Calculate.

The table display is re-sorted by the % column, which now shows each agent's 
calculated chance of preference fulfillment. (You can use the table's vertical 
scroll bar to display more agents.)

Adjust Fulfillment Ratio (-100 — +100)

To adjust the preference fulfillment ratio using the controls below the table:

1. In the Adjust Fulfillment Ratio text box, enter a value or use the up or 
down arrows to modify the displayed value.

2. Click Adjust.

In the % column, WFM Web adds your adjustment to, or subtracts it from, all 
agents’ chances of preference fulfillment. However, it does not increase any 
agent's fulfillment ratio above 100% or reduce it below 0%.

How the Preference Fulfillment Ratio Works

The preference fulfillment ratio modifies the impact of the agent prioritization 
settings.
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• The preference fulfillment functionality applies only to calendar items that 
an agent can request (Shift, Day Off, and Availability). Also these items 
may be inserted into the calendar by a supervisor. Any other preferred 
calendar items (such as Exceptions, Times Off, Working Hours) are not 
fulfilled; they remain in Preferred status even if 100% fulfillment is 
defined.

• If you set the ratio to a value greater than 0, then each agent's chances of 
having his or her preferences fulfilled is increased by whatever value you 
entered, up to the maximum percentage that you set for the Max option.

• If you set the ratio to a value less than 0, then every agent's preference 
fulfillment ratio is reduced by whatever value you entered, down to the 
minimum percentage that you set for the Min option.

Note: Note: The preference fulfillment ratio cannot surpass the Min and Max 
percentage values set under Preference Fulfillment Options. For 
example, if Max is set to 80%, and the preference fulfillment ratio is 
set to 100 (maximum preference fulfillment), all agents will top out at 
80%. If Max is set to 80% and Min is set to 10%, and the preference 
fulfillment ratio is set to -30 (favoring optimization), then agents who 
would be at 80% are dropped to 50%; agents at 40% are dropped to 
10%; and all agents with prioritizations lower than 40% also drop to 
10%.

Navigation Buttons

The buttons at the bottom of the screen provide the following options:

• Click Finish to build the schedule with the settings that you have selected.

• Click Previous to review or change your settings in the Site and Build 
Options screen.

• Click Cancel to close the wizard without building a schedule.

Optimize Profiles

This Schedule Build Wizard screen appeared because the schedule scenario 
you are building contains profiles and not actual agents in the selected site. Use 
these controls described below to optimize the number of profiles.

The grid displays all profiles for the selected site. These are the profiles that 
are based on configured profiles, not profiles that are based on agents. The 
columns are:

Profile—Profile names.

Min—The minimum number of profiles that WFM can use when building the 
schedule.
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Range: Empty (default) or any number from 0 to 9999. This value is editable, 
and must be less than the value of Max.

Max—The maximum number of profiles that WFM can use when building the 
schedule. Range: Empty (default) or any number from 0 to 9999. This value is 
editable, and must be greater than the value of Min.

Existing—The number of actual profiles already present in the selected 
schedule scenario.

Growth Ratio—The current growth ratio value that WFM can use for a 
particular profile when building the schedule. Editable. Range: Empty (default) 
or any number from 0 to 9999

Controls

Total Growth Ratio field—Total of all rows from the grid column Growth 
Ratio (%). Not editable.

Show configured profiles check box—Check to limit filter the grid to show 
only profiles that have Min and Max parameters specified. Default: cleared.

Show existing profiles check box—Check to limit filter the grid to show only 
profiles that are already present in the selected schedule scenario. Grid column 
Existing cannot contain 0 (zero). Default: cleared.

Understaff threshold (%) field—Enter the understaff threshold that WFM 
must use when building the schedule. Range: 0 (no understaffing) to 100 (total 
understaffing). Default: 20.

Team Size field—The maximum number of profiles that WFM can use when 
creating profile teams. Range: Empty (default) or any positive number greater 
than 0 (zero).

Use Backfilling of Existing Teams check box—Select to specify if existing 
non profile teams should be filled up to the number of agents specified in the 
field Team size. The default value is cleared. If you select this check box, then 
the next wizard page is Assign Profiles to Teams.

Note: Team Size and Use Backfilling of Existing Teams are enabled only if 
you selected Use Team Constraints in the Select Site dialog box.

Click Next (if Use Backfilling of Existing Teams is checked ) or Finish.

Assign Profiles to Teams

This screen appears because you selected Use Backfilling of Existing Teams 
on the previous screen (Optimize Profiles).

The schedule scenario that you are building contains profiles and not actual 
agents in the selected site. You can assign profiles to be used to backfill teams 
that require it.
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The grid displays all non profile teams in the selected scenario. For each team, 
you can select the profile should be used to backfill that team. The grid has 
these columns:

Team—The team name

Profile—A drop-down list of possible profile choices:

• None (default)

• A list of profiles that corresponds the value of Max on the page Optimize 
Profiles

1. Select a profile for each team.

2. Click Finish.

Schedule Rebuild Wizard
Use the Schedule Rebuild Wizard to change a built schedule's included agents, 
teams, and/or dates:

1. Click the Rebuild schedule button on a schedule scenario view's Actions 
toolbar or select this command from the Actions menu.

The first of the Schedule Rebuild Wizard's two screens, Choose Start/End 
Date, opens.

Enter the dates for which you want to rebuild the schedule.

Neither date can be outside the scenario's original date range.

2. Click Next.

3. From the Select Team window's Agents list, select the agents you want to 
include in the modified schedule. 

You can expand business units to display their sites and you can expand 
sites to display their teams and agents. You can select any number of 
agents and/or teams within a single site. 

Note: A highlighted background color indicates agents whose schedules 
were edited (for the selected date range) after the last build or 
rebuild.

4. If appropriate, select Do not rebuild modified agent schedules.

Selecting this check box prevents the schedule builder from making further 
schedule changes for agents whose schedules were edited after the last 
build/rebuild.

5. Click Finish to rebuild the schedule with the new parameters.

Or click Back to review or change your Start/End Date selections, or 
Cancel to close the wizard without modifying the schedule.



252 Workforce Management 7.6

Chapter 5: Scheduling Publishing/Extracting Schedules

Select Agents

Use the Intra-Day Schedule Rebuild Wizard's Select Agents screen to select 
one or more teams or agents within a team.

• Under Select Agents, you can expand business units (if configured) to 
display their sites and expand sites to display their agents. The tree shows 
only those agents who have the skills that are required for the scheduled 
activities.

You can select individual agents from multiple teams, or you can select whole 
teams or the whole site. 

A highlighted background appears around the names of Agents whose 
schedule was edited in the selected date range after the last build or rebuild.

If you selected Reschedule breaks, meals, activities/activity sets/task 
sequences, shift start and/or end times may change on the Select Options 
screen, the Select Activities screen appears. Otherwise, click Finish, or Cancel 
to discard your selections and close the wizard.Select Do not rebuild 
modified agent schedules to exclude agents whose schedules have already 
been changed from the last time the schedule was built, re-built, or published. 

Select Activities

The Select Activities screen appears if, on the Rescheduling Options screen, 
you select one of the following options:

• Reschedule activities/activity sets/task sequences only

• Reschedule breaks, meals, activities/activity sets/task sequences, without 
affecting shift start/end times

• Reschedule breaks, meals, activities/activity sets/task sequences, shift start 
and/or end times may change

To complete this screen:

1. Select one or more activities.

2. Select Retain scheduled activities to have the build add any activities 
selected above while still keeping the activities currently in the Schedule.

3. Click Finish, or Cancel to discard your selections and close the wizard.

Publishing/Extracting Schedules
Use the Publish Schedule Wizard to transfer unpublished schedule scenarios 
(or republish already-published schedule scenarios) to the Workforce 
Management database's Master Schedule, or to extract Master Schedule 
information to schedule scenarios.

The following sections cover:
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• Publishing to the WFM Database.

• Extracting from the WFM Database.

Why Publish Schedules?

• Publishing represents the act of making a schedule scenario official. Only 
the Master Schedule is regarded as the official schedule.

• Until a schedule is published, you cannot calculate certain performance 
data or real-time agent adherence data.

• Until a schedule is published, agents cannot view it in the WFM Web for 
Agents client interface.

Publishing to the Master Schedule

Before launching the Publish Schedule Wizard:

• Assign real agents to your schedule scenario's profile slots. (Only real 
agents' schedules are published to the Master Schedule.)

• Commit all pending changes that you want to include in the Master 
Schedule. Uncommitted pending changes are disregarded when the 
scenario is published.

To publish a schedule:

1. In the Schedule Scenarios view's Scenarios Table, select the scenario that 
you want to publish. Then, click the Publish button on the Actions toolbar.

The Publish Schedule Wizard's Select Action screen appears.

2. Select Publish to Master Schedule, and click Next.

The Publish to Master Schedule screen appears.

3. In the Publish Dates section, select the Start Date and End Date.

By default, the selected scenario's start and end dates appear in these fields. 

4. If you want to repeat the schedule in the future, select Publish to Date 
Range, and then select the Start Date and End Date that you want. 

The publish to Date Range feature enables you to publish the same 
schedule scenario for more than one schedule period. You can quickly 
publish schedules to fill an extended time period. However, be aware that:

If schedule length and the period selected to be published to the new date 
range do not match exactly, the Wizard copies as many days of the 
schedule as will fit into the new date-range period. For example, if the 
schedule is three weeks and the Publish to Date Range period is two 
weeks, the wizard copies only the first two weeks of the schedule. If the 
schedule is two weeks and the Publish to Date Range period is five weeks, 
the wizard copies the whole schedule twice in succession, and then copies 
the first week again to provide the fifth week of the new date range.
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All data within the schedule scenario is published to the new date range 
exactly. All schedule items, such as exceptions, breaks, meals, and time 
off, are also transferred.

5. From the Agents list, select which agents you want to publish to the target 
schedule.

You can expand business units to display their sites and you can expand 
sites to display their agents. You can select any number of real (not profile) 
agents.

6. Select the check box Insert granted exception, time off, and day off 
Calendar items to overlay these items in the schedule when the scenario is 
published to the Master Schedule. Clear the check box to ignore these 
items.

This option is useful when you want to use "fixed" agent schedules. You 
would create a 1-to-6 week schedule for one or more agents, and then use 
this feature to copy the schedule out into the future. When copying the 
schedule, WFM will account for granted Calendar items such as time off, 
exceptions, and days off. WFM may not be able to overlay all of the 
granted Calendar items because they may conflict with the items already in 
the schedule. In this case, you will receive a warning about the Calendar 
items which could not be scheduled.

7. Click Finish.

Baseline Master Schedule

After you publish a schedule scenario to the Master Schedule, WFM retains a 
snapshot of the Master Schedule at that point in time. This is called the 
baseline Master Schedule. Then, after you make changes to the Master 
Schedule, such as adding exceptions and granting vacations, you can compare 
the schedule coverage shown in the current Master Schedule against the 
schedule coverage stored in the baseline Master. The Schedule Summary 
Report and the Schedule Summary view present the comparison. 

The Master Schedule baseline is created/updated each time something is 
published to the Master Schedule for a particular date range. Example: Assume 
on May 25, you publish the June schedule scenario to the Master Schedule. 
Assume on May 28, you re-publish the same June schedule scenario to the 
Master Schedule. On the Schedule Summary Report and in the Schedule 
Summary view, WFM uses the May 28 published schedule as the baseline 
against which the current schedule is compared.

Extracting a Schedule from the Workforce Management 
Database

To transfer data from the Master Schedule into a schedule scenario: 
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1. In the Schedule Scenarios view's Scenarios Table, select the scenario into 
which you want to extract the data. Then, click the Publish button on the 
Actions toolbar.

The Publish Schedule Wizard's Select Action screen appears.

2. Select Extract from Master Schedule, and then click Next.

The Extract from Master Schedule screen appears.

3. In the Dates section, select the Start Date and End Date.

You must select dates within the target scenario's date range.

4. From the Agents list, select the agents whose schedules you want to extract 
to the target scenario.

You can expand business units to display their sites and you can expand 
sites to display their agents. You can select any number of real (not profile) 
agents.

5. Click Finish.

Note: Pending changes to the Master Schedule are not extracted to the 
schedule scenario.

Schedule Validation
Use the Review Messages window to manage warning and error messages that 
were generated the last time the schedule was built, validated, or rebuilt. 

The sections below cover:

• Using the Review Messages window.

• The Warnings list.

• The Errors list.

Using the Review Messages Window

The Review Messages window contains the following controls:

Choose Site—Use this drop-down list to select one site.

Reviewed—Select the check boxes in this column to indicate messages that 
you have reviewed.

Message—Shows the text of each generated message.

Save—Saves your reviewed selections and closes the window. 

Close—Discards all changes and closes the window. 
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Warnings List

Note: When Schedule building or validation generates the following 
warnings, the variable text shown here in braces { } is replaced with 
the actual value.

Warning[1] The workload of agent {A} cannot be increased to meet the planning period 
requirements.

The number of planning period hours scheduled for this agent is less than the 
minimum planning period requirement for the agent as described in the 
contract. This can happen when the agent is forced to take days off. Forced 
days off are usually caused by unrealistic contract weekend and day-off 
constraints. Other possible causes of forced days off include: the day-to-day 
distance constraint cannot be met; there are no shifts available on the day; or 
the day-off constraints require a day off. However, in cases where the agent 
begins work in the middle of a planning period, planning period work cannot 
be increased to the usual amount; therefore, you should either disregard the 
warning or enter the agent's history for the beginning of the planning period.

Warning[2] The workload of agent {A} cannot be decreased to meet the planning period 
requirements.

The number of planning period hours scheduled for this agent is greater than 
the maximum planning period requirement for the agent as described in the 
contract. This usually happens when the set number of daily and/or weekly 
hours does not allow for the planning period-hours constraint to be satisfied.

Warning[3] The scheduler could not assign a day off for agent {A} on week with first day 
{B}.

No days off have been assigned to an agent in the specified week in order to 
satisfy the agent's minimum days off per week requirement. This can happen 
when the contract day-off rules and the weekend fairness rules create a 
mandatory pattern of days-off assignment that is not compatible with the 
minimum number of days off per week.

Warning[4] Too many days off have already been assigned for agent {A} on week with 
first day {B}.

The user has assigned more days off to an agent in the specified week than are 
permitted by the agent's constraints. Contract weekend and/or day-off rules 
limit the number of days off allowed.

Warning[5] The workload of agent {A} cannot be increased to meet the weekly 
requirements on week with first day {B}.

The number of hours scheduled for this agent in the specified week does not 
meet the minimum weekly hours requirement for the agent as described in the 
contract. See Warning[1] for possible causes.
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Warning[6] The workload of agent {A} cannot be decreased to meet the weekly 
requirements on week with first day {B}.

The number of hours scheduled for this agent in the specified week is more 
than the maximum weekly hours requirement for the agent as described in the 
contract. See Warning[2] for possible causes.

Warning[7] No shifts match the constraints for contract {A} of agent {B} on day {C}.

No shifts matched the contract constraints for the specified agent on the 
specified day. Usually, this means that the shift does not have a duration that 
will satisfy the daily or weekly hours constraints for the contract, or that 
individual constraints or exceptions on that day prevent all available shifts for 
the agent.

Warning[8] No shifts match the constraints for agent {A} on day {B}; agent assigned a day 
off.

Scheduler is forced to schedule a day off for this agent because no shifts match 
the agent's contract constraints for this day. If a shift is configured to be 
available on this day, then this warning signals a bad configuration of either the 
shift or an associated meal. Verify that the durations for the shift and meal are 
valid.

Warning[9] Meal {A} is removed from shift {B} since it does not fit shift start/end 
constraints.

There is inconsistent data. For example, shifts are defined with a meal, but 
there is no way to schedule such a meal in the shift. In this case, the meal is 
removed from the definition of the shift, and the meal is ignored. This shift 
will not be used for scheduling. This is often reported along with Warning[8], 
described above.

Warning[10] Understaffed for day {A}, activity {B}, timestep {C}:{D} agents requested, 
{E} agents available.

There are not enough agents scheduled for this timestep to cover the specified 
activity.

Warning[11] Adjacency constraints force a day off for agent {A} on day {B}.

The minimum interval between two working days (as defined in Policies/Site 
Rules) cannot be satisfied. Therefore, Scheduler is forced to assign the agent a 
day off.

Warning[12] Break constraints were relaxed for agent {A} on day {B} in order to schedule 
breaks.

Scheduler is unable to schedule a break that complies with all constraints for 
this agent on the specified day, but assigns the most optimal breaks possible 
given the constraints.

Warning[13] Agent {A} has requested too many availability preferences; the maximum 
allowable was {B}; therefore, the satisfaction percentage has been decreased to 
{C}.
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The agent has requested more availability preferences than Scheduler could 
assign. Therefore, the preference fulfillment percentage has been decreased. 
This can happen when constraints, such as day-to-day distance, shift 
occurrences, or start-time synchronicity, make it impossible to satisfy all the 
preferences. It can also arise if the days-off constraint conflicts with a shift 
preference.

Warning[14] Meal {A} is in conflict with meal {B} for shift {C}.

Two meals or shift splits conflict on a given shift. In this case, the first of these 
two meals or splits is removed from the shift.

Warning[15] Agent {A} has made few availability preference requests; the minimum 
expected was {B}, therefore, the satisfaction percentage has been increased to 
{C}.

The agent has made very few availability preference requests. Because 
Scheduler was able to assign most or all the preferences, the preference 
fulfillment percentage has been increased. This can happen when an agent is 
set to work at a time that coincides with his or her availability preference, as in 
the case of synchronicity constraints.

Warning[16] The timestep constraint {A} is not satisfied for initial values of meal {B}.

When you specify the starting timestep for a meal, you must satisfy other 
constraints. (For example, ensure that the meal does not overlap with other 
schedule items.)

Warning[17] Historical data missing for agents; therefore, planning period constraints are 
ignored.

The schedule period begins after the first day of the planning period but there 
is no historical data for the planning period. Because there is no way to know 
how much the agent has already worked before the schedule was built, 
planning period constraints are ignored for this planning period only. One 
workaround is to publish a schedule covering the dates before the dates of the 
schedule that generated this message.

Warning[19] This warning may say one of the following:
 The Meeting {A} could not be scheduled.
 The Meeting {A} could not be scheduled on day {B}.
 The Meeting {A} could not be scheduled on days {B}-{C}.

The desired meeting cannot be scheduled as entered. Either no day was found 
that would satisfy the meeting requirements or the meeting could not be 
scheduled for certain dates.

Warning[20] Not enough seats on day {A} at time {B}.

There are not enough seats for the scheduled agents for this timestep. In some 
cases, this can produce violations of the agent hours and/or day-off constraints.

Warning[21] Not enough seats on day {A}, at time {B} and activity {C}.



Supervisor User’s Guide 259

Chapter 5: Scheduling Schedule Validation

The Maximum-Number-of-Seats constraint for the specified activity does not 
allow all agents to be scheduled. Scheduler schedules the agents anyway, but 
for each timestep during which there are more agents than seats, it generates 
this warning. The use of the maximum-seats constraint for each activity is for 
multiskilled scheduling only. Possible causes of this warning include 
insufficient flexibility in hours and/or day-off constraints, forcing agents to 
work when they are not needed.

Warning[22] Seniority of agent {A} is given as level {B}. This is greater than 100,000; 
therefore, the seniority level is set to 100,000.

The specified agent has a seniority greater than 100,000. This should not occur 
in normal use of Workforce Management.

Warning[23] The date interval {A} to {B} of constraint {C} is not included in the fine-grain 
period, so the outside part of this constraint is ignored.

This constraint extends for a longer period than the schedule period. Only the 
period covered by the schedule is "fine-grained." Constraints that extend past 
the schedule period are not considered during schedule building. This situation 
should not occur in normal Workforce Management use.

Warning[24] An incompatible shift preference and paid-hours exception on day {A} for 
agent {B}; therefore, the exception wins.

Both a preference and granted paid hours have been set in Staff. Scheduler 
accepts the paid hours and ignores the shift preference. 

Warning[25] Consider that team, maxseats, day-to-day, weekly, and monthly constraints are 
soft for agent {A} on day {B}.

You can override soft constraints in case a scheduling conflict occurs. Possible 
causes include:

One or more agents have a rotating schedule that forces them into conflict with 
team-synchronicity constraints.

An agent has an exception that requires a shift outside of the team start time 
window.

The maximum-seats constraint could not be adhered to, usually because the 
configuration does not allow enough flexibility in day-off and paid-hours 
assignments.

A coupling of weekend day-off and min/max/consecutive day-off constraints 
can force violations. Violations of weekly and/or monthly constraints usually 
indicate a significant configuration problem.

Warning[26] Rest (compensation) for agent {A} on day {B} lowered weekly/monthly goals 
by {C} hours.

A paid day off (a "bonus" paid day off in addition to regular days off) has been 
scheduled for the agent on the specified day. Therefore, weekly and monthly 
workload goals have been decreased by a certain number of hours.
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Warning[27] Rest (compensation) for agent {A} on day {B} raised weekly/monthly goals 
by {C} hours.

A paid day off (a "bonus" paid day off in addition to regular days off) has been 
scheduled for the agent on the specified day. Therefore, weekly and monthly 
workload goals have been increased by a certain number of hours.

Warning[28] Forced day off for agent {A} on day {B} lowered weekly/monthly goals by 
{C} hours.

Conflicting contract constraints will force the agent to have the day off. 
Usually, this is due to a combination of min/max/consecutive day-off and 
weekend day-off rules. It can also be caused by shift rejections.

Warning[29] Cannot meet shift maximum occurrences constraint for agent {A} and shift 
{B}.

Scheduler is unable to schedule a different shift, in violation of the constraint 
for maximum shift occurrence. This can occur if another shift is rejected or not 
available because of configuration constraints. It can also be caused by the 
start-time synchronicity constraint if alternate shifts do not allow the 
synchronicity constraint to be observed.

Warning[30] Cannot meet shift minimum occurrences constraint for agent {A} and shift 
{B}.

Scheduler is unable to meet shift constraints with regard to minimum number 
of hours/days configured for the specified agent and shift. See Warning[29], 
above.

Warning[31] Failed to satisfy constraint of type {A} for agent {B}.

Scheduler was unable to assign the schedule items for the agent required by the 
specified constraint. Usually, this is due to a conflicting combination of 
constraints.

Warning[32] Cannot assign a day-off period needed for agent {A}.

The agent is due for a day off in order to comply with the specific day-off 
period constraint, but Scheduler could find no possible time window in which 
to schedule a day-off period. This situation can sometimes occur if the 
minimum number of days per week or weekend-days per month requires a 
pattern of days off that is incompatible with the day-off period constraint.

Warning[33] Even breaks with relaxed constraints could not be scheduled for agent {A} on 
day {B}.

Scheduler could not assign any breaks to the agent on the specified day.

Warning[34] The start-step constraint {A} is not satisfied for initial values of shift {B}.

Check that the shift start time is compatible with the timestep requested.

Warning[35] Scheduler could not assign days off for agent {A}.
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Due to a conflict in constraints, Scheduler could not produce a satisfactory 
day-off sequence for this agent. Usually, this is due to a combination of 
minimum/maximum/consecutive day-off and weekend day-off rules.

Warning[36] {A} percent of activity {B} coverage has deteriorated on account of after-
scheduling swaps on day {C}.

Because of seniority considerations, the coverage for the specified activity has 
diminished by a certain percentage. This percentage is based upon the agents 
that had their schedules changed to account for seniority rights. If this effect is 
undesirable, change the Loose or Free setting in the Schedule Build Wizard to 
Strict.

Warning[37] Agent {A} has requested very few availability preferences. {B} requests were 
granted; therefore, the satisfaction percentage has been increased to {C}.

The agent has made few availability preference requests. A certain number has 
been granted; therefore, the preference fulfillment ratio has been increased by 
the specified amount.

Warning[38] Agent {A} has made too many availability preference requests. {B} requests 
were granted; therefore, the satisfaction percentage has been decreased to {C}.

The agent has made many availability preference requests. Only the specified 
number could be granted; therefore, the preference fulfillment ratio has been 
decreased by the indicated amount.

Warning[39] Agent {A} has requested very few shift preference requests. {B} requests were 
granted; therefore, the satisfaction percentage has been increased to {C}.

The agent has made few shift preference requests. More than the expected 
number has been granted; therefore, the preference fulfillment ratio has been 
increased by the specified amount.

Warning[40] Agent {A} has made too many shift requests. {B} requests were granted; 
therefore, the satisfaction percentage has been decreased to {C}.

The agent has made many shift preference requests. Only the specified number 
could be granted; therefore, the preference fulfillment ratio has been decreased 
by the indicated amount.

Warning[41] Scheduling period begins in the middle of the month and no scheduling history 
is provided.

No schedule has been published for the beginning of the first schedule month.

Warning[42] Work constraints starting on {A} and ending on {B} for agent {C} cannot be 
satisfied.

Because of conflicts in constraint settings, workload constraints for this agent 
cannot be fulfilled for the specified days.

Warning[43] Planning period work constraint for the dates {A} - {B} for agent {C} cannot 
be satisfied.
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Because of conflicts in planning period constraint settings, workload 
constraints for this agent cannot be fulfilled for the specified days.

Warning[44] Agent {A} cannot be swapped because of either a nonstandard shift, a forced 
day off, or an infeasible day-off sequence within the swap period.

The specified agent's schedule cannot be given to any other agent because it 
contains fixed elements that cannot be exchanged.

Warning[45] Schedule for agent {A} cannot be assigned to anyone; therefore, this agent has 
been removed from swap post treatment.

Because this agent's schedule is not valid for any other agent, it cannot be 
exchanged during swapping.

Warning[46] No activity was found for agent {A} on day {B} at timestep {C}; therefore, a 
forced break was assigned.

None of this agent's assigned activities are available during the specified 
timestep(s). Therefore, Scheduler was forced to assign a break. This situation 
occurs when the agent's activities are all exclusive and could not be assigned 
without violating the minimum-duration-for-exclusive-activity constraint.

Warning[47] Agent {A} has no nonexclusive activity for day {B}.

All of this agent's activities are contained in exclusivity sets, which limit how 
the agent's activities can be scheduled. These constraints might create some 
periods during this agent's workday when no activity can be scheduled.

Warning[48] For day {A}, agent {B} can work only on exclusive activity and is useless 
according to charge. Therefore, activity distribution might be inconsistent.

The agent has been configured to work on an activity for which the forecast 
predicts no interactions. The assignment of the agent to the unnecessary 
activity might degrade workload coverage.

Warning[49] The paid exception or time off was removed on day {A} for agent {B} to find 
feasible shift.

A part-day exception or time off that violates shift settings has been removed 
so that Scheduler can assign this agent a shift.

Warning[50] The Day Off per Period constraint configured for agent {A} is incorrect.

Warning[51] Ignored activity {A} matching no task sequence of {B}.

Scheduler is not using the specified activity because, although it is included in 
the activity set configured for the task sequence, its constraints do not match 
the task sequence constraints. 

Warning[52] Break {A}, anchorage to start implies minimum/maximum lengths from start 
to be equal.

Because this break is anchored to the shift start time, the distance between the 
shift start time and the break start time cannot vary. 

Warning[53] No shift of {A}'s contract can match preferences on day {B} (ignore).
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Warning[54] Preference requirement on period ({A}..{B}) for agent {C} cannot be fulfilled, 
and is ignored.

Warning[55] Meal {A} does not fit in shift {B}. Shift can not be scheduled.

Warning[56] Time-window for day {A} of agent {B} reduced to [{C},{D}] to match 
activity open hours.

Warning[57] Break and meal sequence for [{A},{B}] duration of shift {C} was ignored as 
infeasible. Sequence: {D}

Warning[58] Break and meal sequence for [{A},{B}] duration of shift {C} contains no valid 
break combination.

Warning[59] Default break sequence for shift {A} is infeasible and there is no break 
sequence for work duration of {B}.

Warning[60] Exception is removed on day {A} for agent {B} as it is out of day time 
window.

Warning[61] Planning period hours limit granted preferences to {A} for agent {B}. 
Decreasing quotas to {C}.

Warning[62] More than {A} constraints were violated during dayoff scheduling. Further 
warnings will not be generated.

Warning[63] Single skill mode can not be used when task sequences are defined. Changing 
to multi-skill mode.

Warning[64] {A} constraint can not be satisfied for agent {B} starting at {C} and ending at 
{D}.

The specified constraint for this agent cannot be satisfied for the specified date 
interval.

Warning[65] Some breaks could not be scheduled for agent {A} on day {B}.

Warning[66] Maximum distance Shift Items constraint could not be satisfied for agent {A} 
on day {B}.

Warning[67] Minimum shift item distance constraint could not be satisfied for agent {A}.

Warning[68] Shift items could not be scheduled at configured time intervals for agent {A} 
on day {B}.

Warning[1000] Calendar item containing invalid shift ID={A} assigned to agent '{B}' on day 
{C}.

Warning[1001] Exception will be ignored for overnight shift of day {A} for agent '{B}'. Strict 
work time can not accommodate partially covered exception.

Warning[1002] Schedule start date weekday is not the same as long period start day. Moving 
long period back {A} days.

Warning[1003] Task sequence '{A}' was removed as it contains activity set '{B}' with no 
activities or assigned activities are not present in schedule scenario.
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Warning[1004] Null element ignored in break meal list of shift '{A}'

Warning[1005] Both break and meal are not null element in break meal list of shift '{A}'

Warning[1006] Shift '{A}' task sequence ID={B} was not found.

Warning[1007] Agent '{A}' has no assigned contract. Agent will not be scheduled.

Warning[1008] Contract ID={A} assigned to agent '{A}' is unknown at site '{B}'.

Warning[1009] Agent '{A}' has accrual rule ID={B} that is not known to WFMServer.

Warning[1010] The team ID={A} of agent '{B}' does not exist at site '{C}'.

Warning[1012] Removed activity set '{A}' with no activities. Activities are either not present 
in schedule scenario or misconfigured.

Warning[1013] Removed task sequence '{A}' ID={B} since it contains invalid activity sets. 
Check prior warnings for activity set configuration problems.

Warning[1014] Removed agent '{A}' with no activities. Activities are either not assigned to 
agent, missing in schedule scenario or not configured properly.

Warning[1015] Minimum shift '{A}'s' paid duration is not covered by combine list. Minimum 
shift paid time changed to {B} hours {C} minutes.

Warning[1016] Task sequence ID={A} was removed from shift '{B}'. Task sequence may be 
misconfigured or contain not available activity set.

Warning[1017] Shift '{A}' was removed since it has no assigned mandatory task sequences.

Warning[1018 One or more shifts assigned to contract '{A}' could not be used due to 
configuration problems.

Not all shifts that were assigned to contract could be used for scheduling. This 
warning usually is issued after more detailed shift configuration warnings.

Warning[1019] Agent '{A}' will not be scheduled. Scenario activities can not be used in any 
one of task sequences of contract shifts.

Schedule scenario does not contain activities that are required in order to 
schedule shifts with mandatory task sequences. 

Warning[1020] Activity sets will be used for scheduling even though task sequences exist in 
the site.

Task sequences exist in the database but are not assigned to the shifts. 

Warning[1021] Removed contract '{A}'. Shifts assigned to this contract are not configured 
properly.

Contract has no useable shifts, and therefore the contract is removed from 
scheduling. Shift configuration problems are described in other warnings. 

Warning[1022] Removed agent '{A}' with mis-configured contract.

Contract that was assigned to agent cannot be used. This warning usually 
follows warning 1021.
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Errors List

Note: When Schedule building or validation generates the following errors, 
the variable text shown here in braces { } is replaced with the actual 
value.

Error[1] Shift {A} violates contract constraints for agent {B} on day {C}.

Error[2] The constrained start and end times {A} and {B} are not compatible with 
imposed activity for agent {C} on day {D}.

Error[3] No shift was found for agent {A} on day {B}

Error[4] Schedule build was canceled by user.

Error[5]] Wrong time unit for timestep {A}.

Error[6] Wrong scheduling start date {A} and/or end date {B}.

Error[7] Length of break {A} is not a supported break length.

Error[8] 0 is not a valid value for minimal daily workload in contract {A}.

Error[9] The minimum/maximum constraints for contract {A} make it impossible to 
schedule.

Error[10] The minimum weekly workload cannot be reached for contract {A}.

Error[11] The minimum planning period workload cannot be reached for contract {A}.

Error[12] The day {A} that was given is outside the planning period.

Error[13] On day {A}, activity {B} has not been declared.

Error[14] On day {A}, the charge specification for activity {B} cannot be processed.

Error[15] On day {A}, the charge specification for activity {B} has the wrong length.

Error[16] The code for contract {A} given for the agent {B} is not valid.

Error[17] The activity string {A} given for the agent {B} is not valid.

Error[18] Too many consecutive days worked: {A} days worked prior to the planning 
period for the agent {B}.

Error[19] The month goal {A} for agent {B} conflicts with the contract {C}: minimum 
{D}, maximum {E}.

Error[20] Impossible to assign a weekend off in the first month to the agent {A}.

Error[21] The code number {A} is not valid to designate an agent.

Error[22] The team for agent {A} has already been assigned.

Error[23] The day-off type {A} for agent {B} is not valid.

Error[24] The preference weight {A} for agent {B} is not valid.
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Error[26] The day off costs for day off type {A} are invalid.

Error[27] Impossible to schedule work for agent {A} on day {B} although required by 
exceptions or hard preferences.

Error[28] Wrong shift index: {A}

Error[29] Wrong meal index: {A}

Error[30] Schedule of agent {A} cannot be assigned to any other agent. Do not use this 
agent for after-scheduling swapping.

Error[31] Break length {A} is not a multiple of time unit {B}.

Error[32] The day-of-week indexed by number {A} is not valid. See definition of shift 
{B}.

Error[33] There is not enough memory for this problem {A}; adjust memory parameters.

Error[34] Too many activities configured: {A} is the maximum number of activities. 
Configured {B}.

Error[35] No other agent's schedule can be assigned to agent {A}. Remove this agent 
from after-scheduling swapping.

Error[36] Impossible to overwrite shift for agent {A} on day {B}: unpaid times and work 
length not compatible.

Error[37] Impossible to find acceptable shift for agent {A} on day {B}: forbidden by 
day-to-day distance constraint.

Error[38] Activity hours start time {A}, end time {B}, for activity {C} not compatible 
with scheduled hours.

Error[39] Request on day {A} and time {B} violates activity open hours for activity {C}.

Error[40] Contradictory requirements for agent {A} on day {B}: agent should be both 
present and off.

Error[41] Unable to satisfy week/month constraints after giving compensation rest for 
agent {A} on day {B}.

Error[42] At least one schedule in the preference list for agent {A} is not swappable for 
this agent.

Error[43] Too many shifts: the maximum number is {A}, but more than {B} were 
requested.

Error[44] Agent {A} was not in the initial list of swappable agents.

Error[45] Wrong preference time window for agent {C}: timestep {A} < timestep {B}.

Error[46] Rescheduling data of agent {A} on day {B} is inconsistent with the current 
meal definition. Restore initial settings before rescheduling.

Error[47] The list of time windows for a meeting between time {A} and time {B} is 
incorrect.
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Error[48] The list that specifies the DOC set for agent {A} is not correct.

Note: DOC = Day-Off Constraint.

Error[49] The number {A} is not valid to designate a team.

Error[50] Weekly work constraint for agent {A} has invalid dates {B} and {C}.

Error[51] Rescheduling data of agent {A} on day {B} is inconsistent with current shift 
definition. Do not change it before rescheduling.

Error[52] Wrong break index: {A}

Error[53] Wrong activity index: {A}

Error[54] Wrong task sequence index: {A}

Error[55] Activity {A} already belongs to activity set {B} (hence cannot be included in 
activity set {C})

Error[56] Invalid break sequence({A}): all alternatives of the combine list must share the 
same unpaid length

Error[57] Invalid break sequence({A}): a sequence with no break must have 
minDuration=0

Error[58] Invalid task sequence({A}): mismatching start/end anchors

Error[59] Exclusive activities and task sequences cannot coexist

Error[60] No agent has been defined: solve aborted.

Error[61] More than {A} constraint failures during dayoff scheduling.

Error[62] Shortest shift item sequence for shift {A} has minimum duration of {B}. 
Sequence covering minimum shift duration is required.

Error[63] Shift {A} item sequence for longer shift contains less unpaid time ({B} 
minutes) than shorter sequence.

Error[66] Internal scheduling engine error.

Error[1000] Failed to load schedule scenario. Scenario ID={A}

Error[1001] Loaded schedule scenario does not contain required site. Scenario ID={A}, 
site ID={B}.

Error[1002] Specified schedule interval is {A} days. At least one week is required.

Error[1003] Specified schedule interval is {A} days long. Schedule period can not be 
longer than 6 weeks.

Error[1004] Specified schedule interval is {A} days long. Schedule period must contain 
exact number of weeks.

Error[1005] Invalid long period type={A} detected (more than 6 weeks or less than 0) for 
site '{B}'.
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Error[1006] WFMServer returned 0 sites.

Error[1007] Site to be scheduled was not found in database. Site ID={A}.

Error[1008] Activities not found in the database for site '{B}'.

Error[1009] Activity '{B}' belongs to unknown activity set. Set ID={A}.

Error[1010] Task sequence '{B}' references activity set ID={A} that is not defined in 
database.

Error[1011] Task anchor value {A} is incorrect for sequence '{B}' task index={A}.

Error[1012] Unknown break ID={A} assigned to shift '{B}'.

Error[1013] Unknown meal ID={A} assigned to shift '{B}'.

Error[1014] Meal ID={A} is in combine list but not assigned to shift '{B}'.

Error[1015] Break ID={A} is in combine list but not assigned to shift '{B}'.

Error[1016] Can not create schedule. Schedule scenario or configuration is not valid.

Error[1017] Synchronize work start threshold value {A} is out of range [-1, 6]—for site 
'{B}'.

Error[1018] Can not schedule task sequences in single skill scheduling mode. Use multi-
skill scheduling instead.

Error[1020] Unknown calendar item exception type ID={A} assigned to agent '{B}' on day 
{C}.

Error[1021] No activities configured for scheduling. Check schedule scenario and 
configuration.

Error[1022] No contracts configured for scheduling. Check schedule scenario and 
configuration.

Error[1023] No shifts configured for scheduling. Check schedule scenario and 
configuration.

Error[1024] No agents configured for scheduling. Check schedule scenario and 
configuration.

Error[1025] Long period start date is not defined for site '{A}'.

Error[1026] Cannot reschedule. Previous schedule was created with incompatible version 
of WFM Builder.

Error[1027] Cannot reschedule. Shift from original schedule is no longer available.

Error[1028] Cannot reschedule. Meal from original schedule is no longer available.

Error[1029] Cannot reschedule. Meal assignment to shifts have changed.

Error[1030] Cannot reschedule. Shift assignment to contracts have changed.

Error[1031] Cannot reschedule. Shift configuration has changed.
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Error[1032] Cannot reschedule. Task sequence from original schedule is no longer 
available.

Error[1035] No daily agent schedules are available for schedule re-optimization.

Error[1066] Internal error.

Error[1067] Not enough memory to build the schedule. {A} MBytes of free memory is 
required.

Error[1068] WFM Builder failed to save schedule.

Error[1069] WFM Server communication problem: {A}.

Error[1070] WFM Server communication problem.

Error[1071] Configuration Server communication problem: {A}.

Error[1072] More than one WFM Server specified in Builder connections.

Error[1073] WFM Server not specified in application connections.

Error[1074] Failed to retrieve WFM Server '{A}' information.
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6 Trading
Use the Trading module to review, and accept or decline, agents’ proposed 
schedule trades. The features of this module are:
 Using the List of Trades View, page 271
 How Trading Works, page 272
 List of Trades View, page 275
 Trading Comments Dialog Box, page 277
 Schedule Details Dialog Box, page 277

Using the List of Trades View
The List of Trades view displays a week's schedule trading information for a 
single site at a time. Controls enable you to view details about each trade, to 
accept or decline the trade, and to enter comments about your decision.

Trade proposals appear in the List of Trades view if they meet the following 
criteria:

• The trade has not been automatically approved. Automatic approval is 
based on WFM's built-in trade rules or on exception types' own configured 
trade rules.

• The trade has not been automatically canceled. WFM automatically 
cancels a proposed trade if either agent's schedule has been modified in 
some way in the Master Schedule since the trade request was made. For 
example, a supervisor has explicitly modified the agent schedule; or 
another trade, with overlapping schedule data, has been approved and 
executed.

• The trade has not been automatically declined. WFM automatically 
declines a proposed trade if either agent's schedule overlaps with overnight 
schedule from the previous day for a recipient agent.
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• The trade has not yet been explicitly approved or declined by any 
supervisor. (Once acted upon, trades no longer appear.)

If a trade proposal has not been approved or declined by its effective date, the 
proposal expires and the trade does not occur.

How Trading Works
The following sections describe how a schedule trade proceeds to approval or 
rejection:

• Trading Summarized

• Requirements for a Successful Trade

• How Trades Get Tested for Automatic Approval
 Exceptions' Trade Conditions
 Auto-Decline Conditions
 Auto-Approval Conditions
 Supervisor Approval Conditions
 Auto-Cancel Conditions
 Expiration Conditions

Trading Summarized

A trade can include up to one full week of schedule days. Every schedule trade 
requires:

• One agent's proposal for a trade. The proposal specifies which schedule 
days this agent wants to trade.

• Another agent's response to that proposal. The response indicates this 
agent's willingness to accept the proposed trade. 

• An approval. The approval can be either automatic (by WFM Web) or 
explicit (by a supervisor).

For some trades, the proposing agent must explicitly accept the response 
before submitting the trade for approval. This is always true for community 
proposals, which are offered to all agents within a team or site.

If a trade is approved, it is executed and both agents' schedules change to 
reflect it. The trade no longer appears in most trading windows within WFM 
Web for Agents. (However, agents still see their own proposals in the WFM 
Web for Agents My Proposals window, even after the corresponding trades are 
executed.)

Not all trades are approved: 

• Under certain conditions (for example, when one agent is not qualified for 
the other's scheduled activities), WFM Web automatically declines a trade. 
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• If either agent's schedule is changed before a pending trade's approval, the 
trade is automatically canceled. 

• A supervisor may explicitly decline a trade. 

• If a pending trade has not been approved before the first day involved in 
the trade, it expires. 

In each of these cases, the trade does not occur.

Requirements for a Successful Trade

For a trade to take place, all of the following steps must occur. (See Workforce 
Management Web for Agents Help for details about how agents perform the 
first three steps.)

• One agent creates a community or personal trade proposal.

• At least one agent responds to the community proposal, or the receiving 
agent accepts the personal proposal.

• The proposing agent accepts a response to a community or personal 
proposal.

(This step is required for personal proposals only if the proposing agent 
specified manual approval.)

• The trade receives either WFM Web's automatic approval or a supervisor's 
explicit approval.

Note: At all steps before approval, a pending trade can fail in one of three 
ways: either agent can cancel it; the trade can automatically be 
canceled if either agent's schedule is changed; or the trade can expire.

How Trades are Tested for Automatic Approval

Once both agents have accepted a trade proposal, WFM Web tests it for 
automatic approval. These tests evaluate the trade using the conditions listed in 
each of the following sections:

Exceptions' Trade Conditions

If either agent has a scheduled exception on any of the days to be traded, WFM 
Web tests the trade against the trade rules configured for that exception type. 
For example, exceptions that count as vacation time always have either the 
Delete or the Keep with agent rule. 

Here is how WFM Web acts upon each trade rule:

Delete—Allows the trade to proceed to the next test, but deletes the exception 
from the schedule.
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Do not trade—Agent is not allowed to create trading proposal on day with 
scheduled exception “Do not trade”.

Keep with agent—Allows the trade to proceed to the next test, but keeps the 
scheduled exception with the original agent.

Keep with schedule—Allows the trade to proceed to the next test, and trades 
the exception along with the schedule.

Auto-Decline Conditions

WFM Web automatically declines a trade if any of the following conditions is 
true for any day included in the trade:

• Either agent's schedule overlaps with the overnight schedule from the 
previous day for a recipient agent.

• A trading proposal includes a day with the “do not trade” exception.

Supervisor Approval Conditions

WFM Web places a trade “in review”—a status that requires a supervisor to 
approve the trade—if the trade involves any of the following conditions:

• The traded schedules have different work durations.

• Either agent is trading days off for working days.

• Either agent has a scheduled exception with the delete rule enabled.

• Either agent is trading a keep with agent exception for fixed-staff work.

• The trade violates an agent's availability (contract availability, granted 
availability preferences, or rotating availability).

• The trade violates certain contract terms or site rules: minimum or 
maximum working hours per day or per week; minimum or maximum days 
off per week; or minimum time off between consecutive working days.

Auto-Approval Conditions

If a schedule trade does not match any of the Auto-Decline or Supervisor 
Approval conditions, WFM Web automatically approves it and trades the 
schedules.

Auto-Cancel Conditions

WFM Web automatically cancels a trade proposal, a response, or a pending 
trade in review if either agent's schedule is modified in the Master Schedule. 
Examples of auto-cancel conditions are:

• A supervisor explicitly modifies either agent's schedule.
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• Another trade is approved and executed for either agent that involves a 
schedule period that overlaps with the schedule period for this trade.

Expiration Conditions

If a trade has not received approval by the day before its first included day, it 
expires, and can no longer be approved by any agent or supervisor.

List of Trades View
Use the List of Trades view to review and manage agents' pending schedule 
trades. The view displays a table of agents’ proposed schedule trades, standard 
date-selection controls, buttons to accept or decline each pending trade, and a 
drop-down list that modifies the table's contents.

The following sections cover:

• Displaying the list of trades

• Using the table

• Accepting or declining trades

• The Show data for drop-down list (Working Start/End Times, Total Paid 
Hours, or Shift Names)

Displaying the List of Trades

To display the List of Trades view:

1. In the Modules tree, click Trading > List of Trades.

The List of Trades view appears.

2. In the Objects tree, select a site, teams, and/or agents.

You can expand business units to display their sites and you can expand 
sites to display their teams and agents. You can select any number of 
agents and/or teams within a single site. 

Trades can occur only between agents in the same site. If you select a new 
site or its teams/agents, this clears any previous selection that you made 
within a different site.

3. Click Get data to populate the table for the selected agents.

Using the Table

The List of Trades table shows all of the proposed schedule trades that meet 
the following criteria:

• At least one trade participant is among the agents that you selected in the 
Objects tree.
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• The trade can still be accepted or declined. (Once accepted or declined, 
trades no longer appear in the table.)

• The trade is within the selected week. (To see other weeks, use the date-
selection controls at the upper right.)

Each proposed trade appears on two rows. (If a scroll bar appears to the right, 
you can use it to reveal more trades.) The table includes the following 
columns:

Dates—Start and end dates for the proposed trade.

Agent—Names of both agents involved in the trade.

[Weekdays]—Agent schedule information for the specific day in the trade. 
The cell contents correspond to your selection from the Show Data for drop-
down list.

If the agent is not scheduled for a shift on this day, the cell contains: Day Off, 
Vacation, Working Hours (for scheduled working hours without a shift), or an 
exception name (for scheduled full-day exceptions). A blank cell indicates that 
this day is not included in the proposed schedule trade.

Total Paid—Total paid hours in the trade proposal.

Details—Button to display schedule details for both agents involved in the 
trade.

Accepting or Declining Trades

To accept or decline proposed trades:

1. Click one or more trades in the table to select them. 

2. Select one of the following options from the view's right side (or on the 
Actions menu):

Accept—Opens the Comments window for you to add an (optional) 
comment and approve the selected trade(s)

Decline—Opens the Comments window for you to add a (required) 
comment and reject the selected trade(s).

Show Data for

From this drop-down list, you can select what you want to display inside each 
day's table cell:

Total Working Hours—Total working time for each day.

Working Start/End Time—Start and end times of agents' work. (Default 
display option.)

Shift Names—Names of agents' assigned shifts for each day.
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Trading Comments Dialog Box
Use the Trading Comments dialog box to confirm your acceptance or rejection 
of a proposed schedule trade, and to add a comment about your decision:

1. Type your comment into the Comments text box.

A comment is required when you decline a trade, but it is optional when 
you accept a trade.

2. Do one of the following:
 Click OK to attach your comment and confirm the trade's acceptance 

or rejection.
 Click Cancel to discard your comment and take no action on the 

proposed trade.

Clicking either button closes the window and returns you to the List of 
Trades view.

Schedule Details Dialog Box
Use the Schedule Details dialog box to view schedule information for both of 
the agents in a proposed schedule trade. 

Each column displays one agent's information, in the following rows:

Agent—The agent's name.

Date—The date for which details are displayed.

Paid Hrs—The agent's total paid hours for the scheduled states/activities.

Sch. States—the states or activities for which the agent is scheduled.

Sch. Attendance: Start Time—The agent's scheduled start time for these 
states/activities.

Sch. Attendance: End Time—The agent's scheduled end time for these 
states/activities.
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7 Performance and 
Adherence
Use the Performance module to display performance statistics for Business 
Units, sites, and activities. The features of this module are:
 Performance Monitor View, page 280
 Performance Intra-Day View, page 282
 Performance Graphs View, page 285
 Performance Alerts View, page 286
 Performance Options Dialog Box, page 287
 What-If Window, page 288
 Adherence, page 290
 Adherence Overview, page 290
 Adherence Details View, page 290
 Adherence Filter Dialog Box, page 292
 Adherence Details Options Dialog Box, page 293
 Adherence Graphical View, page 294

This module includes a Monitor view for the most recently completed 
timestep, an Intra-day table view, an Alerts view, and a Graphs view. 

All views display the following statistics, which are calculated by the WFM 
servers:

• Interaction Volume—Forecast and Actual number of interactions. 

• AHT (sec)—Forecast and Actual average handling time, in seconds.

• Abandoned Calls (%)—Scheduled, Required, and Actual percentage of 
abandoned calls.

• Service Level (%)—Scheduled, Required, and Actual service level 
percentage. 

• ASA (sec)—Scheduled, Required, and Actual average speed of answer, in 
seconds.
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• Staffing—Scheduled (Sch.) and Required (Req.) number of agents for 
each activity. If an agent works only part of a time interval, only the 
portion during which the agent works (rounded to the nearest minute) is 
counted toward scheduled staffing. As a result, the scheduled staffing 
values may be expressed as fractions. Required staffing values are taken 
from the forecast and are always whole numbers.

• Variance—Optimal staffing value for the timestep minus the scheduled 
number of agents (Sch.), and the optimal staffing value for the timestep 
minus the required number of agents (Req.).

Note: Optimal staffing is a calculation based on actual interaction volume, 
actual AHT, and the service objectives specified in the forecast. This 
value is not displayed on its own, but is used in calculating Variance 
values. 

• Headcount—Number of scheduled (Sch.) and actually working (Act.) 
agents. For more information, see description of Headcount in the Master 
Schedule Summary view.

These statistics are presented for a 24-hour range, with 12 hours before, and 12 
hours after, the current timestep. The displayed data is automatically refreshed 
at least once per minute.

For timesteps in the future, the displayed “actual” values are those that WFM 
Web anticipates by comparing past data with the planned forecast. These 
anticipated values do not affect the schedule, and they are not saved.

The anticipated values can help you make real-time changes to your site setup. 
For example, unneeded agents can be sent home if you are overstaffed, or extra 
agents can be called in if you are understaffed. You cannot change the 
schedule from the Performance views; use the Master Schedule Intra-Day view 
to do so.

Note: For timesteps that have an interaction volume of zero, you can display 
service-level data as either 0% or 100%. This is determined in 
Configuration Server by the WFM Server application’s Options tab > 
PerformanceService section > NoCallsServiceLevel key, whose 
value can be set to either 0 or 100. The default value is 0.

Performance Monitor View
Use the Monitor view to view a horizontal bar graph for each performance 
statistic, based on the most recent timestep. 

The following sections cover:

• Displaying the Monitor view.

• Using the Monitor view.
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• Required data options.

Displaying the Monitor View

1. In the Modules tree, select Performance > Monitor.

The Monitor view appears. If you switched to this view from another 
Performance view, it retains your earlier objects selection and shows 
graphs for the most recent timestep.

2. Select the enterprise, a business unit, site, or activity in the Objects tree.

In the tree, you can expand business units to show their sites and expand sites 
to show their activities. If you make a new selection, the graphs refresh to 
match it.

Using the Monitor View

The Monitor view shows as many graphs as can fit on the screen at once. Use 
the scroll bar to the right to reveal graphs for additional statistics.

Each graph shows actual data, and either forecasted data or scheduled and 
required data. The displayed data is automatically refreshed at the conclusion 
of each 15-minute timestep, and represents the values from the most recent 
timestep.

The Legend (at the bottom) shows which color bar indicates which data 
category. Next to each data bar, a label lists the numerical value shown on the 
graph, with the following prefixes: A for actual data, F for forecasted, S for 
scheduled, and R for required.

Note: Scheduled metrics such as scheduled Average Speed of Answer (sec), 
Scheduled Service Level Percentage, and so on, describe what 
objectives you should meet based on the number of agents scheduled.

If alerts were configured for a statistic and that statistic exceeds the alert's 
configured deviation level, a red ALERT comment appears near the graph.

• Double-click any graph to display a graphical view of the corresponding 
statistic.

Required Data Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

• Show Required—Turns on and off the display of “Required” data in some 
statistics' graphs. (This option is a toggle: A darker button color, or a check 
mark beside the Actions menu option, indicates that it is selected. Click the 
same option again to deselect it.)
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• Use Multi-site Activities—This button becomes enabled when you select 
a multi-site activity or business unit in the Objects tree. Clicking this 
button displays data for the selected multi-site activity.

You can also use the Performance drop-down list (to the right of Show 
Required) to jump to other Performance views.

Performance Intra-Day View
Use the Intra-Day view to display performance statistics (both summarized and 
detailed) in a grid. 

The following sections cover:

• Displaying the Intra-Day view.

• Reading and navigating the grid.

• Display, copy/paste, and other options.

Displaying the Intra-Day View

1. In the Modules tree, select Performance > Intra-Day. 

The Intra-Day view appears. If you switched to this view from another 
Performance view, it retains your earlier Objects tree selection and shows 
the corresponding statistics.

2. Select the enterprise, a business unit, a multi-site activity, an activity 
group, a site, or an activity in the Objects tree.

In the tree, you can expand business units to show their sites and activity 
groups and multi-site activities, and expand sites to show their activities. If you 
made a new selection in the Objects tree, the grid is updated to match it.

Reading and Navigating the Grid

For each statistic, the grid displays actual values compared to forecasted, or 
scheduled and required, values. The displayed data is automatically refreshed 
at the conclusion of each 15-minute timestep, and represents the values from 
the most recent timestep. The grid's rows show timesteps, and its columns 
show statistic categories. The current timestep is identified by a yellow 
background.

By default, the grid shows a rolling view, which displays 12 hours before, and 
12 hours after, the current timestep. You can choose instead to have the grid 
show the Current Day view, which shows all of the timesteps, from midnight 
to midnight, of the current day.

• To use the current-day view, select Current Day from the Actions menu.
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Note: When WFM is unable to calculate a value for a particular timestep, or 
if no value has yet been entered for it in forecast views, the cell is 
empty (blank). 

Grid Rows

The grid contains the following rows, which are labeled in the Time Step 
column:

First row (--)—The first row displays summary (aggregate total or average) 
values for each statistic, calculated from the grid's first displayed timestep until 
the current timestep. 

Timestep rows (numbered)—The remaining rows show 15-minute timesteps. 
There are 24 hours' worth of data, which may be shown as including 12 hours 
before, and 12 hours after, the current timestep (rolling view) or from midnight 
to midnight of the current day (Current Day view). The rolling view is the 
default view.

Use the scroll bar to the right to reveal more timesteps. A yellow bar indicates 
the current timestep.

Grid Columns

The grid's remaining columns show the following statistics and subcategories:

Interaction Volume—Forecast and Actual number of interactions. 

AHT (sec)—Forecast and Actual average handling time, in seconds.

Abandoned Calls (%)—Scheduled, Required, and Actual percentage of 
abandoned calls.

Service Level (%)—Scheduled, Required, and Actual service level 
percentage. 

ASA (sec)—Scheduled, Required, and Actual average speed of answer, in 
seconds.

Staffing—Scheduled (Sch.) and Required (Req.) number of agents for each 
activity. If an agent works only part of a time interval, only the portion during 
which the agent works (rounded to the nearest minute) is counted toward 
scheduled staffing. As a result, the scheduled staffing values may be expressed 
as fractions. Required staffing values are taken from the forecast and are 
always whole numbers.

Variance—Optimal staffing value for the timestep minus the scheduled 
number of agents (Sch.), and the optimal staffing value for the timestep minus 
the required number of agents (Req.).
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Note: Optimal staffing is a calculation based on actual interaction volume, 
actual AHT, and the service objectives specified in the forecast. This 
value is not displayed on its own, but is used in calculating Variance 
values. 

Headcount—Number of scheduled (Sch.) and actually working (Act.) agents. 
For more information, see description of Headcount in the Master Schedule 
Summary view. 

Note: Use the Show Required button to display or hide all of the Required 
columns.

Anticipated Values

For Interaction Volume and AHT, future “actual” timestep values are 
calculated based on the ratio of previous actual/forecast values from moment 
to moment. For the other columns, values for future timesteps are forecasted 
based on anticipated IV and AHT. Actual values replace these anticipated 
values as the displayed data is refreshed. 

Display, Copy/Paste, and Other Options

The Intra-Day view provides the following options:

• You can resize the grid columns to better view their contents.

• You can copy data from the grid to the clipboard and then paste it into 
another application.

1. Click, or use the Tab or arrow keys, to move the selection box to one or 
more table cells.

2. Select Edit > copy, or use your operating system's “copy” keyboard 
shortcut (such as Ctrl+C or Command+C).

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

Show Required—Turns on and off the display of Required columns for all 
statistics. (This option is a toggle: A darker button color, or a check mark 
beside the Actions menu option, indicates that it is selected. Click the same 
option again to deselect it.)

User time zone—If this setting is configured in the WFM Configuration 
Utility, you can select this option to display performance data adjusted to the 
user's time zone, if it differs from that of the site. (This is also a toggle.)

What if—Opens the What If window for calculating “what if” scenarios based 
on the selected timestep's data.
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Use multi-site activities—This button becomes enabled when you select a 
multi-site activity or business unit in the Objects tree. Click to display data for 
the selected multi-site activity.

Current Day—Click this button to switch from a rolling view (12 hours 
before and 12 hours after the current timestep) to a current-day view (from 
midnight to midnight of the current day).

Options—Displays an Options dialog box with the logged in user's time zone 
selected.

You can also use the Performance drop-down list (to the right of Show 
Required) to jump to other Performance views.

Performance Graphs View
Use the Graphs view to view a single performance statistic as a line chart. The 
displayed data is automatically refreshed at the conclusion of each 15-minute 
timestep, and represents the values from the most recent timestep. 

The following sections cover:

• Displaying the Graphs view.

• Using the Graphs view.

Displaying the Graphs View

1. In the Modules tree, select Performance > Graphs. 

The Graphs view appears. If you switched to this view from another 
Performance view, it retains your earlier Objects tree selection and shows a 
corresponding graph.

2. Select the enterprise, a business unit, activity group, site, or activity in the 
Objects tree.

In the tree, you can expand business units to show their sites and expand sites 
to show their activities. If you make a new selection, the graph is updated to 
match it.

Using the Graphs View

By default, you see a graph for the Interaction Volume statistic. 

To switch to a different statistic:

• Select the statistic from the View drop-down list. The graph changes to 
match your selection.

The graph shows times on the horizontal axis, and values on the vertical axis. 
The Legend (below the graph) indicates which color is used for which data 
category.
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By default, the graph shows a rolling view. To switch from rolling to current-
day view, select Current Day from the Actions menu.

• Rolling View—12 hours before and 12 hours after the current timestep

• Current-Day View—from midnight to midnight of the current day

Toolbar Buttons/Actions Menu Options

You can use the following buttons on the toolbar (these commands also appear 
in the Actions menu):

Show Required—Turns on and off the display of “Required” data in some 
statistics' graphs. (This option is a toggle: A darker button color, or a check 
mark beside the Actions menu option, indicates that it is selected. Click the 
same option again to deselect it.)

User time zone—If this setting is configured in the WFM Configuration 
Utility, you can select this option to display performance data adjusted to the 
logged in user's time zone, if it differs from that of the site. (This is also a 
toggle.)

Use multi-site activities—This button becomes enabled when you select a 
multi-site activity or business unit in the Objects tree. Click to display data for 
the selected multi-site activity.

Current Day—Click this button to switch from a rolling view (12 hours 
before and 12 hours after the current timestep) to a current-day view (from 
midnight to midnight of the current day).

Options—Displays an Options dialog box with the logged in user's time zone 
selected.

You can also use the Performance drop-down list (to the right of Show 
Required) to jump to other Performance views.

Performance Alerts View
Use the Performance Alerts view to configure visual alert notifications for 
unacceptable performance.

The Alerts function uses Master Forecast and schedule data as a baseline for 
acceptable performance results. 

If user-defined performance limits are violated (for example, if too many 
interactions are being abandoned, or if service levels fall too low), an Alert 
warning in the Monitor view notifies site managers that action may be 
necessary.

To configure alerts:

1. In the Modules tree, select Performance > Alerts.



Supervisor User’s Guide 287

Chapter 7: Performance and Adherence Performance Options Dialog Box

The Alerts view appears. If you switched to this view from another 
Performance view, it retains your earlier Objects tree selection. At right, 
the Deviation table is refreshed with any alert settings that have already 
been configured for this selection.

2. To set an alert on a different business unit, site, or activity, select it in the 
Objects tree.

You can expand business units to show their activity groups and sites and 
expand sites to show their activities. If you made a new selection, the 
Deviation table is updated to match it.

3. In the Deviation table, select the Alerts check box beside each statistic 
name for which you want an alert. Clear the check box for statistics that 
should not have alerts.

4. Set the Minimum (%) and Maximum (%) allowable deviation for each 
statistic whose check box you selected.

Set these limits by clicking and typing in the appropriate columns. These 
limits define the variance beyond which an alert is displayed. For example, 
assume that you set 3.0 as the Minimum (%) deviation level for Average 
Handling Time, and 5.0 (%) as the Maximum (%). In this case, an alert 
appears when the AHT goes more than 3 percent under, or 5 percent over, 
the number set in the forecast.

5. Click Apply. (Or, to discard your changes, click Cancel.)

6. If desired, configure alerts for other Business Units, activity groups, sites, 
or activities.

You can repeat Steps 2-5 for as many Objects tree selections as you like. If 
you make a new selection without first clicking Apply, a dialog box 
prompts you to save your changes (Yes), discard them (No), or keep 
working with the same selection (Cancel).

7. To exit the Alerts view, click Close, or select a different view from the 
Objects tree or the Performance drop-down list.

Performance Options Dialog Box
Selecting the Options button in Performance Intra-Day View or Performance 
Graphs View opens the Options dialog box with your time zone already 
selected.

To select another time zone:

1. Click the drop-down arrow to the right of the User Time Zone text box.

2. Select the time zone from the drop down list. 

3. Click Apply.

Performance data is adjusted to the selected time zone.
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What-If Window
Use the What-If window to immediately analyze how changes in some 
statistics would affect other factors.

To open the What-If window:

1. Select an activity in the Performance Intra-Day module. 

2. Select a timestep in the data grid.

3. Click the What if button on the Actions toolbar.

Once the window is open, you can change certain values shown in the window 
to perform what-if calculations.

Statistics presented in the What-If window are as follows:

Interaction volume—Initial value is the forecasted interaction volume taken 
from Master Forecast. Enter a value greater than zero.

AHT (Average handle time)—Initial value is the forecasted AHT taken from 
Master Forecast. Enter a value greater than zero. 

Abandoned calls (percentage)—Initial value is the scheduled abandoned 
calls percentage. Enter a value greater than 0 and less than 100. If you do not 
enter a value, the abandoned calls percentage is not included in the what-if 
calculation.

Service level (percentage)—Initial value is the scheduled service level 
percentage. Enter a value greater than 0 and less than 100. If you do not enter a 
value, service level is not included in the what-if calculation.

ASA (Average speed of answer)—Initial value is the scheduled average 
speed of answer. Enter a value greater than zero. If you do not enter a value, 
ASA is not included in the what-if calculation. 

Coverage—Initial value is the scheduled coverage, which is also called 
Staffing in the Performance Intra-day View. Enter a value greater than zero. 

Service time (sec)—Taken from Master Forecast. Configured in Staffing 
Build Wizard. 

Average time to abandon (sec)—Taken from Master Forecast. Configured in 
Staffing Build Wizard. 

Indirectly Occupied Time (%)—Taken from Master Forecast. Configured in 
Staffing Build Wizard. 

Maximum Occupancy (%)—Taken from Master Forecast. Configured in 
Staffing Build Wizard. 

The window also shows the following parameters from your forecast, if a 
forecast has been built (otherwise, these indicators are empty):

• Service time

• Average time to abandon

• Indirectly occupied time
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• Maximum occupancy

To calculate what-if scenarios, you must have the following:

• Published forecast values for interaction volume and AHT (which initialize 
the window's first two fields), abandonment, service level, ASA, indirectly 
occupied time, and maximum occupancy.

• A published schedule that allows staffing suitability calculations. (This 
initializes the window's Coverage field.)

Calculating What-If Scenarios

You can calculate what-if scenarios for the group of service-level statistics 
(Abandoned calls, Service level, and Average speed of answer), or for the 
coverage level.

Calculating Abandoned Calls, Service Level, and 
Average Speed of Answer

1. Enter values into the Interaction volume and AHT text boxes. 

2. Enter values into the Coverage text box.

For successful calculations, enter values in all of these text boxes. 

3. Click the Calculate button next to the Service level text box.

The window shows the expected impact of your changes on the Abandoned 
calls, Service level, and ASA. If a box is empty, there is no data for the 
appropriate statistic for that timestep.

Calculating Coverage Scenarios

1. Enter values into the Interaction volume and/or AHT text boxes.

2. Enter values into the Abandoned calls, Service level, and/or ASA text 
boxes. For successful calculations, enter a value in at least one of these text 
boxes.

3. Click the Calculate button next to the Coverage text box.

The window shows the expected impact of your changes on the Coverage.

Closing the What-If Window

When you have completed your Coverage Scenario, click Close.
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Adherence

Overview

Use the Adherence module to monitor real-time agent adherence to the 
schedule. You can display adherence data in the Details View (table) or the 
Graphical View (pie chart).

Each view refreshes its data at the time interval that is specified in WFM Web 
Application object's Options tab > Adherence section > RefreshTime option. 
The minimum refresh interval that you can configure is one second. Genesys 
recommends that you set the refresh interval to the minimum acceptable time 
such as 20 seconds, as a shorter refresh time will affect overall system 
performance.

Agent information is updated automatically when the data in Configuration 
Server changes. 

To force a display of updated information in either view:

• Click Refresh. 

Adherence Overview
Use the Adherence module to monitor real-time agent adherence to the 
schedule. You can display adherence data in the Details View (table) or the 
Graphical View (pie chart).

Each view refreshes its data at the time interval that is specified in WFM Web 
Application object's Options tab > Adherence section > RefreshTime option. 
The minimum refresh interval that you can configure is one second. Genesys 
recommends that you set the refresh interval to the minimum acceptable time 
such as 20 seconds, as a shorter refresh time will affect overall system 
performance.

Agent information is updated automatically when the data in Configuration 
Server changes. 

To force a display of updated information in either view:

• Click Refresh. 

Adherence Details View
Use the Adherence Details view to examine individual agents' adherence 
statuses. 

The following sections cover:

• Displaying the Adherence Details view.
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• Reading the Details table.

• Customizing the table.

Displaying the Adherence Details View

To display the Details view:

1. In the Modules tree, select Adherence > Details module.

Or, if you are in the Adherence Graphical view, use the Adherence drop-
down list (on the right side of the toolbar) to select Details module.

2. In the Objects tree, select teams or agents you want and then click Get 
data.

If you previously selected teams or agents in the Adherence Graphical view, 
these selections remain. You can modify them if you want to.

You can expand business units to display their sites and sites to display their 
teams and agents. You can select an entire site or several sites within a single 
business unit, or any combination of agents and teams within a business unit. 
For independent sites, you can select the entire site or any number of teams and 
agents within the site.

Note: Selecting a site or its teams/agents in a different business unit clears 
any previous selection within the first business unit. Or (for 
independent sites) selecting a different site or its teams/agents clears 
your selections under the first site.

The Details table is populated with adherence data for the selected agents 
and/or teams.

Reading the Details Table

The table columns list the following information for each agent:

• Last and First name

• Team

• Scheduled state group

• Current state

• Duration of non-adherence

• Shift start time (optional—use the Detail Options dialog box to select this 
column if you want to see it)

Note: If you include the Shift Start column but an agent has no shift, the cell 
for the agent in this column is empty.
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• Site (optional—use the Detail Options dialog box to select this column if 
you want to see it)

Colors indicate each agent's degree of non-adherence: Adherent, Non-
adherent, or Severely non-adherent (that is, non-adherent for more minutes 
than a defined threshold allows). The Legend below the table identifies each 
color's meaning.

Customizing the Table

You can use the following options to customize the table's display:

• By default, agents are ranked according to non-adherence. Therefore, the 
agent who is out of adherence the longest appears at the top of the list. You 
can sort the display according to different columns (except for Scheduled 
State Group) by clicking the column headers.

• To filter the displayed information by state or by reason (aux) code, click 
the Filter button on the Actions toolbar or select Settings from the Actions 
menu. 

• To change which columns appear, click the Options button on the Actions 
toolbar or select Options from the Actions menu.

• Agent names do not appear if the following option in the WFM Web 
Application object is set to true: Options tab > Options section > 
HideNames.

• The display is updated at a user-defined interval, as described in the 
Adherence Overview.

Adherence Filter Dialog Box
Use the Adherence Filter dialog box to filter the items displayed in the data 
pane.

1. In the Adherence Details view or in the Adherence Graphical view, click 
the Filter button on the Actions toolbar or select Filter from the Actions 
menu.

The Adherence Filter dialog box appears. It contains four tabs that present 
four different ways to filter the data that appears in the Data pane:
 Scheduled State Groups This tab displays a hierarchical list of items 

corresponding to the current selection(s) in the object pane: 
 Business Unit (BU) Sites Schedule State Groups if the object pane 

selection is a BU or multiple sites.
 Site Schedule State Groups if the selection is only one site.

 Genesys States This tab displays all possible Genesys states.
 Adherence Statuses This tab displays all four possible statuses: 

Adherent, Non-adherent, Severely non-adherent, and No information.
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 Activities This tab displays a hierarchical list of items corresponding to 
the current selection(s) in the object pane: 
 BU Sites Activities if the object pane selection is a BU or multiple 

sites.
 Site Activities if the object pane selection is only one site.

2. Clear an item's check box to filter that item from the displayed data.

3. To filter on user-defined Reason codes, select the Filter using the Filter 
using the following reason check box; then type the appropriate code in the 
text box to its right. 

Note: The specified reason code must not contain any spaces inside, or at 
the end of, the key value.

4. Click OK.

The Adherence Filter dialog box closes and your filter selections are applied 
immediately. They will continue to apply until you change them or log off.

Notes: 
• In the toolbar, the filter icon is blue if all defaults are in effect and 

red if any are not.
• The Adherence Details view updates automatically if you change 

your selection(s) in the Object pane. Also, if you select agents or 
teams in another site, then their selection under the Scheduled 
States tab returns to the default, All.

• Items that you have configured to appear using the WFM 
Configuration Utility are displayed in the Scheduled State Groups 
and Genesys State tabs.

• You can also use the Filter dialog in the Adherence Graphical 
View. Changes that you make in one view apply to both views.

Adherence Details Options Dialog Box
Use the Options dialog box to select which columns should appear in the 
Adherence Details view:

1. In the Adherence Details view, click the Options button on the Actions 
toolbar or select Options from the Actions menu.

The Options dialog box appears.

2. To view the Shift Start column in the Adherence Details view, select the 
Shift Start check box.
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 If an agent is already working during the period shown in the 
Adherence Details view, this column shows the start time of the current 
shift. If the shift start time is the previous day, the time has a minus 
sign (-) in front of it.

 If an agent is not currently on a shift, this column shows the next 
scheduled shift start time. If the shift starts on the following day, the 
time has a plus sign (+) in front of it.

3. To view the Site column in the Adherence Details view, select the Site 
check box. This column shows each agent's site.

4. Click Apply.

The Adherence Details view reappears. It is automatically updated to show the 
columns you selected.

Adherence Graphical View
Use the Adherence Graphical view to see a pie-chart summary of agents' 
adherence states. 

The following sections cover:

• Displaying the Adherence graphical view.

• How to read the chart.

Displaying the Adherence Graphical View

To display the Graphical view:

1. In the Modules tree, select Adherence > Graphical module.

Or, if you are in the Adherence Details view, use the Adherence drop-down 
list (on the right side of the toolbar) to select Graphical module.

2. In the Objects tree, select the teams or agents that you want, and then click 
Get data.

If you previously selected teams or agents in the Adherence Details view, these 
selections remain. You can modify them if you want to.

You can expand business units to display their sites and expand sites to display 
their teams and agents. You can select an entire site or multiple sites within a 
single business unit, or any combination of agents and teams within the 
business unit. For independent sites, you can select the entire site or any 
number of teams and agents within the site.

Note: Selecting a site or its teams/agents in a different business unit clears 
any previous selection within the first business unit. Or (for 
independent sites) selecting a different site or its teams/agents clears 
your selections under the first site.
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The pie chart displays adherence data for the selected agents and/or teams.

To filter the displayed information by state or by reason (aux) code, click the 
Filter button on the Actions toolbar or select Settings from the Actions menu.

How to Read the Chart

The pie chart summarizes the share of agents in each of the following 
adherence states:

• Adherence.

• Non-adherence.

• Severe non-adherence. (Severe non-adherence means that the agent has 
been non-adherent for more minutes than a defined threshold allows. This 
threshold is set in the WFM Configuration Utility, at the site level.)

Each category is represented by a colored wedge in the pie chart. The Legend 
(below the chart) identifies each color's meaning. If no data is available, the 
whole chart is gray.

Beside each wedge, the first number shows the percentage of agents in the 
category. The second number shows the actual number of agents in the 
category.
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8 Reports
 Reports Overview, page 297
 Configuration Reports, page 302
 Policies Reports, page 305
 Calendar Reports, page 313
 Forecast Reports , page 320
 Schedule Reports, page 324
 Performance Reports, page 348
 Adherence Reports, page 356
 Audit Reports , page 363

Reports Overview
Use WFM Web's Reports features to generate a variety of Configuration, 
Policies, Calendar, Forecast, Schedule, Performance, Adherence, and Audit 
reports. (See the Reports List for details about the reports available.) Once 
generated, the reports appear in the Report Viewer.

Report Viewer Features

With the Report Viewer, you can:

• View all information contained in the report.

• Print the report. You can create many reports in .csv (comma-separated 
values) format, which is easily opened with spreadsheet software.

• Export the report to a local file.

• Regenerate the report, using the same or modified settings.

• Review an already generated report.
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Viewing Reports

To view all pages of a multi-page report, use the following navigation buttons 
on the Reports Viewer's toolbar (these look like the physical buttons on video 
or Compact Disk players):

• To move one page forward or back, click > or < (respectively).

• To jump to the final page or back to the first page, click >| or |< 
(respectively).

• To jump to a particular page, type the page number into the first text box 
between the > and < buttons and then press Enter.

• The button with a square (Stop) icon duplicates your browser's Stop 
button.

To zoom to a different magnification:

• Use the drop-down list to select a different %, Page Width, or Whole 
Page.

Report Viewer displays reports based on the selections that you made in the 
Reports Wizard. To change these settings, see Using Reports as Templates.

Printing Reports

To print a copy of a report, click the Printer icon on the Report Viewer toolbar.

Exporting Reports to Local Files

1. Click the Save As button on the Actions toolbar.

A dialog box appears.

2. Select a report format from the Report Format drop-down list.

3. Click OK or Apply.

4. If a File Download dialog box appears, click Save or OK. 

This confirms that you want to save (not open) the file and displays a final 
dialog box.

Adjust the report's destination folder and file name.

5. Click Save or OK.

Using Reports as Templates

You can define and generate a new report based on the current report's settings 
(including all of your selections in the Reports Wizard). 

1. Click the Use as Template button on the Actions toolbar.

The current report's first wizard screen appears. Each screen retains the last 
selections you made.
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2. Proceed through the wizard screens, changing your selections as necessary 
on each screen.

3. Click Finish on the last screen.

The Report Viewer displays the new report.

Reviewing Reports

Once a report has been generated, you can reopen and review it without 
regenerating it:

1. In the Objects tree, click the report name or expand its expand/collapse 
control.

Any generated copies of this report appear in the tree, labeled by the date 
and time they were generated.

2. Double-click a generated report to review it.

The report opens in the Report Viewer.

Copies of generated reports remain in the Objects tree until you either close 
them or exit WFM Web.

Closing Reports

To close a displayed report: 

1. Click the Close button on the Actions toolbar. 

This clears the working pane and removes this report (whether standard or 
generated) from the Objects tree. However, your last Reports branch remains 
selected in the Modules tree.

Reports List

Use the Modules tree's Reports branch to generate the following reports 
(grouped here by category):

Configuration Reports

• Activity Properties Report—Includes hours of operation, skills, and 
activity set assignments.

Policies Reports

• Agent Properties Report—Includes hire date, contract, wage, and skills.

• Contract Properties Report—Includes daily, weekly, and monthly paid 
hours, synchronization settings, and days off.
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• Shift Properties Report—Includes shift duration, start and end times, days 
of the week, contract assignments, and break settings.

• Rotating Pattern Properties Report—Includes weekly pattern information, 
shifts, and activities.

Calendar Reports

• Calendar Items Report—Summarizes agent rotating patterns, availabilities, 
days off, shifts, working hours, times off, and exceptions for the selected 
time range.

• Time Off Report—Lists all preferred, granted, declined, and scheduled 
time off in a selected time range for selected agents. Optionally, includes 
time-off balances for all the time-off types selected. 

• Time Off Balance Report—Displays time off balances for time off types.

Forecast Reports

• Forecast Report—Forecast values for Calculated Staffing, Required 
Staffing, Interaction Volumes, Average Handling Time (AHT), Service 
Level, Average Speed of Answer (ASA), Percentage of Interactions 
Abandoned, and Maximum Occupancy. Shows these values for selected 
dates and selected targets (activities, multi-site activities, business units, or 
sites).

• Forecast Graphs Report—Graphic presentation of forecast values for 
Calculated Staffing, Required Staffing, Interaction Volumes, and AHT. 
Graphs these values for selected dates and selected targets (activities or 
multi-site activities).

Performance Reports

• Actual Overhead Report—Forecast and scheduled agent information, 
including overhead figures.

• Workforce Performance Report—Average percentage of the deviation 
between Forecast, Required, Scheduled, and Actual staffing.

• Contact Center Performance Report—Number of agents, interaction 
volumes, AHT, service level, ASA, and percentage of interactions 
abandoned. Shows these statistics for activities, multi-site activities, sites, 
or business units.

• Contact Center Performance Graphs Report—Forecast and actual 
adherence data for selected activities displayed in a graph format.

Schedule Reports

• Schedule States Report—Agent schedule states, organized by team.
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• Schedule State Totals Report—Total durations of scheduled states for 
agents, teams, or sites, over a selected period.

• Individual Schedule Report—Paid hours and scheduled states for the 
selected agent.

• Team Schedule Report—Total hours, paid hours, effective hours, and 
schedule state information for all agents on a selected team.

• Activity Weekly Schedule Report—Total employment figures (full-time 
equivalents) for the selected activity, and paid, effective, and noneffective 
paid hours for each agent.

• Team Weekly Schedule Report—Weekly paid, effective, and noneffective 
hours for each agent on the selected team, as well as total hours (paid hours 
plus unpaid hours) for the team.

• Weekly Schedule Coverage Report—Calculated (or Required) and 
Scheduled Staffing for a specific activity or site; difference between 
Calculated and Scheduled Staffing; and total staffing hours. 

• Scheduled Budget Report—Regular, overtime, and total budgeted hours 
for each agent within a team.

• Agent Comments Report—Comments entered for agents in the Comments 
text box of the schedule.

• Schedule Validation Report—The Schedule Validation window's data in a 
report format. If the configuration settings lead to a disparity between the 
staffing requirements and the actual schedule, the Schedule Validation 
window records the problems. It also indicates what parameters need to be 
changed to correct the disparity.

• Schedule Trade Report—Schedule trade participants (proposer and 
respondent), dates involved, approval status, approving supervisor, and 
comments.

• Schedule Summary Report—Coverage, headcount; service level 
percentages; scheduled and forecasted for interaction volume, AHT, and 
budget. Optional columns include published coverage and the difference 
between schedule coverage based on the current Master Schedule and 
schedule coverage based on the baseline Master Schedule.

• Schedule Marked Time Report—Agent marked time, organized by team.

• Schedule Marked Time Totals Report—Total durations of marked time for 
agents, teams, or sites, over a selected period.

• Schedule Bidding Report—Includes ranking system, agent, team, agent's 
relative position in the bidding process, agent's original bid number, and 
more.

• Weekly Schedule Report—Includes date range, agent, paid hours, effective 
hours, non-effective hours, planning period hours, totals, and more.
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Adherence Reports

• Agent Adherence Report—All schedule non-adherence for selected agents.

• Adherence Totals Report—Average adherence percentage for selected 
teams or sites, with calculated agent adherence.

• Agent States Report—A timestep-by-timestep account of each selected 
agent's state throughout the selected days.

Audit Reports

• Calendar Audit Report—Insertion/deletion/editing of Calendar items. Also 
granting/declining Calendar items, and making Calendar items Preferred. 

• Schedule Audit Report—Publishing/cleanup, modification of Master 
Schedule including insertions, edits, and deletions.

Saving Reports to Files

To export a report to a disk file:

1. Click the Save As button on the Actions toolbar.

A dialog box appears.

2. Select a report format from the Report Format drop-down list.

3. Click OK or Apply.

4. If a File Download dialog box appears, click Save or OK. 

This confirms that you want to save (not open) the file and displays a final 
dialog box.

5. Adjust the report's destination folder and file name.

6. Click Save or OK.

Configuration Reports

Overview

The Configuration report summarizes the configuration settings for WFM 
objects. (For a complete list of all WFM reports, see the Reports List.) 

The Configuration report is:

• Activity Properties Report.
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Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the End Date selector is disabled.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

A list of the selected category's reports appears in the working pane and in 
the Objects tree.

2. From either list, select the report that you want:

3. Click once on a report's name in the working pane. 

4. Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

5. To print a header on the report, select Show Header and type your header 
text into the text box.

6. Click Next.

7. Select the objects, dates, or other options you want to include in the report.

The number of screens that follow the first one depends on the report you 
are creating. 

8. Click Next after making your selections on each intermediate screen. 

9. Make your selections on the final screen (which has a Finish button).

10. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer opens to display it. 
The report is also added to the Objects tree so you can review it later.
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Note: For a detailed explanation of what is displayed in the report, see 
Activity Properties Report.

Activity Properties Report

To Create an Activities Properties Report:

1. In the Modules tree, select Reports > Configuration Reports. 

A list of Configuration Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Activity Properties Report.

The Reports Wizard's first screen (Header) appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. On the Data screen, select the activities you want to include in the report.

You can expand business units to display their sites; you can expand sites 
to display their activities. You can select any combination of activities 
from multiple sites.

6. Click Finish.

The report appears in the Report Viewer.

Table 3: Understanding the Activity Properties Report

Item Description

Site [header] The selected site, its time zone, and the maximum number of seats 
available.

Activity Each activity that you selected to include in the report.

Hours of Operation (Start 
Time, End Time)

The start and end times for each activity on the indicated day in 
hh:mm format. (A plus sign (+) before the end time indicates that 
the activity ends on the next day.)

Maximum Simultaneous 
Users

The maximum number of agents scheduled to perform each activity 
at any one time.

Minimum Staffing The minimum staffing levels configured for each activity. 
Minimum Staffing Level can be shown as a percentage or shown as 
number of agents. If Minimum Staffing Level is configured as 
percentage in Configuration Utility, then the value is shown as a 
percentage; example: 20%. If set as agents, then this value is shown 
as a number; example: 20.
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Policies Reports

Overview

Policies reports summarize the properties of agents, contracts, shifts, and 
rotating patterns. (For a complete list of all WFM reports, see the Reports 
List.) 

The Policies reports are:

Agent Properties Report.

• Contract Properties Report.

• Shift Properties Report.

• Rotating Pattern Properties Report.

Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the End Date selector is disabled.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

Skills (Min-Max Levels) The skills, and minimum and maximum skill levels, configured for 
each activity.

Activity Set Name The name of the activity set in which the activity is included (if 
applicable).

Table 3: Understanding the Activity Properties Report (Continued) 

Item Description
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A list of the selected category's reports appears in the working pane and in the 
Objects tree.

2. From either list, select the report that you want:

3. Click once on a report's name in the working pane. 

4. Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

5. To print a header on the report, select Show Header and type your header 
text into the text box.

6. Click Next.

7. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you 
are creating. 

8. Click Next after making your selections on each intermediate screen. 

9. Make your selections on the final screen (which has a Finish button).

10. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree so you can review it later.

Note: For detailed explanations of what is displayed in each report, click the 
name of the report in the bullet list above.

Agent Properties Report

To create an Agent Properties Report:

1. In the Modules tree, select Reports > Policies Reports. 

A list of Policies Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Agent Properties Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. On the Data screen, select the agents that you want to include in the report.

You can expand business units to display their sites, teams, and agents. 
You can select any combination of agents or teams, from multiple sites.
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6. Click Finish.

The report appears in the Report Viewer.

To create a Contract Properties Report:

1. In the Modules tree, select Reports > Policies Reports. 

A list of Policies Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Contract Properties Report.

Table 4: Understanding the Agent Properties Report

Item Description

Site [header] The report is organized by sites, by teams within each site, and site 
time zone.

Agent Name of each agent included in the report.

ID Agent’s identification number.

Hire Date Date that agent was hired.

Termination Date Date that agent was terminated.

Rank Agent's rank set in Configuration Utility.

Contract The contract type assigned to agent.

Rotating Pattern The agent's rotating pattern, if one was assigned.

Wage The current wage set for the agent.

Skills (Level) The skills that have been assigned to agent.

Activities List of activities that the agent can work on.

Comments Any comments for agent that were entered during configuration.

Time Off Rule Time off rule assigned to agent.

Time Off Type Time off type associated with time off rule.

Bonus Time-Off Hours The number of time-off hours earned in addition to that accrued by 
the usual time-off rules.

Last Carry-Over Date Most recent date for carry-over of unused time-off hours.

Hours Carried Over Number of time-off hours carried over from the previous year to the 
current one.

Stop Date Date when Time Off Rule became inactive for agent.
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The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. On the Data screen, select the contracts to include in the report.

You can expand business units to display their sites, and expand sites to 
display their contracts. You can select any combination of contracts from 
multiple sites.

6. Click Finish.

The report appears in the Report Viewer.

Table 5: Understanding the Contract Properties Report

Item Description

Site [header] The selected site, its time zone, and the first selected contract name.

Daily Working Hours (Min, 
Std, Max)

The daily minimum, standard, and maximum working hours defined 
for each contract in the report.

Weekly Working Hours (Min, 
Std, Max)

The weekly minimum, standard, and maximum working hours 
defined for each contract.

Schedule Planning Period 
Working Hours (Min, Std, 
Max)

The minimum, standard, and maximum working hours defined for 
the user-defined Schedule Planning Period for each contract.

Weekly Working Days (Min, 
Max)

The minimum and maximum number of working days per week 
allowed for each contract.

Daily Availability (Start and 
End Time)

The start time and end time for each day of the week. A plus sign 
(+) before end time indicates the next day.

Days Off The number of First Weekend Days, Second Weekend Days, and 
weekend combinations allowed or required for this contract

Max. Consecutive Working 
Days

Maximum number of days that an agent can work without a Day 
Off scheduled.

Max. Consecutive Working 
Weekends

Maximum number of consecutive weekends that an agent can have 
scheduled as working without Days Off.

Synch. Period The length of time that the synchronization setting is applied.

Synch. of Daily Schedules 
Flexibility

If synchronization is selected, the amount of flexibility in 
synchronized start times.

Synch. Type A rule that defines how synchronization will be performed during 
scheduling.



Supervisor User’s Guide 309

Chapter 8: Reports Policies Reports

Shift Properties Report

To create a Shift Properties Report:

1. In the Modules tree, select Reports > Policies Reports. 

A list of Policies Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Shift Properties Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. On the Data screen, select the shifts to include in the report.

You can expand business units expand to display their sites, and expand 
sites to display their shifts. You can select any combination of shifts from 
multiple sites.

6. Click Finish.

The report appears in the Report Viewer.

Week Days Of Synch. Weekdays to which synchronization will be applied.

Weekend First Day The day of the week when the weekend starts.

Shifts The list of all shifts associated with the contract in Configuration 
Utility.

Table 5: Understanding the Contract Properties Report (Continued) 

Item Description

Table 6: Understanding the Shift Properties Report

Item Description

Site [header] The selected site, its time zone, and the (first) selected shift. Each 
subsequent shift is displayed separately.

Shift Name The name of the shift whose properties are displayed below.

Min. Paid Hours The minimum number of hours defined for this shift. All contracts 
assigned to the shift must be available to work at least this number 
of hours.

Max. Paid Hours The maximum number of hours defined for this shift. 

Earliest Start Time The earliest time that this shift can start. 
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Latest Start Time The latest time that this shift can start. 

Earliest End Time The earliest time that this shift can end.

Latest End Time The latest time that this shift can end.

Days of Week Days on which this contract can be scheduled.

Day Off Rule Rule for scheduling this shift. (For example, one possible value is 
Next day is not off.)

Distrib. Period Distribution period for this shift.

Min Distrib. Minimum amount of time that this shift should be scheduled during 
the Distribution Period.

Max Distrib. Maximum amount of time that this shift should be scheduled during 
the Distribution Period.

Min. Distance Between Shift 
Items

The shortest amount of time allowed between shift items (breaks 
and meals).

Max. Distance between Shift 
Items

The longest amount of time allowed between shift items (breaks and 
meals). Also applies to the distance from shift start to first shift item 
and from last shift item to shift end.

Task sequences usage The usage for Task Sequences during scheduling.

Task sequences [if 
applicable]

Task Sequence Name—The task sequence associated with the 
shift.

Index—The position of the task-sequence item in the task 
sequence.

Activity Set—The activity set on which the agent can work during 
the specified task-sequence interval.

Min Duration—Minimum task sequence duration.

Max Duration—Maximum task sequence duration.

Fixed Position—Whether the task-sequence interval has strict 
bounds. Possible values are:

• Task is flexible within the earliest start, latest end interval.

• Start is fixed, end is flexible.

• End is fixed, start is flexible.

• Start and end are fixed.

Table 6: Understanding the Shift Properties Report (Continued) 

Item Description
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Contracts The contracts associated with the shift.

Shift Item sequences 
[if applicable]

Min. Paid Hours—The minimum paid shift duration for which this 
break and meal sequence takes effect. (This break and meal 
sequence cannot be applied to shifts shorter than this duration.)

Allowed—Specifies if this Shift Item Sequence be used while 
scheduling (value can be Yes or No).

Index—The position of the shift item in the Shift Item Sequence.

Meal—Meals that are assigned to this Shift Item Sequence.

Break—Breaks that are assigned to this Shift Item Sequence

Break 
[if applicable]

Break Name—The break associated with the shift.

Index—The position of the break in the shift's list of breaks. The 
same break may occur more than once.

Duration—The length of the break.

in. Length From Shift Start—The minimum distance between the 
start of the shift and the start of the break.

Max. Length from Shift Start—The maximum distance between 
the start of the shift and the start of the break. 

Min. Length from Shift End—The minimum distance between the 
end of the break and the end of the shift.

Paid Time—Shows break is paid or not.

Start Step—Shows increments between break start times. For 
example, with a start step of 15 minutes, agents leave for the break 
15 minutes apart.

Start Offset—Sets how many minutes past the hour in the interval 
in which a break may occur that the start step calculation should 
begin.

Fixed Position—Shows whether the break has to occur at a specific 
point in the shift.

Table 6: Understanding the Shift Properties Report (Continued) 

Item Description
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Rotating Pattern Properties Report

To create a Rotating Pattern Properties Report:

1. In the Modules tree, select Reports > Policies Reports. 

A list of Policies Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Rotating Pattern Properties Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. On the Data screen, select the rotating patterns you want to include in the 
report.

You can expand business units to display their sites, and expand sites to 
display their rotating patterns. You can select any combination of rotating 
patterns from multiple sites.

6. Click Finish.

Meals 
[if applicable]

Meal Name—The meal associated with the shift.

Index—The position of the meal in the shift's list of meals. The 
same meal may occur more than once.

Earliest Start Time—The earliest time this meal can start.

Latest End Time—The latest time this meal can end.

Duration—The length of the meal.

Min. Time Before Meal—The minimum distance between the 
shift's start time and the meal's start time.

Min. Time After Meal—The minimum distance between meal's 
end time and the shift's end time.

Paid—Whether the meal is paid or unpaid.

Start Step—The meal's start times must be a multiple of this 
integer.

Table 6: Understanding the Shift Properties Report (Continued) 

Item Description
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The report appears in the Report Viewer.

Calendar Reports
Calendar reports list time off, days off, shifts, rotating patterns, availabilities, 
working hours, exceptions, and preferences. (For a complete list of all WFM 
reports, see the Reports List.) 

The Calendar reports are:

• Time Off Report.

Table 7: Understanding the Rotating Pattern Properties Report

Item Description

Site [header] The selected site.

Time Zone The time zone for the site.

Rotating Pattern The rotating pattern displayed.

Weekly Pattern The name of displayed weekly pattern.

Min. Paid Hours If Use Weekly Paid Hours is selected in Configuration Utility, the 
minimum Paid Hours for the weekly pattern.

Max. Paid Hours If Use Weekly Paid Hours is selected in Configuration Utility, the 
maximum paid hours for the weekly pattern.

Day of Week The weekly schedule settings for each day of the week.

Shift The shift assigned on each day for each weekly schedule within the 
rotating pattern, if applicable.

Start Time The shift's start time on each day of the weekly schedule, if 
applicable.

Paid Hours/Duration The paid hours in the shift on each day of the weekly schedule, if 
applicable.

Estimated End Time The estimated end time of the shift (start time + paid hours), if 
applicable.

Activities The activities performed on each day for the weekly schedule. 
Displays “All Applicable” if All Activities was selected on the 
Rotating Pattern Available Activities dialog in Configuration 
Utility.

Possible Day Off Whether it is possible for the Schedule resolution process to assign 
this day as a day off.
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• Time Off Balance Report

• Calendar Items Report.

Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

A list of the selected category's reports appears in the working pane and in 
the Objects tree.

2. From either list, select the report that you want:
 Click once on a report's name in the working pane. 
 Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you are 
creating. 

6. Click Next after making your selections on each intermediate screen. 

7. Make your selections on the final screen (which has a Finish button).

8. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree so that you can review it later.



Supervisor User’s Guide 315

Chapter 8: Reports Calendar Reports

Note: For detailed explanations of what is displayed in each report, see Time 
Off Report, Time Off Balance Report, or Calendar Items Report.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the End Date selector is disabled.

Calendar Items Report

To create a Calendar Items Report:

1. In the Modules tree, select Reports > Calendar Reports. 

A list of Calendar Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Calendar Items Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. In the Date Range screen, select a start and end date for the report. 

6. Optionally, you can select Show comments to control whether comments, 
if any, are shown on the report. Click Next.

7. On the Data screen, from the Available Agents list, select the agents that 
you want to include in your report.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can select any combination of teams 
and/or agents from multiple sites. Click Next.
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8. On the Calendar Items screen, select the check boxes for items that you 
want to include in the report, and clear the check boxes for items that you 
want to omit. Available selections are Rotating Patterns, Availabilities, 
Days Off, Shifts, Working Hours, Times Off, and Exceptions. 

9. Click Finish.

Note: If Exceptions and Time Off are selected on Calendar Items page, you 
must specify Exceptions and Time Off.

The report appears in the Report Viewer.

Time Off Report

For the agents and dates that you select, this report displays granted, preferred, 
declined, and scheduled time off. Optionally, includes time-off balances for all 
the time-off types selected.

To create a Time Off Report:

1. In the Modules tree, select Reports > Calendar Reports. 

Table 8: Understanding the Calendar Items Report

Item Description

Site [header] The selected site, its time zone, and the (first) selected team. The 
report is organized by team.

Date Period [header] The dates covered in the report.

Agent The name of each agent included in the report.

Date The date on which the agent requested an exception, rotating 
pattern, or preference. The report can show multiple Calendar items 
for agents.

Type Rotating patterns, availabilities, days off, shifts, working hours, 
times off, or exceptions.

Description The name of exception or preference, or description of rotating 
pattern.

Start Time The time at which the Calendar item starts.

End Time The time at which the Calendar item ends.

Status Whether the Calendar item is Scheduled, Not Scheduled, Granted, 
Declined, Preferred, or Recalled.

Comments Optional column.
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A list of Calendar Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Time Off Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. In the Date Range screen, select a start and end date for the report. 

6. From the Sort Options drop-down list, select to sort the report by agent 
name, by the date for which time off was requested, or by the request's date 
submitted.

7. Optionally, you can select Show time off balance.

8. Optionally, you can select Show comments to control whether comments, 
if any, are shown on the report.

9. Click Next.

10. On the Data screen, select the agents you want to see in the report.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can select any combination of teams 
and/or agents from multiple sites.

11. Click Next.

12. On the Available Time Off Types screen, select the time off types you 
want to see in the report. Time off types are grouped by business unit (if 
any), site, and time off type.

13. Click Finish.
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The report appears in the Report Viewer.

Time Off Balance Report

For the agents and dates that you select, this report displays granted, preferred, 
declined, and scheduled time off. It optionally includes time-off balances for 
all the time-off types selected.

To create a Time Off Balance Report:

1. In the Modules tree, select Reports > Calendar Reports. 

A list of Calendar Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Time Off Balance Report.

The Reports Wizard's first screen, Header, appears.

Table 9: Understanding the Time Off Report

Item Description

Site [header] The selected site and its time zone.

Team [header] The team to which the agents in the table below belong. If you 
selected more than one team, teams are listed in alphabetical order, 
with the data for agents in one team appearing before the next team 
name in the list. 

Date Period [header] The dates covered in the report.

Agent The name of the agent whose information is displayed.

Date The date for which the agent has submitted a time-off preference. 
The time-off balance shown in the Balance column is also for this 
date.

Description The name of the time-off type.

Start Time and End Time When the time-off period starts and ends. For a full-day time-off 
request, both columns say Full Day.

Status Whether the time-off preference is Preferred, Granted, Declined, 
Recalled, Scheduled, or not Scheduled.

Date and Time Submitted The time at which the time-off preference was made.

Balance The agent's available time-off hours as of the date of the request.

Comments Comments, if any, submitted with time off item.
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3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. In the Date Range screen, select a start and end date for the report. 

6. From the Sort Options drop-down list, select to sort the report by agent 
name or by the date for which time off was requested. Click Next.

7. On the Data screen, select the agents you want to see in the report.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can select any combination of teams 
and/or agents from multiple sites. Click Next.

On the Available Time Off Types screen, select the time off types you 
want to see in the report. Time off types are grouped by business unit (if 
any), site, and time off type.

8. Click Finish.

The report appears in the Report Viewer.

Table 10: Understanding the Time Off Balance Report

Item Description

Site [header] The selected site and its time zone.

Team [header] The team to which the agents in the table below belong. If you 
selected more than one team, teams are listed in alphabetical order, 
with the data for agents in one team appearing before the next team 
name in the list. 

Date Period [header] The dates covered in the report.

Agent The name of the agent whose information is displayed.

Date The date for which the agent has submitted a time-off preference. 
The time-off balance shown in the Balance column is also for this 
date.
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Forecast Reports 

Overview

Forecast reports display key details of anticipated activity and staff 
requirements, in tabular and/or graph formats. (For a complete list of all WFM 
reports, see the Reports List.) 

The Forecast reports are:

• Forecast Report.

• Forecast Graphs Report.

Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

A list of the selected category's reports appears in the working pane and in 
the Objects tree.

2. From either list, select the report that you want:

3. Click once on a report's name in the working pane. 

4. Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

5. To print a header on the report, select Show Header and type your header 
text into the text box.

6. Click Next.

Description The name of the time-off type.

Balance The agent's current number of available time-off hours of the type 
shown in the Description column, as of the date shown in the Date 
column.

Table 10: Understanding the Time Off Balance Report (Continued) 

Item Description
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7. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you 
are creating. 

8. Click Next after making your selections on each intermediate screen. 

9. Make your selections on the final screen (which has a Finish button).

10. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree so that you can review it later.

Note: For detailed explanations of what is displayed in each report, click the 
name of the report in the bullet list above.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the End Date selector is disabled.

Forecast Report

To create a Forecast Report:

1. In the Modules tree, select Reports > Forecast Reports. 

A list of Forecast Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Forecast Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a forecast scenario or the Master Forecast 
and then click Next.

On the Date Range screen:
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5. Select a Granularity and a corresponding Start and End Date. (Your 
Granularity selection may restrict your Date selections.) 

6. Select Activity, Site, Multi-site Activity, or Business Unit from the drop-
down list. 

7. Click Next.

8. In the Data screen, select forecast targets.

This page's tree displays activities, sites, multi-site activities, or business 
units (depending on your choice of target). If you selected a target other 
than business unit, the tree's business units expand to display their 
contents. You can make multiple selections.

9. Click Next.

On the Forecast Data Types screen, select the Data Types you want to 
include. 

10. Click Finish.

The report appears in the Report Viewer.

Table 11: Understanding the Forecast Report

Item Description

Site Information or 
Business Unit Information 
or Enterprise [header]

The site name and time zone, if you selected activity as the report's 
target.
The business unit name and time zone, if you selected multi-site 
activity or site as the report's target.
The enterprise, if you selected business unit as the report's target.
(Each root is displayed separately.)

Activity, Multi-Site Activity, 
Site, or Business Unit 
[header]

The report is organized by activity, multi-site activity, site, or 
Business Unit— depending on the target that you selected in the 
Reports Wizard.

Date/Date Period [header] The dates covered by the report. The report displays separate 
information for each target and date. This header shows the Date if 
you selected Intra-day granularity and Date Period for other 
granularities.

Time Step, Day, Week Of, X 
Weeks of, Month

The time period shown. The header and the column contents depend 
on the granularity that you selected.
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Forecast Graphs Report

To create a Forecast Graphs Report:

1. In the Modules tree, select Reports > Forecast Reports. 

A list of Forecast Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Forecast Graphs Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a forecast scenario or the Master Forecast 
and then click Next.

5. On the Date Range screen:
 Select a Granularity and a corresponding Start and End Date. (Your 

Granularity selection may restrict your Date selections.) 
 Select Activity or Multi-site Activity from the drop-down list. 
 Click Next.

6. On the Data screen, select forecast targets.

Statistics/Options [columns] The forecast value, for each period, for the display options that you 
selected in the wizard. The possible columns are:

• Interaction Volume.

• Average Handling Time.

• Calculated Staffing.

• Required Staffing.

• Service Level.

• ASA.

• Abandons Factor.

• Max. Occupancy.

Total/Average for 
Activity/Site [footer]

The total or average forecast value for each statistic shown in the 
table for this activity or site.

Total/Average for 
Site/Business Unit [footer]

The total and/or average forecast value for each displayed option for 
the displayed target.

Table 11: Understanding the Forecast Report (Continued) 

Item Description
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The tree's contents depend on your choice of target. You can expand 
business units to display their sites or multi-site activities. You can expand 
sites to display their activities. You can make multiple selections.

7. If you selected Multi-site Activity as the target:
 The Data screen is the Wizard's final screen. Click Finish.

If you selected Activity as the target:
 Click Next.
 On the Forecast Data Types screen, select the Data Types you want to 

include. 
 Click Finish.

The report appears in the Report Viewer.

Schedule Reports 

Overview

Schedule reports display detailed schedule settings, in tabular and/or graph 
formats. (For a complete list of all WFM reports, see the Reports List.) The 
Schedule reports are:

Table 12: Understanding the Forecast Graphs Report

Item Description

Site or Business Unit 
[header]

The site, or Business Unit, and time zone included in the report.

Activity or Multi-Site Activity 
[header]

The activity or multi-site activity displayed in the following graph.

Date [header] The dates covered by the report. The information in the report is 
shown separately for each activity, display option, and date.

Statistics/Options [graph 
bars]

Each display option is shown in a separate graph. The displayed 
statistic, and its units, are labeled on the left side. The possible 
columns are:

Interaction Volume.

Average Handling Time.

Calculated Staffing.

Required Staffing.

Timestep / Day / Week of / 
Month / X weeks of [bottom 
labels]

The time period covered by each bar in the graph. The period 
depends on the granularity that you selected in the wizard.
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• Schedule States Report 

• Schedule State Totals Report 

• Individual Schedule Report 

• Team Schedule Report 

• Activity Weekly Schedule Report 

• Team Weekly Schedule Report 

• Weekly Schedule Coverage Report 

• Scheduled Budget Report 

• Agent Comments Report 

• Schedule Validation Report 

• Schedule Trade Report 

• Schedule Summary Report 

• Schedule Marked Time Report

• Schedule Marked Time Totals Report

• Schedule Bidding Report 

• Weekly Schedule Report 

Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the end date selector is disabled.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

A list of the selected category's reports appears in the working pane and in 
the Objects tree.

2. From either list, select the report that you want:
 Click once on a report's name in the working pane. 
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 Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first page (Header Page) 
appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you 
are creating. 
 Click Next after making your selections on each intermediate screen. 
 Make your selections on the final screen (which has a Finish button).
 Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree so that you can review it later.

Note: For detailed explanations of what is displayed in each report, click the 
name of the report in the bullet list above.

Activity Weekly Schedule Report

To create an Activity Weekly Schedule Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Activity Weekly Schedule Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. Fill in the Date Range screen.
 Select a Start and End Date for the report.

You can select multiple weeks for the report output, but your selection 
must be full weeks.

 If necessary, select Show Required Staffing and/or Show Paid 
Hours.
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 Click Next.

6. On the Data screen, select the activity or activities for which to generate 
the report.

You can expand business units to display their sites and activities.

7. Click Finish.

The report appears in the Report Viewer.

Table 13: Understanding the Activity Weekly Schedule Report

Item Description

Site [header] The site's name and time zone.

Activity [header] The activity that is covered by the report.

Date Period [header] The date range that you selected in the Reports Wizard.

Scheduled FTEs The number of agents (full-time equivalents) scheduled for the 
activity on the selected days.

Calculated FTEs The number of agents (full-time equivalents) in the calculated 
staffing for the activity.

Difference The difference between calculated and scheduled FTEs.

Required FTEs The number of agents (full-time equivalents) in the required staffing 
for the activity. This row and the next appear if you selected the 
Show Required Staffing check box.

Difference The difference between required and scheduled FTEs.

Agent The agent's name.

ID The agent's identification number.

Days Multiple columns display the agent’s start/end times (or paid hours, 
if Paid Hours check box was selected) for each weekday of the 
report period.

Weekly Work Hours–Paid The agent's paid work hours per week.

Weekly Work Hours–Off. The agent's effective work hours per week.

Weekly Work Hours–
Nonlife.

The agent's noneffective work hours per week (that is, hours during 
which the agent is paid but not working, such as during paid breaks 
and paid days off).

Total Hours The total number of paid-hours spent by all agents scheduled to 
work under the activity during the day. This row includes a total for 
each day, and a weekly total for each paid-hours category.
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Presentation

The finished report is grouped by this hierarchy:
Enterprise
Business Unit
Site
Week date range

Team
Activity

Agent

Agent Comments Report

Note: This report presents information only for agents and days that have 
comments entered. The report is not generated if the selected agent 
schedule days have no comments.

To create an Agent Comments Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Agent Comments Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

Total Paid Hours The team's paid work hours per week.

Total Effective Hours The team's effective work hours per week.

Total Non-Effective Hours The team's noneffective work hours per week.

Total Hours for each week 
day

The team's paid work hours, for each day, per week.

Footnote Indicates that the agent worked on a different activity during the 
specified time.

Table 13: Understanding the Activity Weekly Schedule Report (Continued) 

Item Description
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5. On the Date Range screen, select a Start and End Date. Then click Next.

6. On the Data screen, select the agents that you want to include in the report.

You can expand business units to display their sites, teams, and agents. 
You can select multiple agents across teams and sites. You can also select 
whole teams or sites.

7. Click Finish.

The report appears in the Report Viewer.

Individual Schedule Report

To create an Individual Schedule Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Individual Schedule Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. On the Date Range screen, select a Start and End date for the report. Then 
click Next.

6. On the Data screen, select the agent(s) for whom to generate the report.

You can expand business units to display their sites, teams, and agents.

7. Click Finish.

Table 14: Understanding the Agent Comments Report

Item Description

Site [header] The name of the site.

Team [header] Agent information is displayed team-by-team.

Date Period [header] The total date range covered by the report.

Day [header] The date to which each group of comments applies.

Agent The name of each agent.

Comments Any comments about the agent entered in the Daily Schedule 
window.
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The report appears in the Report Viewer.

Scheduled Budget Report

To create a Scheduled Budget Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Scheduled Budget Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. On the Date Range screen, select a Start and End Date. Then click Next.

6. On the Data screen, select the team(s) for which to generate the report.

You can expand business units to display their sites and teams.

7. Click Finish.

Table 15: Understanding the Individual Schedule Report

Item Description

Site [header] The site's name and time zone.

Team [header] The selected agent's team.

Agent [header] The selected agent's name.

Date Period [header] The total date range covered by the report.

Day The date for each information set.

Paid Hours Total number of paid hours the agent works on each displayed day.

Schedule State The agent's schedule states on each displayed day.

Start Time The time at which the agent is scheduled to start each scheduled 
state.

End Time The time at which the agent is scheduled to end each scheduled 
state.
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The report appears in the Report Viewer.

Schedule Marked Time Report

To create a Schedule Marked Time Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule Marked Time Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenarios screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. On the Date Range screen, select start and end dates for the report. Then 
click Next.

If you selected a scenario on the previous screen, you cannot select dates 
outside the scenario date range.

Table 16: Understanding the Scheduled Budget Report

Item Description

Site [header] The site's name.

Team [header] The report is organized team-by-team. 

Date Period [header] The total time period covered by the report.

Day [headers] For each team, the report displays budget information day-by-day.

Agent The name of each agent on the team.

Regular Budget The agent's pay for regular work hours on the given day.

Overtime Budget The agent's pay for overtime work hours on the given day.

Total Budget The agent's total pay for the given day.

Number of Agents Number of agents on the team.

Total Per Day [row] The entire team's total regular, overtime, and total budgets for the 
given day.

Total for Team [row] The team's total regular, overtime, and total budgets for the whole 
selected date range.
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6. On the first Data screen, select the enterprise or the business units, sites, 
teams or agents you want to see in the report.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can select any combination of teams 
and/or agents from multiple sites.

7. Click Next.

8. On the second Data screen, select the marked-time types that you want to 
be displayed. Marked-time types are listed under the sites for which they 
are configured. 

9. Click Finish.

The report appears in the Report Viewer.

Schedule Marked Time Totals Report

To create a Schedule Marked Time Totals Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule Marked Time Totals Report.

Table 17: Understanding the Schedule Marked Time Report

Item Description

Site [header] The site's name and time zone.

Team [header] Agents are displayed by team. 

Date and Time Period 
[header]

The dates covered by the report, and the time period covered each 
day.

Agent The agent whose information is displayed.

Date The date on which the marked time occurs.

Marked Time The name of the marked-time type.

Start Time The marked time's start time.

End Time The marked time's end time.

Duration The duration of each marked-time period.

Paid Hours The number of paid hours covered by the marked-time period.

Total Duration and Total 
Paid Hours for Team

The total number of marked-time hours and the total paid marked-
time hours for the team during the selected report period.
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The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. On the Date Range screen:
 Select a granularity and a corresponding start and end date. (Your 

granularity selection may restrict your date selections.)
 On the Target pane, select Agent, Team, or Site from the drop-down 

list. 
 Click Next.

6. On the first Data screen, select the targets (agents, teams, or sites) that you 
want to include in the report. Then click Next.

You can expand business units to display their sites. If you selected Team 
or Agent on the Target pane, you can further expand the tree's branches. 
You can select across multiple sites.

7. On the second Data screen, select the marked-time types to include. Then 
click Finish.

You can expand business units to display their sites, and expand sites to 
display their marked-time types. You can select multiple marked-time types 
across different sites.

The report appears in the Report Viewer.

Understanding the Schedule Marked Time Totals 
Report

The report takes one of three forms, depending on the target that you selected. 

Table 18: Site Schedule Marked Time Totals Report

Item Description

Enterprise [header] The name and time zone of the enterprise in which this site is 
included.

Business Unit [header] The name of the business unit, if any, to which the selected site 
belongs. If the report covers independent sites, no business unit 
name appears.

Date Period [header] The time range covered by the report.

Selected Schedule Marked 
Times [header]

The marked time types covered by the report.
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Site The name of each site included in the report.

Day Each date in the selected date range.

Duration The time that this site's agents spent in the selected marked-time 
types for each day included in the report.

Paid Hours The number of the marked-time hours that were paid.

Total Duration and Total 
Paid Hours for Business 
Unit

The combined time that all the sites spent in the selected marked-
time types over the report's date range and the number of those 
hours that were paid.

Table 18: Site Schedule Marked Time Totals Report (Continued) 

Item Description

Table 19: Team Schedule Marked Time Totals Report

Item Description

Business Unit [header] The name of the business unit. If the report covers only independent 
sites, no business unit name appears.

Site [header] The name and time zone of the site.

Date Period [header] The time range covered by the report.

Selected Schedule Marked 
Times [header]

The marked-time types covered by the report.

Team The name of each team included in the report.

Day Each matching date in the selected date range.

Duration The time that each team spent the selected marked-time types 
during each day included in the report.

Paid Hours The number of hours spent in the marked-time types that were paid.

Total Duration and Total 
Paid Hours for Site

The combined time that all of the teams in the site spent in the 
selected marked-time types during the report's date range.
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Schedule States Report

To create a Schedule States Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule States Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenarios screen, select a schedule scenario or the Master Schedule 
and then click Next.

5. On the Date Range screen, select Start and End Dates and Times for the 
report. Then click Next.

Table 20: Agent Schedule Marked Time Totals Report

Item Description

Site [header] The name and time zone of each site included in the report.

Team [header] The team to which the selected agents belong.

Date Period [header] The time range covered by the report.

Selected Schedule Marked 
Times [header]

The marked-time types covered by the report.

Agent The name of each agent in the team who had marked time.

Day Each matching date in the selected date range.

Duration The time that this team's agents spent in the selected marked-time 
types for each day included in the report.

Paid Hours The number of marked-time hours that were paid for each day 
included in the report.

Total Duration and Paid 
Time for Team

The combined time that all of the team's agents spent in the selected 
marked time over the report's date range, and how many of those 
hours were paid.
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Note: You can select fewer weeks than are defined in the scenario that you 
selected in step 4.

6. On the first Data screen, select teams and/or agents.

You can expand business units to display their sites, and expand sites to 
display their teams and agents. You can select any combination of teams 
and/or agents from multiple sites.

7. Click Next.

8. On the second Data screen, select schedule state groups and states.

You can expand business units to display their sites, and expand sites to 
display their schedule state groups and schedule states. You can select 
multiple schedule states across different sites.

9. Click Finish.

The report appears in the Report Viewer.

Table 21: Understanding the Schedule States Report

Item Description

Site [header] The site name and time zone.

Selected Schedule State 
Groups and Schedule 
States [header]

A comma-separated list of the schedule state groups and schedule 
states that were selected in the wizard, and are applicable to the 
selected site.

Team [header] Agents are displayed by team. 

Date and Time Period 
[header]

The dates covered by the report, and time period covered each day.

Agent The agent whose information is displayed.

Day The date on which the schedule state’s shift begins.

Schedule State The name of the schedule state.

Start Time The schedule state start time.

End Time The schedule state end time.

Duration The duration of each schedule state.

Paid Hours The paid hours for each schedule state.
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Notes: The durations of full-day time offs and full-day exceptions in the 
report are computed according to these rules:

• If the start and end are specified or estimated by WFM Server, then 
the duration is the difference between the end and start values.

• If the start and end are not specified or estimated:
• The durations of paid full-day time offs and exceptions are equal to 

paid time.
• The durations of unpaid full-day time offs and exceptions are equal 

to Standard Daily Paid Hours from the agent's contract.

Schedule Summary Report

To create a Schedule Summary Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule Summary Report.

The Reports Wizard's first page, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

Total Duration/Paid Hours 
for Agent
(not labeled)

Note: This total appears beneath the statistics for each agent.
Duration: The total duration of all the agent's schedule states during 
the time range covered by the report.
Paid Hours: The total paid hours for all the agent's schedule states 
during the time range covered by the report.

Total Duration/Paid Hours 
for Team

Note: This total appears at the end of the report.
Duration: The total duration of all selected agents on each selected 
team.
Paid Hours: The total paid hours of all selected agents on each 
selected team.

Total Duration/Paid Hours 
for Site

Note: This total appears at the end of the report.
Duration: The total duration of all selected agents from all selected 
teams on the site.
Paid Hours: The total paid hours of all selected agents from all 
selected teams on the site.

Table 21: Understanding the Schedule States Report (Continued) 

Item Description
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4. On the Scenarios page, select a schedule scenario or the Master Schedule. 
Then click Next.

5. On the Date Range page:
 Select the radio button for the granularity you want. 

If you select Intraday, the report shows the data for one 24-hour period 
in timesteps. Use the drop-down box to specify timestep granularity: 
15 (default), 30, or 60 minutes.

 If you selected [X]-weeks granularity, next select the number of weeks 
to include. You can generate the report for any number of weeks 
between one and six. This option is unavailable if you selected any 
granularity other than weeks.

 Enter the date range you want displayed in the report. If you have 
selected to generate the report for a schedule scenario, the dates must 
fall within the scenario period.

 Select the Target type—activity, multi-site activity, site, business 
unit—for which you want the report generated. If you select multi-site 
activity or business unit, the following check box appears: Use Multi-
site Activities. Leave checked to aggregate report data by multi-site 
activities.

 Click Next.

6. On the Data page, select the specific objects that you want to view. 
Depending on your choice of object type, you can choose to view the 
enterprise, business units, sites, or activities. Not all options are available 
for all object types. 

If you select Activity, the tree contains the enterprise, business units (if 
applicable), sites, and activities. If you select Site, the tree contains the 
enterprise, business units (if applicable), and sites. If you select Business 
Unit, the tree contains the enterprise and business units. You can generate 
the report for only the enterprise, one business unit, one site, or one 
activity.

7. On the Statistics page, select the statistics that you want to include in the 
report, by clicking the check box next to each statistic. You can select up to 
18 items from the list. For descriptions of these statistics, see “Appendix B: 
Metrics” in the current Workforce Management Administrator's Guide. 

The list of statistics includes these categories: Headcount, Service Level, 
Interaction Volume, AHT, Budget, Staffing, Difference, Coverage, ASA, 
Occupancy; and for each category one or more of these metrics: Sch. 
(Scheduled), Frc. (Forecast), Diff. (Difference); Calc. (Calculated), Req. 
(Required), Publ. (Published).

If Master was selected on the Scenario screen, the check boxes Coverage 
Publ. and Coverage Diff. are enabled and selected by default. This latter 
column displays the difference between schedule coverage based on the 
current Master Schedule and schedule coverage based on the baseline 
Master Schedule.
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8. Click Finish.

The report appears in the Report Viewer.

Table 22: Understanding the Schedule Summary Report

Item Description

Site Information or 
Business Unit Information 
or Enterprise [header]

The site's name and time zone, if you selected activity as the report's 
target.
The business unit's name and time zone, if you selected multi-site 
activity or site as the report's target.
The enterprise, if you selected business unit as the report's target.
(Each root is displayed separately.)

Activity, Multi-Site Activity, 
Site, or Business Unit 
[header]

The report is organized by activity, multi-site activity, site, or 
business unit— depending on the target that you selected in the 
Reports Wizard.

Date/Date Period [header] The dates covered by the report. The report displays separate 
information for each target and date. This header shows the Date if 
you selected Intra-day granularity and Date Period for other 
granularities.

Time Step, Day, Week Of, X 
Weeks of, Month

The time period shown. The header and the column contents depend 
on the granularity that you selected.

Coverage [Scheduled] The scheduled staffing coverage.

Headcount [Scheduled] The number of agents scheduled.

Service Level Percentage 
Scheduled

The service level percentage that can be achieved given the staffing 
coverage—assuming that other planned metrics (such as interaction 
volumes and Average Handling Time) remain unchanged.

Service Level Percentage 
Forecasted

The service level percentage that can be expected to be achieved 
based on the number of agents forecasted. 

This may differ than the original service level objective that was 
stated when the staffing forecast was built due to agent rounding. 
For example, WFM may forecast a staffing requirement of 12 
agents to meet a service level objective of 80% of interactions 
answered within 20 seconds, but Service Level Percentage Forecast 
may report a higher number, such as 83.48%. This is because 12 
was the minimum number of agents required to meet the 80% 
service level objective but, with that number of agents, the contact 
center can be expected to achieve a slightly better service level than 
80%. With one less agent (11 agents), the contact center would not 
be expected to achieve the 80% service level.

Interaction Volume 
Scheduled

The number of interactions that can be handled based on the 
schedule coverage.
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Schedule State Totals Report

To create a Schedule Marked Time Totals Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule State Totals Report.

The Reports Wizard's first screen, Header, appears.

Interaction Volume 
Forecasted

The expected number of interactions, according to the Master 
Forecast—assuming that other planned metrics remain unchanged.

AHT Scheduled The Average Handling Time per interaction, based on the 
schedule—assuming that other planned metrics remain unchanged.

AHT Forecasted The expected Average Handling Time, according to the Master 
Forecast.

Budget Scheduled The budget for the scheduled coverage for the selected day and 
target, based on the scheduled agents' paid hours and wages. 

Budget Forecasted The budget for the calculated staffing for the selected day and 
target, based on the full-time-equivalent (FTE) paid hours per day 
and salary specified in the scenario.

Staffing Calculated The required number of agents as calculated by WFM, based on the 
forecasted interaction volumes, AHT, and applicable service 
objectives.

Staffing Required The required number of agents defined by the user, either by 
explicitly entering forecast targets or by using a template.

Difference Calculated The difference between Coverage [Scheduled] and Staffing 
Calculated.

Difference Required The difference between Coverage [Scheduled] and Staffing 
Required.

Coverage Publ. The published staffing coverage. 

Coverage Diff. The difference between schedule coverage based on the current 
Master Schedule and schedule coverage based on the baseline 
Master Schedule.

Table 22: Understanding the Schedule Summary Report (Continued) 

Item Description
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3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule 
and then click Next.

5. On the Date Range screen, select a Granularity and a corresponding Start 
and End Date. (Your Granularity selection may restrict your Date 
selections.) Then click Next.

6. On the Target screen, select Agent, Team, or Site from the drop-down list. 
Then click Next.

7. On the first Data screen, select the targets (agents, teams, or sites) to 
include in the report.

You can expand business units to display their sites. If you selected Team 
or Agent in the Target Page, you can further expand the tree's branches. 
You can select across multiple sites.

8. Click Next.

On the second Data screen, select the schedule states to include. 

9. Click Finish.

The report appears in the Report Viewer.

Understanding the Schedule State Totals Report

The report takes one of three forms, depending on the target that you selected. 

Table 23: Site Schedule State Totals Report

Item Description

Enterprise [header] The enterprise covered by the report.

Business Unit [header] The name of each business unit included in the report.

Date Period [header] The time range covered by the report.

Selected Schedule State 
Groups and Schedule 
States [header]

The schedule state groups and schedule states covered by the report.

Site The name of each site included in the report.

Total Duration for Business 
Unit

The combined time that all the business unit's agents spent in the 
selected schedule states, over the report date range.
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Notes: The durations of full-day time offs and full-day exceptions in the 
report are computed according to these rules:

• If the start and end are specified or estimated by WFM Server, then 
the duration is the difference between the end and start values.

• If the start and end are not specified or estimated:
• The durations of paid full-day time offs and exceptions are equal to 

paid time.
• The durations of unpaid full-day time offs and exceptions are equal 

to Standard Daily Paid Hours from the agent's contract.

Schedule Trade Report

To create a Schedule Trade Report:

1. In the Modules tree, select Reports > Schedule Reports. 

Table 24: Team Schedule State Totals Report

Item Description

Business Unit [header] The name of each business unit included in the report.

Site [header] The name and time zone of the site.

Date Period [header] The time range covered by the report.

Selected Schedule State 
Groups and Schedule 
States [header]

The schedule state groups and schedule states covered by the report.

Team The name of each team included in the report.

Day Each matching date in the selected date range.

Duration The time each agent spent in the selected schedule states, for each 
day included in the report.

Total Duration [per Agent] The total time each agent spent in the selected schedule states, over 
the report's date range.

Total Duration for Site The combined time that all the site's agents spent in the selected 
schedule states, over the report's date range.

Total Duration for Team The combined time that all the team's agents spent in the selected 
schedule states, over the report's date range.
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A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule Trade Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Date Range screen, select a Start and End Date.

5. In the Data Type section, select each trade status that you want to include 
in the report. Clear the check boxes for each status that you want to omit. 
Then click Next.

6. On the Data screen, select the agents that you want to include in the report.

You can expand business units expand to display their sites, teams, and 
agents. You can select multiple agents across teams. You can also select 
whole teams or a whole site.

7. Click Finish.

The report appears in the Report Viewer.

Table 25: Understanding the Schedule Trade Report

Item Description

Site [header] The site's name and time zone.

Date Period [header] The date range that you selected in the Reports Wizard.

Proposer: Team, Name The team and name of the agent proposing each trade.

Respondent: Team, Name The team and name of the agent responding to each trade proposal.

Trade: Days The dates included in each trade proposal.

Status The status of each trade proposal. (If you cleared a status on the 
Reports Wizard's Schedule Trade States screen, trades with that 
status do not appear in the report.)

Transaction Date The date on which the trade proposal entered its current status.

Approved By / Declined By The supervisor who approved or declined the trade proposal, or 
“Auto-Approved” / “Auto-Declined” if it was done by the system.

Comments Any comments attached by the supervisor who acted on the trade 
proposal.
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Schedule Validation Report

To create a Schedule Validation Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Schedule Validation Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. 

4. Click Next.

5. On the Scenario screen, select a schedule scenario or the Master Schedule.

6. Click Finish.

The report appears in the Report Viewer.

Understanding the Schedule Validation Report

This report provides a printable, searchable format in which to view generated 
Schedule Validation warnings. You can browse the same warnings in the 
Review Messages window. 

For more information about these warnings, see Schedule Validation.

Team Schedule Report

To create a Team Schedule Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Team Schedule Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 

5. Optionally, click the Sort by shift start check box. Then click Next.

6. In the Date Range Page, select a Start and End date for the report. Then 
click Next.

7. On the Data screen, select the team(s) for which to generate the report.

You can expand business units to display their sites and teams.
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The report is sorted in alphabetical order by business unit, site name within 
each business unit, and team name.

8. Click Finish.

The report appears in the Report Viewer.

Team Weekly Schedule Report

To create a Team Weekly Schedule Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Team Weekly Schedule Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

Table 26: Understanding the Team Schedule Report

Item Description

Site [header] The site's name and time zone.

Team [header] The team covered by the report.

Date Period [header] The date period covered by the report.

Day [header] The report is organized day-by-day. This line identifies the first 
displayed date.

Agent The name of each of the team's agents.

Total Hours The agent's total hours (paid hours plus unpaid hours) for the day.

Paid Hours The agent's paid hours for the day.

Effective Hours The hours during which the agent is paid and working. (Activity 
work is included, but breaks are not.)

Schedule State Schedule state and activity set information.

Start Time The time at which the agent is scheduled to start each scheduled 
state.

End Time The time at which the agent is scheduled to end each scheduled 
state.



346 Workforce Management 7.6

Chapter 8: Reports Schedule Reports

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. Fill in the Date Range screen:
 Select a Start and End date for the report.
 To include required staffing figures, select the Show Required Staffing 

check box.
 Select a data type: Start/End Time or Paid Hours.

You can select multiple weeks for the report output, but your selection 
must be full weeks.

 Click Next.
 On the Data screen, select the team(s) for which to generate the report.

You can expand business units to display their sites and teams.

6. Click Finish.

The report appears in the Report Viewer. The report is sorted in alphabetical 
order by business unit, site name within each business unit, and team name.

Table 27: Understanding the Team Weekly Schedule Report

Item Description

Site [header] The site's name and time zone.

Team [header] The team covered by the report.

Date Period [header] The date range that you selected in the Reports Wizard.

Activity Each activity performed by agents on the selected team. The report 
is organized by activity name.

Agent Each agent scheduled to work on the indicated activity.

ID Each agent's identification number.

Day Each day of the week.

Weekly Work Hours–Paid The number of paid hours per week for each agent. (This column 
and the next two only appear if you selected the Show Paid Hours 
check box.)

Weekly Work Hours–Eff. The number of effective hours per week for each agent. (Excludes 
paid breaks and paid days off.)

Weekly Work Hours–NonEff. The number of noneffective hours per week for each agent. (Paid 
non-working hours, such as paid breaks and paid days off.)
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Presentation

The finished report is grouped by this hierarchy:
Enterprise
Business Unit
Site
Week date range

Team
Activity

Agent

Weekly Schedule Coverage Report

To create a Weekly Schedule Coverage Report:

1. In the Modules tree, select Reports > Schedule Reports. 

A list of Schedule Reports appears in the working pane and in the Objects 
tree.

2. From either list, select Weekly Schedule Coverage Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. On the Scenario screen, select a schedule scenario or the Master Schedule. 
Then click Next.

5. On the Date Range screen, select a Start and End Date. Then click Next.
 Select a Start Date and an End Date in the Data Range pane.
 Select Show Required Staffing or Calculated Staffing in the Options 

pane.
 Select one: Activity, Site, Multi-site Activity, or Business Unit from 

the drop-down list in the Target pane. 
 Click Next.

Total Hours The total number of paid hours worked by the entire team if it had 
agents scheduled to work at the activity during the day (for the daily 
total) and the week (for the weekly total). 

Footnote Indicates that the agent worked on a different activity during the 
specified time.

Table 27: Understanding the Team Weekly Schedule Report (Continued) 

Item Description
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6. On the Staffing Type screen, you can optionally select Show Required 
Staffing and/or Calculated Staffing. Then click Next.

7. On the Target screen, select Activity, Site, Multi-site Activity, or Business 
Unit from the drop-down list. Then click Next.

8. On the Data screen, select the targets to include in the report.

This page's tree displays activities, sites, multi-site activities, or business 
units (depending on your selection on the Target screen). If you selected a 
target other than business unit, the tree's business units expand to display 
their contents. You can make multiple selections.

9. Click Finish.

The report appears in the Report Viewer.

Performance Reports 

Overview

Performance reports display site performance measures in tabular and/or graph 
formats. (For a complete list of all WFM, see the Reports List.) 

The Performance reports are:

Table 28: Understanding the Weekly Schedule Report

Item Description

Site [header] The name and time zone of the business unit or site.

Activity or Site [header] The name of the activity or site whose information appears in the 
table.

Date Period [header] The total date range covered by the report.

Timestep The data is displayed timestep-by-timestep.

Days Columns for each day of the week.

Calculated/Required The calculated or required staffing per timestep. (These columns 
appear if you selected Show Required Staffing and/or Calculated 
Staffing in the Reports Wizard.)

Scheduled The effective number of agents that are scheduled for this activity 
for this timestep.

Difference The difference between the calculated/required and scheduled 
staffing.

Total Hours [row] The total full-time-equivalent person-hours for each day.
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• Actual Overhead Report.

• Workforce Performance Report.

• Contact Center Performance Report.

• Contact Center Performance Graphs Report.

Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the End Date selector is disabled.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

A list of the selected category's reports appears in the working pane and in 
the Objects tree.

2. From either list, select the report that you want:
 Click once on a report's name in the working pane. 
 Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.
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5. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you 
are creating. 
 Click Next after making your selections on each intermediate screen. 
 Make your selections on the final screen (which has a Finish button).

6. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree to allow later review.

Note: For detailed explanations of what is displayed in each report, click the 
name of the report in the bullet list above.

Actual Overhead Report

To create an Actual Overhead Report:

1. In the Modules tree, select Reports > Performance Reports. 

A list of Performance Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Actual Overhead Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. On the Date Range screen, select a Granularity and a corresponding Start 
and End Date. (Your Granularity selection may restrict your Date 
selections.)

6. Click Next.

7. On the Data screen, select the sites that you want to include in the report.

You can expand business units to display their sites. You can make 
multiple selections.
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8. Click Finish.

The report appears in the Report Viewer.

Workforce Performance Report

To create a Workforce Performance Report:

1. In the Modules tree, select Reports > Performance Reports. 

A list of Performance Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Workforce Performance Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box.

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 

Table 29: Understanding the Actual Overhead Report

Item Description

Site or Business Unit 
[header]

The name and time zone of the site or business unit.

Date [header] The dates that you selected in the Reports Wizard.

Timestep/Day/Week 
of/Month/X Weeks

The time periods shown in this column correspond to the 
granularity that you selected in the wizard.

Calculated Staffing The amount of overhead calculated in the forecast.

% Working Overhead The percentage of agent time that is work related but not included in 
an activity.

% Nonworking Overhead The percentage of time that agents are not working during paid 
hours.

Scheduled Coverage The scheduled staffing coverage for an activity or multi-site 
activity. 

% Working Exceptions The percentage of time the agent is scheduled for Exceptions, if the 
Exception is defined as a working exception.

% Nonworking Exceptions The percentage of agent time spent in non-work related exceptions, 
such as jury duty or sick leave.

Total/Average [footer] The total or average for each statistic, over the report's displayed 
period. Displayed in Full-Time Equivalents (FTEs).
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(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. On the Date Range screen:
 Select a Granularity and a corresponding Start and End Date. (Your 

Granularity selection may restrict your Date selections.)
 Enter a Percentage of Deviation Threshold. (Periods whose actual 

values differ from the planned values by more than this percentage are 
listed as noncompliant.)

 Select a time zone.
 Select Activity, Site, Activity Group, Multi-site Activity, or Business 

Unit from the drop-down list. 
 Click Next.

6. On the Data screen, select the targets that you want to include in the report.

This page's tree displays activities, sites, activity groups, multi-site 
activities, or business units (depending on your choice of target). If you 
selected a target other than business unit, the tree's business units expand to 
display their contents. You can make multiple selections.

7. Click Finish.

The report appears in the Report Viewer.

Table 30: Understanding the Workforce Performance Report

Item Description

Root/Site [header] The name and time zone of the target or site.

Target/Activity or Site 
[header]

The report is organized by activity, site, business unit, or multi-site 
activity, depending on the target that you selected in the Reports 
Wizard.

Date/Date Period The date or date period selected in the wizard.

Timestep / Day / Week of / 
Month / X Weeks of

Time periods, corresponding to the granularity that you selected in 
the wizard.

Actual The actual staffing for each timestep.

Calculated The calculated staffing for each timestep. The report shows the 
calculated value, the difference between calculated and actual 
values (that is, calculated minus actual), and the difference 
expressed as a percentage.
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Contact Center Performance Report

To create a Contact Center Performance Report:

1. In the Modules tree, select Reports > Performance Reports.

A list of Performance Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Contact Center Performance Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. On the Date Range screen:
 Select a Granularity and a corresponding Start Date and End Date. 

(Your Granularity selection may restrict your Date selections.)

Required The required staffing for each timestep. The report shows the 
required value, the difference between required and actual values 
(that is, required minus actual), and the difference expressed as a 
percentage.

Coverage The scheduled and optimal coverage per period, the scheduled 
coverage minus the optimal coverage, the difference as an absolute 
value, and the difference as a percentage.

Head Count The scheduled staffing for each timestep. The report shows the 
scheduled value, the difference between scheduled and actual 
values (that is, scheduled minus actual), and the difference 
expressed as a percentage.

Deviation [footer] The number of compliant periods. To be compliant, a period's actual 
values must differ from planned values by no more than the 
Percentage of Deviation Threshold that you set in the wizard.

Deviation % The percentage of compliant periods.

Table 30: Understanding the Workforce Performance Report (Continued) 

Item Description
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 Select a time zone. 
 Select the Target type—activity, multi-site activity, site, business 

unit—for which you want the report generated. If you select multi-site 
activity or business unit, the following check box appears: Use Multi-
site Activities. Leave checked to aggregate report data by multi-site 
activities.

 Click Next.

6. On the Data screen, select the targets that you want to include in the report.

7. This page's tree displays activities, sites, multi-site activities, or business 
units (depending on your choice of target). If you selected a target other 
than business unit, you can expand the tree's business units to display their 
contents. You can make multiple selections.

8. Click Next.

9. On the Performance Data Types screen, select the Data Types (statistics) 
that you want to include.

10. Click Finish.

The report appears in the Report Viewer.

Table 31: Understanding the Contact Center Performance Report

Item Description

Root/Site [header] The name and time zone of the target or site.

Target/Activity or Site 
[header]

The report is organized by activity, site, business unit, or multi-site 
activity, depending on the target that you selected in the Reports 
Wizard.

Date or Date Period The date or date period that you selected in the wizard.

Timestep / Day / Week of / 
Month / X Weeks of

The time periods shown in this column correspond to the 
granularity that you selected in the wizard.

Coverage The scheduled and optimal coverage per period; the scheduled 
coverage minus the optimal coverage; the difference as an absolute 
value; and the difference as a percentage.

Head Count The scheduled and actual agents per period; the scheduled number 
minus the actual number; and the percent (%) difference.

Interaction Volumes The forecast and actual interaction volume per period; the forecast 
minus the actual; and the percent (%) difference.

AHT The forecast and actual average handling time per period; the 
forecast minus the actual; and the percent (%) difference.

Service Level The scheduled and actual service level per period.
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Contact Center Performance Graphs Report

To create a Contact Center Performance Graphs Report:

1. In the Modules tree, select Reports > Performance Reports.

A list of Performance Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Contact Center Performance Graphs Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next. 

4. On the Date Range screen:
 Select a Granularity and a corresponding Start Date and End Date. 

(Your Granularity selection may restrict your Date selections.) 
 Select a time zone. 
 Click Next.

5. On the Data screen, select the activities that you want to include in the 
report.

You can expand business units to display their sites, and expand sites to 
display their activities. You can select any combination of activities from 
multiple sites.

6. Click Next.

7. On the Performance Data Types screen, select the Data Types (statistics) 
that you want to include.

8. Click Finish.

ASA The scheduled and actual average speed of answer for each period.

Abandons Factor The scheduled and actual abandons per period.

Total/Average [footer] The total number of agents, interactions, and abandons across the 
report's time range; and the average of the AHT, service-level, and 
ASA values across the report's time range.

Table 31: Understanding the Contact Center Performance Report (Continued) 

Item Description
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The report appears in the Report Viewer.

Adherence Reports 

Overview

Adherence reports display adherence statistics at the business unit, site, team, 
or agent level. (For a complete list of all WFM reports, see the Reports List.) 

The Adherence reports are:

• Agent Adherence Report.

• Adherence Totals Report.

• Agent States Report.

Report Security Restrictions

You can view and print reports only for those sites for which you have security 
access.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

Table 32: Understanding the Contact Center Performance Graphs Report

Item Description

Site [header] The site's name and time zone.

Activity [header] The report is organized by activity.

Date or Date Period [header] The date or date period that you selected in the Reports Wizard.

Forecasted/Actual [legend] Indicates how the report displays forecasted and actual data.

Graph Type The graph's vertical axis identifies the displayed statistic 
(Interaction Volumes, Average Handling Time, or Number of 
Agents), and labels its units.

Timestep / Day / Week of / 
Month / X Weeks of [bottom 
labels]

The graph's horizontal axis labels the time period covered by each 
of the graph's bars. The periods depend on the granularity that you 
selected in the wizard.
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• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

• If you select intra-day granularity, the End Date selector is disabled.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click a category.

A list of the selected category's reports appears in the working pane and in the 
Objects tree.

2. From either list, select the report you want:
 Click once on a report's name in the working pane. 
 Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you 
are creating. 
 Click Next after making your selections on each intermediate screen. 
 Make your selections on the final screen (which has a Finish button).

6. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree so that you can review it later.

Note: For detailed explanations of what is displayed in each report, click the 
name of the report in the bullet list above.

Agent Adherence Report

To create an Agent Adherence Report:

1. In the Modules tree, select Reports > Adherence Reports. 

A list of Adherence Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Agent Adherence Report.
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The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box.

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. On the Date Range screen, select a Start date and End date for the report.

6. Optionally, you can select the Display Every Unique Status check box. 
Select this option if you want to see every nonadherent status that the agent 
was in during nonadherent periods. If you leave this check box cleared, the 
report shows only the first of the consecutive nonadherent statuses that 
occurred during each schedule state. 

Optionally, you can also check the Exclude Days Without Shifts check 
box. In this case, scheduled days without shifts are not included in the 
report.

7. Click Next.

8. On the Data screen, select the agent(s) to include in the report.

9. You can expand business units to display their sites, teams, and agents.

10. Click Finish.

The report appears in the Report Viewer.

Table 33: Understanding the Agent Adherence Report

Item Description

Site [header] The site's name and time zone.

Team [header] The name of the selected agent's team.

Agent [header] The name of the agent whose information is displayed in the report.

Date Period The time range covered by the report. Adherence data is shown for 
each day separately.

Scheduled State Lists the agent's noncompliant scheduled states.

Agent State The noncompliant states registered for the agent throughout the day.

Start Time/End Time The start and end times for the noncompliant states.
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Adherence Totals Report

To create an Adherence Totals Report:

1. In the Modules tree, select Reports > Adherence Reports.

A list of Adherence Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Adherence Totals Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. On the Date Range screen, select a Granularity and a corresponding Start 
Date and End Date. (Your Granularity selection may restrict your Date 
selections.) Then click Next.

In the Target section, select Agent, Team, or Site from the drop-down list.

Optional: you can select the Exclude Days Without Shifts check box. Then 
click Next.

6. On the Data screen, select the targets (agents, teams, or sites) that you want 
to include in the report.

% Adherence Per Day The percent of the day during which the agent was adherent to his or 
her scheduled state. This is calculated using the formula 100 - 
((NC+UNC)*100/(ST+UNC)) where:

NC—Noncompliant time

UNC—Noncompliant time outside of scheduled time

ST—Scheduled time

% Adherence for Agent The percent of the report's total time range during which the agent 
was adherent to his or her scheduled state.

Table 33: Understanding the Agent Adherence Report (Continued) 

Item Description
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You can expand business units to display their sites. If you selected Team 
or Agent on the Target screen, you can further expand the tree's branches. 
You can select across multiple sites.

7. Click Finish.

The report appears in the Report Viewer.

Understanding the Adherence Totals Report

The report takes one of three forms depending on the target selected. The Site, 
Team, and Agent reports are detailed separately below.

Table 34: Site Adherence Totals Report

Item Description

Business Unit [header] The name of the business unit, if applicable, and its time zone.

Date Period [header] The time range covered by the report.

Site The name of each site included in the report.

% of Adherence The percentage of time that the agents in each site spent in a 
compliant state for each day included in the report.

% of Adherence per Day The average of the compliant time for all sites for the specified day.

% Adherence per Week The average of the compliant time for all sites for the specified 
week.

% Adherence per X Weeks The average of the compliant time for all sites, for your specified 
period of up to six weeks.

% Adherence per Month The average of the compliant time for all sites for the specified 
month.

% of Adherence for the 
Business Unit

The total average compliant time for all sites for the specified date 
range.

Table 35: Team Adherence Totals Report

Item Description

Business Unit [header] The name of the business unit, if applicable, and its time zone.

Site [header] The name and time zone of the site.

Date Period [header] The time range covered by the report.

Team The name of each team included in the report.
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% of Adherence The percentage of time that each team spent in a compliant state for 
each day included in the report.

% of Adherence per Day The average of the compliant time for all teams on the specified 
day.

% Adherence per Week
% Adherence per X Weeks

% Adherence per Month

The average of the compliant time for all teams for the specified 
week.
The average of the compliant time for all teams, for a specified 
period of up to six weeks.
The average of the compliant time for all teams, for the specified 
month.

% of Adherence for Site An average of all daily adherence totals for the date period.

Table 35: Team Adherence Totals Report (Continued) 

Item Description

Table 36: Agent Adherence Totals Report

Item Description

Site [header] The name and time zone of the site.

Team [header] The team displayed in the report.

Date Period [header] The time range covered by the report. Each day is shown separately.

Agent The name of each agent included in the selected team.

% of Adherence The percentage of time that each agent spent in a compliant state for 
each day included in the report.

% of Adherence per Day The average of the compliant time for all agents on the specified 
day.

% Adherence per Week
% Adherence per X Weeks

% Adherence per Month

The average of the compliant time for all agents for the specified 
week.
The average of the compliant time for all agents, for a specified 
period of up to six weeks.
The average of the compliant time for all agents, for the specified 
month.

% of Adherence for Team An average of all daily adherence totals for the date period.
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Agent States Report

To create an Agent States Report:

1. In the Modules tree, select Reports > Adherence Reports. 

A list of Adherence Reports appears in the working pane and in the 
Objects tree.

2. From either list, select Agent States Report.

The Reports Wizard's first screen, Header, appears.

3. Optional: To print a header on the report, select Show Header and type 
your header text into the text box. 

Optional: To print the report in report in the comma-separated values 
format, select the check box Create report with .csv friendly format 
(and then, after the report is created, select Actions > Save As and select 
Comma Separated as the report format). Do not use Workforce Management 
(WFM) to print reports that you created in “.csv friendly format,” because 
the result may be truncated. To print such a file correctly, open it in a 
program that reads the .csv format, and then print it.

4. Click Next.

5. On the Date Range screen, select a Start Date and End date for the report. 
Then click Next.

6. On the Data screen, select the agent(s) that you want to include in the 
report.

You can expand business units to display their sites, teams, and agents.

7. Click Next.

8. On the Agent states page, select the Agent States that you want to include 
in the report. Clear the check boxes for Agent States that you want to omit. 
If you want to, enter any Reason Code with which you want to filter the 
report.

9. Click Finish.

The report appears in the Report Viewer.

Table 37: Understanding the Agent States Report

Item Description

Site [header] The site's name and time zone.

Team [header] The team to which the selected agent belongs.

Agent [header] The agent whose status is displayed in the report.

Date Period The dates that you selected in the Reports Wizard.
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Audit Reports 
Audit reports track user (supervisor) actions performed in the Calendar module 
and on the Master Schedule. (For a complete list of all WFM reports, see the 
Reports List.) 

The Audit reports are:

• Calendar Audit Report

• Schedule Audit Report

Report Security Restrictions

To create and print these reports, permission must be assigned through the 
Configuration Utility Reports Security Options.

Date Restrictions

For reports whose wizard includes a Date Range screen: 

• If you select weekly or monthly granularity, the Start Date and End Date 
selectors may be constrained to particular days (to the week's start and end 
days, or to the selected month's first and last days). 

• If you enter dates that do not match these constraints and click Next, an 
error message alerts you to change your selection. 

Agent State The name of the schedule state.

Reason If you are using reason [Aux] codes, the code associated with an 
occurrence of the schedule state.

Start Time The time at which the agent enters the schedule state.

End Time The time at which the agent switches to another state.

Duration Duration of the schedule state.

Total Duration Per Day (row) The combined time of the schedule states per day.

Total Duration Per Date 
Period (row)

The combined time of the schedule states per date period.

Table 37: Understanding the Agent States Report (Continued) 

Item Description
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Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then 
click the Audit Reports category.

A list of the selected category's reports appears in the working pane and in 
the Objects tree.

2. From either list, select the report that you want:
 Click once on a report's name in the working pane. 
 Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first screen, Header, 
appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box.

4. Click Next.

5. Select the objects, dates, or other options that you want to include in the 
report.

The number of screens that follow the first one depends on the report you 
are creating. 
 Click Next after making your selections on each intermediate screen. 
 Make your selections on the final screen (which has a Finish button).

6. Click Finish.

A Progress message box appears. You can click its Cancel button to interrupt 
the report's generation.

When the report has been generated, the Report Viewer appears to display it. 
The report is also added to the Objects tree so that you can review it later.

Note: For detailed explanations of what is displayed in each report, see 
Calendar Audit Report or Schedule Audit Report.

Calendar Audit Report

This report can show Calendar items modified not only by supervisors, but 
also by agents. However, the items modified by agents cannot be filtered by 
the agent name or ID. Instead, all items modified by agents are listed as being 
modified by the SYSTEM user. An example would be an agent time off 
preference. Since time off preferences are Calendar items that can be entered 
by agents through their Web GUI, this type of Calendar item would show up in 
the Calendar Audit Report as having been modified by the SYSTEM user. 

To create a Calendar Audit Report:

1. In the Modules tree, select Reports > Audit Reports. 

A list of Audit Reports appears in the working pane and in the Objects tree.
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2. From either list, select Calendar Audit Report.

The Reports Wizard's first screen, Header, appears.

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. Complete the Date Range screen. 
 Under Action Date Range, do one of the following:

 Select Start and End dates for supervisor actions in the Calendar 
module. 

 Select the Any check box to select any date range for supervisor 
actions in the Calendar module. If checked, the Start and End date 
fields are disabled.

 Under Actions and Statuses, check boxes to indicate the actions and 
statuses that you wish to audit: Insert, Edit, Delete, Preferred, Granted, 
Declined and Recalled.

 Under Calendar Items Date Range, do one of the following:
 Select Start and End dates for the agent Calendar items you wish to 

audit. 
 Select the Any check box to select Calendar items in any date 

range. If checked, the Start and End date fields are disabled.
 Under Options, select Show comments to control whether comments, 

if any, are shown on the report. 
 Under Sort Options, select one of the following: 

 By Agent name
 By Supervisor name
 By Timestamp date
 By Calendar Item date

Click Next.

5. On the Data screen, under Available Users, select the supervisors and other 
users/agents that you want to include in your report. 

Click Next.

6. On the second Data screen, under Available Agents, select the agents to 
include in the report.

You can expand business units to display their sites, teams, and agents. You 
can select agents from multiple sites. 

Click Next.

7. On the Calendar Items screen, select the check boxes for items that you 
want to include in the report, and clear the check boxes for items that you 
want to omit. Available selections are Availabilities, Days Off, Shifts, 
Working Hours, Times Off, and Exceptions. 

8. Click Finish.
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The report appears in the Report Viewer. The report is initially sorted by 
business unit within the enterprise, by site name within each business unit, then 
team name (if any) within each site. Further sorting is based on Sort Options 
selected on the Date Range screen.

Schedule Audit Report

This report can show not only schedule changes made by supervisors, but also 
by agents. However, the schedules modified by agents cannot be filtered by the 
agent name or ID. Instead, all schedules modified by agents are listed as being 
modified by the SYSTEM user. An example would be an agent trade that is 
auto-approved by the system. In this case, no supervisor was involved, and that 
schedule change would be reported in the Schedule Audit Report as being done 
by the SYSTEM user. 

To create a Schedule Audit Report:

1. In the Modules tree, select Reports > Audit Reports. 

A list of Audit Reports appears in the working pane and in the Objects tree.

2. From either list, select Schedule Audit Report.

The Reports Wizard's first screen, Header, appears.

Table 38: Understanding the Calendar Audit Report

Item Description

Site [header] The selected business unit, site, site time zone, and the (first) 
selected team. 

User Name The name of the user (supervisor) or agent responsible for the 
action.

Timestamp The date and time of the supervisor action.

Action The description of the action. Examples: Insert, Edit, and Delete.

Date The Calendar item day.

Agent The name of the agent affected by the action.

Type The item type name. Example: Working Hours.

Name The Calendar item name. 

Status The status assigned by the user. Examples: Granted, Declined.

Comments This column appears if Show Comments was selected on the Date 
Range screen. 



Supervisor User’s Guide 367

Chapter 8: Reports Audit Reports 

3. To print a header on the report, select Show Header and type your header 
text into the text box. Then (whether you entered a header or not) click 
Next.

4. Complete the Date Range screen. 
 Under Action Date Range, do one of the following:

 Select Start and End dates for supervisor actions in the Master 
Schedule. 

 Select the Any check box to select any date range for supervisor 
actions in the Master Schedule. If checked, the Start and End date 
fields are disabled.

 Under Actions, check boxes to indicate the actions you wish to audit. 
Publish, Cleanup, Modify, or Trade.

 Under Schedule Date Range, do one of the following:
 Select Start and End dates for the schedule days you wish to audit. 
 Select the Any check box to select schedule days in any date range. 

If checked, the Start and End date fields are disabled.
 Under Options, select Present action's details to control whether 

additional detail on the action is shown on the report. See 
Understanding the Schedule Audit Report below for more information.

 Under Sort Options, select one of the following: 
 By Supervisor name
 By Timestamp date
 By Schedule date

5. Click Next.

6. On the Data screen, under Available Users, select the supervisors and other 
users/agents that you want to include in your report.
 Click Next.
 On the second Data screen, under Available Agents, select the agents 

to include in the report.
 You can expand business units to display their sites, teams, and agents. 

You can select agents from multiple sites. 

7. Click Finish.

The report appears in the Report Viewer. The report is initially sorted by 
business unit within the enterprise, by site name within each business unit, then 
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team name (if any) within each site. Further sorting is based on Sort Options 
selected on the Date Range screen.

Table 39: Understanding the Schedule Audit Report

Item Description

Site [header] The selected business unit, site, and site time zone.

User Name The name of the user (supervisor) or agent responsible for the 
action.

Timestamp The date and time of the supervisor action.

Action The description of the action. Examples: Publish, Cleanup, Modify.

Date Range If the Action is Publish or Cleanup, this column shows the date 
range for the action. If the Action is Modify, this column shows the 
date of the modified schedule day.

Applied to If the Action is Publish, this column shows the name of the scenario 
used for the published data. If the Action is Modify, this column 
shows the name of the agent associated with the schedule 
modification. If the Action is Cleanup, this column is empty.

If you selected Present action's details on the Data Range screen, 
the following applies:

If the Action is Publish or Cleanup, the report lists all affected 
agents.

Schedule Item, Start Time, 
End Time

If the Action is Modify, the report shows the agent's schedule 
information for the modified day. The following additional columns 
are included: Schedule Item, Start Time, End Time.
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Glossary of Abbreviations
This appendix defines acronyms and abbreviations that appear on Workforce 
Management (WFM) screens and in the documentation.

ACD 

Automatic Call Distribution

ACW 

After Call/Contact Work

AHT 

Average Handling Time; the average amount of time it takes incoming 
interactions to be distributed to agents. You can configure this statistic in 
the WFM Configuration Utility to include noninteraction time, such as 
After Call Work, as a part of the AHT.

ASA 

Average Speed of Answer; the average amount of time agents take to 
respond to incoming interactions. WFM uses this statistic to calculate 
staffing forecasts, and as a basis for contact center performance values.

CIM 

Customer Interaction Management; the Genesys Customer Interaction 
Management platform.

CSV 

Comma-Separated Values; a format used in exporting data to a file, in 
which commas separate data elements.

CTI 

Computer-Telephony Integration

DAP 

Data Access Point

DBO 

Database Owner; a set of user access privileges.

FTE 
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Full-Time Equivalent; an abstract term used to quantify a forecast and 
budget in human terms. The Endnotes section of Appendix B in the current 
Workforce Management Administrator's Guide explains how FTEs are 
calculated.

GUI 

Graphical User Interface; elements of the screen display that are not words, 
including clickable icons.

IOT 

Indirectly Occupied Time

IV 

Interaction Volume; the number of interactions during a specific timestep 
or time period. Forecasted vs. Scheduled is a common comparison.

JDK 

Java Development Kit; the Sun Java Development Kit.

JVM 

Java Virtual Machine

JSP 

Java Server Page; WFM Web uses Java Server Pages to create its dynamic 
web pages.

MSA 

Multi-Site Activities; work activities that are handled at the site (child) 
level. In the object tree, they appear higher in the hierarchy than single-site 
activities.

MSE 

Multi-Skilled Equivalent

MSF 

Multi-Site Forecasting

.MDB 

Microsoft Database format; a three-letter extension signifying the 
Microsoft Access database format.

PTO 

Personal Time Off

SCI 

Solution Control Interface; a Genesys Framework application.

SCS 

Solution Control Server; a Genesys Framework application.

SL 

Service Level
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SSE 

Single-Skill Equivalents

UR 

Universal Routing; a Genesys application.

WFM 

Workforce Management



372 Workforce Management 7.6

Appendix : Glossary of Abbreviations



Supervisor User’s Guide 373

Index

Symbols
% of Abandons control .  .  .  .  .  .  .  .  .  .  .  .  95
% of Abandons Objective control   .  .  .  .  .  .  95

A
Abandoned .  .  .  .  .  .  .  .  .  .  .  .  .280, 282, 286

viewing performance   .  .  .  .  .  . 280, 282, 286
Action Buttons  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  29
Actions menu.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Actions Toolbar .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  14
Actions toolbar .  .  .  .  .  .  .  .  .  .  .  .  .  288, 292
Activities 87, 88, 89, 134, 280, 282, 285, 286, 288, 

304, 309, 320, 321, 323, 326, 344, 345, 
347, 350, 351, 353, 355

adding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 87
removing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 87

Activities defined .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  55
Activity column .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84
Activity control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60
Activity Properties Report   .  .  .  .  .  .  .  .  .  . 304
Activity Weekly Schedule Report.  .  .  .  .  .  . 326
Activity Window   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  87
Actual % column .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  49
Actual Agents column  .  .  .  .  .  .  .  .  .  .  .  .  48
Actual Overhead Report  .  .  .  .  .  .  .  .  .  .  . 350
Actual Status .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
Add activity command  .  .  .  .  .  .  .  .  .  .  .  .  76
Add activity control .  .  .  .  .  .  .  .  .  .  .  .  .62, 86
Add Calendar Item .  .  .  .  .  .  .  .  .  .  .  .  .  .  38
Add Calendar Item Wizard .  .  .  .  .  .  .  .  .  .  37
Add or remove activities within a template .  . 102
Adding  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .40, 41, 42

breaks to schedule   .  .  .  .  .  .  .  .  .  .  .  . 218
comments to Calendar   .  .  .  .  .  .  .  .  .  .  . 40
exceptions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
exceptions to schedules .  .  .  .  .  .  .  .  .  . 218
meals to schedule .  .  .  .  .  .  .  .  .  .  .  .  . 218
preferences  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 41
time off in Calendar  .  .  .  .  .  .  .  .  .  .  .  .  . 42

Adherence 290, 292, 293, 294, 297, 356, 357, 362
agent compliance .  .  .  .  .  .  .  .  .  .  .  .  .  294
changing view.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  290
Details View settings  .  .  .  .  .  .  .  .  .  .  .  293
overview   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  290
viewing chart  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  290
viewing real-time  .  .  .  .  .  .  .  .  .  .  .  .  .  290
viewing shift start  .  .  .  .  .  .  .  .  .  .  .  .  .  293
viewing table   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  294

Adherence Details .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Adherence Graphical View   .  .  .  .  .  .  .  .  . 292
Adherence Totals Report   .  .  .  .  .  .  .  .  .  . 359
Adjust control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .62
Agent Adherence Report   .  .  .  .  .  .  .  .  .  . 357
Agent Properties Report .  .  .  .  .  .  .  .  .  .  . 306
Agents 37, 39, 40, 41, 89, 134, 251, 280, 282, 290, 

292, 294, 304, 306, 309, 326, 330, 335, 
340, 342, 344, 345, 347, 350, 353, 355, 
356, 357, 359, 362

adding Calendar items for   .  .  .  .  .  .  .  .  . 37
adding day off for  .  .  .  .  .  .  .  .  .  .  .  .  .  . 37
adding to schedule  .  .  .  .  .  .  .  .  .  .  .  .  134
adding vacation to   .  .  .  .  .  .  .  .  .  .  .  .  . 37
maximum  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 46
real-time status  .  .  .  .  .  .  .  .  .  .  .  .  .  .  294
viewing compliance .  .  .  .  .  .  .  .  .  .  .  .  294

AHT  .  .  .  .  .  .  .  .  .  .  . 280, 282, 286, 288, 353
viewing performance  .  .  .  .  .  .  .  .  .  .  .  280

AHT column  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 61, 108
AHT control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .60
AHT forecast type  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .65
ASA  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 288
audience

intended.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .8
Audit Report  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 363

Calendar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  364
Schedule  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  366

Average Handling Time  .  .  .  .  .  .  .  .  .  .  . 321
Average Speed of Answer .  .  280, 282, 288, 353

viewing performance  .  .  .  .  .  .  .  .  .  .  .  280
Avg Speed of Answer control  .  .  .  .  .  .  .  .  .95



Index

374 Workforce Management 7.6

Avg Speed of Answer Objective control  .  .  .  95

B
Breaks  .  .  .  .  .  .  .  .  .  .  .  . 309, 326, 344, 345

adding to schedules .  .  .  .  .  .  .  .  .  .  .  . 218
Browsers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 297
Build command.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
Build control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  62
business unit defined.  .  .  .  .  .  .  .  .  .  .  .  .  55
Business Units .  .  .  .  .  .  .  .  .  .  .  .  .  321, 337

C
Calc column  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 75, 110
Calc. staff control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60
Calculated Staffing .  .  .  .  .  .  .  .  .  .  .  .  .  . 321
Calculating What-If Scenarios  .  .  .  .  .  .  .  . 288
Calendar  .  .  .  . 27, 34, 35, 38, 39, 40, 41, 42, 297

adding and editing comments .  .  .  .  .  .  .  . 40
adding and editing time off   .  .  .  .  .  .  .  .  . 42
adding exceptions to   .  .  .  .  .  .  .  .  .  .  .  . 38
adding items to   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 38
adding preferences to .  .  .  .  .  .  .  .  .  .  .  . 38
adding shifts to   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 38
adding working hours to .  .  .  .  .  .  .  .  .  .  . 38
changing dates using  .  .  .  .  .  .  .  . 27, 40, 41
Comments field  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35
filtering view .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
item priority  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27
overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27
Paid Hours field  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35
Reason field .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35
setting view options  .  .  .  .  .  .  .  .  .  .  .  .  . 35

Calendar Audit Report  .  .  .  .  .  .  .  .  .  .  .  . 364
Calendar Items .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27
Calendar Items Report .  .  .  .  .  .  .  .  .  313, 315
Cancel button   .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
Cancel control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
chapter summaries

defining  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  8
Cleanup control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 110
Close command  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
Close control .  .  .  .  .  .  .  .  .  .  .  .  .  .59, 62, 86
commenting on this document .  .  .  .  .  .  .  .  . 8
Comments  .  .  .  .  .  .  .  .  .  .  .  .  . 31, 35, 40, 58

in Calendar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
Comments command   .  .  .  .  .  .  .  .  .  .  .  .  76
Comments control  .  .  .  .  .  .  .  .  .  .  .59, 62, 86
Comments field in Calendar  .  .  .  .  .  .  .  .  .  35
Compare results with previous control .  .  .  .  79
Compliance.  .  .  .  .  .  .  .  .  .  .  .  .290, 294, 351

viewing chart   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 290
viewing real-time   .  .  .  .  .  .  .  .  .  .  .  .  . 294
viewing table.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 294

Configuration   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .19
Configuration Overview  .  .  .  .  .  .  .  .  .  .  .  .19
Contact Center Performance Graphs Report 355
Contact Center Performance Report   .  .  .  . 353
Copying Schedules   .  .  .  .  .  .  .  .  .  .  .  .  . 218
Coverage   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  288, 337
Create a new template.  .  .  .  .  .  .  .  .  .  .  . 102
Create a new template from existing data .  . 102
Created control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .59

D
Dark gray square   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .16
Data Types.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 321
Date Period  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 321
Date Range  .  .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
Date Restrictions.  .  .  .  .  .  .  .  .  .  .  .  320, 321
Dates   .  86, 88, 89, 251, 297, 304, 306, 320, 321, 

323, 324, 326, 330, 335, 340, 342, 344, 
345, 347, 348, 350, 351, 353, 355, 356, 
357, 359, 362

changing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40, 41
Days Off  .  .  .  .  .  .  .  .  27, 38, 40, 309, 326, 345

adding to calendar   .  .  .  .  .  .  .  .  .  .  .  .  . 38
Days or Dates column .  .  .  .  .  .  .  .  .  .  .  .  .61
Days or Dates columns  .  .  .  .  .  .  .75, 108, 110
Delete control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .59
Delete Template control  .  .  .  .  .  .  .  .  .  .  . 104
document

conventions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .8
errors, commenting on  .  .  .  .  .  .  .  .  .  .  .  .8
version number .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .8

E
Edit Template control   .  .  .  .  .  .  .  .  .  .  .  . 104
Edit template values .  .  .  .  .  .  .  .  .  .  .  .  . 102
Editing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35, 40, 42

comments in Calendar  .  .  .  .  .  .  .  .  .  .  . 40
editing in Calendar  .  .  .  .  .  .  .  .  .  .  .  .  . 42
exceptions   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
preference status  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35
shift  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  218

End Date .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
End date .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .58
End date control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .59
End time .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .30
Estimated Budget control  .  .  .  .  .  .  .  .  .  .  .95
Exceptions .  .  .  .  .  .  . 27, 34, 35, 38, 40, 89, 350

adding.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
adding to calendar   .  .  .  .  .  .  .  .  .  .  .  .  . 38
adding to schedules.  .  .  .  .  .  .  .  .  .  .  .  218
deleting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27
editing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
viewing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27



Index

Supervisor User’s Guide 375

F
Filter dialog .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Filter Dialog Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Filtering.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34

Calendar view .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
Filters button .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Finish button  .  .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
Forecast  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
Forecast Data Types .  .  .  .  .  .  .  .  .  .  .  .  . 321
Forecast Graphs Report  .  .  .  .  .  .  .  .  321, 323
Forecast Scenario Graphs View .  .  .  .  .  .  .  57
Forecast Scenario Staffing View .  .  .  .  .  .  .  57
Forecast Scenario Volumes View  .  .  .  .  .  .  57

G
Granularity  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 321
Graphs Report  .  .  .  .  .  .  .  .  .  .  .  .  .  321, 323

H
Headcount  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  280, 337
Hire Date .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
Hour Exceptions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  40
Hourly Wage control  .  .  .  .  .  .  .  .  .  .  .  .  .  79
Hours and Wage Data  .  .  .  .  .  .  .  .  .  .  .  .  79
Hours column   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84

I
Indirectly Occupied Time .  .  .  .  .  .  .  .  .  .  . 288
Indirectly Occupied Time control .  .  .  .  .  .  .  80
initial value defined .  .  .  .  .  .  .  .  .  .  .  .  .  . 105
Inserting

breaks and meals  .  .  .  .  .  .  .  .  .  .  .  .  .  . 37
exceptions into schedules .  .  .  .  .  .  .  .  .  . 37

intended audience  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 8
Interaction Volume .  89, 280, 282, 285, 288, 321, 

353
viewing performance   .  .  .  .  .  .  .  .  .  .  . 280

Interaction Volume and AHT forecast type .  .  65
Interaction volume and/or AHT.  .  .  .  .  .  .  . 288
Interaction Volume forecast type .  .  .  .  .  .  .  65
Intra-day  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
Intra-day View  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 288
IV column.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 61, 108
IV% column   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 61, 108

J
Jump forward or backward one month .  .  .  .  16
Jump forward or backward one year .  .  .  .  .  16
Jump to a specific month.  .  .  .  .  .  .  .  .  .  .  16

Jump to a specific year   .  .  .  .  .  .  .  .  .  .  .  .16

L
Limits.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 46, 49

for time off.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 49
for time-off.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 46

M
Mark as Not Shared control  .  .  .  .  .  .  .  .  .  .59
Mark as Shared control  .  .  .  .  .  .  .  .  .  .  .  .59
Marked Time .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 332

report  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  331
totals report .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  332

Master Forecast  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 288
Max % field   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .50
Max Agent field   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .50
Max. % Agents column   .  .  .  .  .  .  .  .  .  .  .  .48
Max. % column   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .48
Max. Agents column .  .  .  .  .  .  .  .  .  .  .  .  .  .48
Maximum Agents   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .46
Maximum Occupancy control  .  .  .  .  .  .  .  .  .95
Maximum Occupancy Objective control .  .  .  .95
Maximum Occupancy Percentage .  .  .  .  .  . 288
Meals   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27, 40, 309

adding to schedules.  .  .  .  .  .  .  .  .  .  .  .  218
Message Body area .  .  .  .  .  .  .  .  .  .  .  .  .  .21
Minimum Staffing Level  .  .  .  .  .  .  .  .  .  .  . 304
Min-Max Levels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 304
Minute Exceptions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .40
Modules toolbar command.  .  .  .  .  .  .  .  .  .  .13
Multi-Site Activities.  .  .  .  .  .  .  .  .  .  .  .  .  . 321
Multi-site activities defined .  .  .  .  .  .  .  .  .  .  .55
Multi-skilled calculated staffing described .  .  .94
My Scenarios   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .58

N
N. Overhead column.  .  .  .  .  .  .  .  .  .  .  .  .  .84
Name   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .58
Name control.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .59
New control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .59
New Template control  .  .  .  .  .  .  .  .  .  .  .  . 104
No Time Off Allowed .  .  .  .  .  .  .  .  .  .  .  .  .  .50
No Time Off Limits .  .  .  .  .  .  .  .  .  .  .  .  .  .  .50
None control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .95
Non-Working Overhead control  .  .  .  .  .  .  .  .80
Number of Agents  .  .  .  .  .  .  .  .  .  .  .  .  .  . 280

viewing performance  .  .  .  .  .  .  .  .  .  .  .  280

O
Objects toolbar command  .  .  .  .  .  .  .  .  .  .  .13



Index

376 Workforce Management 7.6

One minute exceptions.  .  .  .  .  .  .  .  .  .  .  .  40
Open control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  287, 293

dialog box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 287
for Adherence Details view  .  .  .  .  .  .  .  . 293

Options control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  86
Other Scenarios  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
Overhead Data control .  .  .  .  .  .  .  .  .  .  .  .  80
Overtime  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 218
Overview .  27, 280, 290, 297, 304, 320, 321, 324, 

326, 348, 350, 356, 357
of Adherence   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 290
of Agent Extended view .  .  .  .  .  .  .  .  .  . 218
of Calendar  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27
of Performance  .  .  .  .  .  .  .  .  .  .  .  .  .  . 280
of reporting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 297

Owner   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
Owner control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59

P
Paid Hours .  .  .  .  .  .  .  .  .  .  .  . 27, 31, 35, 218
Paid Hours a Day control.  .  .  .  .  .  .  .  .  .  .  79
Pencil icon  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 218
Performance  .  . 89, 280, 282, 285, 286, 297, 348, 

350, 351, 353, 355, 359
adjust time zone .  .  .  .  .  .  .  .  .  .  .  .  .  . 285
changing time settings.  .  .  .  .  .  .  .  .  .  . 280
changing view settings   .  .  .  .  .  .  .  .  .  . 280
overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 280
performance graphs .  .  .  .  .  .  .  .  .  .  .  . 285
viewing summary  .  .  .  .  .  .  .  .  .  .  .  .  . 280
viewing table.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 282

Preferences   .  .  .  .  .  .  .  .  .  .  .  . 27, 34, 35, 41
adding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 41
adding to calendar.  .  .  .  .  .  .  .  .  .  .  .  .  . 38
changing status  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35
Requested vs Actual status .  .  .  .  .  .  .  .  . 35
viewing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27

Priority  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27
exceptions and preferences .  .  .  .  .  .  .  .  . 27

Profile scheduling defined  .  .  .  .  .  .  .  .  .  . 125
Progress message .  .  .  .  .  .  .  .  .  .  .  320, 321
Properties Report   .  .  .  .  .  .  .  .  .  .  .  .  .  . 304
Publish control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59

R
Real-Time Adherence  .  .  .  .  .  .  .  .  .  290, 294

viewing chart   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 290
viewing table.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 294

Reason .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .31, 35
Reason field in Calendar .  .  .  .  .  .  .  .  .  .  .  35
Refresh toolbar command  .  .  .  .  .  .  .  .  .  .  13
Remove activity command .  .  .  .  .  .  .  .  .  .  76

Remove activity control  .  .  .  .  .  .  .  .  .  . 62, 86
Removing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .87

scheduled activities .  .  .  .  .  .  .  .  .  .  .  .  . 87
Reports   . 297, 299, 302, 304, 306, 309, 313, 315, 

318, 320, 321, 323, 324, 326, 330, 335, 
340, 342, 344, 345, 347, 348, 350, 351, 
353, 355, 356, 357, 359, 362

Activity Properties Report .  .  .  .  .  .  .  .  .  304
Activity Weekly Schedule Report .  .  .  .  .  326
Actual Overhead Report   .  .  .  .  .  .  .  .  .  350
Adherence Totals Report  .  .  .  .  .  .  .  .  .  359
Agent Adherence Report  .  .  .  .  .  .  .  .  .  357
Agent Properties Report   .  .  .  .  .  .  .  .  .  306
Calendar Items Report  .  .  .  .  .  .  .  . 313, 315
Contact Center Performance Graphs Report .  .

355
Contact Center Performance Report  .  .  .  353
Forecast Graphs Report   .  .  .  .  .  .  . 321, 323
Forecast Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  321
Marked Time Totals Report .  .  .  .  .  .  .  .  332
overview   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  297
Reports List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  299
Schedule Marked Time Report  .  .  .  .  .  .  331
Schedule State Totals Report .  .  .  .  .  .  .  340
Schedule States Report .  .  .  .  .  .  .  .  .  .  335
Schedule Trade Report .  .  .  .  .  .  .  .  .  .  342
Schedule Validation Report .  .  .  .  .  .  .  .  344
Scheduled Budget Report   .  .  .  .  .  .  .  .  330
Shift Properties Report  .  .  .  .  .  .  .  .  .  .  309
Site Performance Report  .  .  .  .  .  .  .  .  .  353
Team Schedule Report  .  .  .  .  .  .  .  .  .  .  344
Team Weekly Schedule Report .  .  .  .  .  .  345
Time Off Balance Report  .  .  .  .  .  .  .  .  .  318
Time Off Report .  .  .  .  .  .  .  .  .  .  .  . 313, 315
Weekly Schedule Coverage Report.  .  .  .  347
Workforce Performance Report .  .  .  .  .  .  351

Req column  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75, 110
Req. staff control.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .60
Requested Status  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .36
Required Staffing   .  .  .  .  .  .  .  .  .  .  .  .  .  . 321
Required staffing command  .  .  .  .  .  .  .  .  .  .76

S
Save as template command .  .  .  .  .  .  .  .  .  .76
Save as template control   .  .  .  .  .  .  .  .  .  . 110
Save command  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .76
Save control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 59, 86
Schedule Audit Report .  .  .  .  .  .  .  .  .  .  .  . 366
Schedule Marked Time Report   .  .  .  .  .  .  . 331
Schedule State Totals Report  .  .  .  .  .  .  .  . 340
Schedule States Report  .  .  .  .  .  .  .  .  .  .  . 335
Schedule Trade Report  .  .  .  .  .  .  .  .  .  .  . 342
Schedule Validation Report  .  .  .  .  .  .  .  .  . 344
Scheduled Budget Report .  .  .  .  .  .  .  .  .  . 330
Scheduled State Groups .  .  .  .  .  .  .  .  .  .  . 292



Index

Supervisor User’s Guide 377

Scheduled States.  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Schedules 27, 34, 35, 89, 251, 280, 282, 286, 288, 

290, 292, 297, 304, 309, 324, 326, 330, 
335, 340, 342, 344, 345, 347, 350, 351, 
353, 357, 362

Copying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 218
Validating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 344

Security.  . 304, 320, 321, 324, 326, 348, 350, 356, 
357

Security Permissions .  .  .  .  .  .  .  .  .  .  .  .  . 218
Security Restrictions .  .  .  .  . 320, 321, 356, 357
Select a new start date .  .  .  .  .  .  .  .  .  .  .  .  16
Select and manage forecast templates   .  .  . 102
select Filter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 292
Service Level .  .  .  .  .  .  .  .  . 280, 282, 288, 353

viewing performance   .  .  .  .  .  .  .  .  .  .  . 280
Service Level control .  .  .  .  .  .  .  .  .  .  .  .  .  95
Service Level Objective control   .  .  .  .  .  .  .  95
Set Values Dialog Box  .  .  .  .  .  .  .  .  .  .  .  .  49
Setting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35

calendar view options .  .  .  .  .  .  .  .  .  .  .  . 35
time zones in Performance module .  .  .  . 287

Settings.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 293
for Adherence Details View  .  .  .  .  .  .  .  . 293

Shared  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
Shared control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Shared Scenarios   .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
Shift Definitions Report.  .  .  .  .  .  .  .  .  .  .  . 309
Shift Properties Report .  .  .  .  .  .  .  .  .  .  .  . 309
Shifts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  38

adding to calendar.  .  .  .  .  .  .  .  .  .  .  .  .  . 38
view start time in Adherence   .  .  .  .  .  .  . 293

Show Historical Data control .  .  .  .  .  .  .  .92, 93
Show Secondary Graph control  .  .  .  .  .  .  .  94
Show Special Events control .  .  .  .  .  .92, 93, 94
Show Values control  .  .  .  .  .  .  .  .  .  .92, 93, 94
Show Weighted AHT control .  .  .  .  .  .  .  .  .  93
Site .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
Site column.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84
Sites  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 293

viewing in Adherence Details view   .  .  .  . 293
Sites defined .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  55
Some Time Off Allowed   .  .  .  .  .  .  .  .  .  .  .  50
Sort control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Split command  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
Split control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  62
Split Required Also control .  .  .  .  .  .  .  .  .  .  83
Staffing

scheduled and required .  .  .  .  .  .  .  .  .  . 280
Start date .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
Start date control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Start Offset, Shift Properties Report  .  .  .  .  . 309
Start Step, Shift Properties Report .  .  .  .  .  . 309
Start Time   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  218, 304
Start time .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  30
Status.  .  .  .  .  .  .  . 27, 35, 39, 89, 290, 342, 362

Actual vs Requested  .  .  .  .  .  .  .  .  .  .  .  . 35
changing for preferences .  .  .  .  .  .  .  .  .  . 27
editing for preferences  .  .  .  .  .  .  .  .  .  .  . 35

Status Actual .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .34
Status actual .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .30
Status Requested  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .34
Status requested.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .30
Stop toolbar command.  .  .  .  .  .  .  .  .  .  .  .  .13
Subject area .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .21
Submitted  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .35
Summary.  .  .  .  .  .  .  .  .  .  .  .  .  . 280, 282, 294

performance levels  .  .  .  .  .  .  .  .  .  .  .  .  280

T
Team .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .35
Team Schedule Report   .  .  .  .  .  .  .  .  .  .  . 344
Team Weekly Schedule Report  .  .  .  .  .  .  . 345
Teams 27, 251, 290, 292, 294, 306, 330, 335, 340, 

342, 344, 345, 356, 357, 359, 362
viewing compliance levels   .  .  .  .  .  .  .  .  290

Templates  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .86
Loading Forecast .  .  .  .  .  .  .  .  .  .  .  .  .  . 86

Time Off  .  .  .  .  .  .  .  . 27, 34, 38, 42, 46, 49, 306
adding to calendar   .  .  .  .  .  .  .  .  .  .  . 38, 42
editing in Calendar  .  .  .  .  .  .  .  .  .  .  .  .  . 42
setting limits for .  .  .  .  .  .  .  .  .  .  .  .  . 46, 49

Time Off AllowedóEnter  .  .  .  .  .  .  .  .  .  .  .  .49
Time Off Balance Report.  .  .  .  .  .  .  .  .  .  . 318
time off during  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .49
Time Off Limits .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .27
Time Off LimitsóLeave .  .  .  .  .  .  .  .  .  .  .  .  .49
Time Off Report  .  .  .  .  .  .  .  .  .  .  .  .  313, 315
Time Off Request Status Change notification  .22
Time Zone adjust in Performance Graph  .  . 285
Time Zones   .  .  .  .  .  .  .  .  .  .  .  . 287, 304, 355

adjusting in Performance Graph  .  .  .  .  .  287
Timestep .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 355
To accept or decline proposed trades .  .  .  . 276
To activate the Scenarios view.  .  .  .  .  .  .  . 125

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  128
To add activities to a scenario .  .  .  .  .  .  .  . 152
To add an agent to a scenario .  .  .  .  .  .  .  . 152
To add events  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .71
To assign a real agent to a profile schedule slot.  

160
To bring up the module for notification of 

schedule trade status changes  .  .  .  .20
To bring up the module for notification of time-off 

request status changes .  .  .  .  .  .  .  .22
To bring up the Options dialog box   .  .  .  .  .  .94
To build volume data .  .  .  .  .  .  .  .  .  .  .  .  .  .63
To calculate what-if scenarios  .  .  .  .  .  .  .  . 289
To change a Date range period  .  .  .  .  .  .  .  .61
To change minutes.  .  .  .  .  .  .  .  .  .  .  .  .  .  .40
To change Reports Wizard settings  .  .  .  .  . 298



Index

378 Workforce Management 7.6

To change rotating pattern settings.  .  .  .  .  .  29
To change the activities that are associated with 

the current forecast scenario   .  .  .  .  87
To change the dates  .  .  .  .  .  .  .  .  .  .  .  .  .  47
To change the status of a not-yet-scheduled item

36
To choose a Calendar item.  .  .  .  .  .  .  .  .  .  38
To close a displayed report.  .  .  .  .  .  .  .  .  . 299
To close a wizard without saving .  .  .  .  .  .  .  39
To configure a graph .  .  .  .  .  .  .  .  .  .  .  .  . 147
To configure alerts  .  .  .  .  .  .  .  .  .  .  .  .  .  . 286
To configure data shown on the  .  .  .  .  .  .  . 149
To configure data shown on the Agent Extended 

view  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 149
To configure data shown on the Intra-Day view   . 

149
To configure notifications .  .  .  .  .  .  .  .  .  .  .  22
To configure options in a dialog box  .  .  .  .  . 150
To configure options on the Columns tab   .  . 171
To configure options on the Options tab  .  .  . 171
To configure the Columns tab  .  .  .  .  .  .  .  . 151
To configure the performance data views  .  . 147
To configure the Performance tab  .  .  .  150, 216
To control which State Groups are displayed 164
To control which Statuses are displayed .  .  . 168
To create a Calendar Audit Report .  .  .  .  .  . 364
To create a Calendar Items Report.  .  .  .  .  . 315
To create a Contact Center Performance Graphs 

Report  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 355
To create a Contact Center Performance Report  

353
To create a Contract Properties Report   .  .  . 307
To create a Forecast Graphs Report .  .  .  .  . 323
To create a new forecast template from existing 

data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 106
To create a Rotating Pattern Properties Report   . 

312
To create a Schedule Audit Report.  .  .  .  .  . 366
To create a schedule before you actually hire 

agents .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 125
To create a Schedule Marked Time Report   . 331
To create a Schedule Marked Time Totals Report

332, 340
To create a Schedule States Report  .  .  .  .  . 335
To create a Schedule Summary Report  .  .  . 337
To create a Schedule Trade Report  .  .  .  .  . 342
To create a Schedule Validation Report  .  .  . 344
To create a Scheduled Budget Report .  .  .  . 330
To create a Shift Properties Report   .  .  .  .  . 309
To create a Team Schedule Report   .  .  .  .  . 344
To create a Team Weekly Schedule Report  . 345
To create a Time Off Balance Report   .  .  .  . 318
To create a Time Off Report  .  .  .  .  .  .  .  .  . 316
To create a Weekly Schedule Coverage Report  . 

347
To create a Workforce Performance Report  . 351

To create an Activities Properties Report  .  . 304
To create an Actual Overhead Report .  .  .  . 350
To create an Adherence Totals Report.  .  .  . 359
To create an Agent Adherence Report.  .  .  . 357
To create an Agent Comments Report.  .  .  . 328
To create an Agent Properties Report .  .  .  . 306
To create an Agent States Report  .  .  .  .  .  . 362
To create an Individual Schedule Report   .  . 329
To customize a displayed table   .  .  .  .  .  .  . 140
to customize a Forecast Graphs view .  .  .  .  .92
to customize the Scenario Graphs view .  .  .  .91
To define a new forecast general parameters .55
To display a column  .  .  .  .  .  .  .  .  .  .  .  .  .  .35
To display a table with status information  .  . 131
To display the Agent-Extended view.  .  .  .  . 154
To display the Details view.  .  .  .  .  .  .  .  .  . 291
To display the following controls .  .  .  .  .  .  . 130
To display the Graphical view  .  .  .  .  .  .  .  . 294
To display the Intra-Day view  .  .  .  .  .  .  .  . 143
To display the List of Trades view  .  .  .  .  .  . 275
To display the Scenario Coverage view .  .  . 136
To display the Scenario Profiles/Bidding view159
To display the Scenario Weekly view  .  .  .  . 138
To display the Staffing view  .  .  .  .  .  .  . 74, 109
To display the Summary view  .  .  .  .  .  .  .  . 164
To display the Volumes view.  .  .  .  .  .  .  .  .  .60
To edit a Calendar item  .  .  .  .  .  .  .  .  .  .  .  .44
To edit a scenario  .  .  .  .  .  .  .  .  .  .  .  . 58, 129
To edit exceptions  .  .  .  .  .  .  .  .  .  .  .  .  .  . 201
To edit exceptions on the Schedule Intra-day or 

Agent-Extended view .  .  .  .  .  .  .  . 200
To edit the start time, and the end time or 

duration, of an agent’s schedule item200
To exit the Alerts view  .  .  .  .  .  .  .  .  .  .  .  . 287
To export a report to a disk file.  .  .  .  .  .  .  . 302
To fill in the Select Agents screen . 175, 181, 186
To fill in the Select Breaks screen .  .  .  .  .  . 182
To fill in the Select Exception screen   .  .  .  . 178
To fill in the Select Exceptions screen .  .  .  . 183
To fill in the Select Meals screen.  .  .  .  .  .  . 183
To fill in the Select State Type screen  .  .  .  . 176
To fill in the Select State Types screen   .  .  . 182
To fill in the Select Time Off screen  .  .  .  .  . 178
To fill in the Select Time Offs screen.  .  .  .  . 184
To fill in the wizard screen General Parameters .  

132
To fill in the wizard screen Select Activity  .  . 133
To fill in the wizard screen Select Agents  .  . 134
To fill in the wizard screen, Select Profile  .  . 135
To filter the displayed information by state or by 

reason.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 295
To filter the displayed information by state or by 

reason (aux) code .  .  .  .  .  .  .  .  .  . 292
To find a specific agent in the Scenario Intra-Day 

view .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 146
To find a specific agent in the Scenario Weekly 



Index

Supervisor User’s Guide 379

view  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 141
To finish defining a new forecast .  .  .  .  .  .  .  56
To force a display of updated information  .  . 290
To hide a column .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
To include all pending changes that are in an 

agent's schedule.  .  .  .  .  .  .  .  .  .  . 191
To include required staffing figures .  .  .  .  .  . 346
To insert a break into an agent’s schedule .  . 192
To insert a full-day exception .  .  .  .  .  .  .  .  . 195
To insert a meal into an agent’s schedule  .  . 193
To insert a part-day exception  .  .  .  .  .  .  .  . 194
To insert a part-day time off schedule item.  . 196
To insert a shift into an agent’s schedule.  .  . 191
To insert an activity set into an agent’s schedule  

194
To insert full-day time-off into an agent's 

schedule .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 198
To insert marked time into an agent’s schedule   . 

199
To jump to a particular page  .  .  .  .  .  .  .  .  . 298
To jump to the final page .  .  .  .  .  .  .  .  .  .  . 298
To jump to the first page  .  .  .  .  .  .  .  .  .  .  . 298
To keep changes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  48
To log off from any WFM Web view  .  .  .  .  .  18
To make changes to one agent's schedule at a 

time  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 145
To make changes to the selected agent's 

schedule .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 155
To make detailed scheduled changes for one 

agent at a time.  .  .  .  .  .  .  .  .  .  .  . 147
To modify activities associated with a forecast 

template .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 105
To modify an agent’s activity set by adding or 

removing activities .  .  .  .  .  .  .  .  .  . 201
To modify the message subject or body text .  21
To move one page forward or back   .  .  .  .  . 298
To open a view .  .  .  .  .  .  .  .  .  .  .  .  .  126, 128
To open Find Agent dialog box .  .  .  .  .  .  .  .  31
To open Master Schedule views .  .  .  .  .  .  . 126
To open the Edit Comments dialog box  .  .  . 149
To open the Options dialog box   .  .  .  .  149, 171
To open the Select Target window .  .  .  .  .  . 148
To open the What-If window  .  .  .  .  .  .  .  .  . 288
To populate the Scenario Properties pane .  . 129
To print a copy of a report  .  .  .  .  .  .  .  .  .  . 298
To print a header on a report . 303, 304, 306, 308, 

309, 312, 314, 315, 317, 319, 320, 321, 
326, 328, 329, 330, 331, 333, 335, 337, 
341, 343, 344, 345, 347, 349, 350, 351, 
353, 355, 357, 358, 359, 362, 364, 365, 
367

To print a report in report in comma-separated 
values format   .  314, 315, 317, 319, 349, 
350, 351, 353, 358, 359, 362

To publish a forecast .  .  .  .  .  .  .  .  .  .  .  .  .  90
To remove a column from the table   .  .  .  .  .  47

To remove a scenario's views  .  .  .  .  .  .  .  .  .57
To remove a scenario's views from the displayed 

lists  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 53, 126
To remove a scenario's views from these 

controls  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 128
To remove an agent assignment.  .  .  .  .  .  . 160
To remove an agent from a scenario   .  .  .  . 152
To remove an agent profile slot  .  .  .  .  .  .  . 160
To respond to warnings  .  .  .  .  .  .  .  .  .  .  . 179
To retrieve specific data  .  .  .  .  .  .  .  .  .  .  .  .31
To search a table for particular agents.  .  .  . 141
To search for one or more agents  .  .  .  .  .  .  .17
To see agents who have an exception.  .  . 32, 34
To select an option .  .  .  .  .  .  .  .  .  .  .  .  .  . 129
To select another time zone .  .  .  .  .  .  .  .  . 287
To set an alert on a different business unit, site, 

or activity  .  .  .  .  .  .  .  .  .  .  .  .  .  . 287
To set minimum time-off limits .  .  .  .  .  .  .  .  .49
To set the minimum for multiple timesteps at 

once .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .49
To set the Start and End Time for Availability or 

Working Hours   .  .  .  .  .  .  .  .  .  .  .  .39
To start using WFM Web.  .  .  .  .  .  .  .  .  .  .  .12
To switch from rolling to current-day view .  . 286
To switch to a different statistic   .  .  .  .  .  .  . 285
To transfer data from the Master Forecast into a 

forecast scenario  .  .  .  .  .  .  .  .  .  .  .91
To unassign a real agent from the selected shift   

162
To use the Add Calendar Items wizard   .  .  .  .37
To use the Add/Remove Scenario Elements 

Wizard.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 152
To use the Calendar Options dialog box .  .  .  .35
To use the Commit/Rollback Multiple Wizard 186
To use the current-day view .  .  .  .  .  .  .  .  . 282
To use the Insert Multiple Wizard  .  .  .  .  .  . 173
To use the New Forecast Wizard   .  .  .  .  .  .  .54
To use the Set Values dialog box  .  .  .  .  .  .  .49
To view all pages of a multi-page report .  .  . 298
To view Calendar items  .  .  .  .  .  .  .  .  .  .  .  .29
To view performance data .  .  .  .  .  .  .  .  .  . 148
To view the Shift Start column .  .  .  .  .  .  .  . 293
To view the Site column  .  .  .  .  .  .  .  .  .  .  . 294
To zoom to a different magnification .  .  .  .  . 298
Tokens area  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .21
Total Hours.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 218
typographical styles  .  .  .  .  .  .  .  .  .  .  .  .  .  .  8

U
Use

Set Values dialog  .  .  .  .  .  .  .  .  .  .  .  .  .  . 49
Use AHT Forecast control .  .  .  .  .  .  .  .  . 72, 82
Use All Activities control .  .  .  .  .  .  .  .  .  . 73, 83
Use Multi-Site Activities  .  .  .  .  .  .  .  .  .  .  . 282
Use multi-site activities command .  .  .  .  .  .  .76



Index

380 Workforce Management 7.6

Use multi-site activities control .  .  .  . 62, 86, 110
Use multi-site activity control .  .  .  .  .  .  .  .  .  95
Use Service-Level Objectives control  .  .  .  .  80

V
Validation Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 344
Variance  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 280
version numbering

document  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  8
View template values in a graph .  .  .  .  .  .  . 102
Viewing .  .  .  .  .  .  .  .  .  .  . 27, 34, 280, 290, 294

adherence .  .  .  .  .  .  .  .  .  .  .  .  .  .  .290, 294
adherence chart .  .  .  .  .  .  .  .  .  .  .  .  .  . 290
adherence table .  .  .  .  .  .  .  .  .  .  .  .  .  . 294
agent compliance levels .  .  .  .  .  .  .  .  .  . 294
Calendar.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27
compliance levels  .  .  .  .  .  .  .  .  .  .  .  .  . 290
filtering Calendar view .  .  .  .  .  .  .  .  .  .  .  . 34
performance .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 280
performance graphs .  .  .  .  .  .  .  .  .  .  .  . 285
performance summary   .  .  .  .  .  .  .  .  .  . 280
performance table .  .  .  .  .  .  .  .  .  .  .  .  . 282
preferences and exceptions .  .  .  .  .  .  .  .  . 27

Views Toolbar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  14
Volumes control   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60

W
W. Overhead column.  .  .  .  .  .  .  .  .  .  .  .  .  84
Wage column.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84
Week/Time Step column .  .  .  .  .61, 75, 108, 110
Week/Timestep column   .  .  .  .  .  .  .  .  .  .  .  48
Weekly Schedule Coverage Report  .  .  .  .  . 347
Weekly Totals column  .  .  .  .  .  .  .  .  .  . 61, 109
Weekly Totals columns .  .  .  .  .  .  .  .  .  . 75, 110
WFM Configuration Utility  .  .  .  .  .  .  .  .  .  . 292
WFM reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  320, 321
WFM Web  .  .  .  .  .  .  .  .  .  .  . 40, 280, 290, 297

reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 297
What-if Dialog for performance.  .  .  .  .  .  .  . 288
Wizards.  .  89, 251, 297, 304, 309, 320, 321, 324, 

326, 332, 355, 356, 357
Workforce Performance Report   .  .  .  .  .  .  . 351
Working Hours .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  38

adding to Calendar   .  .  .  .  .  .  .  .  .  .  .  .  . 38
Working Overhead control  .  .  .  .  .  .  .  .  .  .  80


	Table of Contents
	Preface
	Intended Audience
	Document Conventions
	Making Comments on This Document

	Getting Started
	Overview
	Site Freedom
	Security Features
	Setting the Clock

	Logging In
	The Supervisor’s Window
	Elements of the Supervisors Window
	Customizing Table Views

	Date Selectors
	Selecting the Start Date
	Selecting the Month
	Weekly Views: Automatic Start Day Selection

	Finding Agents in Tables
	Logging Off

	Configuration Module
	Configuring Notifications Overview
	Default Setting
	Security Permissions
	WFM Daemon

	Notification of Schedule Trade Status Changes
	Message Tab
	Modifying the Message
	Targets Tab
	Rules for Sending
	Double-Handshake Trade Proposals

	Notification of Time-Off Request Status Changes
	Message Tab

	Notification of Schedule Modifications

	Calendar Module
	Calendar Items Overview
	Calender Module Controls
	About the Calendar Items Module
	Calendar Module Security
	Displaying the Calendar Module
	Calendar Module Columns
	How to Use the Calendar
	Calendar Object Hierarchy
	Explanation of Calendar Colors

	Filter Dialog Box
	Options Dialog Box
	Change Preference Status
	Preference Statuses
	Requested Status vs. Actual Status

	Add Calendar Items Wizard
	Overview
	Choose Agents
	Choose Calendar Item
	Add Calendar Item

	Add or Edit Start/End Time
	Add or Edit Comments
	Add or Edit Exceptions
	Add or Edit Shifts
	Add or Edit Time Off

	Update Schedule Options
	Edit Calendar Items
	Calendar Items Wizard Screen Sequences

	Review Calendar Messages Dialog Box
	Time Off Limits
	Overview
	Setting Time-Off Limits
	The Time-Off Limits Table
	Setting Minimum Time-Off Limits

	The Set Values Dialog Box

	Forecasting
	Overview
	About Forecasting
	Creating and Working with Forecasts
	Using the Forecast Scenarios View
	Using Other Scenario Views

	New Forecast Wizard
	Overview
	Terminology Review
	General Parameters
	Select Activity

	Forecast Scenarios
	Overview
	Forecast Scenarios View
	Scenario Volumes View

	Volumes Build Wizard
	Overview
	Select Activities
	Select Data Build Method
	Select Historical Data
	Select Templates
	Select Events
	Volumes Split Wizard
	Adjust Volume Dialog Box
	Scenario Staffing View
	Required Staffing Dialog Box

	Staffing Build Wizard
	Overview
	Staffing Build Results View
	Staffing Split Wizard
	Scenario Graphs View
	Load Forecast Template Window
	Add Activity Window
	Remove Activity Window
	Add Comments to a Forecast
	Publish/Extract Forecasts

	Graph View Options
	Overview
	Interaction Volume
	AHT
	Staffing

	Overlays
	Getting Started
	Managing the List of Overlays
	Editing an Overlay

	New Overlay Wizard
	Properties Page
	Usage Page

	Forecast Templates
	Overview
	List View

	Master Forecast Views
	Master Forecast Overview
	Master Forecast Volumes View
	Master Forecast Staffing View
	Master Forecast Graphs View
	Options for the Master Forecast Graphs

	Historical Data
	Overview
	Historical Data Overview
	Historical Data Volumes View
	Historical Data Graphs View
	Options for Historical Data Graphs


	Scheduling
	Overview
	Schedule Module
	Schedule Security
	About Scheduling
	Using the Schedule Scenarios View
	Using Other Scenario Views
	Using the Master Schedule Views
	Pending Schedule Changes

	Schedule Scenarios View
	Schedule Scenarios View
	Creating and Managing Scenarios

	New Schedule Scenario Wizard
	Overview
	General Parameters
	Select Activity
	Select Agents
	About Scheduling with Profiles
	Scenario Coverage View
	Scenario Weekly View
	Toolbar: Modifying the Schedule
	Scenario Intra-Day View
	Add/Remove Scenario Elements Wizard
	Scenario Agent-Extended View
	Scenario Profiles/Bidding View

	Scenario State Group Totals
	Displaying State Group Totals
	Scenario Summary View

	Schedule Filter Dialog Box
	Statuses Filter Dialog Box
	Options Dialog Boxes
	Summary View Options Dialog Box
	Weekly View Options Dialog Box

	Sorting Dialog Box
	Swap Agent Schedules Wizard
	Review Swapping Messages
	Reviewing Messages
	Insert Multiple Wizard
	Overview
	Select Agents Screen
	Select Dates Screen
	Select State Type Screen
	Select Shift Screen
	Select Activity Set Screen
	Select Break Screen
	Select Meal Screen
	Select Exception Screen
	Select Time Off Screen
	Review Messages Dialog Box

	Delete Multiple Wizard
	Overview
	Select Agents Screen
	Select Dates Screen
	Select State Types Screen
	Select Breaks Screen
	Select Meals Screen
	Select Exceptions Screen
	Select Time Offs Screen

	Commit/Rollback Multiple Wizard
	Overview
	Select Agents Screen
	Select Dates Screen

	Modify Individual Agents' Schedules
	Overview
	Insert Shift Wizard
	Insert Break Dialog Box
	Insert Meal Dialog Box
	Insert Activity Set Dialog Box
	Insert Exception Dialog Boxes
	Insert Time Off Dialog Boxes
	Insert Marked Time Dialog Box
	Edit Item Dialog Box
	Edit Exception Dialog Box
	Set Activities Dialog Box
	Copy Schedule Dialog Box

	Meeting Scheduler Wizard
	Meeting Scheduler vs. Meeting Planner

	Master Schedule
	Master Schedule Coverage View
	Master Schedule Weekly View
	Weekly View Options Dialog Box
	Master Schedule Intra-Day View
	Master Schedule Agent-Extended View
	Master Schedule Summary View
	Cleanup Master Schedule Window
	Master Schedule Changes Approval
	Filter By Agent Properties
	Review Validation Messages Dialog Box

	Schedule Bidding
	Overview
	Configure Bidding Scenario
	Bidding Candidates Selection
	Control Bidding Process Wizard
	Resolving and Publishing a Bidding Scenario
	Auto-Assign Schedules Wizard

	Schedule Build Wizard
	Overview
	Select Site/Build Options
	Preference Fulfillment Options
	Preference Fulfillment Options

	Intra-Day Schedule Rebuild Wizard
	Overview
	Select Options
	Site and Build Options
	Team Synchronicity
	Preference Fulfillment Options
	Optimize Profiles
	Assign Profiles to Teams

	Schedule Rebuild Wizard
	Select Agents
	Select Activities

	Publishing/Extracting Schedules
	Why Publish Schedules?
	Publishing to the Master Schedule
	Extracting a Schedule from the Workforce Management Database

	Schedule Validation
	Using the Review Messages Window
	Warnings List
	Errors List


	Trading
	Using the List of Trades View
	How Trading Works
	Trading Summarized
	Requirements for a Successful Trade
	How Trades are Tested for Automatic Approval

	List of Trades View
	Displaying the List of Trades
	Using the Table
	Accepting or Declining Trades

	Trading Comments Dialog Box
	Schedule Details Dialog Box

	Performance and Adherence
	Performance Monitor View
	Displaying the Monitor View
	Using the Monitor View
	Required Data Options

	Performance Intra-Day View
	Displaying the Intra-Day View
	Reading and Navigating the Grid
	Display, Copy/Paste, and Other Options

	Performance Graphs View
	Displaying the Graphs View
	Using the Graphs View

	Performance Alerts View
	Performance Options Dialog Box
	What-If Window
	Calculating What-If Scenarios

	Adherence
	Overview

	Adherence Overview
	Adherence Details View
	Displaying the Adherence Details View
	Reading the Details Table
	Customizing the Table

	Adherence Filter Dialog Box
	Adherence Details Options Dialog Box
	Adherence Graphical View
	Displaying the Adherence Graphical View
	How to Read the Chart


	Reports
	Reports Overview
	Report Viewer Features
	Reports List
	Saving Reports to Files

	Configuration Reports
	Overview
	Creating a Report
	Activity Properties Report

	Policies Reports
	Overview
	Creating a Report
	Agent Properties Report
	Shift Properties Report
	Rotating Pattern Properties Report

	Calendar Reports
	Calendar Items Report
	Time Off Report
	Time Off Balance Report

	Forecast Reports
	Overview
	Forecast Report
	Forecast Graphs Report

	Schedule Reports
	Overview
	Creating a Report
	Activity Weekly Schedule Report
	Agent Comments Report
	Individual Schedule Report
	Scheduled Budget Report
	Schedule Marked Time Report
	Schedule Marked Time Totals Report
	Schedule States Report
	Schedule Summary Report
	Schedule State Totals Report
	Schedule Trade Report
	Schedule Validation Report
	Team Schedule Report
	Team Weekly Schedule Report
	Weekly Schedule Coverage Report

	Performance Reports
	Overview
	Creating a Report
	Actual Overhead Report
	Workforce Performance Report
	Contact Center Performance Report
	Contact Center Performance Graphs Report

	Adherence Reports
	Overview
	Creating a Report
	Agent Adherence Report
	Adherence Totals Report
	Agent States Report

	Audit Reports
	Creating a Report
	Calendar Audit Report
	Schedule Audit Report


	Glossary of Abbreviations
	Index

